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Designing Experiments 
Design of Experiments (DOE) Overview 
In industry, designed experiments can be used to systematically investigate the process or product variables that 
influence product quality. After you identify the process conditions and product components that influence product quality, 
you can direct improvement efforts to enhance a product's manufacturability, reliability, quality, and field performance. 
For example, you may want to investigate the influence of coating type and furnace temperature on the corrosion 
resistance of steel bars. You could design an experiment that allows you to collect data at combinations of 
coatings/temperature, measure corrosion resistance, and then use the findings to adjust manufacturing conditions. 
Because resources are limited, it is very important to get the most information from each experiment you perform. Well-
designed experiments can produce significantly more information and often require fewer runs than haphazard or 
unplanned experiments. In addition, a well-designed experiment will ensure that you can evaluate the effects that you 
have identified as important. For example, if you believe that there is an interaction between two input variables, be sure 
to include both variables in your design rather than doing a "one factor at a time" experiment. An interaction occurs when 
the effect of one input variable is influenced by the level of another input variable. 
Designed experiments are often carried out in four phases: planning, screening (also called process characterization), 
optimization, and verification. For examples of creating, analyzing, and plotting experimental designs, see Examples of 
designed experiments. 

More Our intent is to provide only a brief introduction to the design of experiments. There are many resources that 
provide a thorough treatment of these methods. For a list of resources, see Factorial Designs References, 
Response Surfaces Designs References, Mixture Designs References, and Robust Designs References.  

 

Planning  
Careful planning can help you avoid problems that can occur during the execution of the experimental plan. For example, 
personnel, equipment availability, funding, and the mechanical aspects of your system may affect your ability to complete 
the experiment. If your project has low priority, you may want to carry out small sequential experiments. That way, if you 
lose resources to a higher priority project, you will not have to discard the data you have already collected. When 
resources become available again, you can resume experimentation. 
The preparation required before beginning experimentation depends on your problem. Here are some steps you may 
need to go through: 

•    Define the problem. Developing a good problem statement helps make sure you are studying the right variables. At 
this step, you identify the questions that you want to answer. 

•    Define the objective. A well-defined objective will ensure that the experiment answers the right questions and yields 
practical, usable information. At this step, you define the goals of the experiment. 

•    Develop an experimental plan that will provide meaningful information. Be sure to review relevant background 
information, such as theoretical principles, and knowledge gained through observation or previous experimentation. 
For example, you may need to identify which factors or process conditions affect process performance and contribute 
to process variability. Or, if the process is already established and the influential factors have been identified, you may 
want to determine optimal process conditions. 

•    Make sure the process and measurement systems are in control. Ideally, both the process and the measurements 
should be in statistical control as measured by a functioning statistical process control (SPC) system. Even if you do 
not have the process completely in control, you must be able to reproduce process settings. You also need to 
determine the variability in the measurement system. If the variability in your system is greater than the 
difference/effect that you consider important, experimentation will not yield useful results.  
Minitab provides numerous tools to evaluate process control and analyze your measurement system.  

 

Screening  
In many process development and manufacturing applications, potentially influential variables are numerous. Screening 
reduces the number of variables by identifying the key variables that affect product quality. This reduction allows you to 
focus process improvement efforts on the really important variables, or the "vital few." Screening may also suggest the 
"best" or optimal settings for these factors, and indicate whether or not curvature exists in the responses. Then, you can 
use optimization methods to determine the best settings and define the nature of the curvature. 
The following methods are often used for screening: 

•    Two-level full and fractional factorial designs are used extensively in industry 

•    Plackett-Burman designs have low resolution, but their usefulness in some screening experimentation and robustness 
testing is widely recognized 
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•    General full factorial designs (designs with more than two-levels) may also be useful for small screening experiments 
 

Optimization  
After you have identified the "vital few" by screening, you need to determine the "best" or optimal values for these 
experimental factors. Optimal factor values depend on the process objective. For example, you may want to maximize 
process yield or reduce product variability.  
The optimization methods available in Minitab include general full factorial designs (designs with more than two-levels), 
response surface designs, mixture designs, and Taguchi designs.  

•    Factorial Designs Overview describes methods for designing and analyzing general full factorial designs.  

•    Response Surface Designs Overview describes methods for designing and analyzing central composite and Box-
Behnken designs.  

•    Mixture Designs Overview describes methods for designing and analyzing simplex centroid, simplex lattice, and 
extreme vertices designs. Mixture designs are a special class of response surface designs where the proportions of 
the components (factors), rather than their magnitude, are important.  

•    Response Optimization describes methods for optimizing multiple responses. Minitab provides numerical optimization, 
an interactive graph, and an overlaid contour plot to help you determine the "best" settings to simultaneously optimize 
multiple responses. 

•    Taguchi Designs Overview describes methods for analyzing Taguchi designs. Taguchi designs may also be called 
orthogonal array designs, robust designs, or inner-outer array designs. These designs are used for creating products 
that are robust to conditions in their expected operating environment. 

 

Verification  
Verification involves performing a follow-up experiment at the predicted "best" processing conditions to confirm the 
optimization results. For example, you may perform a few verification runs at the optimal settings, then obtain a 
confidence interval for the mean response. 
 

Modifying and Using Worksheet Data  
When you create a design using one of the Create Design procedures, Minitab creates a design object that stores the 
appropriate design information in the worksheet. Minitab needs this stored information to analyze and plot data properly.  
The following columns contain your design: 

•    StdOrder 

•    RunOrder 

•    CenterPt (two-level factorial and Plackett-Burman designs) 

•    PtType (general full factorial, response surface, and mixture design)  

•    Blocks 

•    factor or component columns 
If you want to analyze your design with the Analyze Design procedures, you must follow certain rules when modifying 
worksheet data. If you make changes that corrupt your design, you may still be able to analyze it with the Analyze Design 
procedures after you use one of the Define Custom Design procedures. 

•    You cannot delete or move the columns that contain the design. 

•    You can enter, edit, and analyze data in all the other columns of the worksheet, that is, all columns beyond the last 
design column. You can place the response and covariate data here, or any other data you want to enter into the 
worksheet. 

•    You can delete runs from your design. If you delete runs, you may not be able to fit all terms in your model. In that 
case, Minitab will automatically remove any terms that cannot be fit and do the analysis using the remaining terms. 

•    You can add runs to your design. For example, you may want to add center points or a replicate of a particular run of 
interest. Make sure the levels are appropriate for each factor or component and that you enter appropriate values in 
StdOrder, RunOrder, CenterPt, PtType, and Blocks. These columns and the factor or component columns must all be 
the same length. You can use any numbers that seem reasonable for StdOrder and RunOrder. Minitab uses these 
two columns to order data in the worksheet. 

•    You can change the level of a factor for a botched run in the Data window. 

•    You can change factor level settings using Modify Design. However, you cannot change a factor type from numeric to 
text or text to numeric. 
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•    You can change the name of factors and components using Modify Design. 

•    You can use any procedures to analyze the data in your design, not just the procedures in the DOE menu. 

•    You can add factors to your design by entering them in the worksheet. Then, use one of the Define Custom Design 
procedures 

Note If you make changes that corrupt your design, you may still be able to analyze it. You can redefine the design 
using one of the Define Custom Design procedures.  
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Factorial Designs 
Factorial Designs Overview  
Factorial designs allow for the simultaneous study of the effects that several factors may have on a process. When 
performing an experiment, varying the levels of the factors simultaneously rather than one at a time is efficient in terms of 
time and cost, and also allows for the study of interactions between the factors. Interactions are the driving force in many 
processes. Without the use of factorial experiments, important interactions may remain undetected.  

Screening designs 
In many process development and manufacturing applications, the number of potential input variables (factors) is large. 
Screening (process characterization) is used to reduce the number of input variables by identifying the key input variables 
or process conditions that affect product quality. This reduction allows you to focus process improvement efforts on the 
few really important variables, or the "vital few." Screening may also suggest the "best" or optimal settings for these 
factors, and indicate whether or not curvature exists in the responses. Optimization experiments can then be done to 
determine the best settings and define the nature of the curvature. 
In industry, two-level full and fractional factorial designs, and Plackett-Burman designs are often used to "screen" for the 
really important factors that influence process output measures or product quality. These designs are useful for fitting first-
order models (which detect linear effects), and can provide information on the existence of second-order effects 
(curvature) when the design includes center points.  
In addition, general full factorial designs (designs with more than two-levels) may be used with small screening 
experiments. 

Full factorial designs 
In a full factorial experiment, responses are measured at all combinations of the experimental factor levels. The 
combinations of factor levels represent the conditions at which responses will be measured. Each experimental condition 
is a called a "run" and the response measurement an observation. The entire set of runs is the "design." 
The following diagrams show two and three factor designs. The points represent a unique combination of factor levels. 
For example, in the two-factor design, the point on the lower left corner represents the experimental run when Factor A is 
set at its low level and Factor B is also set at its low level. 

Two factors Three factors 

 

 

Two levels of Factor A 
Three levels of Factor B 

Two levels of each factor 

Two-level full factorial designs 
In a two-level full factorial design, each experimental factor has only two levels. The experimental runs include all 
combinations of these factor levels. Although two-level factorial designs are unable to explore fully a wide region in the 
factor space, they provide useful information for relatively few runs per factor. Because two-level factorials can indicate 
major trends, you can use them to provide direction for further experimentation. For example, when you need to further 
explore a region where you believe optimal settings may exist, you can augment a factorial design to form a central 
composite design. 

General full factorial designs 
In a general full factorial design, the experimental factors can have any number levels. For example, Factor A may have 
two levels, Factor B may have three levels, and Factor C may have five levels. The experimental runs include all 
combinations of these factor levels. General full factorial designs may be used with small screening experiments, or in 
optimization experiments. 
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Fractional factorial designs 
In a full factorial experiment, responses are measured at all combinations of the factor levels, which may result in a 
prohibitive number of runs. For example, a two-level full factorial design with 6 factors requires 64 runs; a design with 9 
factors requires 512 runs. To minimize time and cost, you can use designs that exclude some of the factor level 
combinations. Factorial designs in which one or more level combinations are excluded are called fractional factorial 
designs. Minitab generates two-level fractional factorial designs for up to 15 factors. 
Fractional factorial designs are useful in factor screening because they reduce down the number of runs to a manageable 
size. The runs that are performed are a selected subset or fraction of the full factorial design. When you do not run all 
factor level combinations, some of the effects will be confounded. Confounded effects cannot be estimated separately 
and are said to be aliased. Minitab displays an alias table which specifies the confounding patterns. Because some 
effects are confounded and cannot be separated from other effects, the fraction must be carefully chosen to achieve 
meaningful results. Choosing the "best fraction" often requires specialized knowledge of the product or process under 
investigation. 

Plackett-Burman designs 
Plackett-Burman designs are a class of resolution III, two-level fractional factorial designs that are often used to study 
main effects. In a resolution III design, main effects are aliased with two-way interactions. 
Minitab generates designs for up to 47 factors. Each design is based on the number of runs, from 12 to 48, and is always 
a multiple of 4. The number of factors must be less than the number of runs. 

More Our intent is to provide only a brief introduction to factorial designs. There are many resources that provide a 
thorough treatment of these designs. For a list of resources, see References. 

 

Factorial Experiments in Minitab 
Performing a factorial experiment may consist of the following steps: 
1    Before you begin using Minitab, you need to complete all pre-experimental planning. For example, you must 

determine what the influencing factors are, that is, what processing conditions influence the values of the response 
variable. See Factorial Designs Overview.  

2    In MINITAB, create a new design or use data that is already in your worksheet. 
•    Use Create Factorial Design to generate a full or fractional factorial design, or a Plackett-Burman design. 
•    Use Define Custom Factorial Design to create a design from data you already have in the worksheet. Define 

Custom Factorial Design allows you to specify which columns are your factors and other design characteristics. 
You can then easily fit a model to the design and generate plots. 

3    Use Modify Design to rename the factors, change the factor levels, replicate the design, and randomize the design. 
For two-level designs, you can also fold the design, add axial points, and add center points to the axial block.  

4    Use Display Design to change the display order of the runs and the units (coded or uncoded) in which Minitab 
expresses the factors in the worksheet.  

5    Perform the experiment and collect the response data. Then, enter the data in your Minitab worksheet. See Collecting 
and Entering Data. 

6    Use Analyze Factorial Design to fit a model to the experimental data. Use Analyze Variability to analyze the standard 
deviation of repeat or replicate responses. 

7    Display plots to look at the design and the effects. Use Factorial Plots to display main effects, interactions, and cube 
plots. For two-level designs, use Contour/Surface Plots to display contour and surface plots. 

8    If you are trying to optimize responses, use Response Optimizer or Overlaid Contour Plot to obtain a numerical and 
graphical analysis. 
Depending on your experiment, you may do some of the steps in a different order, perform a given step more than 
once, or eliminate a step. 

 

Choosing a Factorial Design  
The design, or layout, provides the specifications for each experimental run. It includes the blocking scheme, 
randomization, replication, and factor level combinations. This information defines the experimental conditions for each 
test run. When performing the experiment, you measure the response (observation) at the predetermined settings of the 
experimental conditions. Each experimental condition that is employed to obtain a response measurement is a run.  
Minitab provides two-level full and fractional factorial designs, Plackett-Burman designs, and full factorials for designs with 
more than two levels. When choosing a design you need to  

•    identify the number of factors that are of interest 

•    determine the number of runs you can perform 
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•    determine the impact that other considerations (such as cost, time, or the availability of facilities) have on your choice 
of a design 

Depending on your problem, there are other considerations that make a design desirable. You may want to choose a 
design that allows you to 

•    increase the order of the design sequentially. That is, you may want to "build up" the initial design for subsequent 
experimentation. 

•    perform the experiment in orthogonal blocks. Orthogonally blocked designs allow for model terms and block effects to 
be estimated independently and minimize the variation in the estimated coefficients. 

•    detect model lack of fit. 

•    estimate the effects that you believe are important by choosing a design with adequate resolution. The resolution of a 
design describes how the effects are confounded. Some common design resolutions are summarized below: 
−    Resolution III designs − no main effect is aliased with any other main effect. However, main effects are aliased 

with two-factor interactions and two-factor interactions are aliased with each other. 
−    Resolution IV designs − no main effect is aliased with any other main effect or two-factor interaction. Two-factor 

interactions are aliased with each other.  
−    Resolution V designs − no main effect or two-factor interaction is aliased with any other main effect or two-factor 

interaction. Two-factor interactions are aliased with three-factor interactions.  
 

Create Factorial Design 
2-Level  
Create Factorial Design 
Stat > DOE > Factorial > Create Factorial Design 
Generates 2-level designs, either full or fractional factorials, and Plackett-Burman designs. See Factorial Designs 
Overview for descriptions of these types of designs. 

Dialog box items 
Type of Design  

2-level factorial (default generators): Choose to use Minitab's default generators.  
2-level factorial (specify generators): Choose to specify your own design generators. 
Plackett-Burman design: Choose to generate a Plackett-Burman design. See Plackett-Burman Designs for a 
complete list.  
General full factorial design: Choose to generate a design in which at least one factor has more than two levels. 

Number of factors: Specify the number of factors in the design you want to generate.  
 

Creating 2-Level Factorial Designs 
Use Minitab's 2-level factorial options to generate settings for 2-level 

•    full factorial designs with up to seven factors 

•    fractional factorial designs with up to 15 factors 
You can use default designs from Minitab's catalog (these designs are shown in the Display Available Designs subdialog 
box) or create your own design by specifying the design generators.  
The default designs cover many industrial product design and development applications. They are fully described in the 
Summary of 2-Level Designs.  
To create full factorial designs when any factor has more than two levels or you have more than seven factors, see 
Creating General Full Factorial Designs. 

Note To create a design from data that you already have in the worksheet, see Define Custom Factorial Design.

 

To create a two-level factorial design 
1    Choose Stat > DOE > Factorial > Create Factorial Design. 
2    If you want to see a summary of the factorial designs, click Display Available Designs. Use this table to compare 

design features. Click OK.  
3    Under Type of Design, choose 2-level factorial (default generators) 
4    From Number of factors, choose a number from 2 to 15. 
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5    Click Designs.  
6    In the box at the top, highlight the design you want to create. If you like, use any of the dialog box options. 
7    Click OK even if you do not change any of the options. This selects the design and brings you back to the main dialog 

box.  
8    If you like, click Options, Factors, and/or Results to use any of the dialog box options. Then, click OK in each dialog 

box to create your design. 
 

Factorial Design − Available Designs 
Stat > DOE > Factorial > Create Factorial Design > choose a 2-level or Plackett-Burman option > Display Available 
Designs 
Displays a table to help you select an appropriate design, based on 

•    the number of factors that are of interest, 

•    the number of runs you can perform, and 

•    the desired resolution of the design. 
This dialog box does not take any input. See Summary of two-level designs and Summary of Plackett-Burman designs. 
 

Factorial Design − Designs (default generators) 
Stat > DOE > Factorial > Create Factorial Design > choose 2-level factorial (default generators) > Designs  
Allows you to select a design, add center points and replicates, and block the design. 

Dialog box items 
The list box at the top of the Design subdialog box shows all available designs for the number of factors you selected in 
the main Create Factorial Design dialog box. Highlight your design choice. The design you choose will affect the possible 
choices for the options below. 
Number of center points per block: Choose the number of center points to be added per block to the design. When you 
have both text and numeric factors, there really is no true center to the design. In this case, center points are called 
pseudo-center points. See Adding center points for a discussion of how Minitab handles center points.  
Number of replicates for corner points: Choose the number of replicates. 
Number of blocks: Choose the number of blocks you want (optional). Click the arrow for the number of blocks to see a 
list of possible choices. This list contains all the possible blocking combinations for the selected design with the number of 
specified replicates. If you change the design or the number of replicates, this list will reflect the new set of possibilities. 
 

Factorial Design − Designs (specify generators) 
Stat > DOE > Factorial > Create Factorial Design > choose 2-level factorial (specify generators) > Designs 
Allows you to select a design, and add center points and replicates.  

Dialog box items 
The list box at the top of the Design subdialog box shows all available designs for the number of factors you selected in 
the main Create Factorial Design dialog box. Highlight your design choice. The design you choose will affect the possible 
choices for the options below. 
Number of center points per block: Specify the number of center points to be added per block to the design. When you 
have both text and numeric factors, there really is no true center to the design. In this case, center points are called 
pseudo center points. See Adding center points for a discussion of how Minitab handles center points.  
Number of replicates for corner points: Enter the number of replications of each corner point. Center points are not 
replicated. 
 

Factorial Design − Generators 
Stat > DOE > Factorial > Create Factorial Design > choose 2-level factorial (specify generators) > Designs > 
Generators 
Allows you to add factors to your model and define the blocks to be used. 

Dialog box items 
Add factors to the base design by listing their generators (for example, F=ABC): Specify additional factors to add to 
the design. This allows you to customize designs rather than use a design in Minitab's catalog. The added factors must be 
given in alphabetical order and the total number of factors in the design cannot exceed 15. You can use a minus 
interaction for a generator, for example D = -AB. If you add factors, you must specify your own block generators.  
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Define blocks by listing their generators (for example, ABCD): Specify the terms to be used as block generators. You 
must specify your own block generators if you added any factors to the design. 
 

Generators for 2-Level Designs 
The first line for each design gives the number of factors, the number of runs, the resolution (R) of the design without 
blocking, and the design generators. On the following lines, there is one entry for each number of blocks. The number 
before the parentheses is the number of blocks, in the parentheses are the block generators, and the number after the 
parentheses is the resolution of the blocked design. 

factor runs R Design Generators 
2 4 − Full 
   2(AB)3 
    
3 4 3 C=AB 
   no blocking 
3 8 − Full 
   2(ABC)4 4(AB,AC)3 
    
4 8 4 D=ABC 
   2(AB)3 4(AB,AC)3 
4 16 − Full 
   2(ABCD)5 4(BC,ABD)3 8(AB,BC,CD)3 
    
5 8 3 D=AB,E=AC 
   2(BC)3 
5 16 5 E=ABCD (E=ABC for 8 blocks) 
   2(AB)3 4(AB,AC)3 8(AB,AC,AD)3  
5 32 − Full 
   2(ABCDE)6 4(ABC,CDE)4 8(AC,BD,ADE)3 16(AB,AC,CD,DE)3 
    
6 8 3 D=AB,E=AC,F=BC 
   2(BE)3 
6 16 4 E=ABC,F=BCD 
   2(ACD)4  4(AE,ACD)3  8(AB,BC,BF)3 
6 32 6 F=ABCDE 
   2(ABF)4 4(BC,ABF)3 8(AD,BC,ABF)3 16(AB,BC,CD,DE)3 
6 64 − Full 
   2(ABCDEF)7 4(ABCF,ABDE)5 8(ACE,ADF,BCF)4 
   16(AD,BE,CE,ABF)3 32(AB,BC,CD,DE,EF)3 
7 8 3 D=AB,E=AC,F=BC,G=ABC 
   no blocking 
7 16 4 E=ABC,F=BCD,G=ACD 
   2(ABD)4  4(AB,AC)3  8(AB,AC,AD)3 
7 32 4 F=ABCD,G=ABDE 
   2(CDE)4 4(CF,CDE)3 8(AB,AD,CG)3 
7 64 7 G=ABCDEF 
   2(CDE)4 4(ACF,CDE)4 8(ACF,ADG,CDE)4 16(AB,AC,EF,EG)3 
7 128 − Full 
   2(ABCDEFG)8 4(ABDE,ABCFG)5 8(ABC,AFG,DEF)4 16(ABE,ADG,CDE,EFG)4 

32(AC,BD,CE,DF,ABG)3 64(AB,BC,CD,DE,EF,FG)3 
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8 16 4 E=BCD,F=ACD,G=ABC,H=ABD 
   2(AB)3  4(AB,AC)3  8(AB,AC,AD)3 
8 32 4 F=ABC,G=ABD,H=BCDE 
   2(ABE)4 4(EH,ABE)3 8(AB,AC,BD)3 
8 64 5 G=ABCD,H=ABEF 
   2(ACE)4 4(ACE,BDF)4 8(BC,FH,BDF)3 16(BC,DE,FH,BDF)3 
8 128 8 H=ABCDEFG 
   2(ABCD)5 4(ABCD,ABEF)5 8(ABCD,ABEF,BCEG)5  

16(BF,DE,ABG,AEH)3  32(AC,BD,BF,DE,AEH)3 
    
9 16 3 E=ABC,F=BCD,G=ACD,H=ABD,J=ABCD 
   2(AB)3  4(AB,AC)3 
9 32 4 F=BCDE,G=ACDE,H=ABDE,J=ABCE 
   2(AEF)4  4(AB,CD)3  8(AB,AC,CD)3 
9 64 4 G=ABCD,H=ACEF,J=CDEF 
   2(BCE)4 4(ABF,ACJ)4 8(AD,AH,BDE)3 16(AC,AD,AJ,BF)3 
9 128 6 H=ACDFG,J=BCEFG 
   2(CDEJ)5 4(ABFJ,CDEJ)5 8(ACF,AHJ,BCJ)4 16(AE,CG,BCJ,BDE)3 
    
10 16 3 E=ABC,F=BCD,G=ACD,H=ABD,J=ABCD,K=AB 
   2(AC)3  4(AD,AG)3 
10 32 4 F=ABCD,G=ABCE,H=ABDE,J=ACDE,K=BCDE 
   2(AB)3  4(AB,BC)3  8(AB,AC,AH)3 
10 64 4 G=BCDF,H=ACDF,J=ABDE,K=ABCE 
   2(AGJ)4  4(CD,AGJ)3  8(AG,CJ,CK)3  16(AC,AG,CJ,CK)3 
10 128 5 H=ABCG,J=BCDE,K=ACDF 
   2(ADG)4 4(ADG,BDF)4 8(AEH,AGK,CDH)4 16(BH,EG,JK,ADG)3 
    
11 16 3 E=ABC,F=BCD,G=ACD,H=ABD,J=ABCD,K=AB,L=AC 
   2(AD)3  4(AE,AH)3 
11 32 4 F=ABC,G=BCD,H=CDE,J=ACD,K=ADE,L=BDE 
   2(ABD)4  4(AK,ABD)3  8(AB,AC,AD)3 
11 64 4 G=CDE,H=ABCD,J=ABF,K=BDEF,L=ADEF 
   2(AHJ)4 4(FL,AHJ)3 8(CD,CE,DL)3 16(AB,AC,AE,AF)3 
11 128 5 H=ABCG,J=BCDE,K=ACDF,L=ABCDEFG 
   2(ADJ)4 4(ADJ,BFH)4 8(ADJ,AHL,BFH)4 16(BC,DF,GL,BFH)3 
    
12 16 3 E=ABC,F=ABD,G=ACD,H=BCD,J=ABCD,K=AB,L=AC,M=AD 
   2(AG)3 4(AF,AG)3 
12 32 4 F=ACE,G=ACD,H=ABD,J=ABE,K=CDE,L=ABCDE,M=ADE 
   2(ABC)4 4(DG,DH)3 8(AB,AC,AD)3 
12 64 4 G=DEF,H=ABC,J=BCDE,K=BCDF,L=ABEF,M=ACEF 
   2(ABM)4 4(AB,AC)3 8(AB,AC,BM)3 16(AB,AD,BE,BM)3 
12 128 4 H=ACDG,J=ABCD,K=BCFG,L=ABDEFG,M=CDEF 
   2(ACF)4 4(BG,BJ)3 8(BG,BJ,AGM)3 16(BG,BJ,FM,AGM)3 
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13 16 3 E=ABC,F=ABD,G=ACD,H=BCD,J=ABCD,K=AB,L=AC,M=AD,N=BC 
   2(AG)3 
13 32 4 F=ACE,G=BCE,H=ABC,J=CDE,K=ABCDE,L=ABE,M=ACD,N=ADE 
   2(ABD)4 4(CG,GH)3 8(AB,AC,AD)3 
13 64 4 G=ABC,H=DEF,J=BCDF,K=BCDE,L=ABEF,M=ACEF,N=BCEF 
   2(AB)3 4(AB,AC)3 8(AB,AC,AN)3 16(AB,AD,BE,BM)3 
13 128 4 H=DEFG,J=BCEG,K=BCDFG,L=ABDEF,M=ACEF,N=ABC 
   2(ADE)4 4(AB,AC)3 8(AB,AC,AGK)3 16(AB,AC,ABM,AGK)3 
    
14 16 3 E=ABC,F=ABD,G=ACD,H=BCD,J=ABCD,K=AB,L=AC,M=AD,N=BC,O=BD 
   2(AG)3 
14 32 4 F=ABC,G=ABD,H=ABE,J=ACD,K=ACE,L=ADE,M=BCD,N=BCE, O=BDE 
   2(ACL)4 4(AB,ACL)3 8(AC,AL,AO)3 
14 64 4 G=BEF,H=BCF,J=DEF,K=CEF,L=BCE,M=CDF,N=ACDE,O=BCDEF 
   2(ABC)4 4(BC,BE)3 8(BC,BE,BG)3 16(AB,BC,BE,BG)3 
14 128 4 H=EFG,J=BCFG,K=BCEG,L=ABEF,M=ACEF,N=BCDEF,O=ABC 
   2(ADE)4 4(AB,AC)3 8(AB,AC,BM)3 16(AB,AC,BM,DG)3 
    
15 16 3 E=ABC,F=ABD,G=ACD,H=BCD,J=ABCD,K=AB,L=AC,M=AD,N=BC,O=BD,P=CD 
   no blocking 
15 32 4 F=ABC,G=ABD,H=ABE,J=ACD,K=ACE,L=ADE,M=BCD,N=BCE,O=BDE, P=CDE 
   2(ABP)4 4(AB,BP)3 8(AB,AD,AK)3 
15 64 4 G=ABC,H=ABD,J=ABE,K=ABF,L=ACD,M=ACE,N=ACF,O=ADE,P=ADF 
   2(ABL)4 4(AM,ABL)3 8(AB,AC,AD)3 16(AB,AC,AD,AE)3 
15 128 4 H=ABFG,J=ACDEF,K=BEF,L=ABCEG,M=CDFG,N=ACDEG,O=EFG, 
   P=ABDEFG 
   2(ADE)4 4(EG,GP)3 8(EG,GP,OP)3 16(BO,EG,GP,OP)3 

 

To add factors to the base design by specifying generators 
1    Choose Stat > DOE > Factorial > Create Factorial Design. 
2    Under Type of Design, choose 2-level factorial (specify generators). 
3    From Number of factors, choose a number from 2 to 15. 
4    Click Designs.  
5    In the box at the top, highlight the design you want to create. The selected design will serve as the base design 
6    If you like, choose a number from Number of center points per block and Number of replicates for corner points. 
7    Click Generators.  
8    In Add factors to the base design by listing their generators, enter the generators for up to 15 additional factors in 

alphabetical order. Click OK in the Generators and Design subdialog boxes. 
9    If you want to block the design, in Define blocks by listing their generators, enter the block generators. Click OK in 

the Generators and Design subdialog boxes.  
10  If you like, click Options, Factors, and/or Results to use any of the dialog box options, then click OK in each dialog 

box to create your design. 
 

Example of specifying generators 
Suppose you want to add two factors to a base design with three factors and eight runs. 
1    Choose Stat > DOE > Factorial > Create Factorial Design. 
2    Choose 2-level factorial (specify generators). 
3    From Number of factors, choose 3. 
4    Click Designs. 
5    In the Designs box at the top, highlight the row for a full factorial. This design will serve as the base design. 
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6    Click Generators. In Add factors to the base design by listing their generators, enter D = AB     E = AC. Click OK 
in each dialog box. 

Session window output 

Fractional Factorial Design 
 
 
Factors:  5   Base Design:         3, 8   Resolution:  III 
Runs:     8   Replicates:             1   Fraction:    1/4 
Blocks:   1   Center pts (total):     0 
 
* NOTE * Some main effects are confounded with two-way interactions.
 
Design Generators: D = AB, E = AC 
 
 
Alias Structure (up to order 3) 
 
I + ABD + ACE 
 
A + BD + CE 
B + AD + CDE 
C + AE + BDE 
D + AB + BCE 
E + AC + BCD 
BC + DE + ABE + ACD 
BE + CD + ABC + ADE 

Interpreting the results 
The base design has three factors labeled A, B, and C. Then Minitab adds factors D and E. Because of the generators 
selected, D is confounded with the AB interaction and E is confounded with the AC interaction. This gives a 2(5-2) or 
resolution III design. Look at the alias structure to see how the other effects are confounded. 
 

Adding center points 
Adding center points to a factorial design may allow you to detect curvature in the fitted data. If there is curvature that 
involves the center of the design, the response at the center point will be either higher or lower than the fitted value of the 
factorial (corner) points. 
The way Minitab adds center points to the design depends on whether you have text, numeric, or a combination of text 
and numeric factors. Here is how Minitab adds center points: 

•    When all factors are numeric and the design is: 
−    Not blocked, Minitab adds the specified number of center points to the design. 
−    Blocked, Minitab adds the specified number of center points to each block. 

•    When all of the factors in a design are text, you cannot add center points. 

•    When you have a combination of numeric and text factors, there is no true center to the design. In this case, center 
points are called pseudo-center points. When the design is:  
−    Not blocked, Minitab adds the specified number of center points for each combination of the levels of the text 

factors. In total, for Q text factors, Minitab adds 2Q times as many centerpoints. 
−    Blocked, Minitab adds the specified number of center points for each combination of the levels of the text factors 

to each block. In each block, for Q text factors, Minitab adds 2Q times as many centerpoints. 
For example, consider an unblocked 23 design. Factors A and C are numeric with levels 0, 10 and .2, .3, respectively. 
Factor B is text indicating whether a catalyst is present or absent. If you specify 3 center points in the Designs 
subdialog box, Minitab adds a total of 2 x 3 = 6 pseudo-center points, three points for the low level of factor B and 
three for the high level. These six points are: 

5 present .25 

5 present .25 

5 present .25 

5 absent  .25 

5 absent  .25 

5 absent  .25 
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Next, consider a blocked 25 design where three factors are text, and there are two blocks. There are 2 x 2 x 2 = 8 
combinations of text levels. If you specify two center points per block, Minitab will add 8 x 2 = 16 pseudo-center points 
to each of the two blocks. 

 

Blocking the Design 
Although every observation should be taken under identical experimental conditions (other than those that are being 
varied as part of the experiment), this is not always possible. Nuisance factors that can be classified can be eliminated 
using a blocked design. For example, an experiment carried out over several days may have large variations in 
temperature and humidity, or data may be collected in different plants, or by different technicians. Observations collected 
under the same experimental conditions are said to be in the same block. 
The way you block a design depends on whether you are creating a design using the default generators or specifying your 
own generators.  

•    If you use default generators to create your design, Minitab blocks the design for you. See Generators for two-level 
designs.  

•    If you specify your own generators, you must specify your own block generators because Minitab cannot automatically 
determine the appropriate generators when you add factors. 
Suppose you generate a 64 run design with 8 factors (labeled alphabetically) and specify the block generators to be 
ABC  CDE. This gives four blocks which are shown in "standard" (Yates) order below:  

Block ABC CDE 
1 − − 

2 + − 

3 − + 

4 + + 

Note Blocking a design can reduce its resolution. Let r1 = the resolution before blocking. Let r2 = the length of the 
shortest term that is confounded with blocks. Then the resolution after blocking is the smaller of r1 and (r2 + 
1). 

 

To block a design created by specifying your own generators 
1    In the Designs subdialog box, click Generators.  
2    In Define blocks by listing their generators, type the block generators. Click OK. 
 

To block a design created with the default generators 
1    In the Create Factorial Design dialog box, click Designs. 
2    From Number of blocks, choose a number. Click OK. 
The list shows all the possible blocking combinations for the selected design with the number of specified replicates. If you 
change the design or the number of replicates, the list will reflect a new set of possibilities.  
If your design has replicates, Minitab attempts to put the replicates in different blocks. For details, see Rule for blocks with 
replicates for default design. 
 

Rule for blocks with replicates for default designs 
For a blocked default design with replicates, Minitab puts replicates in different blocks to the extent that it can. 
The following rule is used to assign runs to blocks: Let k = the number of factors, b = the number of blocks, r = the number 
of replicates, and n = the number of runs (corner points). 

Let D = the greatest common divisor of b and r. Then b = B∗D and r = R∗D, for some B and R. Start with the standard 
design for k factors, n runs, and B blocks. (If there is no such design, you will get an error message.) Replicate this entire 
design r times. This gives a total of B∗r blocks, numbered 1, 2, ... , B, 1, 2, ...  , B, ... , 1, 2, ... , B. Renumber these blocks 
as 1, 2, ... , b, 1, 2, ... , b, ... , 1, 2, ... , b. This will give b blocks, each replicated R times, which is what you want. 
For example, suppose you have a factorial design with 3 factors and 8 runs, run in 6 blocks, and you want to add 15 
replicates. 
Then k = 3, b = 6, r = 15, and n = 8. The greatest common divisor of b and r is 3. Then B = 2 and R = 5. Start with the 
design for 3 factors, 8 runs, and 2 blocks. Replicate this design 15 times. This gives a total of 2∗15 = 30 blocks, numbered 
1, 2, 1, 2, 1, 2, ... , 1, 2. Renumber these blocks as 1, 2, 3, 4, 5, 6, 1, 2, 3, 4, 5, 6, ... , 1, 2, 3, 4, 5, 6. This gives 6 blocks, 
each replicated 5 times. 
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Factorial Design − Factors (2-level factorial or Plackett-Burman design) 
Stat > DOE > Factorial > Create Factorial Design > Factors 
Allows you to name or rename the factors and assign values for factor levels. If your factors could be continuous, use 
numeric levels; if your factors are categorical, use text levels. Continuous variables can take on any value on the 
measurement scale being used (for example, length of reaction time). Categorical variables can only assume a limited 
number of possible values (for example, type of catalyst). 
Use the arrow keys to navigate within the table, moving across rows or down columns. 

Dialog box items 
Factor: Shows the number of factors you have chosen for your design. This column does not take any input. 
Name: Enter text to change the name of the factors. By default, Minitab names the factors alphabetically, skipping the 
letter I. 
Type: Choose to specify whether the levels of the factors are numeric or text. For information on how Minitab handles 
centerpoints when you have a combination of text and numeric factors, see Adding center points.  

Low: Enter the value for the low setting of each factor. By default, Minitab sets the low level of all factors to −1. Factor 
settings can be changed to any numeric or text value. If one of the settings for a factor is text, Minitab interprets the other 
setting as text. 
High: Enter the value for the high setting of each factor. By default, Minitab sets the high level of all factors to +1. Factor 
settings can be changed to any numeric or text value. If one of the settings for a factor is text, Minitab interprets the other 
setting as text. 

Note For information on how Minitab handles centerpoints when you have a combination of text and numeric factors, 
see Adding center points.  

 

To name factors 
1    In the Create Factorial Design dialog box, click Factors.  
2    Under Name, click in the first row and type the name of the first factor. Then, use the arrow key to move down the 

column and enter the remaining factor names. Click OK. 

More After you have created the design, you can change the factor names by typing new names in the Data window, 
or with Modify Design. 

 

To assign factor levels 
When creating a design 
1    In the Create Factorial Design dialog box, click Factors.  
2    Under Low, click in the factor row you would like to assign values and enter any numeric or text value. Use the arrow 

key to move to High and enter a value. For numeric levels, the High value must be larger than the Low value.  
3    Repeat step 2 to assign levels for other factors. Click OK. 

After creating a design  
To change the factor levels after you have created the design, use Modify Design. Unless some runs result in botched 
runs, do not change levels by typing them in the worksheet. 
 

Factorial Designs − Options (2-level factorial design) 
Stat > DOE > Factorial > Create Factorial Design > Options  
Allows you to fold the design, which is a way to reduce confounding, specify the fraction to be used for design generation, 
randomize the design, and store the design (and design object) in the worksheet.  

Dialog box items 
Fold Design  

Do not fold: Choose to not fold the design.  
Fold on all factors: Choose to fold the design on all factors. 
Fold just on factor: Choose to fold the design on one of the factors, then choose the factor you want to fold on. 

Fraction If the design is a fractional factorial, you can specify which fraction to use. 
Use principal fraction: Choose to use the principal fraction. This is the fraction where all signs on the design 
generators are positive. 
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Use fraction number: Choose to use a specific fraction, then specify which fraction you want to use. Minitab numbers 
the fractions in a "standard order" using the design generators.  

Randomize runs: Check to randomize the runs in the data matrix. If you specify blocks, randomization is done separately 
within each block and then the blocks are randomized. 

Base for random data generator: Enter a base for the random data generator. By entering a base for the random 
data generator, you can control the randomization so that you obtain the same pattern every time.  

Note If you use the same base on different computer platforms or with different versions of Minitab, you may not get 
the same random number sequence.  

Store design in worksheet: Check to store the design in the worksheet. When you open this dialog box, the Store 
design in worksheet option is checked. If you want to see the properties of various designs (such as alias tables) before 
selecting the one design you want to store, you would uncheck this option. If you want to analyze a design, you must store 
it in the worksheet. 
 

Folding the Design 
Folding is a way to reduce confounding. Confounding occurs when you have a fractional factorial design and one or more 
effects cannot be estimated separately. The effects that cannot be separated are said to be aliased. 
Resolution IV designs may be obtained from resolution III designs by folding. For example, if you fold on one factor, say 
A, then A and all its 2-factor interactions will be free from other main effects and 2-factor interactions. If you fold on all 
factors, then all main effects will be free from each other and from all 2-factor interactions. 
For example, suppose you are creating a three-factor design in four runs.  

•    When you fold on all factors, Minitab adds four runs to the design and reverses the signs of each factor in the 
additional runs.  

•    When you fold on one factor, Minitab adds four runs to the design, but only reverses the signs of the specified factor. 
The signs of the remaining factors stay the same. These rows are then appended to the end of the data matrix.  

Original fraction Folded on all factors Folded on factor A 
A B C 

- - + 
+ - - 
- + - 
+ + + 

A B C 

- - + 
+ - - 
- + - 
+ + + 

+ + - 
- + + 
+ - + 
- - - 

A B C 
- - + 
+ - - 
- + - 
+ + + 

+ - + 
- - - 
+ + - 
- + + 

When you fold a design, the defining relation or alias structure of the design is usually shortened because fewer terms are 
confounded with one another. Specifically, when you fold on all factors, any word in the defining relation that has an odd 
number of the letters is omitted. When you fold on one factor, any word containing that factor is omitted from the defining 
relation. For example, you have a design with five factors. The defining relation for the unfolded and folded designs (both 
folded on all factors and just folded on factor A) are: 

Unfolded design I + ABD + ACE + BCDE 

Folded design I + BCDE 

If you fold a design and the defining relation is not shortened, then the folding just adds replicates. It does not reduce 
confounding. In this case, Minitab gives you an error message. 
If you fold a design that is blocked, the same block generators are used for the folded design as for the unfolded design. 
 

To fold the design  
1    In the Create Factorial Design dialog box, click Options. 
2    Do one of the following, then click OK. 

•    Choose Fold on all factors to make all main effects free from each other and all two-factor interactions. 
•    Choose Fold just on factor and then choose a factor from the list to make the specified factor and all its two-

factor interactions free from other main effects and two-factor interactions. 
 

Choosing a Fraction 
When you create a fractional factorial design, Minitab uses the principal fraction by default. The principal fraction is the 
fraction where all signs are positive. However, there may be situations when a design contains points that are impractical 
to run and choosing an appropriate fraction can avoid these points.  
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A full factorial design with 5 factors requires 32 runs. If you want just 8 runs, you need to use a one-fourth fraction. You 
can use any of the four possible fractions of the design. Minitab numbers the runs in "standard" (Yates) order using the 
design generators as follows: 

1  D = -AB   E = -AC 
2  D =  AB   E = -AC 
3  D = -AB   E =  AC 
4  D =  AB   E =  AC 

In the blocking example, we asked for the third fraction. This is the one with design generators D = −AB and E = AC.  
Choosing an appropriate fraction can avoid points that are impractical or impossible to run. For example, suppose you 
could not run the design in the previous example with all five factors set at their high level. The principal fraction contains 
this point, but the third fraction does not. 

Note If you choose to use a fraction other than the principal fraction, you cannot use minus signs for the design 
generators in the Generators subdialog box. Using minus signs in this case is not useful anyway. 

 

Randomizing the Design 
By default, Minitab randomizes the run order of the design. The ordered sequence of the factor combinations 
(experimental conditions) is called the run order. It is usually a good idea to randomize the run order to lessen the effects 
of factors that are not included in the study, particularly effects that are time-dependent. 
However, there may be situations when randomization leads to an undesirable run order. For instance, in industrial 
applications, it may be difficult or expensive to change factor levels. Or, after factor levels have been changed, it may take 
a long time for the system to return to a steady state. Under these conditions, you may not want to randomize the design 
in order to minimize the level changes. 
Every time you create a design, Minitab reserves and names C1 (StdOrder) and C2 (RunOrder) to store the standard 
order and run order, respectively. 

•    StdOrder shows what the order of the runs in the experiment would be if the experiment was done in standard 
order − also called Yates' order. 

•    RunOrder shows what the order of the runs in the experiment would be if the experiment was run in random order.  
If you do not randomize, the run order and standard order are the same. 
If you want to re-create a design with the same ordering of the runs (that is, the same design order), you can choose a 
base for the random data generator. Then, when you want to re-create the design, you just use the same base. 

Note When you have more than one block, MINITAB randomizes each block independently. 

More You can use Display Design to switch back and forth between a random and standard order display in the 
worksheet. 

 

Storing the design 
If you want to analyze a design, you must store it in the worksheet. By default, Minitab stores the design. If you want to 
see the properties of various designs, such as alias structures before selecting the design you want to store, uncheck 
Store design in worksheet in the Options subdialog box. 
Every time you create a design, Minitab reserves and names the following columns: 

•    C1 (StdOrder) stores the standard order. 

•    C2 (RunOrder) stores run order. 

•    C3 (CenterPt or PtType) stores the point type.  If you create a 2-level design, this column is labeled CenterPt. If you 
create a Plackett-Burman or general full factorial design, this column in labeled PtType. The codes are: 0 is a center 
point run and 1 is a corner point. 

•    C4 (Blocks) stores the blocking variable. When the design is not blocked, Minitab sets all column values to 1.  

•    C5− Cn stores the factors/components. Minitab stores each factor in your design in a separate column. 
If you name the factors, these names display in the worksheet. If you did not provide names, Minitab names the factors 
alphabetically. After you create the design, you can change the factor names directly in the Data window or with Modify 
Design. 
If you did not assign factor levels in the Factors subdialog box, Minitab stores factor levels in coded form (all factor levels 
are −1 or +1). If you assigned factor levels, the uncoded levels display in the worksheet. If you assigned factor levels, the 
uncoded levels display in the worksheet. After you create the design, you can change the factor levels with Modify Design. 

Caution When you create a design using Create Factorial Design, Minitab stores the appropriate design information in 
the worksheet. Minitab needs this stored information to analyze and plot data. If you want to use Analyze 
Factorial Design, you must follow certain rules when modifying the worksheet data. If you do not, you may 
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corrupt your design. See Modifying and Using Worksheet Data.  

If you make changes that corrupt your design, you may still be able to analyze it with Analyze Factorial Design 
after you use Define Custom Factorial Design.  

 

Studying specific interactions  
When you are interested in studying specific interactions, you do not want these interactions confounded with each other 
or with main effects. Look at the alias structure to see how the interactions are confounded, then assign factors to 
appropriate letters in Minitab's design. 
For example, suppose you wanted to use a 16 run design to study 6 factors: pressure, speed, cooling, thread, hardness, 
and time. The alias structure for this design is shown in Example of a fractional factorial design. Suppose you were 
interested in the 2-factor interactions among pressure, speed, and cooling. You could assign pressure to A, speed to B, 
and cooling to C. The following lines of the alias table demonstrate that AB, AC, and BC are not confounded with each 
other or with main effects 
AB + CE + ACDF + BDEF 
AC + BE + ABDF + CDEF 
... 
AE + BC + DF + ABCDEF 
You can assign the remaining three factors to D, E, and F in any way. 
If you also wanted to study the three-way interaction among pressure, speed, and cooling, this assignment would not work 
because ABC is confounded with E. However, you could assign pressure to A, speed to B, and cooling to D. 
 

Factorial Design − Results (2-level factorial) 
Stat > DOE > Factorial > Create Factorial Design > Results 
You can control the output displayed in the Session window. 

Dialog box items 
Printed Results  

None: Choose to suppress display of the results. 
Summary table: Choose to display a summary of the design. The table includes the number of factors, runs, blocks, 
replicates, center points, and the resolution, the fraction and the design generators.  
Summary table, alias table: Choose to display a summary of the design and the alias structure. 
Summary table, alias table, design table: Choose to display a summary of the design, the alias structure, and a table 
with the factors and their settings at each run.  
Summary table, alias table, design table, defining relation: Choose to display a summary of the design, the alias 
structure, a table with the factors and their levels at each run, and the defining relation. 

Contents of Alias Table  
Default interactions: Choose to display all interactions for designs with 2 to 6 factors, up to three-way interactions for 
7 to 10 factors, and up to two-way interactions for 11 to 15 factors. 
Interactions up through order: Specify the highest order interaction to print in the alias table. Specifying a high order 
interaction with a large number of factors could take a very long time to compute. 

 

Summary of 2-Level Designs 
The table below summarizes the two-level default designs and the base designs for designs in which you specify 
generators for additional factors. Table cells with entries show available run/factor combinations. The first number in a cell 
is the resolution of the unblocked design. The lower number in a cell is the maximum number of blocks you can use. 

 Number of factors 
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Number 
of runs 

2 3 4 5 6 7 8 9 10 11 12 13 14 15 

4 full 
2 

III 
1 

            

8 
 full 

4 
IV 
4 

III 
2 

III 
2 

III 
1 

        

16 
  full 

8 
V 
8 

IV 
8 

IV 
8 

IV 
8 

III 
4 

III 
4 

III 
4 

III 
4 

III 
2 

III 
2 

III 
1 

32 
   full 

16 
VI 
16 

IV 
8 

IV 
8 

IV 
8 

IV 
8 

IV 
8 

IV 
8 

IV 
8 

IV 
8 

IV 
8 

64 
    full 

32 
VII 
16 

V 
16 

IV 
16 

IV 
16 

IV 
16 

IV 
16 

IV 
16 

IV 
16 

IV 
16 

128 
     full 

64 
VIII 
32 

VI 
16 

V 
16 

V 
16 

IV 
16 

IV 
16 

IV 
16 

IV 
16 

 

Example of creating a fractional factorial design 
Suppose you want to study the influence six input variables (factors) have on shrinkage of a plastic fastener of a toy. The 
goal of your pilot study is to screen these six factors to determine which ones have the greatest influence. Because you 
assume that three-way and four-way interactions are negligible, a resolution IV factorial design is appropriate. You decide 
to generate a 16 run fractional factorial design from Minitab's catalog.  
1    Choose Stat > DOE > Factorial > Create Factorial Design. 
2    From Number of factors, choose 6. 
3    Click Designs. 
4    In the box at the top, highlight the line for 1/4 fraction. Click OK. 
5    Click Results. Choose Summary table, alias table, design table, defining relation. 
6    Click OK in each dialog box. 

Session window output 

Fractional Factorial Design 
 
Factors:   6   Base Design:         6, 16   Resolution:   IV
Runs:     16   Replicates:              1   Fraction:    1/4
Blocks:    1   Center pts (total):      0 
 
 
Design Generators: E = ABC, F = BCD 
 
 
Defining Relation:  I = ABCE = BCDF = ADEF 
 
 
Alias Structure 
 
I + ABCE + ADEF + BCDF 
 
A + BCE + DEF + ABCDF 
B + ACE + CDF + ABDEF 
C + ABE + BDF + ACDEF 
D + AEF + BCF + ABCDE 
E + ABC + ADF + BCDEF 
F + ADE + BCD + ABCEF 
AB + CE + ACDF + BDEF 
AC + BE + ABDF + CDEF 
AD + EF + ABCF + BCDE 
AE + BC + DF + ABCDEF 
AF + DE + ABCD + BCEF 
BD + CF + ABEF + ACDE 
BF + CD + ABDE + ACEF 
ABD + ACF + BEF + CDE 
ABF + ACD + BDE + CEF 



Factorial Designs 

 Copyright © 2003–2005 Minitab Inc.  All rights reserved.  23

 
 
Design Table (randomized) 
 
Run  A  B  C  D  E  F 
  1  +  -  -  -  +  - 
  2  -  +  +  -  -  - 
  3  -  -  -  -  -  - 
  4  -  -  -  +  -  + 
  5  -  -  +  -  +  + 
  6  +  +  -  +  -  - 
  7  -  +  +  +  -  + 
  8  +  -  +  +  -  - 
  9  +  +  +  +  +  + 
 10  -  -  +  +  +  - 
 11  +  -  -  +  +  + 
 12  +  +  +  -  +  - 
 13  +  -  +  -  -  + 
 14  +  +  -  -  -  + 
 15  -  +  -  +  +  - 
 16  -  +  -  -  +  + 

Interpreting the results 
The first table gives a summary of the design: the total number of factors, runs, blocks, replicates, and center points. 
With 6 factors, a full factorial design would have 26 or 64 runs. Because resources are limited, you chose a 1/4 fraction 
with 16 runs. 
The resolution of a design that has not been blocked is the length of the shortest word in the defining relation. In this 
example, all words in the defining relation have four letters so the resolution is IV. In a resolution IV design, some main 
effects are confounded with three-way interactions, but not with any 2-way interactions or other main effects. Because 2-
way interactions are confounded with each other, any significant interactions will need to be evaluated further to define 
their nature. 
Because you chose to display the summary and design tables, Minitab shows the experimental conditions or settings for 
each of the factors for the design points. When you perform the experiment, use the order that is shown to determine the 
conditions for each run. For example, in the first run of your experiment, you would set Factor A high, Factor B low, Factor 
C low, Factor D low, Factor E high, and Factor F low, and measure the shrinkage of the plastic fastener. 
Minitab randomizes the design by default, so if you try to replicate this example your run order may not match the order 
shown. 
 

Example of creating a blocked design 
You would like to study the effects of five input variables on the impurity of a vaccine. Each batch only contains enough 
raw material to manufacture four tubes of the vaccine. To remove the effects due to differences in the four batches of raw 
material, you decide to perform the experiment in four blocks. To determine the experimental conditions that will be used 
for each run, you create a 5-factor, 16-run design, in 4 blocks. 
1    Choose Stat >DOE > Factorial > Create Factorial Design. 
2    From Number of factors, choose 5. 
3    Click Designs. 
4    In the box at the top, highlight the line for 1/2 fraction.  
5    From Number of blocks, choose 4. Click OK. 
6    Click Results. Choose Summary table, alias table, design table, defining relation. Click OK in each dialog box. 

Session window output 

Fractional Factorial Design 
 
 
Factors:   5   Base Design:         5, 16   Resolution with blocks:  III 
Runs:     16   Replicates:              1   Fraction:                1/2 
Blocks:    4   Center pts (total):      0 
 
* NOTE * Blocks are confounded with two-way interactions. 
 
Design Generators: E = ABCD 
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Block Generators: AB, AC 
 
 
Defining Relation:  I = ABCDE 
 
 
Alias Structure 
 
I + ABCDE 
 
Blk1 = AB + CDE 
Blk2 = AC + BDE 
Blk3 = BC + ADE 
 
A + BCDE 
B + ACDE 
C + ABDE 
D + ABCE 
E + ABCD 
AD + BCE 
AE + BCD 
BD + ACE 
BE + ACD 
CD + ABE 
CE + ABD 
DE + ABC 
 
 
Design Table (randomized) 
 
Run  Block  A  B  C  D  E 
  1      1  +  -  -  -  - 
  2      1  -  +  +  -  + 
  3      1  -  +  +  +  - 
  4      1  +  -  -  +  + 
  5      3  -  +  -  +  + 
  6      3  +  -  +  -  + 
  7      3  +  -  +  +  - 
  8      3  -  +  -  -  - 
  9      4  +  +  +  +  + 
 10      4  +  +  +  -  - 
 11      4  -  -  -  +  - 
 
 12      4  -  -  -  -  + 
 13      2  +  +  -  -  + 
 14      2  -  -  +  +  + 
 15      2  -  -  +  -  - 
 16      2  +  +  -  +  - 

Interpreting the results 
The first table gives a summary of the design: the total number of factors, runs, blocks, replicates, center points, and 
resolution. After blocking, this is a resolution III design because blocks are confounded with 2-way interactions. 
Because you chose to display the summary and design tables, Minitab shows the experimental conditions or settings for 
each of the factors for the design points. When you perform the experiment, use the order that is shown to determine the 
conditions for each run. 
The first four runs of your experiment would all be performed using raw material from the same batch (Block 1). For the 
first run in block one, you would set Factor A high, Factor B low, Factor C low, Factor D low, and Factor E low, and 
measure the impurity of the vaccine. 
Minitab randomizes the design by default, so if you try to replicate this example your run order may not match the order 
shown. 
 

Plackett-Burman 
Create Factorial Design 
Stat > DOE > Factorial > Create Factorial Design 
Generates 2-level designs, either full or fractional factorials, and Plackett-Burman designs. See Factorial Designs 
Overview for descriptions of these types of designs. 
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Dialog box items 
Type of Design  

2-level factorial (default generators): Choose to use Minitab's default generators.  
2-level factorial (specify generators): Choose to specify your own design generators. 
Plackett-Burman design: Choose to generate a Plackett-Burman design. See Plackett-Burman Designs for a 
complete list.  
General full factorial design: Choose to generate a design in which at least one factor has more than two levels. 

Number of factors: Specify the number of factors in the design you want to generate.  
 

Creating Plackett-Burman Designs 
Plackett-Burman designs are a class of resolution III, 2-level fractional factorial designs that are often used to study main 
effects. In a resolution III design, main effects are aliased with two-way interactions. Therefore, you should only use these 
designs when you are willing to assume that 2-way interactions are negligible.  
Minitab generates designs for up to 47 factors. Each design is based on the number of runs, from 12 to 48, and is always 
a multiple of 4. The number of factors must be less than the number of runs. For example, a design with 20 runs allows 
you to estimate the main effects for up to 19 factors. See Summary of Plackett-Burman Designs.  
Minitab displays alias tables only for saturated 16-run designs. For 12-, 20-, and 24-run designs, each main effect gets 
partially confounded with more than one two-way interaction thereby making the alias structure difficult to determine.  
After you create the design, perform the experiment to obtain the response data, and enter the data in the worksheet, you 
can use Analyze Factorial Design. 
 

Summary of Plackett-Burman Designs 
These are the designs given in [4], up through n = 48, where n is the number of runs. In all cases except n = 28, the 
design can be specified by giving just the first column of the design matrix. In the table below, we give this first column 
(written as a row to save space). This column is permuted cyclically to get an (n − 1) x (n − 1) matrix. Then a last row of all 
minus signs is added. For n = 28, we start with the first 9 rows. These are then divided into 3 blocks of 9 columns each. 
Then the 3 blocks are permuted (rowwise) cyclically and a last column of all minus signs is added to get the full design. 

Each design can have up to k = (n − 1) factors. If you specify a k that is less than (n − 1), just the first k columns are used. 

 

12 Runs  

 + + − + + + − − − + − 
20 Runs  

 + + − − + + + + − + − + − − − − + + − 
24 Runs  

�+ + + + + − + − + + − − + + − − + − + − − − − 

28 Runs  

�+ − + + + + − − − − + − − − + − − + + + − + − + + − + 

�+ + − + + + − − − − − + + − − + − − − + + + + − + + − 

�− + + + + + − − − + − − − + − − + − + − + − + + − + + 

�− − − + − + + + + − − + − + − − − + + − + + + − + − + 

�− − − + + − + + + + − − − − + + − − + + − − + + + + − 

�− − − − + + + + + − + − + − − − + − − + + + − + − + + 

�+ + + − − − + − + − − + − − + − + − + − + + − + + + − 

�+ + + − − − + + − + − − + − − − − + + + − + + − − + + 

�+ + + − − − − + + − + − − + − + − − − + + − + + + − + 

32 Runs 

 − − − − + − + − + + + − + + − − − + + + + + − − + + − + − − + 
36 Runs  

 − + − + + + − − − + + + + + − + + + − − + − − − − + − + − + + − − + − 
40 Runs (note, derived by duplicating the 20 run design) 

 + + − − + + + + − + − + − − − − + + − + + − − + + + + − + − + − − − − + + − 
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44 Runs  

 + + − − + − + − − + + + − + + + + + − − − + − + + + − − − − − + − − − + +− + − + + − 
48 Runs 

 + + + + + − + + + + − − + − + − + + + − − + − − + + − + + − − − + − + − + + − − − − + − − − − 
 

To create a Plackett-Burman design 
1    Choose Stat > DOE > Factorial > Create Factorial Design.  
2    If you want to see a summary of the Plackett-Burman designs, click Display Available Designs. Use this table to 

compare design features. Click OK. 
3    Choose Plackett-Burman design. 
4    From Number of factors, choose a number from 2 to 47. 
5    Click Designs.  
6    From Number of runs, choose the number of runs for your design. This list contains only acceptable numbers of runs 

based on the number of factors you choose in step 4. (Each design is based on the number of runs, from 12 to 48, 
and is always a multiple of 4. The number of factors must be less than the number of runs.) 

7    If you like, use any of the options in the Design subdialog box .  
Even if you do not use any of these options, click OK. This selects the design and brings you back to the main dialog 
box.  

8    If you like, click Options or Factors to use any of the dialog box options, then click OK to create your design. 
 

Factorial Design − Available Designs 
Stat > DOE > Factorial > Create Factorial Design > choose a 2-level or Plackett-Burman option > Display Available 
Designs 
Displays a table to help you select an appropriate design, based on 

•    the number of factors that are of interest, 

•    the number of runs you can perform, and 

•    the desired resolution of the design. 
This dialog box does not take any input. See Summary of two-level designs and Summary of Plackett-Burman designs. 
 

Factorial Design − Designs (Plackett-Burman) 
Stat > DOE > Factorial > Create Factorial Design > choose Plackett-Burman > Designs  
Specifies the number of runs, center points, replicates, and blocks. 

Dialog box items 
Number of runs: Choose the number of runs in the design you want to generate. The design generated is based on the 
number of runs, and must be specified as a multiple of 4 ranging from 12 to 48. If the number of runs is not specified, 
Minitab sets the number of runs to the smallest possible value for the specified number of factors. Plackett-Burman 
Designs lists the designs that Minitab generates. 
Number of center points per replicate: Enter the number of center points (up to 50) to add to the design. When you 
have both text and numeric factors, there really is no true center to the design. In this case, center points are called 
pseudo center points. See Adding center points for a discussion of how Minitab handles center points. 
Number of replicates: Enter a number up to 50. Suppose you are creating a design with 3 factors and 12 runs, and you 
specify 2 replicates. Each of the 12 runs will be repeated for a total of 24 runs in the experiment. 

Block on replicates: Check to block the design on replicates. Each set of replicate points will be placed in a separate 
block. 

 

Adding center points 
Adding center points to a factorial design may allow you to detect curvature in the fitted data. If there is curvature that 
involves the center of the design, the response at the center point will be either higher or lower than the fitted value of the 
factorial (corner) points. 
The way Minitab adds center points to the design depends on whether you have text, numeric, or a combination of text 
and numeric factors. Here is how Minitab adds center points: 

•    When all factors are numeric and the design is: 
−    Not blocked, Minitab adds the specified number of center points to the design. 
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−    Blocked, Minitab adds the specified number of center points to each block. 

•    When all of the factors in a design are text, you cannot add center points. 

•    When you have a combination of numeric and text factors, there is no true center to the design. In this case, center 
points are called pseudo-center points. When the design is:  
−    Not blocked, Minitab adds the specified number of center points for each combination of the levels of the text 

factors. In total, for Q text factors, Minitab adds 2Q times as many centerpoints. 
−    Blocked, Minitab adds the specified number of center points for each combination of the levels of the text factors 

to each block. In each block, for Q text factors, Minitab adds 2Q times as many centerpoints. 
For example, consider an unblocked 23 design. Factors A and C are numeric with levels 0, 10 and .2, .3, respectively. 
Factor B is text indicating whether a catalyst is present or absent. If you specify 3 center points in the Designs 
subdialog box, Minitab adds a total of 2 x 3 = 6 pseudo-center points, three points for the low level of factor B and 
three for the high level. These six points are: 

5 present .25 

5 present .25 

5 present .25 

5 absent  .25 

5 absent  .25 

5 absent  .25 

Next, consider a blocked 25 design where three factors are text, and there are two blocks. There are 2 x 2 x 2 = 8 
combinations of text levels. If you specify two center points per block, Minitab will add 8 x 2 = 16 pseudo-center points 
to each of the two blocks. 

 

Factorial Design − Factors (2-level factorial or Plackett-Burman design) 
Stat > DOE > Factorial > Create Factorial Design > Factors 
Allows you to name or rename the factors and assign values for factor levels. If your factors could be continuous, use 
numeric levels; if your factors are categorical, use text levels. Continuous variables can take on any value on the 
measurement scale being used (for example, length of reaction time). Categorical variables can only assume a limited 
number of possible values (for example, type of catalyst). 
Use the arrow keys to navigate within the table, moving across rows or down columns. 

Dialog box items 
Factor: Shows the number of factors you have chosen for your design. This column does not take any input. 
Name: Enter text to change the name of the factors. By default, Minitab names the factors alphabetically, skipping the 
letter I. 
Type: Choose to specify whether the levels of the factors are numeric or text. For information on how Minitab handles 
centerpoints when you have a combination of text and numeric factors, see Adding center points.  

Low: Enter the value for the low setting of each factor. By default, Minitab sets the low level of all factors to −1. Factor 
settings can be changed to any numeric or text value. If one of the settings for a factor is text, Minitab interprets the other 
setting as text. 
High: Enter the value for the high setting of each factor. By default, Minitab sets the high level of all factors to +1. Factor 
settings can be changed to any numeric or text value. If one of the settings for a factor is text, Minitab interprets the other 
setting as text. 

Note For information on how Minitab handles centerpoints when you have a combination of text and numeric factors, 
see Adding center points.  

 

To name factors 
1    In the Create Factorial Design dialog box, click Factors.  
2    Under Name, click in the first row and type the name of the first factor. Then, use the arrow key to move down the 

column and enter the remaining factor names. Click OK. 

More After you have created the design, you can change the factor names by typing new names in the Data window, 
or with Modify Design. 
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To assign factor levels 
When creating a design 
1    In the Create Factorial Design dialog box, click Factors.  
2    Under Low, click in the factor row you would like to assign values and enter any numeric or text value. Use the arrow 

key to move to High and enter a value. For numeric levels, the High value must be larger than the Low value.  
3    Repeat step 2 to assign levels for other factors. Click OK. 

After creating a design  
To change the factor levels after you have created the design, use Modify Design. Unless some runs result in botched 
runs, do not change levels by typing them in the worksheet. 
 

Create Design − Options 
Stat > DOE > Factorial > Create Factorial Design > choose Plackett-Burman or General full factorial design > Options 
Allows you to randomize the design, and store the design (and design object) in the worksheet.  

Dialog box items 
Randomize runs: Check to randomize the runs in the data matrix. If you specify blocks, randomization is done separately 
within each block and then the blocks are randomized. 

Base for random data generator: Enter a base for the random data generator. By entering a base for the random 
data generator, you can control the randomization so that you obtain the same pattern every time.  

Note If you use the same base on different computer platforms or with different versions of Minitab, you may not get 
the same random number sequence. 

Store design in worksheet: Check to store the design in the worksheet. When you open this dialog box, the "Store 
design in worksheet" option is checked. If you want to see the properties of various designs before selecting the one 
design you want to store, you would uncheck this option. If you want to analyze a design, you must store it in the 
worksheet. 
 

Randomizing the Design 
By default, Minitab randomizes the run order of the design. The ordered sequence of the factor combinations 
(experimental conditions) is called the run order. It is usually a good idea to randomize the run order to lessen the effects 
of factors that are not included in the study, particularly effects that are time-dependent. 
However, there may be situations when randomization leads to an undesirable run order. For instance, in industrial 
applications, it may be difficult or expensive to change factor levels. Or, after factor levels have been changed, it may take 
a long time for the system to return to a steady state. Under these conditions, you may not want to randomize the design 
in order to minimize the level changes. 
Every time you create a design, Minitab reserves and names C1 (StdOrder) and C2 (RunOrder) to store the standard 
order and run order, respectively. 

•    StdOrder shows what the order of the runs in the experiment would be if the experiment was done in standard 
order − also called Yates' order. 

•    RunOrder shows what the order of the runs in the experiment would be if the experiment was run in random order.  
If you do not randomize, the run order and standard order are the same. 
If you want to re-create a design with the same ordering of the runs (that is, the same design order), you can choose a 
base for the random data generator. Then, when you want to re-create the design, you just use the same base. 

Note When you have more than one block, MINITAB randomizes each block independently. 

More You can use Display Design to switch back and forth between a random and standard order display in the 
worksheet. 

 

Storing the design 
If you want to analyze a design, you must store it in the worksheet. By default, Minitab stores the design. If you want to 
see the properties of various designs, such as alias structures before selecting the design you want to store, uncheck 
Store design in worksheet in the Options subdialog box. 
Every time you create a design, Minitab reserves and names the following columns: 

•    C1 (StdOrder) stores the standard order. 

•    C2 (RunOrder) stores run order. 
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•    C3 (CenterPt or PtType) stores the point type.  If you create a 2-level design, this column is labeled CenterPt. If you 
create a Plackett-Burman or general full factorial design, this column in labeled PtType. The codes are: 0 is a center 
point run and 1 is a corner point. 

•    C4 (Blocks) stores the blocking variable. When the design is not blocked, Minitab sets all column values to 1.  

•    C5− Cn stores the factors/components. Minitab stores each factor in your design in a separate column. 
If you name the factors, these names display in the worksheet. If you did not provide names, Minitab names the factors 
alphabetically. After you create the design, you can change the factor names directly in the Data window or with Modify 
Design. 
If you did not assign factor levels in the Factors subdialog box, Minitab stores factor levels in coded form (all factor levels 
are −1 or +1). If you assigned factor levels, the uncoded levels display in the worksheet. If you assigned factor levels, the 
uncoded levels display in the worksheet. After you create the design, you can change the factor levels with Modify Design. 

Caution When you create a design using Create Factorial Design, Minitab stores the appropriate design information in 
the worksheet. Minitab needs this stored information to analyze and plot data. If you want to use Analyze 
Factorial Design, you must follow certain rules when modifying the worksheet data. If you do not, you may 
corrupt your design. See Modifying and Using Worksheet Data.  

If you make changes that corrupt your design, you may still be able to analyze it with Analyze Factorial Design 
after you use Define Custom Factorial Design.  

 

Factorial Design − Results (full factorial or Plackett-Burman) 
Stat > DOE > Factorial > Create Factorial Design > Results 
You can control the output displayed in the Session window. 

Dialog box items 
Printed Results  

None: Choose to suppress display of the results. 
Summary table: Choose to display a summary of the design. The table includes the number of factors, runs, blocks, 
replicates, and center points.  
Summary table and design table: Choose to display a summary of the design and a table with the factors and their 
settings at each run. 

 

Example of creating a Plackett-Burman design with center points 
Suppose you want to study the effects of 9 factors using only 12 runs, with 3 center points. In this 12 run design, each 
main effect is partially confounded with more than one 2-way interaction. 
1    Choose Stat > DOE > Factorial > Create Factorial Design. 
2    Choose Plackett-Burman design. 
3    From Number of factors, choose 9. 
4    Click Designs. 
5    From Number of runs, choose 12. 
6    In Number of center points per replicate, enter 3.  
7    Click Results. Choose Summary table and design table. Click OK in each dialog box. 

Session window output 

Plackett - Burman Design 
 
 
Factors:       9     Replicates:     1
Base runs:    15     Total runs:    15
Base blocks:   1     Total blocks:   1
 
Center points: 3 
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Design Table (randomized) 
 
Run  Blk  A  B  C  D  E  F  G  H  J 
  1    1  -  -  -  +  +  +  -  +  + 
  2    1  +  +  +  -  +  +  -  +  - 
  3    1  +  -  +  -  -  -  +  +  + 
  4    1  +  -  +  +  -  +  -  -  - 
  5    1  -  +  +  -  +  -  -  -  + 
  6    1  +  +  -  +  -  -  -  +  + 
  7    1  0  0  0  0  0  0  0  0  0 
  8    1  -  -  -  -  -  -  -  -  - 
  9    1  +  -  -  -  +  +  +  -  + 
 10    1  0  0  0  0  0  0  0  0  0 
 11    1  -  +  -  -  -  +  +  +  - 
 12    1  -  -  +  +  +  -  +  +  - 
 13    1  -  +  +  +  -  +  +  -  + 
 14    1  0  0  0  0  0  0  0  0  0 
 15    1  +  +  -  +  +  -  +  -  - 

Interpreting the results 
In the first table, Total runs shows the total number of runs including any runs created by replicates and center points. For 
this example, you specified 12 runs and added 3 runs for center points, for a total of 15. 
Minitab does not display an alias tables for this 12 run design because each main effect is partially confounded with more 
than one 2-way interaction.  
Minitab shows the experimental conditions or settings for each of the factors for the design points. When you perform the 
experiment, use the order that is shown to determine the conditions for each run. For example, in the first run of your 
experiment, you would set Factor A low, Factor B low, Factor C low, Factor D high, Factor E high, Factor F high, Factor G 
low, Factor H high, and Factor J high.  
Minitab randomizes the design by default, so if you try to replicate this example your runs may not match the order shown. 
 

General full factorial 
Create Factorial Design 
Stat > DOE > Factorial > Create Factorial Design 
Generates 2-level designs, either full or fractional factorials, and Plackett-Burman designs. See Factorial Designs 
Overview for descriptions of these types of designs. 

Dialog box items 
Type of Design  

2-level factorial (default generators): Choose to use Minitab's default generators.  
2-level factorial (specify generators): Choose to specify your own design generators. 
Plackett-Burman design: Choose to generate a Plackett-Burman design. See Plackett-Burman Designs for a 
complete list.  
General full factorial design: Choose to generate a design in which at least one factor has more than two levels. 

Number of factors: Specify the number of factors in the design you want to generate.  
 

Creating Full Factorial Designs 
Use Minitab's general full factorial design option when any factor has more than two levels. You can create designs with 
up to 15 factors. Each factor must have at least two levels, but not more than 100 levels. 
If all the factors have two levels, use one of the 2-level factorial options. 

Note To create a design from data that you already have in the worksheet, see Define Custom Factorial Design.

 

To create a general full factorial design 
1    Choose Stat > DOE > Factorial > Create Factorial Design.  
2    Choose General full factorial design. 
3    From Number of factors, choose a number from 2 to 15.  
4    Click Designs.  
5    Click in Number of Levels in the row for Factor A and enter a number from 2 to 100. Use the arrow key to move down 

the column and specify the number of levels for each factor.  
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6    If you like, use any of the options in the Design subdialog box. 
7    Click OK. This selects the design and brings you back to the main dialog box. 
8    If you like, click Options or Factors and use any of the dialog box options , then click OK to create your design. 
 

Factorial Design − Available Designs 
Stat > DOE > Factorial > Create Factorial Design > choose General full factorial design > Display Available 
Designs 
This dialog box does not take any input.  
 

Factorial Design − Designs  
Stat > DOE > Factorial > Create Factorial Design > choose General full factorial design > Design 
Allows you to name factors, specify the number of levels for each factor, add replicates, and block the design. 

Dialog box items 
Factor: Shows the number of factors you have chosen for your design. This column does not take any input. 
Name: Enter text to change the name of the factors. By default, Minitab names the factors alphabetically. 
Number of Levels: Enter a number from 2 to 100 for each factor. Use the arrow keys to move up or down the column. 
Number of replicates: Enter a number up to 50. Suppose you are creating a design with 3 factors and 12 runs, and you 
specify 2 replicates. Each of the 12 runs will be repeated for a total of 24 runs in the experiment. 

Block on replicates: Check to block the design on replicates. Each set of replicate points will be placed in a separate 
block. 

 

Factorial Design − Factors 
Stat > DOE > Factorial > Create Factorial Design > choose General full factorial design > Designs > Factors 
Allows you to name or rename the factors and assign values for factor levels. If your factors could be continuous, use 
numeric levels; if your factors are categorical, use text levels. Continuous variables can take on any value on the 
measurement scale being used (for example, length of reaction time). In contrast, categorical variables can only assume a 
limited number of possible values (for example, type of catalyst). 
Use the arrow keys to navigate within the table, moving across rows or down columns. 

Dialog box items 
Factor: Shows the number of factors you have chosen for your design. This column does not take any input. 
Name: Enter text to change the name of the factors. By default, Minitab names the factors alphabetically, skipping the 
letter I. 
Type: Choose to specify whether the levels of the factors are numeric or text. 
Levels: Shows the number of levels for each factor. This column does not take any input. 
Level Values: Enter numeric or text values for each level of the factor. You can have up to 100 levels for each factor. By 
default, Minitab sets the level values in numerical order 1, 2, 3, ... .  
 

To name factors 
1    In the Create Factorial Design dialog box, click Factors.  
2    Under Name, click in the first row and type the name of the first factor. Then, use the arrow key to move down the 

column and enter the remaining factor names. Click OK. 

More After you have created the design, you can change the factor names by typing new names in the Data window, 
or with Modify Design. 

 

To assign factor levels 
1    In the Create Factorial Design dialog box, click Factors. 
2    Under Level Values, click in the factor row to which you would like to assign values and enter any numeric or text 

value. Enter numeric levels from lowest to highest. 
3    Use the arrow key to move down the column and assign levels for the remaining factors. Click OK. 

More To change the factor levels after you have created the design, use Modify Design. Unless some runs result in 
botched runs, do not change levels by typing them in the worksheet. 
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Create Design − Options 
Stat > DOE > Factorial > Create Factorial Design > choose Plackett-Burman or General full factorial design > Options 
Allows you to randomize the design, and store the design (and design object) in the worksheet.  

Dialog box items 
Randomize runs: Check to randomize the runs in the data matrix. If you specify blocks, randomization is done separately 
within each block and then the blocks are randomized. 

Base for random data generator: Enter a base for the random data generator. By entering a base for the random 
data generator, you can control the randomization so that you obtain the same pattern every time.  

Note If you use the same base on different computer platforms or with different versions of Minitab, you may not get 
the same random number sequence. 

Store design in worksheet: Check to store the design in the worksheet. When you open this dialog box, the "Store 
design in worksheet" option is checked. If you want to see the properties of various designs before selecting the one 
design you want to store, you would uncheck this option. If you want to analyze a design, you must store it in the 
worksheet. 
 

Randomizing the Design 
By default, Minitab randomizes the run order of the design. The ordered sequence of the factor combinations 
(experimental conditions) is called the run order. It is usually a good idea to randomize the run order to lessen the effects 
of factors that are not included in the study, particularly effects that are time-dependent. 
However, there may be situations when randomization leads to an undesirable run order. For instance, in industrial 
applications, it may be difficult or expensive to change factor levels. Or, after factor levels have been changed, it may take 
a long time for the system to return to a steady state. Under these conditions, you may not want to randomize the design 
in order to minimize the level changes. 
Every time you create a design, Minitab reserves and names C1 (StdOrder) and C2 (RunOrder) to store the standard 
order and run order, respectively. 

•    StdOrder shows what the order of the runs in the experiment would be if the experiment was done in standard 
order − also called Yates' order. 

•    RunOrder shows what the order of the runs in the experiment would be if the experiment was run in random order.  
If you do not randomize, the run order and standard order are the same. 
If you want to re-create a design with the same ordering of the runs (that is, the same design order), you can choose a 
base for the random data generator. Then, when you want to re-create the design, you just use the same base. 

Note When you have more than one block, MINITAB randomizes each block independently. 

More You can use Display Design to switch back and forth between a random and standard order display in the 
worksheet. 

 

Storing the design 
If you want to analyze a design, you must store it in the worksheet. By default, Minitab stores the design. If you want to 
see the properties of various designs, such as alias structures before selecting the design you want to store, uncheck 
Store design in worksheet in the Options subdialog box. 
Every time you create a design, Minitab reserves and names the following columns: 

•    C1 (StdOrder) stores the standard order. 

•    C2 (RunOrder) stores run order. 

•    C3 (CenterPt or PtType) stores the point type.  If you create a 2-level design, this column is labeled CenterPt. If you 
create a Plackett-Burman or general full factorial design, this column in labeled PtType. The codes are: 0 is a center 
point run and 1 is a corner point. 

•    C4 (Blocks) stores the blocking variable. When the design is not blocked, Minitab sets all column values to 1.  

•    C5− Cn stores the factors/components. Minitab stores each factor in your design in a separate column. 
If you name the factors, these names display in the worksheet. If you did not provide names, Minitab names the factors 
alphabetically. After you create the design, you can change the factor names directly in the Data window or with Modify 
Design. 
If you did not assign factor levels in the Factors subdialog box, Minitab stores factor levels in coded form (all factor levels 
are −1 or +1). If you assigned factor levels, the uncoded levels display in the worksheet. If you assigned factor levels, the 
uncoded levels display in the worksheet. After you create the design, you can change the factor levels with Modify Design. 
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Caution When you create a design using Create Factorial Design, Minitab stores the appropriate design information in 
the worksheet. Minitab needs this stored information to analyze and plot data. If you want to use Analyze 
Factorial Design, you must follow certain rules when modifying the worksheet data. If you do not, you may 
corrupt your design. See Modifying and Using Worksheet Data.  

If you make changes that corrupt your design, you may still be able to analyze it with Analyze Factorial Design 
after you use Define Custom Factorial Design.  

 

Factorial Design − Results (full factorial or Plackett-Burman) 
Stat > DOE > Factorial > Create Factorial Design > Results 
You can control the output displayed in the Session window. 

Dialog box items 
Printed Results  

None: Choose to suppress display of the results. 
Summary table: Choose to display a summary of the design. The table includes the number of factors, runs, blocks, 
replicates, and center points.  
Summary table and design table: Choose to display a summary of the design and a table with the factors and their 
settings at each run. 

 

Define Custom Factorial Design 
Define Custom Factorial Design 
Stat > DOE > Factorial > Define Custom Factorial Design 
Use Define Custom Factorial Design to create a design from data you already have in the worksheet. For example, you 
may have a design that you created using Minitab session commands, entered directly into the Data window, imported 
from a data file, or created with earlier releases of Minitab. You can also use Define Custom Factorial Design to redefine a 
design that you created with Create Factorial Design and then modified directly in the worksheet.  
Define Custom Factorial Design allows you to specify which columns contain your factors and other design 
characteristics. After you define your design, you can use Modify Design, Display Design, and Analyze Factorial Design. 

Dialog box items 
Factors: Enter the columns that contain the factor levels. 
2-level factorial: Choose if all the factors in your design have only two levels. 
General full factorial: Choose if any of the factors in you design have more than two levels. 
 

To define a custom factorial design 
1    Choose Stat > DOE > Factorial > Define Custom Factorial Design. 
2    In Factors, enter the columns that contain the factor levels.  
3    Depending on the type of design you have in the worksheet, choose 2-level factorial or General full factorial. 
4    By default, for each factor, Minitab designates the smallest value in a factor column as the low level; the highest value 

in a factor column as the high level. 
•    If you do not need to change this designation, go to step 5. 
•    If you need to change this designation, click Low/High. 

1    Under Type, choose either numeric or text for each factor.  

2    Under Low, click in the factor row you would like to assign values and enter the appropriate numeric or text 
value. Use the arrow key to move to High and enter a value. For numeric levels, the High value must be 
larger than Low value. 

3    Repeat step 2 to assign levels for other factors. 

4    Under Worksheet Data Are, choose Coded or Uncoded. 

5    Click OK. 

5    Do one of the following: 
•    If you do not have any worksheet columns containing the standard order, run order, center point indicators, or 

blocks, click OK in each dialog box. 
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•    If you have worksheet columns that contain data for the blocks, center point identification (two-level designs only), 
run order, or standard order, click Designs.  

1    If you have a column that contains the standard order of the experiment, under Standard Order Column, 
choose Specify by column and enter the column containing the standard order. 

2    If you have a column that contains the run order of the experiment, under Run Order Column, choose 
Specify by column and enter the column containing the run order. 

3    For two-level designs, if you have a column that contains the center point identification values, under Center 
points, choose Specify by column and enter the column containing these values. The column must contain 
only 0's and 1's. Minitab considers 0 a center point; 1 not a center point. 

4    If your design is blocked, under Blocks, choose Specify by column and enter the column containing the 
blocks. 

5    Click OK in each dialog box. 

 

Define Custom 2-Level Factorial − Design 
Stat > DOE > Factorial > Define Custom Factorial Design > choose 2-level factorial > Designs 
Allows you to specify which columns contain the standard order, run order, center point indicators, and blocks. 

Dialog box items 
Standard Order Column  

Order of the data: Choose if the standard order is the same as the order of the data in the worksheet.  
Specify by column: Choose if the standard order of the data is stored in a separate column, then enter the column. 

Run Order Column  
Order of the data: Choose if the run order is the same as the order of the data in the worksheet. 
Specify by column: Choose if the run order of the data is stored in a separate column, then enter the column. 

Center Points  
No center points: Choose if your design does not contain center points. 
Specify by column: Choose if your design contains center points, then enter the column containing the center point 
identifiers.  

Blocks  
No blocks: Choose if your design is not blocked. 
Specify by column: Choose if your design is blocked, then enter the column containing the blocks. 

 

Define Custom General Full Factorial − Design 
Stat > DOE > Factorial > Define Custom Factorial Design > choose General full factorial > Designs 
Allows you to specify which columns contain the standard order, run order, point type, and blocks. 

Dialog box items 
Standard Order Column  

Order of the data: Choose if the standard order is the same as the order of the data in the worksheet.  
Specify by column: Choose if the standard order of the data is stored in a separate column, then enter the column. 

Run Order Column  
Order of the data: Choose if the run order is the same as the order of the data in the worksheet. 
Specify by column: Choose if the run order of the data is stored in a separate column, then enter the column. 

Point Type Column  
Unknown: Choose if the type of design points is unknown. 
Specify by column: Choose if your design contains point types, then enter the column containing the point type 
identifiers.  

Blocks  
No blocks: Choose if your design is not blocked. 
Specify by column: Choose if your design is blocked, then enter the column containing the blocks. 
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Define Custom 2-Level Factorial − Low/High 
Stat > DOE > Factorial > Define Custom Factorial Design > choose 2-level factorial > Low/High 
Allows you to define the low and high levels for each factor and specify whether worksheet data are in coded or uncoded 
form. 

Dialog box items 
Low and High Values for Factors 

Factor: Shows the factor letter designation. This column does not take any input. 
Name: Shows the name of the factors. This column does not take any input. 
Type: Choose either numeric or text for each factor. 
Low: Enter the value or category for the low level for each factor. 
High: Enter the value or category for the high level for each factor. 

Worksheet data are 
Coded: Choose if the worksheet data are in coded form(-1 = low; +1 = high). 
Uncoded: Choose if the worksheet data are in uncoded form. That is, the worksheet values are in units of the actual 
measurements. 

 

Preprocess Responses for Analyze Variability 
Preprocess Responses/Analyze Variability Overview 
Experiments that include repeat or replicate measurements of a response allow you to analyze variability in your response 
data, which enables you to identify factor settings that produce less variable results. Minitab calculates and stores the 
standard deviations (σ) of your repeat or replicate responses and analyzes them to detect differences, or dispersion 
effects, across factor settings.  
For example, you conduct a spray-drying experiment with replicates and find that two settings of drying temperature and 
atomizer speed produce the desired particle size. By analyzing the variability in particle size at different factor settings, 
you find that one setting produces particles with more variability than the other setting. You choose to run your process at 
the setting that produces the less variable results.  
Once you have created your design, analyzing variability is a two-step process: 

1    Preprocess Responses − First, you calculate and store the standard deviations and counts of your repeat or replicate 
responses or specify standard deviations that you have already stored in the worksheet. You can analyze and graph 
stored standard deviations as response variables using other DOE tools, such as Analyze Variability, Analyze 
Factorial Design, Contour Plots, and Response Optimization.  

2    Analyze Variability − Second, you fit a linear model to the log of the standard deviations you stored in the first step to 
identify significant dispersion effects. Once you fit a model, you can use other tools, such as contour and surface 
plots, and response optimization to better understand your results. You can also store weights calculated from your 
model to perform weighted regression when analyzing the location (mean) effects of your original responses in 
Analyze Factorial Design. 

 

Preprocess Responses for Analyze Variability 
Stat > DOE > Factorial > Preprocess Responses for Analyze Variability 
To preprocess your responses, first either: 

•    Create and store a 2-level factorial design with repeats or replicates, using Create Factorial Design 

•    Create a 2-level factorial design from data that you already have in the worksheet, using Define Custom Factorial 
Design 

Preprocess responses with your 2-level factorial design to: 

•     Calculate and store the standard deviations of repeat or replicate measurements 

•     Calculate and store the means of repeat measurements 

•     Define your precalculated standard deviations 

Dialog box items 
Standard deviation to use for analysis: 
Compute for repeat responses across rows : Choose to compute standard deviations from repeat measurements.   

Repeat responses across rows of: Enter the columns containing the repeat measurements. 
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Store standard deviations in: Enter a storage column for the standard deviations. 
Store number of repeats in: Enter a storage column for the number of repeat responses for each run. 
Store means in (optional): Enter a storage column for the means of repeat responses. 

Compute for replicates in each response column:  
Response: Enter a column containing the replicates, one for each response. You can calculate standard deviations for 
up to 10 responses at once. Enter each response column in a separate row. 
Store standard deviations in:Enter a storage column for the standard deviations for each response. 
Store number of replicates in: Enter a storage column for the number of replicates for each response. 
Adjust for covariates: Enter columns containing covariates for which to adjust in the calculation of the standard 
deviations for replicates. 

Standard deviations already in the worksheet: Choose to enter precalculated standard deviations already in the 
worksheet. 

Precalculated standard deviations in worksheet:  
Use Std Devs in: Enter a column containing the precalculated standard deviations for each response. 
Use Counts in: Enter a constant or column containing the number of repeats or replicates for each response. 

 

Data − Preprocess Responses 
To use Preprocess Responses, you must create or define a 2-level factorial design and enter response data that includes 
at least one of following:  

•    Repeat responses 

•    Replicate responses  

•    Precalculated standard deviations for your repeat or replicate responses  
Each row in your worksheet contains data corresponding to one run of your experiment. You enter repeat and replicate 
responses differently from each other following the examples below. You can have both repeat and replicate 
measurements for the same response. Response columns must be equal in length to the design variables in the 
worksheet. Enter data in any columns not occupied by the design data. 

Repeats 
Enter up to 200 repeats for one response in numeric columns, one column for each repeated measurement. You must 
have at least two repeats at each run for Minitab to calculate a standard deviation. Each run need not have the same 
number of repeats. In this case, you must type the missing value symbol "∗" in the empty cells (see the example below). 
Enter your data following this example: 

 Three Repeats of Response Y  

Design Obs 1 Obs 2 Obs 3 
A  B 
-  - 
+  + 
+  - 
-  + 

 
5 
8 
9 
4 

 
3 

10 
7 
2 

 
4 
9 
∗ 
3 

Replicates 
Enter your replicate observations for a response in one column, in the row corresponding to the appropriate run of the 
experiment. You can calculate standard deviations for up to 10 different responses at a time. You need not have the same 
number of replicates for each combination of factor settings, but you must have at least two at each run for Minitab to 
calculate a standard deviation. Enter your data following this example:  

Three replicates Design Obs for Response Y 

 

Replicate 1 
 
 
 

Replicate 2 
 
 
 

A  B 
-  - 
+  + 
+  - 
-  + 
-  - 
+  + 
+  - 
-  + 

 
5 
8 
9 
4 

10 
12 
8 
1 
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Replicate 3 -  - 
+  + 
+  - 
-  + 

3 
14 
15 
6 

Note If you create your design in Stat > DOE > Factorial > Create Factorial Design, you should specify the 
number of replicates in your experiment so the worksheet contains the correct number of rows in which to 
enter your response data. You can also change the number of replicates in your design in Stat > DOE > 
Modify Design. 

Precalculated standard deviations 
Enter your precalculated standard deviations, one column for each response, in the row corresponding to the appropriate 
run. You can store up to 10 columns of standard deviations at a time. You must enter a column or a constant indicating 
the number of repeats or replicates in your experiment.  
For replicates, enter the standard deviation in the row where each combination of factor settings first appears. Minitab 
enters missing values in the empty cells. Because the columns must be equal in length to the design variables in the 
worksheet, you may need to enter a missing value in the last row to make the column length correct.  

Covariates 
Enter covariates in columns equal in length to the design variables in the worksheet in the row corresponding to the 
appropriate run. Minitab can adjust replicate standard deviations for up to 50 covariates. 

Analyzing design with botched runs 
A botched run occurs when the actual value of a factor setting differs from the planned factor setting. When a botched run 
occurs, you need to change the factor levels for that run in the worksheet. If you have botched runs for replicates of the 
same combination of factor settings, Minitab does not recognize them as replicates. You must have two or more replicates 
at the same combination of factor settings to compute a standard deviation.  

Note Minitab omits missing data from all calculations.  

 

To preprocess responses for analyze variability 
1    Choose Stats > DOE > Preprocess Responses for Analyze Variability. 
2    Do one of the following: 

•     If your response measurements are repeats: 

1    Choose Compute for repeat responses across rows. 

2    In Repeat responses across rows of, enter the columns containing repeat response measurements. 

3    In Store standard deviations in, enter the storage column for the standard deviations.  

4    In Store number of repeats in, enter the storage column for the number of repeats. 

5    In Store means in (optional), enter the storage column for the means of the repeats. 
•     If your response measurements are replicates:  

1    Choose Compute for replicates in each response column. Under Replicates in individual response 
columns, complete the table as follows: 

2    Under Response, enter a column containing replicate responses in the first row. 

3    Under Store Std Dev in, enter the storage column for the standard deviations for the response in the first row. 

4    Under Store number of replicates in, enter the storage column for the number of replicates for the response 
in the first row. 

5    In Adjust for covariates, enter columns containing covariates for which you want to account in the standard 
deviations for replicates. Minitab uses the same set of covariates for each response. 

6    If you have more than one response with replicates, repeat steps 1−4 for each response in the next available 
row. 

•     If you have already stored standard deviations for your repeat or replicate measurements, you need to define 
them before Minitab can use them in Analyze Variability. 

1    Choose Standard deviations already in worksheet. Under Precalculated standard deviations in 
worksheet, complete the table as follows: 

2    Under Store Std Dev in, enter the column containing the standard deviations of your repeat or replicate 
response in the first row. 
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3    Under Number of repeats or replicates, enter the column or constant containing the number of repeats or 
replicates in the first row. 

4    If you have more than one column with stored standard deviations, repeat steps 2 and 3 for each stored 
column in the next available row. 

3    Click OK.  
 

Repeat Versus Replicates 
Repeat and replicate measurements are both multiple response measurements taken at the same combination of factor 
settings; but repeat measurements are taken during the same experimental run or consecutive runs, while replicate 
measurements are taken during identical but distinct experimental runs, which are often randomized.  
It is important to understand the differences between repeat and replicate response measurements. These differences 
influence the structure of the worksheet and the columns in which you enter the response data, which in turn affects how 
Minitab interprets the data. You enter repeats across rows of multiple columns, while you enter replicates down a single 
column. For more information on entering repeat and replicate response data into the worksheet, see Data − Preprocess 
Responses.  
Whether you use repeats or replicates depends on the sources of variability you want to explore and your resource 
constraints. Because replicates are from distinct experimental runs, usually spread over a longer period of time, they can 
include sources of variability that are not included in repeat measurements. For example, replicates can include variability 
from changing equipment settings between runs or variability from other environmental factors that may change over time. 
Replicate measurements can be more expensive and time-consuming to collect. You can create a design with both 
repeats and replicates, which enables you to examine multiple sources of variability. 

Example of repeats and replicates 
A manufacturing company has a production line with a number of settings that can be modified by operators. Quality 
engineers design two experiments, one with repeats and one with replicates, to evaluate the effect of the settings on 
quality.  

•    The first experiment uses repeats. The operators set the factors at predetermined levels, run production, and measure 
the quality of five products. They reset the equipment to new levels, run production, and measure the quality of five 
products. They continue until production is run once at every combination of factor settings and five quality 
measurements are taken at each run.  

•    The second experiment uses replicates. The operators set the factors at predetermined levels, run production, and 
take one quality measurement. They reset the equipment, run production, and take one quality measurement. In 
random order, the operators run each combination of factor settings five times, taking one measurement at each run.  

In each experiment, five measurements are taken at each combination of factor settings. In the first experiment, the five 
measurements are taken during the same run; in the second experiment, the five measurements are taken in different 
runs. The variability among measurements taken at the same factor settings tends to be greater for replicates than for 
repeats because the machines are reset before each run, adding more variability to the process. 
 

Analyzing Location and Dispersion Effects 
Minitab enables you to analyze both location and dispersion effects in a 2-level factorial design. To examine dispersion 
effects, you must have either repeat or replicate measurements of your response.  

•    Location model − examines the relationship between the mean of the response and the factors  

•    Dispersion model − examines the relationship between the standard deviation of the repeat or replicate responses and 
the factors  

Once you have determined your design and gathered data, you can analyze both location and dispersion models. Listed 
below are steps for analyzing location and dispersion models in Minitab, with options to consider at each step: 
1    Calculate or define standard deviations of repeat or replicate responses (Preprocess responses). Consider whether to: 

•    Adjust for covariates in calculating standard deviation for replicates 

•    Store means of repeats so you can analyze the location effects 
2    Analyze dispersion model (Analyze Variability). Consider whether to: 

•    Use least squares or maximum likelihood estimation methods, or both 
•    Store weights − using fitted or adjusted variance− to use when analyzing the location model 

3    Analyze location model (Analyze Factorial Design). Consider: 

•    Which response column to use: 
–    If you have repeats, use the column of stored means calculated in Preprocess Responses.  
–    If you have replicates, use the column containing the original response data. 
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Here is an example: A 23 factorial design with four repeats has eight experimental runs with four measurements 
per run. Minitab calculates the mean of the four repeats at each run, giving you a total of eight observations. The 
same design with four replicates has 32 experimental runs. In this case, each measurement is a distinct 
observation, giving you 32 observations. Experiments with replicate measurements have more degrees of 
freedom for the error term than experiments with repeats, which provide greater power to find differences among 
factor settings in the location model.  

•    Whether to use weights stored in the dispersion analysis 
 

Adjusting for Covariates in Replicates 
Because covariates are not controlled in experiments, they can vary across replicates measurements. Minitab enables 
you to adjust for up to 50 covariates in the calculation of the standard deviations of your replicate responses. In adjusting 
for the covariate, Minitab removes the variability in the measurements due to the covariate, so that the variability is not 
included in the standard deviation of the replicates. 
For example, you conduct an experiment with replicates during one day. The temperature, which you cannot control, 
varies greatly from morning to afternoon. You are concerned that the temperature differences may influence the 
responses. To account for this variability, at each run of the experiment, you record the temperature and adjust for it when 
calculating the standard deviations.  
You do not need to adjust for covariates with repeat measurements. For repeats, the standard deviation is calculated from 
the same run or consecutive runs. Covariates are measured once at each run of the experiment. As a result, there is only 
one covariate value for each group of repeats and, therefore, no covariate variability to account for in the standard 
deviation calculation. 
 

Storing Means for Repeats 
When you have repeat measurements of your response, Minitab calculates the mean of the repeats for each row and 
stores them in a column. You can then analyze these stored means in Analyze Factorial Design. If you have repeats with 
some replicated points and you can use the row means to store adjusted weights when you analyze variability of the 
repeats.  
 

Pre-calculated standard deviations 
If you have already calculated the standard deviations of your repeat or replicate measurements, you need to specify in 
which columns the standard deviations are located so Minitab makes them available in Analyze Variability and other DOE 
functions. 
 

Example of preprocessing responses for analyze variability 
You are investigating how processing conditions affect the yield of a chemical reaction. You believe that three processing 
conditions (factors)−reaction time, reaction temperature, and type of catalyst−affect the variability in yield. You decide to 
conduct a 2-level full factorial experiment with 8 replicates so you can analyze the variability in the responses at different 
factor settings. 
In order to analyze the variability in your responses, you must first preprocess the replicate responses to calculate and 
store the standard deviations and number of replicates.  
1    Open the worksheet YIELDSTDEV.MTW. (The design and response data have been saved for you.)  
2    Choose Stat > DOE > Factorial > Preprocess Responses for Analyze Variability. 
3    Under Standard deviation to use for analysis, choose Compute for replicates in each response column. 
3    Under Response, in the first row, enter Yield. 
4    Under Store Std Dev in, in the first row, type StdYield to name the column in which the standard deviations are 

stored. 
5    Under Store number of replicates in, in the first row, type NYield to name the column in which the number of 

replicates are stored. Click OK. 

Data window output 

Note Preprocessing responses does not produce output in the Session window. Instead, columns are stored in the 
worksheet. 
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StdOrder RunOrder CenterPt Blocks Time Temp Catalyst Yield StdYield NYield
3 1 1 1 20 200 A 45.1931 1.0240 8
24 2 1 1 50 200 B 59.6118 10.0303 8
35 3 1 1 20 200 A 44.8025 ∗ ∗
33 4 1 1 20 150 A 43.2365 0.2800 8
64 5 1 1 50 200 B 38.8697 ∗ ∗
47 6 1 1 20 200 B 47.2578 2.0003 8
29 7 1 1 20 150 B 42.3529 0.4915 8
30 8 1 1 50 150 B 40.7675 3.9723 8
58 9 1 1 50 150 A 48.4485 3.0456 8
42 10 1 1 50 150 A 49.7662 ∗ ∗
22 11 1 1 50 150 B 48.3112 ∗ ∗
55 12 1 1 20 200 B 46.2602 ∗ ∗
60 13 1 1 50 200 A 56.4470 8.0317 8
... ... ... ... ... ... ... ... ... ... 

Interpreting the results 
In the example, Minitab calculates and stores the standard deviations of the replicates of yield in the column StdYield. 
Minitab calculates and stores the number of replicates in the column NYield. Minitab stores one standard deviation and 
the number of replicates for each combination of factor settings in the row where that combination first appears. In this 
example, Minitab stored 8 standard deviations and 8 numbers of replicates, filling the remaining rows with the missing 
data symbol (∗). 
To analyze this data using Analyze Variability, see Example of analyzing variability. Keep this worksheet active in order to 
use the stored standard deviations and number of replicates in the analyzing variability example. 

Note If this data contained repeats instead of replicates, the worksheet will look different than the worksheet 
above, but the results produced by analyzing the variability in the data will be the same.  

 

Analyze Factorial Design 
Analyze Factorial Design 
Stat > DOE > Factorial > Analyze Factorial Design 
To use Analyze Factorial Design to fit a model, you must  

•    create and store the design using Create Factorial Design, or  

•    create a design from data that you already have in the worksheet with Define Custom Factorial Design 
You can fit models with up to 127 terms.  
When you have center points in your data set, Minitab automatically does a test for curvature. When you have pseudo-
center points, Minitab calculates pure error but does not do a test for curvature. For a description of pseudo-center points, 
see Adding center points. 

You can also generate effects plots − normal and Pareto − to help you determine which factors are important and 
diagnostic plots to help assess model adequacy. For the diagnostic plots, you have the choice of using regular residuals, 
standardized residuals, or deleted residuals − see Choosing a residual type.  

Dialog box items 
Responses: Select the column(s) containing the response variable(s). If there is more than one response variable, 
Minitab fits separate models for each response. You can have up to 25 responses. 
 

Collecting and Entering Data 
After you create your design, you need to perform the experiment and collect the response (measurement) data. To print 
a data collection form, follow the instructions below. After you collect the response data, enter the data in any worksheet 
column not used for the design. For a discussion of the worksheet structure, see Storing the design. 

Printing a data collection form 
You can generate a data collection form in two ways. You can simply print the Data window contents, or you can use a 
macro. A macro can generate a "nicer" data collection form − see %FORM in Session Command Help. Although printing 
the Data window will not produce the prettiest form, it is the easiest method. Just follow these steps: 
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1    When you create your experimental design, Minitab stores the run order, block assignment, and factor settings in the 
worksheet. These columns constitute the basis of your data collection form. If you did not name factors (or 
components) or specify factor levels (or lower bounds) when you created the design, and you want names or levels to 
appear on the form, use Modify Design.  

2    In the worksheet, name the columns in which you will enter the measurement data obtained when you perform your 
experiment.  

3    Choose File > Print Worksheet. Make sure Print Grid Lines is checked, then click OK. 

More You can also copy the worksheet cells to the Clipboard by choosing Edit > Copy Cells. Then paste the 
Clipboard contents into a word-processing application, such as Microsoft WordPad, or Microsoft Word, where 
you can create your own form. 

 

Data for Analyze Factorial Design 
Enter up to 25 numeric response data columns that are equal in length to the design variables in the worksheet. Each row 
will contain data corresponding to one run of your experiment. You may enter the response data in any column(s) not 
occupied by the design data. The number of columns reserved for the design data is dependent on the number of factors 
in your design. 
If there is more than one response variable, Minitab fits separate models for each response.  
Minitab omits missing data from all calculations. 

Note When all the response variables do not have the same missing value pattern, Minitab displays a message. 
Since you would get different results, you may want to repeat the analysis separately for each response 
variable. 

Analyzing designs with botched runs 
A botched run occurs when the actual value of a factor setting differs from the planned factor setting. When this 
happens, you need to change the factor levels for that run in the worksheet. You can only have botched runs with two-
level designs; general factorial designs cannot have botched runs. Minitab can automatically detect botched runs and 
analyze the data accordingly. 

Note When you have a botched run, you need to determine the extent to which the actual factor settings deviate 
from the planned settings. When the executed settings fall within the normal range of their set points, you may 
not wish to alter the factor levels in the worksheet. The variability in the actual factor levels will simply 
contribute to the overall experimental error. However, if the executed levels differ notably from the planned 
levels, you should change them in the worksheet.  

 

To analyze a factorial design 
1    Choose Stat > DOE > Factorial > Analyze Factorial Design.  
2    In Responses, enter up to 25 columns that contain the response data. 
3    If you like, use any of the dialog box options, then click OK.  
 

Analyze Factorial Design − Terms (2-level factorial design)  
Stat > DOE > Factorial > Analyze Factorial Design > Terms 
Allows you to specify which terms to include in the model.  

Dialog box items 
Include terms in the model up through order: Use this drop-down list to quickly set up a model with a specified order. 
Choose the maximum order for terms to include in the model. For example, if you choose 2, 

•    all main effects and estimable 2-way interactions display in Selected Terms, and  

•    Minitab removes all estimable three-way and higher-order interactions from Selected Terms and displays them in 
Available Terms. 

Available Terms: Shows all terms that are estimable but not included in the fitted model.  
Selected Terms: Minitab includes terms shown in Selected Terms when it fits the model. 
Include blocks in the model: Check to include blocks in the model. Minitab only enables this checkbox if you specified 
more than one block in the Create or Define Factorial Design dialog box. 
Include center points in the model: Check to include center points as a term in the model. Minitab only enables this 
checkbox if you specified more than one distinct value in the CenterPt column of the worksheet. 
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Analyze Factorial Design − Terms (general full factorial design) 
Stat > DOE > Factorial > Analyze Factorial Design > Terms 
Specifies which terms to include in the model. 

Dialog box items 
Include terms in the model up through order: Use this drop-down list to quickly set up a model with a specified order. 
Choose the maximum order for terms to include in the model. For example, if you choose 2, 

•    all main effects and estimable two-way interactions display in Selected Terms, and  

•    Minitab removes all estimable three-way and higher-order interactions from Selected Terms and displays them in 
Available Terms. 

Available Terms: Shows all terms that are estimable but not included in the fitted model.  
Selected Terms: Minitab includes terms shown in Selected Terms when it fits the model. 
Include blocks in the model: Check to include blocks in the model. Minitab only enables this checkbox if you specified 
more than one block in the Create or Define Factorial Design dialog box. 
 

Analyze Factorial Design − Terms (Plackett-Burman design)  
Stat > DOE > Factorial > Analyze Factorial Design > Terms 
Allows you to specify which terms to include in the model.  

Dialog box items 
Include terms in the model up through order: This option is not available. Plackett-Burman designs only include main 
effects. 
Available Terms: Shows all terms that are estimable but not included in the fitted model.  
Selected Terms: Minitab includes terms shown in Selected Terms when it fits the model. 
Include blocks in the model: This option is not available. Plackett-Burman designs are not blocked. 
Include center points in the model: Check to include center points as a term in the model. Minitab only enables this 
checkbox if you specified more than one distinct value in the CenterPt column of the worksheet. 
 

Analyze Factorial Design − Covariates  
Stat > DOE > Factorial > Analyze Factorial Design > Covariates 
You can include up to 50 covariates in your model. Covariates are fit first, then the blocks, then all other terms. 

Dialog box items 
Covariates: Select the column(s) containing covariates to include in the model. The covariates are fit first, then the 
blocks, then all other terms. You may have up to 50 covariates. 
 

Analyze Factorial Design − Graphs 
Stat > DOE > Factorial > Analyze Factorial Design > Graphs 
You can display effects plots and five different residual plots for regular, standardized, or deleted residuals (see Choosing 
a residual type). You do not have to store the residuals and fits in order to produce these plots.  

Dialog box items 
Effects Plots (Effects plots are not available with General Full Factorial designs) 

Normal: Check to display a normal probability plot of the effects. 
Pareto: Check to display a Pareto chart of the effects. 

Alpha: Enter a number between 0 and 1 for the α-level you want to use for determining the significance of the effects. 
The default α-level is 0.05. You can set your own default α-level by choosing Tools > Options > Individual Graphs > 
Effects Plots. 

Residuals for Plots You can specify the type of residual to display on the residual plots. 
Regular: Choose to plot the regular or raw residuals. 
Standardized: Choose to plot the standardized residuals. 
Deleted: Choose to plot the Studentized deleted residuals. 



Factorial Designs 

 Copyright © 2003–2005 Minitab Inc.  All rights reserved.  43

Residual Plots 
Individual plots: Choose to display one or more plots. 

Histogram: Check to display a histogram of the residuals. 
Normal plot: Check to display a normal probability plot of the residuals. 
Residuals versus fits: Check to plot the residuals versus the fitted values. 
Residuals versus order: Check to plot the residuals versus the order of the data in the run order column. The row 
number for each data point is shown on the x-axis − for example, 1 2 3 4... n. 

Four in one: Choose to display a histogram of residuals, a normal plot of residuals, a plot of residuals versus fits, and a 
plot of residuals versus order in one graph window.  
Residuals versus variables: Check to display residuals versus selected variables, then enter one or more columns. 
Minitab displays a separate graph for each column you enter in the text box. 

 

Effects plots 
The primary goal of screening designs is to identify the "vital" few factors or key variables that influence the response. 
Minitab provides two graphs that help you identify these influential factors: a normal plot and a Pareto chart. These graphs 
allow you to compare the relative magnitude of the effects and evaluate their statistical significance.  
 

Normal Probability Plot of the Effects 
In the normal probability plot of the effects, points that do not fall near the line usually signal important effects. Important 
effects are larger and further from the fitted line than unimportant effects. Unimportant effects tend to be smaller and 
centered around zero.  
If there is no error term, Minitab uses Lenth's method [2] to identify important effects. If there is an error term, Minitab uses 
the corresponding p-values shown in the Session window to identify important effects. The normal probability plot uses α 
= 0.05, by default. You can change the α-level in the Graphs subdialog box.  

 
This plot shows that terms B, C, and BC are significant. 

Note If the standard errors of the coefficients are zero, Minitab does not display the Normal effects plot. 

 

Pareto Chart of the Effects 
Use a Pareto chart of the effects to determine the magnitude and the importance of an effect. The chart displays the 
absolute value of the effects and draws a reference line on the chart. Any effect that extends past this reference line is 
potentially important.  
The method Minitab uses depends on whether an error term exists: 

•    If no error term exists, Minitab uses Lenth's method [2] to draw the line and displays the unstandardized effects.  

•    If an error term exists, Minitab uses the corresponding p-value shown in the Session window to identify important 
effects and displays the standardized effects. The reference line corresponds to α = 0.05, by default. You can change 
the α-level in the Graphs subdialog box.   
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This plot shows that terms B, C, and BC are significant. 

Note If the standard errors of the coefficients are zero, Minitab does not display the reference line on the Pareto plot.

 

Analyze Factorial Design − Results (2-level factorial design) 
Stat > DOE > Factorial > Analyze Factorial Design > Results 
You can control the display of Session window output. 

Dialog box items 
Display of Results 

Do not display: Choose to suppress display of the coefficients, analysis of variance table, and a table of unusual 
observations. 
Coefficients and ANOVA table: Choose to display the coefficients and analysis of variance table. 
Unusual observations in addition to the above: Choose to display the coefficients, analysis of variance table, and a 
table of unusual observations (default). 
Full table of fits and residuals in addition to the above: Choose to display the coefficients, analysis of variance 
table, a table of unusual observations, and a table of fits and residuals. 

Display of Alias table Allows you to specify how to display the alias table. 
Do not display: Choose to suppress display of the alias table. 
Default interactions: Choose to display the default interactions. All interactions are displayed for 2 to 6 factors, up to 
three-way interactions for 7 to 10 factors, and 2-way interactions for more than 10 factors. If the design is not 
orthogonal and there is partial confounding, Minitab will not print alias information. 
Interactions up through order: Choose to specify the highest order interaction to display in the alias table, then 
choose the order from the drop-down list. Be careful! A specification larger than the default could take a very long time 
to compute. 

Display of Least Squares Means You can display adjusted (also called least squares) means. 
Available Terms: Shows all terms that you can display means for. Use the arrow buttons to move terms from one list 
to the other. Select a term in one of the lists, then press an arrow button. The double arrows move all the terms in one 
list to the other. You can also move a term by double-clicking it. 
Selected Terms: Minitab displays means terms shown in Selected Terms. Use the arrow buttons to move terms from 
one list to the other. Select a term in one of the lists, then press an arrow button. The double arrows move all the terms 
in one list to the other. You can also move a term by double-clicking it.  

 

Analyze Factorial Design − Results (general full factorial design) 
Stat > DOE > Factorial > Analyze Factorial Design > Results 
You can control the display of Session window output. 

Dialog box items 
Display of Results  

Do not display: Choose to suppress display of the covariate coefficients, analysis of variance table, and a table of the 
unusual observations. 
ANOVA Table: Choose to display only the analysis of variance table. 
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ANOVA Table, covariate coefficients, unusual observations: Choose to display the covariate coefficients, analysis 
of variance table, and a table of the unusual observations (default). 
ANOVA Table, all coefficients, unusual observations: Choose to display the analysis of variance table, all of the 
coefficients, and a table of the unusual observations. 

Display of Least Squares Means You can display adjusted (also called least squares) means. 
Available Terms: Shows all terms that you can display means for. Use the arrow buttons to move terms from one list 
to the other. Select a term in one of the lists, then press an arrow button. The double arrows move all the terms in one 
list to the other. You can also move a term by double-clicking it. 
Selected Terms: Minitab displays means terms shown in Selected Terms. Use the arrow buttons to move terms from 
one list to the other. Select a term in one of the lists, then press an arrow button. The double arrows move all the terms 
in one list to the other. You can also move a term by double-clicking it. 

 

Analyze Factorial Design − Results (Plackett-Burman design) 
Stat > DOE > Factorial > Analyze Factorial Design > Results 
You can control the display of Session window output. 

Dialog box items 
Display of Least Squares Means You can display adjusted (also called least squares) means. 

Available Terms: Shows all terms that you can display means for. Use the arrow buttons to move terms from one list 
to the other. Select a term in one of the lists, then press an arrow button. The double arrows move all the terms in one 
list to the other. You can also move a term by double-clicking it. 
Selected Terms: Minitab displays means terms shown in Selected Terms. Use the arrow buttons to move terms from 
one list to the other. Select a term in one of the lists, then press an arrow button. The double arrows move all the terms 
in one list to the other. You can also move a term by double-clicking it. 

 

Analyze Factorial Design − Storage 
Stat > DOE > Factorial > Analyze Factorial Design > Storage 
You can store the residuals, fitted values, and many other diagnostics for further analysis (see Checking your model). 
Minitab stores the checked values in the next available columns and names the columns 

Dialog box items 
Fits and Residuals  

Fits: Check to store the fitted values. One column is stored for each response variable. 
Residuals: Check to store the residuals. One column is stored for each response variable. 
Standardized residuals: Check to store the standardized residuals.  
Deleted residuals: Check to store Studentized residuals. 

Model Information  
Effects: Check to store the effects. Minitab stores one column for each response. These are the effects that are printed 
on the output.  

Note Effects are not printed or stored for the constant, covariates, or blocks. (This dialog box item is not available for 
General Full Factorial.) 

Coefficients: Check to store the coefficients. One column is stored for each response variable. These are the same 
coefficients as are printed in the output. If some terms are removed because the data cannot support them, the 
removed terms do not appear on the output. 
Design matrix: Check to store the design matrix corresponding to your model. If the design was blocked into k blocks, 
there are (k−1) columns for block dummy variables. Fit Model uses the same method of coding blocks as General 
Linear Model. The block dummy variables are followed by one column for each component. When the model has 2-way 
interactions, the design matrix contains a column for each interaction. The column for a 2-way interaction is the product 
of the corresponding two components. When the model has 3-way interactions, the design matrix contains a column for 
each interaction. The column for a 3-way interaction is the product of the corresponding three components. When the 
model has additional terms for a full cubic, then the design matrix contains one column for each additional term. For 
example, the column for a term such as X1∗X3∗(X1−X3), with X1 in C1 and X3 in C3 is calculated using the equation 
C1∗C3∗(C1−C3). 
When terms are removed because the data cannot support them, the design matrix does not contain the removed 
terms. The columns of the stored matrix match the coefficients that are printed and/or stored. 
Factorial: Check to store the information about the equations fit, using one column for each response. 
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Other  
Hi [leverage]: Check to store leverages.  
Cook's distance: Check to store Cook's distance.  
DFITS: Check to store DFITS. 

 

Analyze Factorial Design − Prediction 
Stat > DOE > Factorial > Analyze Factorial Design > Prediction 
You can calculate and store predicted response values for new design points.  

Dialog box items 
New Design Points (columns and/or constants)   

Factors: Type the text or numeric factor levels, or enter the columns or constants in which they are stored.  The 
number of factors must equal the number of factors in the design. 
Covariates: Type the numeric covariate values, or enter the columns or constants in which they are stored. The 
number of covariates must equal the number of covariates in the design. 
Blocks: Type the text or numeric blocking levels, or enter the column or constant in which they are stored. The values 
must equal one of the blocking levels in the design. You do not have to enter a blocking level.  

Confidence level: Type the desired confidence level (for example, type 90 for 90%). The default is 95%. 
Storage 

Fits: Check to store the fitted values for new design points. 
SEs of fits: Check to store the estimated standard errors of the fits. 
Confidence limits: Check to store the lower and upper limits of the confidence interval. 
Prediction limits: Check to store the lower and upper limits of the prediction interval. 

 

To predict responses in factorial designs 
1    Choose Stat > DOE > Factorial > Analyze Factorial Design > Prediction. 
2    In Factors, do any combination of the following: 

•    Type text or numeric factor levels.  
•    Enter stored constants containing text or numeric factor levels. 
•    Enter columns of equal length containing text or numeric factor levels. 
Factors must match your original design in these ways: 
−    The number of factors and the order in which they are entered 
−    The units and data type (text or numeric) of factor levels 

3    In Covariates, do any combination of the following: 
•    Type numeric covariate values.  
•    Enter stored constants containing numeric covariate values. 
•    Enter columns containing numeric covariate values, equal in length to factor columns. 
The number of covariates must equal the number of covariates in your design and be entered in the same order.  

4    In Blocks, do one of the following: 
•    Type a text or numeric blocking level.  
•    Enter a stored constant containing a text or numeric blocking level. 
•    Enter a column containing a text or numeric blocking level, equal in length to factor columns.  
The blocking level must be one of the blocking levels in your design.  

5    In Confidence level, type a value or use the default, which is 95%. 
6    Under Storage, check any of the prediction results to store them in your worksheet. Click OK. 
 

Analyze Factorial Design − Weights 
Stat > DOE > Factorial > Analyze Factorial Design > Weights 
You can specify weights for your model to perform weighted regression, a method to handle data with observations that 
have different variances. Store weights based on the variability in your response across factor settings in Analyze 
Variability.   
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Dialog box items 
Do a weighted fit, using weights in: Enter a column containing weights for your response. The column must equal the 
length of the design variables.  
 

To specify weights   
1    Choose DOE > Factorial > Analyze Factorial Design > Weights. 
2    In Do a weighted fit, using weights in, enter one column containing weights for your response. Use one of the 

following: 
•     The weight column you stored for your response in Analyze Variability - Storage 
•     Another weight column appropriate for your response   
The weight column must equal the length of the response column. If you have multiple response variables with 
different weight columns, you must run the analyses for each response separately. 

 

Example of analyzing a full factorial design with replicates and blocks 
You are an engineer investigating how processing conditions affect the yield of a chemical reaction. You believe that three 
processing conditions (factors) − reaction time, reaction temperature, and type of catalyst − affect the yield. You have 
enough resources for 16 runs, but you can only perform 8 in a day. Therefore, you create a full factorial design, with two 
replicates, and two blocks. 
1    Open the worksheet YIELD.MTW. (The design and response data have been saved for you.) 
2    Choose Stat > DOE > Factorial > Analyze Factorial Design. 
3    In Responses, enter Yield. 
4    Click Graphs. Under Effects Plots, check Normal and Pareto. Click OK in each dialog box. 

Session window output 

Factorial Fit: Yield versus Block, Time, Temp, Catalyst 
 
 
Estimated Effects and Coefficients for Yield (coded units) 
 
Term                 Effect     Coef  SE Coef       T      P 
Constant                     45.5592  0.09546  477.25  0.000 
Block                        -0.0484  0.09546   -0.51  0.628 
Time                 2.9594   1.4797  0.09546   15.50  0.000 
Temp                 2.7632   1.3816  0.09546   14.47  0.000 
Catalyst             0.1618   0.0809  0.09546    0.85  0.425 
Time*Temp            0.8624   0.4312  0.09546    4.52  0.003 
Time*Catalyst        0.0744   0.0372  0.09546    0.39  0.708 
Temp*Catalyst       -0.0867  -0.0434  0.09546   -0.45  0.663 
Time*Temp*Catalyst   0.0230   0.0115  0.09546    0.12  0.907 
 
 
S = 0.381847   R-Sq = 98.54%   R-Sq(adj) = 96.87% 
 
 
Analysis of Variance for Yield (coded units) 
 
Source              DF   Seq SS   Adj SS   Adj MS       F      P
Blocks               1   0.0374   0.0374   0.0374    0.26  0.628
Main Effects         3  65.6780  65.6780  21.8927  150.15  0.000
2-Way Interactions   3   3.0273   3.0273   1.0091    6.92  0.017
3-Way Interactions   1   0.0021   0.0021   0.0021    0.01  0.907
Residual Error       7   1.0206   1.0206   0.1458 
Total               15  69.7656 
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Estimated Coefficients for Yield using data in uncoded units 
 
Term                       Coef 
Constant                39.4786 
Block                -0.0483750 
Time                  -0.102585 
Temp                  0.0150170 
Catalyst                0.48563 
Time*Temp            0.00114990 
Time*Catalyst        -0.0028917 
Temp*Catalyst       -0.00280900 
Time*Temp*Catalyst  0.000030700 
 
 
Alias Structure 
I 
 
Blocks = 
Time 
Temp 
Catalyst 
Time*Temp 
Time*Catalyst 
Temp*Catalyst 
Time*Temp*Catalyst 

Graph window output 
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Interpreting the results 
The analysis of variance table gives a summary of the main effects and interactions. Minitab displays both the sequential 
sums of squares (Seq SS) and adjusted sums of squares (Adj SS). If the model is orthogonal and does not contain 
covariates, these will be the same. Look at the p-values to determine whether or not you have any significant effects. The 
effects are summarized below: 

Effect P-Value Significant* 
Blocks 0.628 no 
Main 0.000 yes 
Two-way interactions 0.017 yes 
Three-way interactions 0.907 no 

* significant at alpha = 0.05 
The nonsignificant block effect indicates that the results are not affected by the fact that you had to collect your data on 
two different days. 
After identifying the significant effects (main and two-way interactions) in the analysis of variance table, look at the 
estimated effects and coefficients table. This table shows the p-values associated with each individual model term. The p-
values indicate that just one two-way interaction Time * Temp (p = 0.003), and two main effects Time (p = 0.000) and 
Temp (p = 0.000) are significant. However, because both of these main effects are involved in an interaction, you need to 
understand the nature of the interaction before you can consider these main effects. See Example of factorial plots for an 
experiment with three factors for a discussion of this interaction. 
The residual error that is shown in the ANOVA table can be made up of three parts: (1) curvature, if there are center 
points in the data, (2) lack of fit, if a reduced model was fit, and (3) pure error, if there are any replicates. If the residual 
error is just due to lack of fit, Minitab does not print this breakdown. In all other cases, it does. 
The normal and Pareto plots of the effects allow you to visually identify the important effects and compare the relative 
magnitude of the various effects. 
You should also plot the residuals versus the run order to check for any time trends or other nonrandom patterns. 
Residual plots are found in the Graphs subdialog box. See Residual plots choices.  
 

Analyze Variability 
Preprocess Responses/Analyze Variability Overview 
Experiments that include repeat or replicate measurements of a response allow you to analyze variability in your response 
data, which enables you to identify factor settings that produce less variable results. Minitab calculates and stores the 
standard deviations (σ) of your repeat or replicate responses and analyzes them to detect differences, or dispersion 
effects, across factor settings.  
For example, you conduct a spray-drying experiment with replicates and find that two settings of drying temperature and 
atomizer speed produce the desired particle size. By analyzing the variability in particle size at different factor settings, 
you find that one setting produces particles with more variability than the other setting. You choose to run your process at 
the setting that produces the less variable results.  
Once you have created your design, analyzing variability is a two-step process: 

1    Preprocess Responses − First, you calculate and store the standard deviations and counts of your repeat or replicate 
responses or specify standard deviations that you have already stored in the worksheet. You can analyze and graph 
stored standard deviations as response variables using other DOE tools, such as Analyze Variability, Analyze 
Factorial Design, Contour Plots, and Response Optimization.  

2    Analyze Variability − Second, you fit a linear model to the log of the standard deviations you stored in the first step to 
identify significant dispersion effects. Once you fit a model, you can use other tools, such as contour and surface 
plots, and response optimization to better understand your results. You can also store weights calculated from your 
model to perform weighted regression when analyzing the location (mean) effects of your original responses in 
Analyze Factorial Design. 

 

Analyze Variability 
Stat > DOE > Factorial > Analyze Variability 
You can analyze the variability in your 2-level factorial design by examining the standard deviations of repeat or replicate 
responses stored using Pre-process Responses.  

Dialog box items 
Response (standard deviations): Enter a column containing the stored standard deviations of your repeat or replicate 
response.  
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Number of repeats or replicates: Minitab automatically enters the column of counts corresponding to the column of 
standard deviation. 
Estimation method  
Least squares regression: Choose to analyze the standard deviations using least squares regression. 
Maximum likelihood: Choose to analyze the standard deviations using maximum likelihood estimation. 
 

Data − Analyze Variability 
Before you use Analyze Variability, you must:  
1    Create or define a 2-level factorial design that includes repeat or replicate measurements of your response. 

2    Enter your response data into the worksheet following the instructions in Data − Pre-process Responses.  
3    Store the standard deviations and number of repeats or replicates using Pre-process Responses. 
You can fit a model with one response variable at a time. Minitab automatically omits missing data from the calculations. 
 

To analyze variability in a 2-level factorial design 
1    Choose Stat > DOE > Factorial > Analyze Variability. 
2    In Response (standard deviations), enter the column containing the stored standard deviations of your response. 
3    In Number of repeats or replicates, Minitab automatically enters the column containing the number of repeats or 

replicates in your design corresponding to the response. 
4    If you like, use any dialog box options, then click OK. 
 

Repeat Versus Replicates 
Repeat and replicate measurements are both multiple response measurements taken at the same combination of factor 
settings; but repeat measurements are taken during the same experimental run or consecutive runs, while replicate 
measurements are taken during identical but distinct experimental runs, which are often randomized.  
It is important to understand the differences between repeat and replicate response measurements. These differences 
influence the structure of the worksheet and the columns in which you enter the response data, which in turn affects how 
Minitab interprets the data. You enter repeats across rows of multiple columns, while you enter replicates down a single 
column. For more information on entering repeat and replicate response data into the worksheet, see Data − Preprocess 
Responses.  
Whether you use repeats or replicates depends on the sources of variability you want to explore and your resource 
constraints. Because replicates are from distinct experimental runs, usually spread over a longer period of time, they can 
include sources of variability that are not included in repeat measurements. For example, replicates can include variability 
from changing equipment settings between runs or variability from other environmental factors that may change over time. 
Replicate measurements can be more expensive and time-consuming to collect. You can create a design with both 
repeats and replicates, which enables you to examine multiple sources of variability. 

Example of repeats and replicates 
A manufacturing company has a production line with a number of settings that can be modified by operators. Quality 
engineers design two experiments, one with repeats and one with replicates, to evaluate the effect of the settings on 
quality.  

•    The first experiment uses repeats. The operators set the factors at predetermined levels, run production, and measure 
the quality of five products. They reset the equipment to new levels, run production, and measure the quality of five 
products. They continue until production is run once at every combination of factor settings and five quality 
measurements are taken at each run.  

•    The second experiment uses replicates. The operators set the factors at predetermined levels, run production, and 
take one quality measurement. They reset the equipment, run production, and take one quality measurement. In 
random order, the operators run each combination of factor settings five times, taking one measurement at each run.  

In each experiment, five measurements are taken at each combination of factor settings. In the first experiment, the five 
measurements are taken during the same run; in the second experiment, the five measurements are taken in different 
runs. The variability among measurements taken at the same factor settings tends to be greater for replicates than for 
repeats because the machines are reset before each run, adding more variability to the process. 
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Using Least Squares and Maximum Likelihood Estimation 
Minitab provides two methods to analyze the natural log of standard deviation (σ): Least squares estimation (LS) and 
maximum likelihood estimation (MLE). The methods produce equivalent estimates in the saturated model, when a 
separate parameter is estimated for each data point.  
In many cases, the differences between the LS and MLE results are minor, and the methods can be used 
interchangeably. You may want to run both methods and see whether the results confirm one another. If the results differ, 
you may want to determine why. For example, MLE assumes that the original data are from a normal distribution. If your 
data may not be normally distributed, LS may provide better estimates. Also, LS cannot calculate results for data that 
contain a standard deviation equal to zero. MLE may provide estimates for these data, depending on the model.     
One guideline for using LS and MLE together, for different parts of the analysis, is discussed in [4]. This approach states 
that LS provides better p-values for the effects, while MLE provides more precise coefficients. Based on this approach, 
follow these steps to conduct your analysis: 
1    Use least squares regression to select the model, determining which terms are not significant from the p-values of the 

coefficients 
2    Refit the model, excluding nonsignificant terms to identify the appropriate reduced model 
3    Use MLE to estimate the final coefficients of the model and to determine the fits and the residuals 
For more information on these methods or this approach, see [4].  
 

Analyze Variability − Terms 
Stat > DOE > Factorial > Analyze Variability > Terms 
You can specify which terms to include in your model. 

Dialog box items 
Include terms in the model up through order: Use this drop-down list to quickly set up a model with a specified order. 
Choose the maximum order for terms to include in the model. For example, if you choose 2, 

•     all main effects and two-way interactions display in Selected Terms, and 

•     Minitab removes all three-way and higher-order interactions from Selected Terms and displays them in Available 
Terms. 

Available Terms: Shows all possible terms that could be included in the fitted model, but have not been selected yet. 
Selected Terms: Minitab includes terms shown in Selected Terms when it fits the model.  
Include blocks in the model: Check to include blocks in the model. Minitab only enables this checkbox if you have two 
or more values in the block column. 
Include center points in the model: Check to include center points as a term in the model. Minitab only enables this 
checkbox if you have at least one center point, indicated by a zero, in the CenterPt column. 
 

Analyze Variability − Covariates 
Stat > DOE > Factorial > Analyze Variability > Covariates 
You can fit up to 50 covariates in your model.  

Dialog box items 
Covariates: Select the columns containing covariates to include in the model. 

Caution For replicates, there can be problems estimating covariate effects in the dispersion model. If you have different 
covariate values for each replicate, the analysis may be inaccurate because Minitab only uses the value of the 
covariate that is in the same row as the standard deviation for each factor level combination. 

For example, your data include four replicates. Minitab stores the standard deviation of the replicate 
measurements in the first row where each factor level combination appears, and enters missing data in the 
remaining three cells. When analyzing the model, Minitab uses the covariate value that is in the same row as 
the one in which the standard deviation is stored and ignores the covariate values of the other replicates. 

 

Analyze Variability − Graphs 
Stat > DOE > Factorial > Analyze Variability > Graphs 
You can display effects plots and residual plots for ratio, log, or standardized log residuals. You do not have to store the 
residuals and fits to produce these plots.  
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Dialog box items 
Effects Plots  

Normal: Check to display a normal probability plot of the effects. 
Pareto: Check to display a Pareto chart of the effects. 

Alpha: Enter a number between 0 and 1 for the α-level you want to use for determining the significance of the effects. 
The default value is 0.05. You can set your own default α-level by choosing Tools > Options > Individual Graphs > 
Effects Plots. 

Residuals for Plots 
Ratio: Choose to plot the ratio residuals. 
Log: Choose to plot the log residuals. 
Standardized log: Choose to plot the standardized log residuals. 

Residual Plots 
Individual plots: Choose to display one or more plots. 

Histogram: Check to display a histogram of the residuals. 
Residuals versus fits: Check to plot the residuals versus the fitted values. 
Residuals versus order: Check to plot the residuals versus the order of the data in the run order column. The row 
number for each data point is shown on the x-axis − for example, 1 2 3 4... n. 

Three in one: Choose to display a layout of a histogram of the residuals, a plot of residuals versus fits, and a plot of 
residuals versus order. 
Residuals versus variables: Check to display residuals versus selected variables, then enter one or more columns. 
Minitab displays a separate graph for each column. 

 

Analyze Variability − Results 
Stat > DOE > Factorial > Analyze Variability > Results 
You can control the output displayed in the Session window. 

Dialog box items 
Display of Results 

Do not display: Choose to suppress display of the coefficients, analysis of variance table, and a table of unusual 
observations. 
Coefficients and ANOVA table: Choose to display the coefficients and analysis of variance table (default). 
Unusual observations in addition to the above: Choose to display the coefficients, analysis of variance table, and a 
table of unusual observations. 
Full table of fits and residuals in addition to the above: Choose to display the coefficients, analysis of variance 
table, a table of unusual observations, and a table of fits and residuals. 

Display of Alias table Allows you to specify how to display the alias table. 
Do not display: Choose to suppress display of the alias table. 
Default interactions: Choose to display the default interactions. All interactions are displayed for 2 to 6 factors, up to 
three-way interactions for 7 to 10 factors, and two-way interactions for more than 10 factors. If the design is not 
orthogonal and there is partial confounding, Minitab will not print alias information. 
Interactions up through order: Choose to specify the highest order interaction to display in the alias table, then 
choose the order from the drop-down list. Be careful! A specification larger than the default could take a very long time 
to compute. 

Display of Fitted Means You can display adjusted means. The means are in the same scale as the standard deviations, 
not the log of the standard deviations.  

Available Terms: Shows all terms that you can display means for. Use the arrow buttons to move terms from one list 
to the other. Select a term in one of the lists, then press an arrow button. The double arrows move all the terms in one 
list to the other. You can also move a term by double-clicking it. 
Selected Terms: Minitab displays means terms shown in Selected Terms. Use the arrow buttons to move terms from 
one list to the other. Select a term in one of the lists, then press an arrow button. The double arrows move all the terms 
in one list to the other. You can also move a term by double-clicking it.  
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Analyze Variability − Storage 
Stat > DOE > Factorial > Analyze Variability > Storage 
You can store the fits and residuals, model information, and weights.  Minitab stores the checked values in the next 
available columns and names the columns. 

Dialog box items 
Fits and Residuals  

Fits: Check to store the fitted values.  
Ratio Residuals: Check to store the ratio residuals. 
Log residuals: Check to store the log residuals. 
Standardized log residuals: Check to store the standardized log residuals. 

Model Information  
Effects: Check to store the effects, which are also displayed in the output. Effects are not displayed or stored for the 
constant, covariates, or blocks. 
Coefficients: Check to store the coefficients, which are also displayed in the output. If Minitab removes some terms 
because the data cannot support them, the removed terms do not appear in the output. 
Design matrix: Check to store the design matrix corresponding to your model. Analyze Variability uses the same 
method of coding blocks as General Linear Model.  
When terms are removed because the data cannot support them, the design matrix does not contain the removed 
terms. The columns of the stored matrix match the coefficients that Minitab displays and stores. 
Factorial: Check to store the information about the fitted equation. 
Ratio effects: Check to store the ratio effects. 

Other  
Hi (leverage): Check to store leverages.  

Weights (1/Fit^2): Check to store weights based on the fitted variances for use in Analyze Factorial Design. The weights 
are the reciprocal of the fitted variances.  
Adjusted weights: Check to store adjusted weights only if you have repeat measurements with some replicated points. 
Weights are the reciprocal of the adjusted variance. 
For means in: Enter the column containing the means of your repeats associated with the standard deviations. You can 
calculate and store the means in Pre-process responses.  
and covariates (optional): Check to adjust for covariates and enter one or more columns containing the covariates.  
 

Storing Weights 
You can store weights for your response using fitted or adjusted variances. Whether you use fitted or adjusted variances 
depends on whether you have repeat or replicate measurements. Once you have stored the weights, you can specify 
them in Analyze Factorial Design > Weights to perform weighted regression when analyzing the location model.   
Weighted regression is a method for handling data with observations that have different variances. If the variances are not 
constant, observations with: 

•     Large variances should be given relatively small weight 

•     Small variances should be given relatively large weight 
If the variability of responses differ significantly response across factor settings, you may want to consider using weighted 
regression if you analyze the location effects of your response. 

Fitted variance (unadjusted weights) 
Store unadjusted weights using the fitted variance, if the data contain replicate measurements. Use the unadjusted 
weights when analyzing the location effects of replicates in Analyze Factorial Design. 
The weights are the reciprocal of the fitted variance (1 / fitted variance). Minitab stores weights in every row of your 
design, even though the standard deviation is missing in some rows. In this case, Minitab uses the same weight at 
identical combinations of factor settings, unless there are covariates in your model.   

Adjusted variance (adjusted weights) 
Store adjusted weights using the adjusted variance, if your data contain repeat measurements with some replicated 
points. If you have only repeat measurements, you cannot store adjusted weights from your model. Use the adjusted 
weights when analyzing the location effects of the stored means of repeat measurements. You must specify these means 
in DOE > Factorial >Analyze Variability > Storage for Minitab to use them in calculating the adjusted weights. 
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The weights are estimates of the reciprocal variance of the means. This variance includes both the variance of repeats 
from your analysis and the variance of the replicates. The adjustment adds in the contribution due to the replicate 
variance, which is assumed to be constant across factor settings. 
If you have covariates in your location model, you may want to account for them in the adjusted variance. 
 

Adjusting for Covariates in Replicates 
Because covariates are not controlled in experiments, they can vary across replicates measurements. Minitab enables 
you to adjust for up to 50 covariates in the calculation of the standard deviations of your replicate responses. In adjusting 
for the covariate, Minitab removes the variability in the measurements due to the covariate, so that the variability is not 
included in the standard deviation of the replicates. 
For example, you conduct an experiment with replicates during one day. The temperature, which you cannot control, 
varies greatly from morning to afternoon. You are concerned that the temperature differences may influence the 
responses. To account for this variability, at each run of the experiment, you record the temperature and adjust for it when 
calculating the standard deviations.  
You do not need to adjust for covariates with repeat measurements. For repeats, the standard deviation is calculated from 
the same run or consecutive runs. Covariates are measured once at each run of the experiment. As a result, there is only 
one covariate value for each group of repeats and, therefore, no covariate variability to account for in the standard 
deviation calculation. 
 

Analyzing Location and Dispersion Effects 
Minitab enables you to analyze both location and dispersion effects in a 2-level factorial design. To examine dispersion 
effects, you must have either repeat or replicate measurements of your response.  

•    Location model − examines the relationship between the mean of the response and the factors  

•    Dispersion model − examines the relationship between the standard deviation of the repeat or replicate responses and 
the factors  

Once you have determined your design and gathered data, you can analyze both location and dispersion models. Listed 
below are steps for analyzing location and dispersion models in Minitab, with options to consider at each step: 
1    Calculate or define standard deviations of repeat or replicate responses (Preprocess responses). Consider whether to: 

•    Adjust for covariates in calculating standard deviation for replicates 

•    Store means of repeats so you can analyze the location effects 
2    Analyze dispersion model (Analyze Variability). Consider whether to: 

•    Use least squares or maximum likelihood estimation methods, or both 
•    Store weights − using fitted or adjusted variance− to use when analyzing the location model 

3    Analyze location model (Analyze Factorial Design). Consider: 

•    Which response column to use: 
–    If you have repeats, use the column of stored means calculated in Preprocess Responses.  
–    If you have replicates, use the column containing the original response data. 
Here is an example: A 23 factorial design with four repeats has eight experimental runs with four measurements 
per run. Minitab calculates the mean of the four repeats at each run, giving you a total of eight observations. The 
same design with four replicates has 32 experimental runs. In this case, each measurement is a distinct 
observation, giving you 32 observations. Experiments with replicate measurements have more degrees of 
freedom for the error term than experiments with repeats, which provide greater power to find differences among 
factor settings in the location model.  

•    Whether to use weights stored in the dispersion analysis 
 

Example of analyzing variability 
In the Example of preprocessing responses, you decided to conduct a 2-level factorial experiment with 8 replicates to 
investigate how three variables−reaction time, reaction temperature, and type of catalyst−affect the variability of the yield. 
Use Analyze Variability to determine which terms (main effects and two-way interactions) are significantly related to 
differences in the variability of yield. Before you can analyze the variability of this data, you must first do the Example of 
preprocessing responses to store the standard deviations and number of replicates of the response.  
The analysis for this example is performed in two steps. In the first step, you use least squares regression to fit and 
reduce the model. Once you identify an appropriate reduced model, in step two, analyze the reduced model using 
maximum likelihood estimation to obtain the final model coefficients.  
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Step 1: Analyze the design using least squares regression estimation 
1    Choose Stat > DOE > Factorial > Analyze Variability. 
2    In Response (standard deviations), enter StdYield. 
3    Click Terms.  
4    In Include terms from the model up through order, choose 2 from the drop-down list. Click OK. 
5    Click Graphs. Under Effects plots, check Normal and Pareto. Click OK in each dialog box. 

Session window output 

Preprocess: Yield versus Time, Temp, Catalyst 
 
 
Analysis of Variability: StdYield versus Time, Temp, Catalyst 
 
 
Regression Estimated Effects and Coefficients for Natural Log of StdYield 
     (coded units) 
 
                         Ratio 
Term            Effect  Effect     Coef  SE Coef      T      P 
Constant                         0.7020  0.01879  37.35  0.017 
Time            2.0371  7.6682   1.0185  0.01879  54.19  0.012 
Temp            1.1491  3.1552   0.5745  0.01879  30.57  0.021 
Catalyst        0.4300  1.5373   0.2150  0.01879  11.44  0.056 
Time*Temp      -0.2011  0.8178  -0.1005  0.01879  -5.35  0.118 
Time*Catalyst  -0.1861  0.8302  -0.0931  0.01879  -4.95  0.127 
Temp*Catalyst   0.0159  1.0160   0.0079  0.01879   0.42  0.746 
 
R-Sq = 99.98%    R-Sq(adj) = 99.83% 
 
Analysis of Variance for Natural Log of StdYield 
 
Source              DF   Seq SS   Adj SS  Adj MS        F      P 
Main Effects         3  136.942  136.942  45.647  1334.07  0.020 
2-Way Interactions   3    1.824    1.824   0.608    17.77  0.172 
Residual Error       1    0.034    0.034   0.034 
Total                7  138.800 
 
 
 
Regression Estimated Coefficients for Natural Log of StdYield (uncoded units) 
 
Term                   Coef 
Constant           -7.33855 
Time               0.114823 
Temp              0.0323653 
Catalyst           0.376572 
Time*Temp      -2.68115E-04 
Time*Catalyst    -0.0062036 
Temp*Catalyst     0.0003176 
 
Alias Structure 
I 
Time 
Temp 
Catalyst 
Time*Temp 
Time*Catalyst 
Temp*Catalyst 
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Graph window output 

 

 
Interpreting the Results 
In the first step of the analysis, you used least squares regression to fit the model. One approach to analyzing the 
variability of data suggests using least squares regression to determine which factors are significantly related to the 
response. Once a reduced model is identified, use maximum likelihood estimation (MLE) to determine the final model 
coefficients. If you have terms that are borderline significant, you may want to examine both the regression and MLE 
results to determine which factors to retain in your model. See [4] for more information. In many cases, the differences 
between the least squares and MLE results are minor. 
For this example, the analysis of variance table provides a summary of the main effects and interactions. Minitab displays 
both the sequential sums of squares (Seq SS) and adjusted sums of squares (Adj SS). If the model is orthogonal and 
does not contain covariates, these will be the same. Look at the p-values to determine whether or not you have any 
significant effects. The results indicate that the two-way interactions are not significant (p = 0.172). The main effects are 
significant at an α-level of 0.05 (p = 0.020).  

The results indicate that time and temperature are significant at the 0.05 α-level. The variable catalyst is almost significant 
at the 0.05 α-level. The interactions are not significant at the 0.05 α-level. 
The normal and Pareto plots of the effects allow you to visually identify the important effects and compare the relative 
magnitude of the various effects. The plots confirm that time and temperature are significant at the 0.05 α-level. 
At this point, you should reduce the model using the least squares regression method to determine which terms to retain 
in the model. For purposes of this example, the model with time, temperature, and catalyst main effects is used as the 
reduced model. This model is just one of the possible reduced models you could have chosen. In practice, you may need 
to fit several models to find the appropriate model. 

Note If the data in this example were repeats, not replicates, the results and output would be exactly the same as 
the output shown above. Despite this, the results may have different practical implications depending on the 
sources of variability that you analyzed.  
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If you plan on analyzing this data in Analyze Factorial Design, you may want to consider using weights to 
adjust for the differences in variance among factors levels. 

Step 2: Analyze the reduced model using maximum likelihood estimation 
1    Choose Stat > DOE > Factorial > Analyze Variability. 
2    In Response (standard deviations), enter StdYield. 
3    Under Estimation method, choose Maximum likelihood. 
4    Click Terms.  
5    In Include terms from the model up through order, choose 1 from the drop-down list. Click OK. 
6    Click Graphs. Under Effects plots, uncheck Normal and Pareto. Click OK in each dialog box. 

Session window output 

Preprocess: Yield versus Time, Temp, Catalyst 
 
 
Analysis of Variability: StdYield versus Time, Temp, Catalyst 
 
 
MLE Estimated Effects and Coefficients for Natural Log of StdYield (coded 
     units) 
 
                   Ratio 
Term      Effect  Effect    Coef  SE Coef      Z      P 
Constant                  0.7213  0.09449   7.63  0.000 
Time      2.0379   7.674  1.0189  0.09449  10.78  0.000 
Temp      1.1559   3.177  0.5779  0.09449   6.12  0.000 
Catalyst  0.4374   1.549  0.2187  0.09449   2.31  0.021 
 
 
 
MLE Estimated Coefficients for Natural Log of StdYield (uncoded units) 
 
Term           Coef 
Constant   -5.70171 
Time      0.0679285 
Temp      0.0231172 
Catalyst   0.218693 
 
Alias Structure 
I 
Time 
Temp 
Catalyst 

Interpreting the Results 
After choosing an appropriate reduced model using least squares estimation, you refit the model using maximum 
likelihood estimation to obtain the most precise effects and coefficients. The results indicate that: 

•    Time has the strongest effect at 2.0379. The ratio effect indicates that the standard deviation increases by a factor of 
7.7 when time is changed from the low to high level. 

•    Temperature has the next strongest effect at 1.1559. The ratio effect indicates that the standard deviation increases by 
a factor of 3.2 when temperature is changed from the low to high level. 

•    Catalyst has the smallest effect at .4374. The ratio effect indicates that the standard deviation increases by a factor of 
1.5 when catalyst is changed from the low to high level. 

You should also plot the residuals versus the run order to check for any time trends or other nonrandom patterns. 
Residual plots are found in the Graphs subdialog box.  

Note If the data in this example were repeats, not replicates, the results and output would be exactly the same as 
the output shown above. Despite this, the results may have different practical implications depending on the 
sources of variability that you analyzed.  

If you plan on analyzing this data in Analyze Factorial Design, you may want to consider using weights to 
adjust for the differences in variance among factors levels. 
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Factorial Plots 
Factorial Plots 
Stat > DOE > Factorial > Factorial Plots 

You can produce three types of factorial plots to help you visualize the effects − main effects, interactions, and cube plots. 
These plots can be used to show how a response variable relates to one or more factors.  
Factorial Plots is unavailable until you have used Create Factorial Design or Define Custom Factorial Design. 

Dialog box items 
Main effects: Check to display a main effects plot, then click <Setup>.  
Interaction: Check to display an interactions plot, then click <Setup>.  
Cube: Check to display a cube plot, then click <Setup>.  
Type of Means to Use in Plots 

Data means: Choose to plot the means of the response variable for each level of a factor. 
Fitted means: Choose to plot the predicted values for each level of a factor. 

 

Factorial Plots (General Full Factorial) 
Stat > DOE > Factorial > Factorial Plots 

You can produce two types of factorial plots with general full factorial designs to help you visualize the effects − main 
effects and interactions. These plots can be used to show how a response variable relates to one or more factors.  
Factorial Plots is unavailable until you have used Create Factorial Design or Define Custom Factorial Design. 

Dialog box items 
Main effects (response versus levels of 1 factor): Check to display a main effects plot, then click <Setup>.  
Interaction (response versus levels of 2 factors): Check to display an interactions plot, then click <Setup>.  
Type of Means to Use in Plots 

Data means: Choose to plot the means of the response variable for each level of a factor. 
Fitted means: Choose to plot the predicted values for each level of a factor. 

 

Data − Factorial Plots 
You must create a factorial design, and enter the response data in your worksheet for both main effects and interactions 
plots.  
For cube plots, you do not need to have a response variable, but you must create a factorial design first. If you enter a 
response column, Minitab displays the means for the raw response data or fitted values at each point in the cube where 
observations were measured. If you do not enter a response column, Minitab draws points on the cube for the effects that 
are in your model.  
If you are plotting the means of the raw response data, you can generate the plots before you fit a model to the data. If 
you are using the fitted values (least squares means), you need to use Analyze Factorial Design before you can display a 
factorial plot. 
 

To display factorial plots 
1    Choose Stat > DOE > Factorial > Factorial Plots.  
2    Do one or more of the following: 

•    To generate a main effects plot, check Main effects, then click Setup. 
•    To generate a interactions plot, check Interaction, then click Setup. 
•    To generate a cube plot, check Cube, then click Setup. (available for two-level factorial and Plackett-Burman 

designs only) 
The setup subdialog box for the various factorial plots will differ slightly. 

3    In Responses, enter the numeric columns that contain the response (measurement) data. Minitab draws a separate 
plot for each column. (You can create a cube plot without entering any response columns.) 

4    Move the factors you want to plot from the Available box to the Selected box using the arrow buttons. Click OK. 
You can plot up to 50 factors with main effects, up to 15 factors with interactions plots, and up to 8 factors with cube 
plots.  
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•    to move the factors one at a time, highlight a factor then click a single arrow button  
•    to move all of the factors, click one of the double arrow buttons 
You can also move a factor by double-clicking it. 

5    If you like, use any dialog box options, then click OK. 
 

Main effects plots 
A main effects plot is a plot of the means at each level of a factor. You can draw a main effects plot for either the 

•    raw response data − the means of the response variable for each level of a factor 

•    fitted values after you have analyzed the design − predicted values for each level of a factor 

To create a main effects plot, see Factorial Plots - Main Effects (setup). 
For a balanced design, the main effects plot using the two types of responses are identical. However, with an unbalanced 
design, the plots are sometimes quite different. While you can use raw data with unbalanced designs to obtain a general 
idea of which main effects may be important, it is generally good practice to use the predicted values to obtain more 
precise results.  
Minitab plots the means at each level of the factor and connects them with a line. Center points and factorial points are 
represented by different symbols. A reference line at the grand mean of the response data is drawn.  
Minitab draws a single main effects plot if you enter one factor, or a series of plots if you enter more than one factor. You 
can use these plots to compare the magnitudes of the various main effects. Minitab also draws a separate plot for each 
factor-response combination. 
A main effect occurs when the mean response changes across the levels of a factor. You can use main effects plots to 
compare the relative strength of the effects across factors.  

 

The plot shows that tensile strength: 

•    Remains virtually the same when you move from process A to process B. 

•    Increases when you move from the low level to the high level of pressure.  

Note Although you can use these plots to compare main effects, be sure to evaluate significance by looking at the 
effects in the analysis of variable table. 

 

Factorial Plots − Main Effects − Setup 
Stat > DOE > Factorial > Factorial Plots > choose Main Effects > Setup 
Allows you to select the factors to include in the main effects plot. 

Dialog box items 
Responses: Select the column(s) containing the response data. When you enter more than one response variable, 
Minitab displays a separate plot for each response.  
Factors to Include in Plots Use the arrow buttons to move terms from one list to the other. Select a term in one of the 
lists, then click an arrow button. The double arrows move all the terms in one list to the other. You can also move a term 
by double-clicking it. 

Available: Lists all factors in your model. 
Selected: Lists all factors that will be included in the main effects plot(s). You can have up to 50 factors in the Selected 
list. 
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Factorial Plots − Main Effects − Options 
Stat > DOE > Factorial > Factorial Plots > check Main Effects > Setup > Options 
You can add your own title to the plot.  

Dialog box items 
Title: To replace the default title with your own custom title, type the desired text in this box. 
 

Interaction plots 
You can plot two-factor interactions for each pair of factors in your design. An interactions plot is a plot of means for each 
level of a factor with the level of a second factor held constant. You can draw an interactions plot for either the: 

•    raw response data − the means of the response variable for each level of a factor 

•    fitted values after you have analyzed the design − predicted values for each level of a factor 
To create an interaction plot, see Factorial Plots - Interaction (setup). 
For a balanced design, the interactions plot using the two types of responses are identical. However, with an unbalanced 
design, the plots are sometimes quite different. While you can use raw data with unbalanced designs to obtain a general 
idea of which interactions may important, it is generally good practice to use the predicted values to obtain more precise 
results. 
Minitab draws a single interactions plot if you enter two factors, or a matrix of interactions plots if you enter more than two 
factors. 
An interaction between factors occurs when the change in response from the low level to the high level of one factor is not 
the same as the change in response at the same two levels of a second factor. That is, the effect of one factor is 
dependent upon a second factor. You can use interactions plots to compare the relative strength of the effects across 
factors.  

Interaction Plot (Process by Speed) Interaction Plot (Pressure by Speed) 

 
The change in tensile strength when you move from the low 
level to the high level of speed is about the same at both 
levels of process. 

 
The change in tensile strength when you move from the low 
level to the high level of speed is different depending on the 
level of pressure. 

 

Note Although you can use these plots to compare interaction effects, be sure to evaluate significance by looking at 
the effects in the analysis of variable table. 

 

Factorial Plots − Interaction − Setup 
Stat > DOE > Factorial > Factorial Plots > choose Interaction > Setup 
Allows you to select the terms to include in the interaction plot. 

Dialog box items 
Responses: Select the column(s) containing the response data. When you enter more than one response variable, 
Minitab displays a separate plot for each response.  
Factors to Include in Plots Use the arrow buttons to move terms from one list to the other. Select a term in one of the 
lists, then click an arrow button. The double arrows move all the terms in one list to the other. You can also move a term 
by double-clicking it. 

Available: Lists all factors in your model. 
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Selected: Lists all factors that will be included in the interactions plot(s). You can have up to 15 factors in the Selected 
list. Minitab draws all two-way interactions of the selected factors. 

 

Factorial Plots − Interaction − Options 
Stat > DOE > Factorial > Factorial Plots > check Interaction > Setup > Options 
You can display the interaction plot matrix and add your own title to the plot.  

Dialog box items 
Draw full interaction plot matrix: Check to display the full interaction matrix when you specify more than two factors 
instead of displaying only the upper right portion of the matrix. In the full matrix, the transpose of each plot in the upper 
right displays in the lower left portion of the matrix. The full matrix takes longer to display than the half matrix. 
Title: To replace the default title with your own custom title, type the desired text in this box. 
 

Cube Plots 
Cube plots can be used to show the relationships among two to eight factors − with or without a response measure − for 
two-level factorial or Plackett-Burman designs. Viewing the factors without the response allows you to see what a design 
"looks like." If there are only two factors, Minitab displays a square plot. You can draw a cube plot for either the: 

•    Data means − the means of the raw response variable data for each factor level combination 

•    Fitted means after analyzing the design − predicted values for each factor level combination. To plot the fitted means, 
you must fit the full model. 

Cube Plot − No Response Cube Plot − With  Response 

  

Note Although you can use these plots to compare effects, be sure to evaluate significance by looking at the effects 
in the analysis of variable table. 

To create a cube plot, see Factorial Plots - Cube (setup). 
 

Factorial Plots − Cube − Setup 
Stat > DOE > Factorial > Factorial Plots > choose Cube > Setup 
You can to select the 2-level factors to include in the cube plot. The number of factors you can plot depends on the data 
you are fitting: 

•    With data means, you can fit up to 8 2-level factors 

•    With fitted means, you can fit up to 7 2-level factors. You must fit the full model (e.g., model must include all interaction 
terms). 

Dialog box items 
Responses (optional): Select the column(s) containing the response data. For cube plots, the response variable is 
optional. If you do not enter a response variable, you will get a cube plot which only displays the design points. This is a 
nice way to visualize what a factorial design looks like. When you enter more than one response variable, Minitab displays 
a separate plot for each response.  
Factors to Include in Plots Use the arrow buttons to move terms from one list to the other. Select a term in one of the 
lists, then click an arrow button. The double arrows move all the terms in one list to the other. You can also move a term 
by double-clicking it. 
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Available: Lists all factors in your model. 
Selected: Lists all factors that will be included in the cube plot(s). You must plot at least 2 but no more than 8 factors. 

 

Example of factorial plots 
In the Example of analyzing a full factorial design with replicates and blocks, you were investigating how processing 
conditions (factors) − reaction time, reaction temperature, and type of catalyst − affect the yield of a chemical reaction. 
You determined that there was a significant interaction between reaction time and reaction temperature and you would 
like to view the factorial plots to help you understand the nature of the relationship. Because the effects due to block and 
catalyst are not significant, you will not include them in the plots. 
1    Open the worksheet YIELDPLT.MTW. (The design, response data, and model information have been saved for you.) 
2    Choose Stat > DOE > Factorial > Factorial Plots. 
3    Check Main effects plot and click Setup. 
4    In Responses, enter Yield. 

5    Click  to move Time to the Selected box. 

6    Click  to move Temp to the Selected box. Click OK. 
7    Repeat steps 3-6 to set up the interaction plot. Click OK. 

Graph window output 

 

 
Interpreting the results 
The Main Effects Plot indicates that both reaction time and reaction temperature have similar effects on yield. For both 
factors, yield increases as you move from the low level to the high level of the factor. 
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However, the interaction plot shows that the increase in yield is greater when reaction time is high (50) than when reaction 
time is low (20). Therefore, you should be sure to understand this interaction before making any judgments about the 
main effects. 
Although you can use factorial plots to compare the magnitudes of effects, be sure to evaluate significance by looking at 
the effects in an analysis of variance table or the normal or Pareto effects plots. See Example of analyzing a full factorial 
design with replicates and blocks. 
 

Contour/Surface Plots 
Contour/Surface Plots 
Stat > DOE > Factorial > Contour/Surface Plots 

You can produce two types of plots to help you visualize the response surface − contour plots and surface plots. These 
plots show how a response variable relates to two factors based on a model equation. 

Dialog box items 
Contour Plot: Check to display a contour plot, then click <Setup>.  
Surface Plot: Check to display a surface plot, then click <Setup>. 
 

Data − Contour/Surface Plots 
Contour plots and surface plots are model dependent. Thus, you must fit a model using Analyze Factorial Design before 
you can generate response surface plots. Minitab looks in the worksheet for the necessary model information to generate 
these plots.  
 

To plot the response surface 
1    Choose Stat > DOE > Factorial > Contour/Surface Plots. 
2    Do one or both of the following: 

•    to generate a contour plot, check Contour plot and click Setup. If you have analyzed more than one response, 
from Response, choose the desired response.  

•    to generate a surface plot, check Surface plot and click Setup. If you have analyzed more than one response, 
from Response, choose the desired response. 

3    If you like, use one or more of the available dialog box options, then click OK in each dialog box. 
 

Contour and Surface Plots (Factorial Design)  
Contour and surface plots are useful for establishing desirable response values and operating conditions.  

•    A contour plot provides a two-dimensional view where all points that have the same response are connected to 
produce contour lines of constant responses. 

•    A surface plot provides a three-dimensional view that may provide a clearer picture of the response surface.  
The illustrations below show a contour plot and 3D surface plot of the same data. The lowest Y-values are found where 
X1 and X2 both at their low settings. As X1 and X2 move toward their high settings, values for Y increase steadily.  

Contour Plot 3D Surface Plot 
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Note When the model has more than two factors, the factor(s) that are not in the plot are held constant. Any 
covariates in the model are also held constant. You can specify the values at which to hold the remaining 
factors and covariates in the Settings subdialog box. 

 

Contour/Surface Plots − Contour − Setup 
Stat > DOE > Factorial > Contour/Surface Plots > check Contour > Setup 
Generates a response surface contour plot for a single pair of factors or separate contour plots for all possible pairs of 
factors.  

Dialog box items 
Response: Select the column containing the response data. 
Factors: 

Select a pair of factors for a single plot: Choose to display a graph for just one pair (x,y) factors. The graph is 
generated by calculating responses (z-values) using the values in the x- and y-factor columns and giving the other 
factors the values chosen in the Hold extra settings at option in the <Settings> subdialog box. 

X Axis: Choose a factor from the drop-down list to plot on the x-axis. 
Y Axis: Choose a factor from the drop-down list to plot on the y-axis. 

Generate plots for all pairs of factors: Choose to generate graphs for all possible combinations of (x,y) factors with 
the calculated response (z).The graphs are generated by calculating responses (z-values) using the values in the x- 
and y-factor columns and giving the other factors the values chosen in the Hold extra settings at option in the 
<Settings> subdialog box. With n factors, (n∗(n−1))/2 different contour plots will be generated. 

In separate panels of the same page: Choose to display all plots on one page.  
On separate pages: Choose to display each plot on a separate page.  

Display plots using 

Coded units: Choose to display points on the response surface plots using the default coding: −1 for the low level, +1 
for the high level, and 0 for a center point.  
Uncoded units: Choose to display points on the response surface plots using the values that you assign in the Factors 
subdialog box.  

 

Contour/Surface Plots − Surface − Setup 
Stat > DOE > Factorial > Contour/Surface Plots >check Surface > Setup 
Draws a surface plot. Surface plots show how a response variable (the z-variable) relates to two factors (the x- and y-
variables).  
Response: Choose the column containing the response data. 
Factors  

Select a pair of factors for a single plot: Choose to display a graph for just one pair (x,y) factors. The graph is 
generated by calculating responses (z-values) using the values in the x- and y-factor columns and giving the other 
factors the values chosen in the Hold extra settings at option in the <Settings> subdialog box. 

X Axis: Choose a factor from the drop-down list to plot on the x-axis. 
Y Axis: Choose a factor from the drop-down list to plot on the y-axis. 

Generate plots for all pairs of factors: Choose to display a separate graph for each possible combination of (x,y) 
factors with the calculated response (z). The graphs are generated by calculating responses (z-values) using the values 
in the x- and y-factor columns and giving the other factors the values chosen in the Hold extra settings at option in the 
<Settings> subdialog box. With n factors, (n∗(n−1))/2 different contour plots will be generated. 

Display plots using 
Coded units: Choose to display points on the response surface plots using the default coding: 1 for the low level, +1 
for the high level, and 0 for a center point.  
Uncoded units: Choose to display points on the response surface plots using values that you assigned in the Factors 
subdialog box.  

 

Contour/Surface Plots − Contour − Contours 
Stat > DOE > Factorial > Contour/Surface Plots > check Contour > Setup > Contours 
Specify the number or location of the contour levels, and the way Minitab displays the contours. 
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Dialog box items 
Contour Levels Controls the number of contour levels to display. 

Use defaults: Choose to have Minitab determine the number of contour lines (from 4 to 7) to draw.  
Number: Choose specify the number of contour lines, then enter an integer from 2 to 11 for the number of contour lines 
you want to draw. 
Values: Choose to specify the values of the contour lines in the units of your data. Then specify from 2 to 11 contour 
level values in strictly increasing order. You can also put the contour level values in a column and select the column. 

Data Display 
Area: Check to shade the areas that represent the values for the response, which are called contours. 
Contour lines: Check to draw lines along the boundaries of each contour. 
Symbols at design points: Check to display a symbol at each data point. 

 

To control plotting of contour levels (factorial design) 
1    In the Contour/Surface Plots dialog box, check Contour plot and click Setup. 
2    Click Contours. 
3    To change the number of contour levels, do one of the following: 

•    Choose Number and enter a number from 2 to 11. 
•    Choose Values and enter from 2 to 11 contour level values in the units of your data. You must enter the values in 

increasing order.  
4    Click OK in each dialog box. 
 

Contour/Surface Plots − Settings 
Stat > DOE > Factorial > Contour/Surface Plots > Setup > Settings 
You can set the holding level for factors that are not in the plot at their highest, lowest, or middle (calculated mean) 
settings, or you can set specific levels to hold each factor. 

Dialog box items 
You may select one of the three choices for settings OR enter your own by typing a value in the table 
Hold extra factors at 

High settings: Choose to set variables that are not in the graph at their highest setting. 
Middle settings: Choose to set variables that are not in the graph at the calculated median setting. 
Low settings: Choose to set variables that are not in the graph at their lowest setting.  

Factor: Shows all the factors in your design. This column does not take any input. 
Name: Shows all the names of factors in your design. This column does not take any input. 
Setting: Enter a value to hold each factor that is not being plotted. Use the up and down arrows to move in the Setting 
column. 
 

To set the holding level for factors not in the plot (factorial design) 
1    In the Contour/Surface Plots dialog box, click Setup. 
2    Click Settings.  
3    Do one of the following: 

•    To use the preset values, choose High settings, Middle settings, or Low settings under Hold extra factors at 
and/or Hold covariates at. When you use a preset value, all factors or covariates not in the plot will be held at 
their specified settings. 

•    To specify the value at which to hold a factor or covariate, enter a number in Setting for each one you want to 
control. This option allows you to set a different holding value for each factor or covariate. 

4    Click OK. 
 

Contour/Surface Plots − Options 
Stat > DOE > Factorial > Contour/Surface Plots > Setup > Options 
You can determine the title of your plot. 
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Dialog box items 
Title: To replace the default title with your own custom title, type the desired text in this box. 
 

Example of a contour plot and a surface plot (factorial design) 
In the Example of analyzing a full factorial design with replicates and blocks, you were investigating how processing 
conditions (factors) − reaction time, reaction temperature, and type of catalyst − affect the yield of a chemical reaction. 
You determined that there was a significant interaction between reaction time and reaction temperature and you would 
like to view the response surface plots to help you understand the nature of the relationship. Because the effects due to 
block and catalyst are not significant, you did not include them in the plots.  
You can also view main effects and interactions plots. 
1    Open the worksheet YIELDPLT.MTW. (The design, response data, and model information have been saved for you.) 
2    Choose Stat > DOE > Factorial > Contour/Surface Plots. 
3    Check Contour plot and click Setup. Click OK. 
4    Check Surface plot and click Setup. Click OK in each dialog box 

Graph window output 

 

 
Interpreting the results 
Both the contour plot and the surface plot show that Yield increases as both reaction time and reaction temperature 
increase. The surface plot also illustrates that the increase in yield from the low to the high level of time is greater at the 
high level of temperature. 
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Overlaid Contour Plot 
Overlaid Contour Plot  
Stat > DOE > Factorial > Overlaid Contour Plot 
Use overlaid contour plot to draw contour plots for multiple responses and to overlay multiple contour plots on top of each 
other in a single graph. Contour plots show how response variables relate to two continuous design variables while 
holding the rest of the variables in a model at certain settings.  

Dialog box items 
Responses  

Available: Shows all the responses that have had a model fit to them and can be used in the contour plot. Use the 
arrow keys to move up to 10 response columns from Available to Selected. (If an expected response column does not 
show in the Available list, fit a model to it using Analyze Factorial Design.) 
Selected: Shows all responses that will be included in the contour plot. 

Factors  
X Axis: Choose a factor from the drop-down list to plot on the x-axis. 
Y Axis: Choose a factor from the drop-down list to plot on the y-axis. 

Display plots using  
Coded units: Choose to display the plot using coded units. 
Uncoded units: Choose to display the plot using uncoded units (the default). 

 

To create an overlaid contour plot 
1    Choose Stat > DOE > Factorial > Overlaid Contour Plot. 
2    Under Responses, move up to ten responses that you want to include in the plot from Available to Selected using 

the arrow buttons. (If an expected response column does not show in Available, fit a model to it using Analyze 
Factorial Design.) 

•    To move the responses one at a time, highlight a response, then click  or   

•    To move all of the responses, click  or   
You can also move a response by double-clicking it. 

3    Under Factors, choose a factor from X Axis and a factor from Y Axis. 

Note Only numeric factors are valid candidates for X and Y axes.

4    Click Contours.  
5    For each response, enter a number in Low and High. See Defining contours. Click OK. 
6    If you like, use any of the available dialog box options, then click OK. 
 

Data − Overlaid Contour Plot 
1    Create and store a design using Create Factorial Design or create a design from data that you already have in the 

worksheet with Define Custom Factorial Design.  
2    Enter up to ten numeric response columns in the worksheet 
3    Fit a model for each response using Analyze Factorial Design. 

Note Overlaid Contour Plot is not available for general full factorial designs.

 

Overlaid Contour Plot − Contours 
Stat > DOE > Factorial > Overlaid Contour Plot > Contours 
Define the low and high values for the contour lines for each response. For a discussion, see Defining contours. 

Dialog box items 
Low: Enter the low value for the contour lines for each response. 
High: Enter the high value for the contour lines for each response. 
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Defining Contours 
For each response, you need to define a low and a high contour. These contours should be chosen depending on your 
goal for the responses. Here are some examples: 

•    If your goal is to minimize (smaller is better) the response, you may want to set the Low value at the point of 
diminishing returns, that is, although you want to minimize the response, going below a certain value makes little or no 
difference. If there is no point of diminishing returns, use a very small number, one that is probably not achievable. 
Use your maximum acceptable value in High. 

•    If your goal is to target the response, you probably have upper and lower specification limits for the response that can 
be used as the values for Low and High. If you do not have specification limits, you may want to use lower and upper 
points of diminishing returns.  

•    If your goal is to maximize (larger is better) the response, again, you may want to set the High value at the point of 
diminishing returns, although now you need a value on the upper end instead of the lower end of the range. Use your 
minimum acceptable value in Low. 

In all of these cases, the goal is to have the response fall between these two values. 
 

Overlaid Contour Plot − Settings 
Stat > DOE > Factorial > Overlaid Contour Plot > Settings 
You can set the holding level for factors that are not in the plot at their highest, lowest, or middle (calculated median) 
settings, or you can set specific levels to hold each factor. 
The hold values for extra factors and covariates must be expressed in uncoded units. 

Note If you have text factors in your design, you can only set their holding values at one of the text levels. 

Dialog box items 
You may select one of the three choices for settings OR Enter your own setting by typing a value in the table. (Settings 
represent uncoded levels.)  
Hold extra factors at 

High settings: Choose to set variables that are not in the graph at their highest setting. 
Middle settings: Choose to set variables that are not in the graph at the calculated median setting. 
Low settings: Choose to set variables that are not in the graph at their lowest setting. 

Factor: Shows all the factors in your design. This column does not take any input. 
Name: Shows all the names of factors in your design. This column does not take any input. 
Setting: Enter a value to hold each factor that is not being plotted. Use the up and down arrows to move in the Setting 
column. 
Hold covariates at 

High settings: Choose to set covariates at their highest setting. 
Middle settings: Choose to set covariates at the calculated median setting. 
Low settings: Choose to set covariates at their lowest setting. 

Factor: Shows all the factors in your design. This column does not take any input. 
Name: Shows all the names of factors in your design. This column does not take any input. 
Setting: Enter a value to hold each factor that is not being plotted. Use the up and down arrows to move in the Setting 
column. 
 

To set the holding level for extra factors and covariates 
1    Choose Stat > DOE > Factorial> Overlaid Contour Plot > Settings. 
2    Do one of the following to set the holding value for extra factors or covariates: 

•    To use the preset values for factors, covariates, or process variables, choose High settings, Middle settings, or 
Low settings. When you use a preset value, all variables not in the plot will be held at their high, middle 
(calculated median), or low settings. 

•    To specify the value at which to hold the factor, covariate, or process variable, enter a number in Setting for each 
of the design variables you want control. This option allows you to set a different holding value for each variables. 

3    Click OK. 
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Overlaid Contour Plot − Options 
Stat > DOE > Factorial > Overlaid Contour Plot > Options 
You can determine the title of your plot. 

Dialog box items 
Title: To replace the default title with your own custom title, type the desired text in this box. 
 

Example of an overlaid contour plot for factorial design 
This contour plot is a continuation of the factorial response optimization example. A chemical engineer conducted a 2∗∗3 
full factorial design to examine the effects of reaction time, reaction temperature, and type of catalyst on the yield and cost 
of the process. The goal is to maximize yield and minimize cost. In this example, you will create contour plots using time 
and temperature as the two axes in the plot and holding type of catalyst at levels A and B respectively. 
Step 1: Display the overlaid contour plot for Catalyst A 
1    Open the worksheet FACTOPT.MTW. (The design information and response data have been saved for you.) 
2    Choose Stat > DOE > Factorial > Overlaid Contour Plot. 

3    Click  to move Yield and Cost to Selected. 
4    Click Contours. Complete the Low and High columns of the table as shown below. Click OK  

Name Low High 

Yield 35 45 

Cost 28 35 

5    Click OK in the Overlaid Contour Plot dialog box. 
Step 2: Display the overlaid contour plot for Catalyst B 
6    Repeat steps 2-4, then click Settings. Under Hold extra factors at, choose High settings. Click OK in each dialog 

box. 

Graph Window Output 
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Interpreting the results 
Displayed are two overlaid contour plots. The two factors, temperature and time, are used as the two axes in the plots and 
the third factor, catalyst, has been held at levels A and B respectively.  
The white area inside each plot shows the range of time and temperature where the criteria for both response variables 
are satisfied. Use this plot in combination with the optimization plot to find the best operating conditions for maximizing 
yield and minimizing cost.  
 

Response Optimizer 
Response Optimization Overview 
Many designed experiments involve determining optimal conditions that will produce the "best" value for the response. 
Depending on the design type (factorial, response surface, or mixture), the operating conditions that you can control may 
include one or more of the following design variables: factors, components, process variables, or amount variables.  
For example, in product development, you may need to determine the input variable settings that result in a product with 
desirable properties (responses). Since each property is important in determining the quality of the product, you need to 
consider these properties simultaneously. For example, you may want to increase the yield and decrease the cost of a 
chemical production process. Optimal settings of the design variables for one response may be far from optimal or even 
physically impossible for another response. Response optimization is a method that allows for compromise among the 
various responses. 
Minitab provides two commands to help you identify the combination of input variable settings that jointly optimize a set of 
responses. These commands can be used after you have created and analyzed factorial designs, response surface 
designs, and mixture designs. 

•    Response Optimizer − Provides you with an optimal solution for the input variable combinations and an optimization 
plot. The optimization plot is interactive; you can adjust input variable settings on the plot to search for more desirable 
solutions. 

•    Overlaid Contour Plot − Shows how each response considered relates to two continuous design variables (factorial 
and response surface designs) or three continuous design variables (mixture designs), while holding the other 
variables in the model at specified levels. The contour plot allows you to visualize an area of compromise among the 
various responses. 

 

Response Optimizer − Factorial 
Stat > DOE > Factorial > Response Optimizer 
Use response optimization to help identify the combination of input variable settings that jointly optimize a single response 
or a set of responses. Joint optimization must satisfy the requirements for all the responses in the set, which is measured 
by the composite desirability. 
Minitab calculates an optimal solution and draws a plot. The optimal solution serves as the starting point for the plot. This 
optimization plot allows you to interactively change the input variable settings to perform sensitivity analyses and possibly 
improve the initial solution. 

Note Although numerical optimization along with graphical analysis can provide useful information, it is not a 
substitute for subject matter expertise. Be sure to use relevant background information, theoretical principles, 
and knowledge gained through observation or previous experimentation when applying these methods. 
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Dialog box items 
Select up to 25 response variables to optimize  

Available: Shows all the responses that have had a model fit to them and can be used in the analysis. Use the arrow 
keys to move the response columns from Available to Selected. (If an expected response column does not show in 
the Available list, fit a model to it using Analyze Factorial Design.)  
Selected: Shows all responses that will be included in the optimization. 

 

Data − Response Optimizer − Factorial Design 
Before you use Minitab's Response Optimizer, you must  
1    Create and store a design using Create Factorial Design or create a design from data that you already have in the 

worksheet with Define Custom Factorial Design.  
2    Enter up to 25 numeric response columns in the worksheet. 
3    Fit a model for each response Analyze Factorial Design.  

Note Response Optimization is not available for general full factorial designs.

You can fit a model with different design variables for each response. If an input variable was not included in the model for 
a particular response, the optimization plot for that response-input variable combination will be blank. 
Minitab automatically omits missing data from the calculations. If you optimize more than one response and there are 
missing data, Minitab excludes the row with missing data from calculations for all of the responses. 
 

To optimize responses for a factorial design 
1        Choose Stat > DOE > Factorial > Response Optimizer. 
2        Move up to 25 responses that you want to optimize from Available to Selected using the arrow buttons. (If an 

expected response column does not show in Available, fit a model to it using Analyze Factorial Design.) 

•    to move responses one at a time, highlight a response, then click  or  

•    to move all the responses at once, click  or  
You can also move a response by double-clicking it. 

3    Click Setup. 
4    For each response, complete the table as follows: 

•    Under Goal, choose Minimize, Target, or Maximize from the drop-down list. 
•    Under Lower, Target, and Upper, enter numeric values for the target and necessary bounds as follows: 

1    If you choose Minimize under Goal, enter values in Target and Upper. 

2    If you choose Target under Goal, enter values in Lower, Target, and Upper. 

3    If you choose Maximize under Goal, enter values in Target and Lower. 
For guidance on choosing bounds, see Specifying bounds. 

•    In Weight, enter a number from 0.1 to 10 to define the shape of the desirability function. See Setting the weight for 
the desirability function. 

•    In Importance, enter a number from 0.1 to 10 to specify the relative importance of the response. See Specifying 
the importance for the composite desirability. 

5    Click OK. 
6    If you like, use any of the available dialog box options, then click OK. 
 

Method − Response Optimization 
Minitab's Response Optimizer searches for a combination of input variables that jointly optimize a set of responses by 
satisfying the requirements for each response in the set. The optimization is accomplished by:  
1    obtaining the individual desirability (d) for each response 
2    combining the individual desirabilities to obtain the combined or composite desirability (D) 
3    maximizing the composite desirability and identifying the optimal input variable settings  

Note If you have only one response, the overall desirability is equal to the individual desirability. 
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Obtaining individual desirability 
First, Minitab obtains an individual desirability (d) for each response using the goals and boundaries that you have 
provided in the Setup dialog box. There are three goals to choose from. You may want to: 

•    minimize the response (smaller is better)  

•    target the response (target is best) 

•    maximize the response (larger is better)  
Suppose you have a response that you want to minimize. You need to determine a target value and an allowable 
maximum response value. The desirability for this response below the target value is one; above the maximum 
acceptable value the desirability is zero. The closer the response to the target, the closer the desirability is to one. The 
illustration below shows the default desirability function (also called utility transfer function) used to determine the 
individual desirability (d) for a "smaller is better" goal: 

 d = desirability  

Target 
any response 
value less 
than the 
target value 
has a 
desirability of 
one  

Upper bound 
any response 
value greater 
than the upper 
bound has a 
desirability  
of zero 

 
As the response decreases, the desirability increases.  

  

The shape of the desirability function between the upper bound and the target is determined by the choice of weight. The 
illustration above shows a function with a weight of one. To see how changing a weight affects the shape of the 
desirability function, see Setting the weight for the desirability function. 

Obtaining the composite desirability 
After Minitab calculates an individual desirability for each response, they are combined to provide a measure of the 
composite, or overall, desirability of the multi-response system. This measure of composite desirability (D) is the weighted 
geometric mean of the individual desirabilities for the responses. The individual desirabilities are weighted according to 
the importance that you assign each response. For a discussion, see Specifying the importance for composite desirability. 

Maximizing the composite desirability 
Finally, Minitab employs a reduced gradient algorithm with multiple starting points that maximizes the composite 
desirability to determine the numerical optimal solution (optimal input variable settings).  

More    You may want to fine tune the solution by adjusting the input variable settings using the interactive optimization 
plot. See Using the optimization plot.  
 

Response Optimizer − Setup 
Stat > DOE > Factorial > Response Optimizer > Setup 
Specify the goal, boundaries, weight, and importance for each response variable. 

Dialog box items 
Response: Displays all the responses that will be included in the optimization. This column does not take any input. 
Goal: Choose Minimize, Target, or Maximize from the drop-down list.  
Lower: For each response that you chose Target or Maximize under Goal, enter a lower boundary. 
Target: Enter a target value for each response. 
Upper: For each response that you chose Minimize or Target under Goal, enter an upper boundary. 
Weight: Enter a number from 0.1 to 10 to define the shape of the desirability function. 
Importance: Enter a number from 0.1 to 10 to specify the comparative importance of the response. 
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Specifying Bounds 
In order to calculate the numerically optimal solution, you need to specify a response target and lower and/or upper 
bounds. The boundaries needed depend on your goal: 

•    If your goal is to minimize (smaller is better) the response, you need to determine a target value and the upper bound. 
You may want to set the target value at the point of diminishing returns, that is, although you want to minimize the 
response, going below a certain value makes little or no difference. If there is no point of diminishing returns, use a 
very small number, one that is probably not achievable, for the target value.  

•    If your goal is to target the response, you should choose upper and lower bounds where a shift in the mean still 
results in a capable process.  

•    If your goal is to maximize (larger is better) the response, you need to determine a target value and the lower bound. 
Again, you may want to set the target value at the point of diminishing returns, although now you need a value on the 
upper end instead of the lower end of the range.  

 

Setting the Weight for the Desirability Function 
In Minitab's approach to optimization, each of the response values are transformed using a specific desirability function. 
The weight defines the shape of the desirability function for each response. For each response, you can select a weight 
(from 0.1 to 10) to emphasize or de-emphasize the target. A weight 

•    less than one (minimum is 0.1) places less emphasis on the target 

•    equal to one places equal importance on the target and the bounds 

•    greater than one (maximum is 10) places more emphasis on the target 
The illustrations below show how the shape of the desirability function changes when the goal is to maximize the 
response and the weight changes:  

Weight Desirability function 
 d = desirability 

0.1 
A weight less than one places less 
emphasis on the target. a response  
value far from the target may have a 
high desirability.  

                                            target 

 

1 
A weight equal to one places equal 
emphasis on the target and the  
bounds. The desirability for a response 
increases linearly. 

 
                                        target 

 

10 
A weight greater than one places more 
emphasis on the target. A response  
value must be very close to the target 
to havea high desirability. 

 
                                      target 

 
 
The illustrations below summarize the desirability functions: 
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When the goal is to ...  

 

minimize the response  
Below the target the response 
desirability is one; above the 
upper bound it is zero.  

 
 

target the response 
Below the lower bound the 
response desirability is zero; 
at the target it is one; above 
the upper bound it is zero. 

 
 

maximize the response  
Below the lower bound the 
response desirability is zero; 
above the target it is one.  

 
 

Specifying the Importance for Composite Desirability 
After Minitab calculates individual desirabilities for the responses, they are combined to provide a measure of the 
composite, or overall, desirability of the multi-response system. This measure of composite desirability is the weighted 
geometric mean of the individual desirabilities for the responses. The optimal solution (optimal operating conditions) can 
then be determined by maximizing the composite desirability. 
You need to assess the importance of each response in order to assign appropriate values for importance. Values must 
be between 0.1 and 10. If all responses are equally important, use the default value of one for each response. The 
composite desirability is then the geometric mean of the individual desirabilities. 
However, if some responses are more important than others, you can incorporate this information into the optimal solution 
by setting unequal importance values. Larger values correspond to more important responses, smaller values to less 
important responses. 
You can also change the importance values to determine how sensitive the solution is to the assigned values. For 
example, you may find that the optimal solution when one response has a greater importance is very different from the 
optimal solution when the same response has a lesser importance. 
 

Response Optimizer − Options 
Stat > DOE > Factorial > Response Optimizer > Options 
Define a starting point for the search algorithm, suppress display of the optimization plot, and store the composite 
desirability values. 
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Dialog box items 
Factors in design: Displays all the factors that have been included in a fitted model. This column does not take any input. 
Starting values: To define a starting point for the search algorithm, enter a value for each factor. Each value must be 
between the minimum and maximum levels for that factor. 
Hold covariates at:  

Name: Displays any covariates that have been included in a fitted model. This column does not take any input. 
Setting: Enter a value to hold each factor that is not being plotted. Use the up and down arrows to move in the Setting 
column. 
High settings: Choose to hold any covariates in a fitted model at their high levels. 
Middle settings: Choose to hold any covariates in a fitted model at the calculated median (the default). 
Low settings: Choose to hold any covariates in a fitted model at their low levels. 

Optimization plot: Uncheck to suppress display of the optimization plot. The default is to display the plot. 
Store composite desirability values: Check to store composite desirability values. 
Display local solutions: Check to display local solutions. 
 

Response Optimizer − Levels for Input Variables 
Enter a new value to change the input variable settings. 
For further discussion, see Using the optimization plot. 

Dialog box items 
Input New Level Value: Enter a new value to change the input variable settings. 
 

Using the Optimization Plot 
Once you have created an optimization plot, you can change the input variable settings. For factorial and response 
surface designs, you can adjust the factor levels. For mixture designs, you can adjust component, process variable, and 
amount variable settings. You might want to change these input variable settings on the optimization plot for many 
reasons, including: 

•    To search for input variable settings with a higher composite desirability 

•    To search for lower-cost input variable settings with near optimal properties 

•    To explore the sensitivity of response variables to changes in the design variables 

•    To "calculate" the predicted responses for an input variable setting of interest 

•    To explore input variable settings in the neighborhood of a local solution 
When you change an input variable to a new level, the graphs are redrawn and the predicted responses and desirabilities 
are recalculated. If you discover a setting combination that has a composite desirability higher than the initial optimal 
setting, Minitab replaces the initial optimal setting with the new optimal setting. You will then have the option of adding the 
previous optimal setting to the saved settings list. 

Note If you save the optimization plot and then reopen it in Minitab without opening the project file, you will not be 
able to drag the red lines with your mouse to change the factor settings. 

With Minitab's interactive Optimization Plot you can: 

•    Change input variable settings  

•    Save new input variable settings  

•    Delete saved input variable settings  

•    Reset optimization plot to optimal settings  

•    View a list of all saved settings  

•    Lock mixture components  
 

To change input variable settings 
1    Change input variable settings in the optimization plot by: 

•    Dragging the vertical red lines to a new position or  
•    Clicking on the red input variable settings located at the top and entering a new value in the dialog box that 

appears . 
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Note You can return to the initial or optimal settings at any time by clicking  on the Toolbar or by right-clicking and 
choosing Reset to Optimal Settings. 

Note For factorial designs with center points in the model: If you move one factor to the center on the optimization 
plot, then all factors will move to the center. If you move one factor away from the center, then all factors with 
move with it, away from the center. 

Note For a mixture design, you cannot change a component setting independently of the other component settings. 
If you want one or more components to stay at their current settings, you need to lock them. See To lock 
components (mixture designs only). 

 

To save new input variable settings 
1    Save new input variable settings in the optimization plot by 

•    Clicking  on the Optimization Plot Toolbar 
•    Right-clicking and selecting Save current settings from the menu 

Note The saved settings are stored in a sequential list. You can cycle forwards and backwards through the setting 

list by clicking on  or  on the Toolbar or by right-clicking and choosing the appropriate command from 
the menu. 

 

To delete saved input variable settings 
1    Choose the setting that you want to delete by cycling through the list.  
2    Delete the setting by: 

•    Clicking  on the Optimization Plot Toolbar 
•    Right-clicking and choosing Delete Current Setting  

 

To reset optimization plot to optimal settings 
1    Reset to optimal settings by: 

•    Clicking  on the Toolbar 
•    Right-clicking and choosing Reset to Optimal Settings 

 

To view a list of all saved settings 
1    View the a list of all saved settings by 

•    Clicking  on the Optimization Plot Toolbar 
•    Right-clicking and choosing Display Settings List 

More You can copy the saved setting list to the Clipboard by right-clicking and choosing Select All and then choosing 
Copy. 

 

Example of a response optimization experiment for a factorial design 
You are an engineer assigned to optimize the responses from a chemical reaction experiment. You have determined that 
three factors − reaction time, reaction temperature, and type of catalyst − affect the yield and cost of the process. You 
want to find the factor settings that maximize the yield and minimize the cost of the process. 
1    Open the worksheet FACTOPT.MTW. (We have saved the design, response data, and model information for you.) 
2    Choose Stat > DOE > Factorial > Response Optimizer. 

3    Click  to move Yield and Cost to Selected. 
4    Click Setup. Complete the Goal, Lower, Target, and Upper columns of the table as shown below: 
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Response Goal Lower Target Upper 

Yield Maximize 35 45  

Cost Minimize  28 35 

5    Click OK in each dialog box. 

Session Window Output 

Response Optimization 
 
Parameters 
 
                    Goal      Lower     Target      Upper     Weight     Import 
Yield           Maximum         35         45         45          1          1 
Cost            Minimum         28         28         35          1          1 
 
Global Solution 
 
Time         =   46.062 
Temp         =  150.000 
Catalyst     =   -1.000 (A) 
 
Predicted Responses 
 
Yield        =  44.8077, desirability =  0.98077 
Cost         =  28.9005, desirability =  0.87136 
 
Composite Desirability =  0.92445 

Graph Window Output 

 
Interpreting the results 
The individual desirability for Yield is 0.98081; the individual desirability for Cost is 0.87132. The composite desirability for 
both these two variables is 0.92445. 
To obtain this desirability, you would set the factor levels at the values shown under Global Solution in the Session 
window. That is, time would be set at 46.062, temperature at 150, and you would use catalyst A. 
If you want to try to improve this initial solution, you can use the plot. Move the red vertical bars to change the factor 
settings and see how the individual desirability of the responses and the composite desirability change.   
 

Modify Design 
Modify Design (2-level Factorial and Plackett-Burman) 
Stat > DOE > Modify Design 
After creating a factorial design and storing it in the worksheet, you can use Modify Design to make the following 
modifications: 
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•    rename the factors and change the factor levels. 

•    replicate the design. 

•    randomize the design. 

•    fold the design. 

•    add axial points to the design. You can also add center points to the axial block. 
By default, Minitab will replace the current design with the modified design.  

Dialog box items 
Modification  

Modify factors: Choose to rename factors or change factor levels, and then click <Specify>. 
Replicate design: Choose to add up to ten replicates, and then click <Specify>. 
Randomize design: Choose to randomize the design, and then click <Specify>. 
Fold design: Choose to fold the design, and then click <Specify>. 
Add axial points: Choose to add axial points, and then click <Specify>. This allows you to "build" up the two-level 
factorial design to a central composite design. You can also add center points to the axial block. 

Put modified design in a new worksheet: Check to have Minitab place the modified design in a new worksheet rather 
than overwriting the current worksheet. 
 

Modify Design (General Full Factorial) 
Stat > DOE > Modify Design 
After creating a factorial design and storing it in the worksheet, you can use Modify Design to make the following 
modifications: 

•    rename the factors and change the factor levels 

•    replicate the design 

•    randomize the design 
By default, Minitab will replace the current design with the modified design.  

Dialog box items 
Modification  

Modify factors: Choose to rename factors or change factor levels, and then click <Specify>. 
Replicate design: Choose to add up to ten replicates, and then click <Specify>. 
Randomize design: Choose to randomize the design, and then click <Specify>. 

Put modified design in a new worksheet: Check to have Minitab place the modified design in a new worksheet rather 
than overwriting the current worksheet. 
 

Modify Design − Factors (2-level Factorial and Plackett-Burman Design) 
Stat > DOE > Modify Design > choose Factors > Specify 
Allows you to name or rename the factors and assign values for factor settings.  
Use the arrow keys to navigate within the table, moving across rows or down columns. 

Dialog box items 
Factor: Shows the number of factors you have chosen for your design. This column does not take any input. 
Name: Enter text to change the name of the factors. By default, Minitab names the factors alphabetically. 
Type: Shows whether the factor is numeric or text. This column does not take any input. 

Low: Enter the value for the low setting of each factor. By default, Minitab sets the low level of all factors to −1. Factor 
settings can be changed to any numeric or text value. If one of the settings for a factor is text, Minitab interprets the other 
setting as text. 
High: Enter the value for the high setting of each factor. By default, Minitab sets the high level of all factors to +1. Factor 
settings can be changed to any numeric or text value. If one of the settings for a factor is text, Minitab interprets the other 
setting as text. 
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Factorial Design − Factors 
Stat > DOE > Modify Design > choose Modify factors > Specify 
Allows you to name or rename the factors and assign values for factor settings.  
Use the arrow keys to navigate within the table, moving across rows or down columns. 

Dialog box items 
Factor: Shows the number of factors you have chosen for your design. This column does not take any input. 
Name: Enter text to change the name of the factors. By default, Minitab names the factors alphabetically. 
Type: Show whether the factor is numeric or text. This column does not take any input. 
Levels: Shows the number of levels for each factor. This column does not take any input. 
Level Values: Enter numeric or text values for each level of the factor. By default, Minitab sets the levels of a factor to the 
integers 1, 2, 3, ... .  
 

Modify Design − Replicate 
Stat > DOE > Modify Design > Replicate design 
You can add up to ten replicates of your design. When you replicate a design, you duplicate the complete set of runs from 
the initial design. The runs that would be added to a two factor full factorial design are as follows:  

Initial design One replicate added 
(total of two replicates) 

Two replicates added 
(total of three replicates) 

A  B 

-  - 
+  + 
+  - 
-  + 

A  B 

-  - 
+  + 
+  - 
-  + 

-  - 
+  + 
+  - 
-  + 

A  B 

-  - 
+  + 
+  - 
-  + 

-  - 
+  + 
+  - 
-  + 

-  - 
+  + 
+  - 
-  + 

True replication provides an estimate of the error or noise in your process and may allow for more precise estimates of 
effects. 

Dialog box items 
Number of replicates to add: Choose a number up to ten. 
 

To replicate the design 
1    Choose Stat > DOE > Modify Design. 
2    Choose Replicate design and click Specify. 
3    From Number of replicates to add, choose a number up to 10. Click OK. 
 

Modify Design − Randomize Design 
Stat > DOE > Modify Design > choose Randomize design > Specify 
You can randomize the entire design or just randomize one of the blocks. For a general discussion of randomization, see 
Randomizing the design. 

More You can use Display Design to switch back and forth between a random and standard order display in the 
worksheet. 

Dialog box items 
Randomize entire design: Choose to randomize the runs in the data matrix. If your design is blocked, randomization is 
done separately within each block and then the blocks are randomized. 
Randomize just block: Choose to randomize one block, then choose the block to randomize from the drop-down list. 
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Base for random data generator: Enter a base for the random data generator. By entering a base for the random data 
generator, you can control the randomization so that you obtain the same pattern every time.  

Note If you use the same base on different computer platforms or with different versions of Minitab, you may not get 
the same random number sequence. 

 

To randomize the design 
1    Choose Stat > DOE > Modify Design. 
2    Choose Randomize design and click Specify.  
3    Do one of the following: 

•    Choose Randomize entire design. 
•    Choose Randomize just block, and choose a block number from the list. 

4    If you like, in Base for random data generator, enter a number. Click OK. 

Note You can use Stat > DOE > Display Design to switch back and forth between a random and standard order 
display in the worksheet. 

 

Modify Design − Fold Design 
Stat > DOE > Modify Design > choose Fold design > Specify 
Folding is a way to reduce confounding. Confounding occurs when you have a fractional factorial design and one or 
more effects cannot be estimated separately.  

Dialog box items 
Fold Design  

Fold on all factors: Choose to fold the design on all factors. 
Fold just on factor: Choose to fold the design on a single factor, then choose the factor from the list. 

 

To fold the design  
1    Choose Stat > DOE > Modify Design. 
2    Choose Fold design and click Specify.  
3    Do one of the following, then click OK. 

•    Choose Fold on all factors to make all main effects free from each other and all two-factor interactions. 
•    Choose Fold just on factors and then choose a factor from the list to make the specified factor and all its two-

factor interactions free from other main effects and two-factor interactions. 
 

Modify Design − Add Axial Points 
Stat > DOE > Modify Design > choose Add axial points > Specify 
You can add axial points to a two-level factorial design to "build" it up to a central composite design. The position of the 
axial points in a central composite design is denoted by α. The value of α, along with the number of center points, 
determines whether a design can be orthogonally blocked and is rotatable. For a discussion of axial points and the value 
of α, see Changing the value of α for a central composite design. 

Dialog box items 
Value of Alpha  

Default (rotatable if possible): Choose to have Minitab determine the value of alpha (α) based on the design you 
selected. The default value of α provides rotatability whenever possible.  

Face centered: Choose to generate a face-centered design (α = 1). 

Custom: Choose to specify the α value; then enter the desired value in coded units. A value less than 1 places the 
axial points inside the cube; a value greater than 1 places them outside the cube. 

Add the following number of center points (to the axial block): Enter a number. 
 

To add axial points 
1    Choose Stat > DOE > Modify Design. 
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2    Choose Add axial points and click Specify.  
3    Do one of the following: 

•    To have Minitab assign a value to α, choose Default. 
•    To set a equal to 1, choose Face Centered. When α = 1, the axial points are placed on the "cube" portion of the 

design. This is an appropriate choice when the "cube" points of the design are at the operational limits. 
•    Choose Custom and enter a positive number in the box. A value less than 1 places the axial points inside the 

"cube" portion of the design; a value greater than 1 places the axial points outside the "cube." 
4    If you want to add center points to the axial block, enter a number in Add the following number of center points (in 

the axial block). Click OK. 

Note If you a building up a factorial design into a central composite design and would like to consider the properties 
of orthogonal blocking and rotatability, use the table in Summary of central composite designs for guidance on 
choosing α and the number of center points to add. 

 

Display Design 
Display Design 
Stat > DOE > Display Design  
After you create the design, you can use Display Design to change the way the design points display in the worksheet. 
You can change the design points in two ways: 

•    display the points in either random or standard order. Standard order is the order of the runs if the experiment was 
done in Yates' order. Run order is the order of the runs if the experiment was done in random order. 

•    express the factor levels in coded or uncoded form. 

Dialog box items 
How to display the points in the worksheet  
Order for all points in the worksheet: Minitab sorts the worksheet columns according to the display method (random 
order or standard order) you select. By default, Minitab sorts a column if the number of rows is less than or equal to the 
number of rows in the design. Specify any columns that you do not want to reorder in the Columns Not to Reorder dialog 
box. Columns that have more rows than the design cannot be reordered. 

Run order for design: Choose to display points in run order. 
Standard order for design: Choose to display points in standard order. 

Units for factors  

Coded units: Choose to display the design points in coded units. Minitab sets the low level of all factors to −1, the high 
level to +1, and center points to 0. 
Uncoded Units: Choose to display the design points in uncoded units. The levels that you assigned in the Factors 
subdialog box will display in the worksheet. 

 

To change the display order of points in the worksheet 
1    Choose Stat > DOE > Display Design.  
2    Choose Run order for the design or Standard order for the design. If you do not randomize a design, the columns 

that contain the standard order and run order are the same. 
3    Do one of the following: 

•    If you want to reorder all worksheet columns that are the same length as the design columns, click OK. 
•    If you have worksheet columns that you do not want to reorder:  

1    Click Options.  

2    In Exclude the following columns when sorting, enter the columns. These columns cannot be part of the 
design. Click OK twice. 

 

To change the units for the factors 
If you assigned factor levels in Factors subdialog box, the uncoded or actual levels are initially displayed in the worksheet. 
If you did not assign factor levels, the coded and uncoded units are the same.  
1    Choose Stat > DOE > Display Design. 
2    Choose Coded units or Uncoded units. Click OK. 
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Response Surface Designs 
Response Surface Designs Overview  
Response surface methods are used to examine the relationship between one or more response variables and a set of 
quantitative experimental variables or factors. These methods are often employed after you have identified a "vital few" 
controllable factors and you want to find the factor settings that optimize the response. Designs of this type are usually 
chosen when you suspect curvature in the response surface. 
Response surface methods may be employed to 

•    find factor settings (operating conditions) that produce the "best" response 

•    find factor settings that satisfy operating or process specifications 

•    identify new operating conditions that produce demonstrated improvement in product quality over the quality achieved 
by current conditions 

•    model a relationship between the quantitative factors and the response 
Many response surface applications are sequential in nature in that they require more than one stage of experimentation 
and analysis. The steps shown below are typical of a response surface experiment. Depending on your experiment, you 
may carry out some of the steps in a different order, perform a given step more than once, or eliminate a step. 
1    Choose a response surface design for the experiment. Before you begin using Minitab, you must determine what the 

influencing factors are, that is, what the process conditions are that influence the values of the response variable. See 
Choosing a Design. 

2    Use Create Response Surface Design to generate a central composite or Box-Behnken design. 
Use Define Custom Response Surface Design to create a design from data you already have in the worksheet. 
Custom designs allows you to specify which columns are your factors and other design characteristics. You can then 
easily fit a model to the design and generate plots. 

3    Use Modify Design to rename the factors, change the factor levels, replicate the design, and randomize the design.  

4    Use Display Design to change the order of the runs and the units in which Minitab expresses the factors in the 
worksheet.  

5    Perform the experiment and collect the response data. Then, enter the data in your Minitab worksheet. See Collecting 
and Entering Data. 

6    Use Analyze Response Surface Design to fit a model to the experimental data.  
7    Use Contour/Surface Plots to visualize response surface patterns. You can display contour and surface plots. 
8    If you are trying to optimize responses, use Response Optimizer or Overlaid Contour Plot to obtain a numerical and 

graphical analysis.  
 

Choosing a response surface design  
Before you use Minitab, you need to determine what design is most appropriate for your experiment. Choosing your 
design correctly will ensure that the response surface is fit in the most efficient manner. Minitab provides central 
composite and Box-Behnken designs. When choosing a design you need to  

•    identify the number of factors that are of interest. 

•    determine the number of runs you can perform. 

•    ensure adequate coverage of the experimental region of interest 

•    determine the impact that other considerations (such as cost, time, or the availability of facilities) have on your choice 
of a design. 

Depending on your problem, there are other considerations that make a design desirable. You need to choose a design 
that shows consistent performance in the criteria that you consider important, such as the ability to 

•    increase the order of the design sequentially. 

•    perform the experiment in orthogonal blocks. Orthogonally blocked designs allow for model terms and block effects to 
be estimated independently and minimize the variation in the estimated coefficients. 

•    rotate the design. Rotatable designs provide the desirable property of constant prediction variance at all points that are 
equidistant from the design center, thus improving the quality of the prediction. 

•    detect model lack of fit. 

More Our intent is to provide only a brief introduction to response surface methods. There are many resources that 
provide a thorough treatment of these designs. For a list of resources, see References. 
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Create Response Surface Design 
Central composite 
Create Response Surface Design 
Stat > DOE > Response Surface > Create Response Surface Design 
Generates central composite and Box-Behnken response surface designs. 

Dialog box items 
Type of Data  

Central Composite: Choose to create a central composite design. 
Box-Behnken: Choose to create a Box-Behnken design. 

Number of factors: Specify the number of factors in the design you want to generate. 
 

Central composite designs 
You can create blocked or unblocked central composite designs. Central composite designs consist of  

•    2K or 2K-1 factorial points (also called cube points), where K is the number of factors 

•    axial points (also called star points) 

•    center points 
A central composite design with two factors is shown below. Points on the diagrams represent the experimental runs that 
are performed: 

        

The points in the factorial 
portion of the design are 
coded to be −1 and +1. 

The points in the axial (star) portion of 
the design are at:(+ α, 0), (−α, 0), 
(0,+ α), (0,− α) 

Here, the factorial and axial 
portions along with the center point 
are shown. The design center is at 
(0,0). 

Central composite designs are often recommended when the design plan calls for sequential experimentation because 
these designs can incorporate information from a properly planned factorial experiment. The factorial and center points 
may serve as a preliminary stage where you can fit a first-order (linear) model, but still provide evidence regarding the 
importance of a second-order contribution or curvature. 
You can then build the factorial portion of the design up into a central composite design to fit a second-degree model by 
adding axial and center points. Central composite designs allow for efficient estimation of the quadratic terms in the 
second-order model, and it is also easy to obtain the desirable design properties of orthogonal blocking and rotatability.  

More Orthogonally blocked designs allow for model terms and block effects to be estimated independently and 
minimize the variation in the regression coefficients. Rotatable designs provide the desirable property of 
constant prediction variance at all points that are equidistant from the design center, thus improving the quality 
of the prediction. 

 

To create a response surface design 
1    Choose Stat > DOE > Response Surface > Create Response Surface Design. 
2    If you want to see a summary of the response surface designs, click Display Available Designs. Use this table to 

compare design features. Click OK.  
3    Under Type of Design, choose Central composite or Box-Behnken. 
4    From Number of factors, choose a number: 

•    for a central composite design, choose a number from 2 to 9 
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•    for a Box-Behnken design, choose a number from 3 to 7 
5    Click Designs. The subdialog box that displays depends whether you choose Central composite or Box-Behnken in 

step 3.  
6    Do one of the following: 

•    for a central composite design, choose the design you want to create from the list shown at the top of the 
subdialog box  

•    for a Box-Behnken design, you do not have to choose a design because the number of factors determines the 
number of runs  

7    If you like, use any of the options in the Design subdialog box. 
8    Click OK even if you do not change any of the options. This selects the design and brings you back to the main dialog 

box. 
9    If you like, click Options, Factors, or Results to use any of the dialog box options, then click OK to create your 

design. 

Note Summary of central composite designs shows the central composite designs you can generate with Create 
Response Surface Design. The default values of α provide orthogonal blocking and, whenever possible, 
rotatability. The "cube" portions of central composite designs are identical to those generated by Create 
Factorial Design with the same number of center points and blocks. Thus, a design generated by Create 
Factorial Design with the same number of runs, center points, and blocks can be built up into an orthogonally-
blocked central composite design.  

Any factorial design with the right number of runs and blocks can be built up into a blocked central composite 
design. However, to make the blocks orthogonal, Create Factorial Design must use the number of center points 
shown in Summary of central composite designs. 

 

Create Response Surface Design − Available Designs 
Stat > DOE > Response Surface > Create Response Surface Design > Display Available Designs 
Displays a table to help you select an appropriate design, based on 

•    the number of factors that are of interest 

•    the number of runs you can perform 
This dialog box does not take any input.  
 

Create Response Surface Design − Central Composite Design 
Stat > DOE > Response Surface < Create Response Surface Design > choose Central composite > Designs  

Generates central composite designs for 2 to 9 factors. You can also add center points and specify a value for α. 

Dialog box items 
The list box at the top of the Design subdialog box shows all available designs for the number of factors you selected in 
the main Create Response Surface Design dialog box. Highlight your design choice. The design you choose will affect the 
possible dialog and subdialog box options. 
Number of Center Points Adds the specified number of center points to the design. If the design is blocked the center 
points are divided equally among the blocks. If the number specified is not a multiple of the number of blocks, then each 
of the last few blocks will have one less point than the other blocks. 

Default: Choose to have Minitab determine the number of center points based on the design you specified. See the 
text box at the top of this dialog box for the default number of center points. 
Custom: Choose to specify the number of center points you want to add to your base design (before replicates are 
added to the design).  

Cube block: Enter the number of center points for the cube blocks.  
Axial block:  Enter the number of center points for the axial block. 

Tip Use <Tab> to move between the boxes. 

Value of Alpha  

Default: Choose to have Minitab determine the value of alpha (α) based on the design you selected. See the text box 
at the top of this dialog box for the default value. The default values of alpha provide orthogonal blocking and, 
whenever possible, rotatability. 

Face centered: Choose to generate a face-centered design (α = 1). 

Custom: Choose to specify the α value; then enter the desired value. A value less than 1 places the axial points inside 
the cube; a value greater than 1 places them outside the cube. 
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Number of replicates: Enter the number of replicates up to 50.  
Block on replicates: Check to block the design on replicates. If your design has no existing blocks, Minitab places 
each set of replicates in a separate block. If your design already includes blocks, Minitab replicates the existing 
blocking scheme, placing replicates in new blocks. For more information, see Blocking a Central Composite Design.   

 

Blocking a Central Composite Design  
When the number of runs is too large to be completed under steady state conditions, you need to be concerned with the 
error that may be introduced into the experiment. Running an experiment in blocks allows you to separately and 
independently estimate the block effects (or different experimental conditions) from the factor effects. For example, blocks 
might be days, suppliers, batches of raw material, machine operators, or manufacturing shift. 
For a central composite design, the number of orthogonal blocks depends on the number of factors, the number of runs, 
and the design fraction you choose. A central composite design can always be separated into a factorial block and an 
axial point block. With three or more factors, the factorial block can also be divided into two or more blocks. When you are 
creating a design, Minitab displays the appropriate choices.  
If you add replicates to your design, you can also block on replicates. How this works depends on whether you have 
existing blocks in your design.  

•    If your design does not already include blocks, Minitab places each set of replicates in separate blocks. 

•    If your design already includes blocks, Minitab replicates the existing blocking scheme. The points in each existing 
block are replicated to form new blocks. The number of blocks in your design will equal the number of original blocks 
multiplied by the number of replicates. The number of runs in each block stays the same. 

•    If your design already includes blocks but you do not block on replicates, Minitab replicates the points within each 
block. The total number of runs in the each block equals the number of original runs times the number of replicates. 
The total number of blocks in the design stays the same. 

More The value of α, in combination with the number of center points, determines whether a design exhibits the 
properties of rotatability and orthogonal blocking. Minitab provides default designs that achieve rotatability and 
orthogonal blocking, when both properties can be achieved simultaneously. When the design is blocked and 
you cannot achieve both properties simultaneously, the default designs provide for orthogonal blocking.  

 

Changing the value of α for a central composite design 
The position of the axial points in a central composite design is denoted by α. The value of α, along with the number of 
center points, determines whether a design can be orthogonally blocked and is rotatable. Orthogonally blocked designs 
allow for model terms and block effects to be estimated independently and minimize the variation in the regression 
coefficients. Rotatable designs provide the desirable property of constant prediction variance at all points that are 
equidistant from the design center, thus improving the quality of the prediction. 
Minitab's default designs achieve rotatability and orthogonal blocking when both properties can be achieved 
simultaneously. When the design is blocked and you cannot achieve both properties simultaneously, the default designs 
use α such that the design is orthogonally blocked. When there are no blocks, the default designs use α such that the 
design is rotatable. 

The default value for α for each central composite design in Summary of central composite designs. 
 

To change the default value of α 
1    In the Create Response Surface Design dialog box, click Designs. 
2    Do one of the following, then click OK. 

•    To set α equal to 1, choose Face Centered. When α = 1, the axial points are placed on the "cube" portion of the 
design. This is an appropriate choice when the "cube" points of the design are at the operational limits. 

•    Choose Custom and enter a positive number in the box. A value less than one places the axial points inside the 
"cube" portion of the design; a value greater than one places the axial points outside the "cube." 

Note A value of α = (F)**1/4, where F is the number of factorial points in the design, guarantees rotatability. 

 

Changing the number of center points 
The number of center points, along with α (for a central composite design), determines whether or not a design can be 
orthogonally blocked. By default, Minitab chooses the number of center points to achieve orthogonal blocking.  
The inclusion of center points provides an estimate of experimental error and allows you to check the adequacy of the 
model (lack of fit). Checking the adequacy of the fitted model is important as an incorrect or under-specified model can 
result in misleading conclusions. 
The default number of center points is shown in the Designs subdialog box. For a table showing the default number of 
center points for all designs, see Summary of central composite designs and Box-Behnken designs. 
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Note When a Box-Behnken design is blocked, the center points are divided equally (as much as possible) among 
the blocks. 

 

To change the default number of center points 
1    In the Create Response Surface Design dialog box, click Designs.  
2    Do one of the following, then click OK. 

•    For a central composite design, under Number of center points choose Custom and enter a number in Cube 
block. When you have more than one block in your design, you also need to enter a number to indicate the 
number of center points in Axial block.  

•    For a Box-Behnken design, under Number of center points choose Custom and enter a number in the box.  

Note When a Box-Behnken design is blocked, the center points are divided equally (as much as possible) among 
the blocks. 

 

Create Response Surface Design − Factors 
Stat > DOE > Response Surface > Create Response Surface Design > choose Central composite > Factors 
Names the factors and assign values for factor settings.  

Dialog box items 
Levels define  

Cube points: Choose if the factor settings represent the cube points in your design. 
Axial points: Choose if the factor settings represent the axial points in your design. 

Factor: Shows the number of factors you have chosen for your design. This column does not take any input. 
Name: Enter text to change the name of the factors. By default, Minitab names the factors alphabetically.  
Low: Enter a numeric value for the low setting of each factor.  
High: Enter a numeric value for the high setting of each factor.  
 

To name factors 
1    In the Create Response Surface Design dialog box, click Factors. 
2    Under Name, click in the first row and type the name of the first factor. Then, use the arrow key to move down the 

column and enter the remaining factor names. Click OK. 

More After you have created the design, you can change the factor names by typing new names in the Data window 
or with Modify Design. 

 

Setting factor levels 
In a response surface design, you designate a low level and a high level for each factor. These factor levels define the 
proportions of the "cube" around which the design is built. The "cube" is often centered around the current operating 
conditions for the process. For a central composite design, you may have design points inside the "cube," on the "cube," 
or outside the "cube." For a Box-Behnken design, the factor levels are the lowest and highest points in the design. See 
the illustrations in Central composite designs and Box-Behnken designs. 

By default, Minitab sets the low level of all factors to −1 and high level to +1. 

Note In a central composite design, the values you enter for the factor levels are usually not the minimum and 
maximum values in the design. They are the low and high settings for the "cube" portion of the design. The 
axial points are usually outside the "cube" (unless you specify an α that is less than or equal to 1). If you are 
not careful, this could lead to axial points that are not in the region of interest or may be impossible to run. 

Choosing Axial points in the Factors subdialog box guarantees all of the design points will fall between the defined 
minimum and maximum value for the factor(s). Minitab will then determine the appropriate low and high settings for the 
"cube" as follows: 

(α − 1) max + (α + 1) min 
Low Level Setting =  

2 ∗ α 

(α − 1) min + (α + 1) max 
High Level Setting =  

2 ∗ α 

More To change the factor levels after you have created the design, use Modify Design.
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To assign factor levels 
1    In the Create Response Surface Design dialog box, click Factors. 
2    Under Low, click in the row for the factor you would like to assign values and enter any numeric value. Use the arrow 

key to move to High and enter a numeric value that is greater than the value you entered in Low. 
3    Repeat step 2 to assign levels for other factors. 
4    For a central composite design, under Levels Define, choose Cube points or Axial points to specify which values 

you entered in Low and High. Click OK.  
 

Create Response Surface Design − Options 
Stat > DOE > Response Surface > Create Response Surface Design > Options 
Allows you to randomize the design, and store the design (and design object) in the worksheet.  

Dialog box items 
Randomize runs: Check to randomize the run order of the design. 

Base for random data generator: Enter a base for the random data generator. By entering a base for the random 
data generator, you can control the randomization so that you obtain the same pattern every time.  

Note If you use the same base on different computer platforms or with different versions of Minitab, you may not get 
the same random number sequence. 

Store design in worksheet: Check to store the design in the worksheet. When you open this dialog box, the "Store 
design in worksheet" option is checked. If you want to analyze a design, you must store it in the worksheet. 
 

Storing the design 
If you want to analyze a design, you must store it in the worksheet. By default, Minitab stores the design. If you want to 
see the properties of various designs before selecting the design you want to store, uncheck Store design in worksheet 
in the Options subdialog box.  
Every time you create a design, Minitab reserves and names the following columns: 

•    C1 (StdOrder) stores the standard order. 

•    C2 (RunOrder) stores run order. 

•    C3 (PtType) stores the point type. The codes are: 0 is a center point, 1 is a cube point, -1 is a axial point, and 2 is an 
edge centroid point.    

•    C4 (Blocks) stores the blocking variable. When the design is not blocked, Minitab sets all column values to one. 

•    C5 − Cn stores the factors. Minitab stores each factor in your design in a separate column.  
If you named the factors, these names display in the worksheet. If you did not provide names, Minitab names the factors 
alphabetically. After you create the design, you can change the factor names directly in the Data window or with Modify 
Design.  
If you did not assign factor levels in Factors subdialog box, Minitab stores factor levels in coded form (all factor levels are 
−1 or +1). If you assigned factor levels, the uncoded levels display in the worksheet. To switch back and forth between a 
coded and an uncoded display, use Display Design.  

Caution When you create a design using Create Response Surface Design, Minitab stores the appropriate design 
information in the worksheet. Minitab needs this stored information to analyze and plot data. If you want to use 
Analyze Response Surface Design, you must follow certain rules when modifying the worksheet data. See 
Modifying and Using Worksheet Data.  

If you make changes that corrupt your design, you may still be able to analyze it with Analyze Response 
Surface Design after you use Define Custom Response Surface Design. 

 

Create Response Surface Design − Results 
Stat > DOE > Response Surface > Create Response Surface Design > Results 
You can control the output displayed in the Session window. 

Dialog box items 
Printed Results  

None: Choose to suppress display of results. Minitab stores all requested items. 
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Summary table: Choose to display a summary of the design. The summary includes the number of factors, runs, 
blocks, replicates, cube points, axial points, center points in cube and axial, and the value of α. 
Summary and design table: Choose to display a summary of the design and a table with the factors and their settings 
at each run. 

 

Summary of central composite designs 
Summary of the designs generated by the central composite design commands: 

 
 
factors 

 
 
design 

 
total  
runs 

 
total  
blocks 

 
cube  
blocks 

 
cube 
runs 

total  
center 
points 

cube 
center 
points 

axial  
center 
points 

 
default 
alpha 

 
orthogonal 
blocks 

 
 
rotatable 

2 Full 13 1 --- 4 5 --- 0 1.414 --- y 
2 Full 14 2 1 4 6 3 3 1.414 y y 
3 Full 14 1 --- 8 6 --- 0 1.682 --- y 
3 Full 20 2 1 8 6 4 2 1.633 y n 
3 Full 20 3 2 8 6 4 2 1.633 y n 
4 Full 31 1 --- 16 7 --- 0 2.000 --- y 
4 Full 30 2 1 16 6 4 2 2.000 y y 
4 Full 30 3 2 16 6 4 2 2.000 y y 
5 Full 52 1 --- 32 10 --- 0 2.378 --- y 
5 Full 54 2 1 32 12 8 4 2.366 y n 
5 Full 54 3 2 32 12 8 4 2.366 y n 
5 Half 32 1  16 6 --- 0 2.000  y 
5 Half 33 2 1 16 7 6 1 2.000 y y 
6 Full 90 1 --- 64 14 --- 0 2.828 --- y 
6 Full 90 2 1 64 14 8 6 2.828 y y 
6 Full 90 3 2 64 14 8 6 2.828 y y 
6 Full 90 5 4 64 14 8 6 2.828 y y 
6 Half 53 1 --- 32 9 --- 0 2.378 --- y 
6 Half 54 2 1 32 10 8 2 2.366 y n 
6 Half 54 3 2 32 10 8 2 2.366 y n 
7 Full 152 1 --- 128 10 --- 0 3.364 --- y 
7 Full 160 2 1 128 18 8 10 3.364 y y 
7 Full 160 3 2 128 18 8 10 3.364 y y 
7 Full 160 5 4 128 18 8 10 3.364 y y 
7 Half 88 1 --- 64 10 --- 0 2.828 --- y 
7 Half 90 2 1 64 12 8 4 2.828 y y 
7 Half 90 3 2 64 12 8 4 2.828 y y 
7 Half 90 5 4 64 12 8 4 2.828 y y 
8 Half 154 1 --- 128 10 --- 0 3.364 --- y 
8 Half 160 2 1 128 16 8 8 3.364 y y 
8 Half 160 3 2 128 16 8 8 3.364 y y 
8 Half 160 5 4 128 16 8 8 3.364 y y 
8 Quarter 90 1 --- 64 10 --- 0 2.828 --- y 
8 Quarter 90 2 1 64 10 8 2 2.828 y y 
8 Quarter 90 3 2 64 10 8 2 2.828 y y 
8 Quarter 90 5 4 64 10 8 2 2.828 y y 
9 Quarter 156 1 --- 128 10 --- 0 3.364 --- y 
9 Quarter 160 2 1 128 14 8 6 3.364 y y 
9 Quarter 160 3 2 128 14 8 6 3.364 y y 
9 Quarter 160 5 4 128 14 8 6 3.364 y y 
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Example of creating a central composite design 
Suppose you want to conduct an experiment to maximize crystal growth. You have determined that three variables − time 
the crystals are exposed to a catalyst, temperature in the exposure chamber, and percentage of the catalyst in the air 
inside the chamber − explain much of the variability in the rate of crystal growth. 
You generate the default central composite design for three factors and two blocks (to represent the two days you conduct 
the experiment). You assign the factor levels and randomize the design. 
1    Choose Stat > DOE > Response Surface > Create Response Surface Design. 
2    Under Type of Design, choose Central composite. 
3    From Number of factors, choose 3. 
4    Click Designs. To create the design with 2 blocks, highlight the second row in the Design box at the top. Click OK. 
5    Click Factors. Complete the Name, Low, and High columns of the table as shown below: 

Factors Names Low High 
A Time 6 9 
B Temperature 40 60 
C Catalyst 3.5 7.5 

6    Click OK. 
7    Click Results. Choose Summary table and design table. Click OK in each dialog box. 

Session window output 

Central Composite Design 
 
 
Factors:       3     Replicates:     1
Base runs:    20     Total runs:    20
Base blocks:   2     Total blocks:   2
 
Two-level factorial: Full factorial 
 
Cube points:             8 
Center points in cube:   4 
Axial points:            6 
Center points in axial:  2 
 
Alpha: 1.633 
 
 
Design Table (randomized) 
 
Run  Blk       A       B       C 
  1    1   1.000   1.000   1.000 
  2    1  -1.000   1.000   1.000 
  3    1   1.000  -1.000  -1.000 
  4    1   0.000   0.000   0.000 
  5    1   0.000   0.000   0.000 
  6    1  -1.000   1.000  -1.000 
  7    1   1.000   1.000  -1.000 
  8    1   0.000   0.000   0.000 
  9    1   0.000   0.000   0.000 
 10    1  -1.000  -1.000  -1.000 
 11    1   1.000  -1.000   1.000 
 12    1  -1.000  -1.000   1.000 
 13    2   1.633   0.000   0.000 
 14    2   0.000   0.000   0.000 
 15    2  -1.633   0.000   0.000 
 16    2   0.000   1.633   0.000 
 17    2   0.000  -1.633   0.000 
 18    2   0.000   0.000   1.633 
 19    2   0.000   0.000   0.000 
 20    2   0.000   0.000  -1.633 

Interpreting the results 
You have created a central composite design with three factors that will be run in two blocks. This design is both rotatable 
and orthogonally blocked − see Central composite designs.  
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Because you chose to display the summary and design tables, Minitab shows the experimental conditions or settings for 
each of the factors for the design points. When you perform the experiment, use the order that is shown to determine the 
conditions for each run. For example, in the first run of your experiment, you would set the time (A) at 9 minutes (1 = 
high), the temperature (B) at 60° (1 = high), and use 7.5 grams of the catalyst (C) (1 = high).  
Minitab randomizes the design by default, so if you try to replicate this example, your run order may not match the order 
shown. 
 

Box-Behnken 
Create Response Surface Design 
Stat > DOE > Response Surface > Create Response Surface Design 
Generates central composite and Box-Behnken response surface designs. 

Dialog box items 
Type of Data  

Central Composite: Choose to create a central composite design. 
Box-Behnken: Choose to create a Box-Behnken design. 

Number of factors: Specify the number of factors in the design you want to generate. 
 

Box-Behnken designs 
You can create blocked or unblocked Box-Behnken designs. The illustration below shows a three-factor Box-Behnken 
design. Points on the diagram represent the experimental runs that are performed: 

 
You may want to use Box-Behnken designs when performing non-sequential experiments. That is, you are only planning 
to perform the experiment once. These designs allow efficient estimation of the first- and second-order coefficients. 
Because Box-Behnken designs have fewer design points, they are less expensive to run than central composite designs 
with the same number of factors. 
Box-Behnken designs can also prove useful if you know the safe operating zone for your process. Central composite 
designs usually have axial points outside the "cube" (unless you specify an a that is less than or equal to one). These 
points may not be in the region of interest, or may be impossible to run because they are beyond safe operating limits. 
Box-Behnken designs do not have axial points, thus, you can be sure that all design points fall within your safe operating 
zone. Box-Behnken designs also ensure that all factors are never set at their high levels simultaneously. 
 

To create a response surface design 
1    Choose Stat > DOE > Response Surface > Create Response Surface Design. 
2    If you want to see a summary of the response surface designs, click Display Available Designs. Use this table to 

compare design features. Click OK.  
3    Under Type of Design, choose Central composite or Box-Behnken. 
4    From Number of factors, choose a number: 

•    for a central composite design, choose a number from 2 to 9 
•    for a Box-Behnken design, choose a number from 3 to 7 

5    Click Designs. The subdialog box that displays depends whether you choose Central composite or Box-Behnken in 
step 3.  

6    Do one of the following: 
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•    for a central composite design, choose the design you want to create from the list shown at the top of the 
subdialog box  

•    for a Box-Behnken design, you do not have to choose a design because the number of factors determines the 
number of runs  

7    If you like, use any of the options in the Design subdialog box. 
8    Click OK even if you do not change any of the options. This selects the design and brings you back to the main dialog 

box. 
9    If you like, click Options, Factors, or Results to use any of the dialog box options, then click OK to create your 

design. 

Note Summary of central composite designs shows the central composite designs you can generate with Create 
Response Surface Design. The default values of α provide orthogonal blocking and, whenever possible, 
rotatability. The "cube" portions of central composite designs are identical to those generated by Create 
Factorial Design with the same number of center points and blocks. Thus, a design generated by Create 
Factorial Design with the same number of runs, center points, and blocks can be built up into an orthogonally-
blocked central composite design.  

Any factorial design with the right number of runs and blocks can be built up into a blocked central composite 
design. However, to make the blocks orthogonal, Create Factorial Design must use the number of center points 
shown in Summary of central composite designs. 

 

Create Response Surface Design − Available Designs 
Stat > DOE > Response Surface > Create Response Surface Design > Display Available Designs 
Displays a table to help you select an appropriate design, based on 

•    the number of factors that are of interest 

•    the number of runs you can perform 
This dialog box does not take any input.  
 

Create Response Surface Design − Box-Behnken Design 
Stat > DOE > Response Surface > Create Response Surface Design > choose Box-Behnken > Designs 

You can generate a Box-Behnken design for 3 − 7 factors. You can also block the design and change the number of 
center points. 

Dialog box items 
Number of center Points Adds the specified number of center points to the design. If the design is blocked the center 
points are divided equally among the blocks. If the number specified is not a multiple of the number of blocks, then each 
of the last few blocks will have one less point than the other blocks. 

Default: Choose to have Minitab determine the number of center points based on the design you specified. Minitab 
displays the default number of center points. 
Custom: Choose to specify the number of center points you want to add to your design; then enter the value (up to 50) 
in the box. 

Number of blocks: Choose a value other than 1 to block the design. See Blocking the design. 
Number of replicates: Enter a number up to 50.  

Block on replicates: Check to block the design on replicates. If your design does not include other blocks, each set of 
replicates is placed in a separate block. If your design does include blocks, Minitab replicates the blocking scheme, 
placing replicates in new blocks. For more information, see Blocking a Central Composite Design. 

 

Blocking a Box-Behnken Design  
When the number of runs is too large to be completed under steady state conditions, you need to be concerned with the 
error that may be introduced into the experiment. Running an experiment in blocks allows you to separately and 
independently estimate the block effects (or different experimental conditions) from the factor effects. For example, blocks 
might be days, suppliers, batches of raw material, machine operators, or manufacturing shift. 
For a Box-Behnken design, the number of ways to block a design depends on the number of factors. All of the blocked 
designs have orthogonal blocks. When you are creating a design, Minitab displays the appropriate choices. A design with: 

•    Three factors cannot be blocked  

•    Four factors can be run in three blocks 

•    Five, six, or seven factors can be run in two blocks 
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If you add replicates to your design, you can also block on replicates. How this works depends on whether you have 
blocks in your design.  

•    If your design does not have blocks, Minitab places each set of replicates in separate blocks. 

•    If your design includes blocks, Minitab replicates the existing blocking scheme. The points in each existing block are 
replicated to form new blocks. The number of blocks in your design will equal the number of original blocks multiplied 
by the number of replicates. The number of runs in each block stays the same. 

•    If your design includes blocks but you do not block on replicates, Minitab replicates the points within each block. The 
total number of runs in the each block equals the number of original runs times the number of replicates. The total 
number of blocks in the design stays the same. 

 
 

Changing the number of center points 
The number of center points, along with α (for a central composite design), determines whether or not a design can be 
orthogonally blocked. By default, Minitab chooses the number of center points to achieve orthogonal blocking.  
The inclusion of center points provides an estimate of experimental error and allows you to check the adequacy of the 
model (lack of fit). Checking the adequacy of the fitted model is important as an incorrect or under-specified model can 
result in misleading conclusions. 
The default number of center points is shown in the Designs subdialog box. For a table showing the default number of 
center points for all designs, see Summary of central composite designs and Box-Behnken designs. 

Note When a Box-Behnken design is blocked, the center points are divided equally (as much as possible) among 
the blocks. 

 

To change the default number of center points 
1    In the Create Response Surface Design dialog box, click Designs.  
2    Do one of the following, then click OK. 

•    For a central composite design, under Number of center points choose Custom and enter a number in Cube 
block. When you have more than one block in your design, you also need to enter a number to indicate the 
number of center points in Axial block.  

•    For a Box-Behnken design, under Number of center points choose Custom and enter a number in the box.  

Note When a Box-Behnken design is blocked, the center points are divided equally (as much as possible) among 
the blocks. 

 

Create Response Surface Design − Factors 
Stat > DOE > Response Surface > Create Response Surface Design > choose Box-Behnken > Factors  
Names the factors and assign values for factor settings.  

Dialog box items 
Factor: Shows the number of factors you have chosen for your design. This column does not take any input. 
Name: Enter text to change the name of the factors. By default, Minitab names the factors alphabetically. 
Low: Enter a numeric value for the low setting of each factor.  
High: Enter a numeric value for the high setting of each factor.  
 

To name factors 
1    In the Create Response Surface Design dialog box, click Factors. 
2    Under Name, click in the first row and type the name of the first factor. Then, use the arrow key to move down the 

column and enter the remaining factor names. Click OK. 

More After you have created the design, you can change the factor names by typing new names in the Data window 
or with Modify Design. 

 

Setting factor levels 
In a response surface design, you designate a low level and a high level for each factor. These factor levels define the 
proportions of the "cube" around which the design is built. The "cube" is often centered around the current operating 
conditions for the process. For a central composite design, you may have design points inside the "cube," on the "cube," 
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or outside the "cube." For a Box-Behnken design, the factor levels are the lowest and highest points in the design. See 
the illustrations in Central composite designs and Box-Behnken designs. 

By default, Minitab sets the low level of all factors to −1 and high level to +1. 

Note In a central composite design, the values you enter for the factor levels are usually not the minimum and 
maximum values in the design. They are the low and high settings for the "cube" portion of the design. The 
axial points are usually outside the "cube" (unless you specify an α that is less than or equal to 1). If you are 
not careful, this could lead to axial points that are not in the region of interest or may be impossible to run. 

Choosing Axial points in the Factors subdialog box guarantees all of the design points will fall between the defined 
minimum and maximum value for the factor(s). Minitab will then determine the appropriate low and high settings for the 
"cube" as follows: 

(α − 1) max + (α + 1) min 
Low Level Setting =  

2 ∗ α 
(α − 1) min + (α + 1) max 

High Level Setting =  
2 ∗ α 

More To change the factor levels after you have created the design, use Modify Design.

 

To assign factor levels 
1    In the Create Response Surface Design dialog box, click Factors. 
2    Under Low, click in the row for the factor you would like to assign values and enter any numeric value. Use the arrow 

key to move to High and enter a numeric value that is greater than the value you entered in Low. 
3    Repeat step 2 to assign levels for other factors. 
4    For a central composite design, under Levels Define, choose Cube points or Axial points to specify which values 

you entered in Low and High. Click OK.  
 

Create Response Surface Design − Options 
Stat > DOE > Response Surface > Create Response Surface Design > Options 
Allows you to randomize the design, and store the design (and design object) in the worksheet.  

Dialog box items 
Randomize runs: Check to randomize the run order of the design. 

Base for random data generator: Enter a base for the random data generator. By entering a base for the random 
data generator, you can control the randomization so that you obtain the same pattern every time.  

Note If you use the same base on different computer platforms or with different versions of Minitab, you may not get 
the same random number sequence. 

Store design in worksheet: Check to store the design in the worksheet. When you open this dialog box, the "Store 
design in worksheet" option is checked. If you want to analyze a design, you must store it in the worksheet. 
 

Storing the design 
If you want to analyze a design, you must store it in the worksheet. By default, Minitab stores the design. If you want to 
see the properties of various designs before selecting the design you want to store, uncheck Store design in worksheet 
in the Options subdialog box.  
Every time you create a design, Minitab reserves and names the following columns: 

•    C1 (StdOrder) stores the standard order. 

•    C2 (RunOrder) stores run order. 

•    C3 (PtType) stores the point type. The codes are: 0 is a center point, 1 is a cube point, -1 is a axial point, and 2 is an 
edge centroid point.    

•    C4 (Blocks) stores the blocking variable. When the design is not blocked, Minitab sets all column values to one. 

•    C5 − Cn stores the factors. Minitab stores each factor in your design in a separate column.  
If you named the factors, these names display in the worksheet. If you did not provide names, Minitab names the factors 
alphabetically. After you create the design, you can change the factor names directly in the Data window or with Modify 
Design.  
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If you did not assign factor levels in Factors subdialog box, Minitab stores factor levels in coded form (all factor levels are 
−1 or +1). If you assigned factor levels, the uncoded levels display in the worksheet. To switch back and forth between a 
coded and an uncoded display, use Display Design.  

Caution When you create a design using Create Response Surface Design, Minitab stores the appropriate design 
information in the worksheet. Minitab needs this stored information to analyze and plot data. If you want to use 
Analyze Response Surface Design, you must follow certain rules when modifying the worksheet data. See 
Modifying and Using Worksheet Data.  

If you make changes that corrupt your design, you may still be able to analyze it with Analyze Response 
Surface Design after you use Define Custom Response Surface Design. 

 

Create Response Surface Design − Results 
Stat > DOE > Response Surface > Create Response Surface Design > Results 
You can control the output displayed in the Session window. 

Dialog box items 
Printed Results  

None: Choose to suppress display of results. Minitab stores all requested items. 
Summary table: Choose to display a summary of the design. The summary includes the number of factors, runs, 
blocks, replicates, cube points, axial points, center points in cube and axial, and the value of α. 
Summary and design table: Choose to display a summary of the design and a table with the factors and their settings 
at each run. 

 

Summary of Box-Behnken designs 
The table below displays a summary of the Box-Behnken designs that are generated by Minitab. 

number of factors number of runs optional number of 
blocks 

default number of 
center points 

3 15 1 3 

4 27 3 3 

5 46 2 3 

6 54 2 6 

7 62 2 6 

 

Example of creating a Box-Behnken design 
Suppose you have a process for pressure treating utility poles with creosote. In the treating step of the process, you place 
air-dried poles inside a treatment chamber. The pressure in the chamber is increased and the chamber is flooded with hot 
creosote. The poles are left in the chamber until they have absorbed 12 pounds of creosote per cubic foot. You would like 
to experiment with different settings for the pressure, temperature of the creosote, and time in the chamber. Your goal is 
to get the creosote absorption as close to 12 pounds per cubic foot as possible, with minimal variation. Previous 
investigation suggests that the response surface for absorption exhibits curvature. 
The chamber will withstand internal pressures up to 220 psi, although the strain on equipment is pronounced at over 200 
psi. The current operating value is at 175 psi, so you feel comfortable with a range of values between 150 and 200. 
Current operating values for temperature and time are 210 degrees F and 5 hours, respectively. You feel that temperature 
cannot vary by more than 10° from the current value. Time can be varied from 4 to 6 hours. 
A Box-Behnken design is a practical choice when you cannot run all of the factors at their high (or low) levels at the same 
time. Here, the high level for pressure is already at the limit of what the chamber can handle. If temperature were also at 
its high level, this increases the effective pressure, and running at these settings for a long period of time is not 
recommended. The Box-Behnken design will assure that no runs require all factors to be at their high settings 
simultaneously. 
1    Choose Stat > DOE > Response Surface > Create Response Surface Design. 
2    Under Type of Design, choose Box-Behnken. 
3    From Number of factors, choose 3. 
4    Click Designs. Click OK. 
5    Click Factors. Complete the Name, Low, and High columns of the table as shown below: 
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 Factors Names Low High 

 A Pressure 150 200 

 B Temperature 200 220 

 C Time 4 6 

6    Click OK. 
7    Click Results. Choose Summary table and design table. Click OK in each dialog box. 

Session window output 

Box-Behnken Design 
 
 
Factors:       3     Replicates:     1
Base runs:    15     Total runs:    15
Base blocks:   1     Total blocks:   1
 
Center points: 3 
 
 
Design Table (randomized) 
 
Run  Blk  A  B  C 
  1    1  0  0  0 
  2    1  -  +  0 
  3    1  +  -  0 
  4    1  -  -  0 
  5    1  0  0  0 
  6    1  0  +  - 
  7    1  +  0  - 
  8    1  -  0  - 
  9    1  -  0  + 
 10    1  +  +  0 
 11    1  +  0  + 
 12    1  0  -  + 
 13    1  0  -  - 
 14    1  0  0  0 
 15    1  0  +  + 

Interpreting the results 
Because you chose to display the summary and design tables, Minitab shows the experimental conditions or settings for 
each of the factors for the design points. When you perform the experiment, use the order that is shown to determine the 
conditions for each run. For example, in the first run of your experiment, you would set the pressure at 175 psi (0 = 
center), the temperature at 210°F (0 = center), and treat the utility poles for 5 hours (0 = center). 
Minitab randomizes the design by default, so if you try to replicate this example your run order may not match the order 
shown. 
 

Define Custom Response Surface Design 
Define Custom Response Surface Design 
Stat > DOE > Response Surface > Define Custom Response Surface Design 
Use Define Custom Response Surface Design to create a design from data you already have in the worksheet. For 
example, you may have a design that you created using Minitab session commands, entered directly into the Data 
window, imported from a data file, or created with earlier releases of Minitab. You can also use Define Custom Response 
Surface Design to redefine a design that you created with Create Response Surface Design and then modified directly in 
the worksheet.  
Define Custom Response Surface Design allows you to specify which columns contain your factors and other design 
characteristics. After you define your design, you can use Modify Design, Display Design, and Analyze Response Surface 
Design. 

Dialog box items 
Factors: Enter the columns that contain the factor levels. 
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To define a custom response surface design 
1    Choose Stat > DOE > Response Surface > Define Custom Response Surface Design. 
2    In Factors, enter the columns that contain the factor levels. 
3    Do one of the following: 

•    If you do not have any columns containing the blocks, run order, or standard order, click OK. 
•    If you have additional columns that contain data for the blocks, run order, or standard order, click Designs.  

1    If your design is blocked, under Blocks, choose Specify by column and enter the column containing the 
blocks. 

2    If you have a column that contains the run order of the experiment, under Run Order Column, choose 
Specify by column and enter the column containing the run order.  

3    If you have a column that contains the standard order of the experiment, under Standard Order Column, 
choose Specify by column and enter the column containing the standard order.  

4    Click OK in each dialog box.  

 

Define Custom Response Surface Design − Designs 
Stat > DOE > Response Surface > Define Custom Response Surface Design > Designs 
Allows you to specify which columns contain the standard order, run order, point type, and blocks. 

Dialog box items 
Standard Order Column  

Order of the data: Choose if the standard order is the same as the order of the data in the worksheet.  
Specify by column: Choose if the standard order of the data is stored in a separate column, then enter the column. 

Run Order Column  
Order of the data: Choose if the run order is the same as the order of the data in the worksheet. 
Specify by column: Choose if the run order of the data is stored in a separate column, then enter the column. 

Point type 
Unknown: Choose if the type of design points is unknown. 
Specify by column: Choose if your design contains point types, then enter the column containing the point type 
identifiers.  

Blocks  
No blocks: Choose if your design is not blocked. 
Specify by column: Choose if your design is blocked, then enter the column containing the blocks. 

 

Define Custom Response Surface Design − Low/High 
Stat > DOE > Response Surface > Define Custom Response Surface Design > Low/High 
Allows you to define the low and high levels for each factor and specify whether worksheet data are in coded or uncoded 
form. 

Dialog box items 
Low and High Values for Factors  

Factor: Shows the factor letter designation. This column does not take any input. 
Name: Shows the name of the factors. This column does not take any input. 
Low: Enter the value for the low level for each factor. 
High: Enter the value for the high level for each factor. 

Worksheet data are 
Coded: Choose if the worksheet data are in coded form(-1 = low; +1 = high). 
Uncoded: Choose if the worksheet data are in uncoded form. That is, the worksheet values are in units of the actual 
measurements. 
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Select Optimal Design 
Select Optimal Design Overview 
The purpose of an optimal design is to select design points according to some criteria. Minitab's optimal design 
capabilities can be used with response surface designs and mixture designs. You can use Select Optimal Design to:  

Task Use to... 
Select an optimal design Select design points from a candidate set to achieve an optimal design. Select 

optimal design is often used to reduce the number of experimental runs when 
the original design contains more points than are feasible due to time or 
financial constraints.  

Augment an existing design Add design points to either D-optimal or distance-based designs. This may be 
useful if you determine you have additional resources to collect more data 
after you already generated an optimal design and collected data.   

Improve the D-optimality of a 
design 

Add or exchange points to improve the D-optimality of the design. You can not 
improve distance-based designs. 

Evaluate a design Obtain optimality statistics for your design. You can use this information to 
compare designs or to evaluate changes in the optimality of a design if you 
change the model. 
For example, you generate a D-optimal design for a certain model, but then 
decide to fit the model with different terms. You can determine the change in 
optimality using the Evaluate design task. 

Minitab provides two optimality criteria for the selection of design points:  

•    D-optimality − A design selected using this criterion minimizes the variance in the regression coefficients of the fitted 
model. You specify the model, then Minitab selects design points that satisfy the D-optimal criterion from a set of 
candidate design points.  

•    Distance-based optimality − A design selected using this criterion spreads the design points uniformly over the design 
space. The distance-based method can be used when it is not possible or desirable to select a model in advance. 

 

Select Optimal Design (Response Surface) 
Stat > DOE > Response Surface > Select Optimal Design 
Use to select design points based on some criteria to achieve an optimal design. You can use Select Optimal Design to:  

•    Select an "optimal" set of design points 

•    Augment (add points to) an existing design  

•    Improve the D-optimality of an existing design  

•    Evaluate and compare designs  

Dialog box items 
Criterion 

D-optimality: Choose to select design points based on D-optimality. 
Distance-based optimality: Choose to select design points based on distance-based optimality. 

Number of Points in optimal design: Enter the number of points to be selected for the optimal design. If the criterion is 
D-optimality, the number of points must be at least as many design points as there are terms in the model. If the criterion 
is distance-based optimality, the number of points must be less than or equal to the number of distinct design points in the 
candidate set. 
Specify design columns: If the criterion is distance-based optimality, delete the design columns that you do not want to 
include in the optimal design. 

•    For a response surface design, you can include all the factors or a subset of the factors. 
•    For a mixture design, you must include all components. You can also include all the process variables or a subset 

of the process variables, and an amount variable.  
By default, Minitab will include all input variables in the candidate design. 
Task 

Select optimal design: Choose to select an optimal design.  
Augment/improve design (you may optionally provide an indicator column that you created): Choose to 
augment or improve an existing design. If you like, enter an indicator column in the box to define the initial design. 
Evaluate design (you may optionally provide an evaluate column that you created): Choose to evaluate a design. 
If you like, enter an evaluate column in the box to specify which worksheet rows to include in the design. 
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Data - Select Optimal Design 
The worksheet must contain a design generated by Create Response Surface Design, Define Custom Response Surface 
Design, Create Mixture Design, or Define Custom Mixture Design.  
The data required depends on the task. 

Select optimal design 
The design columns in the worksheet comprise the candidate set of design points. For descriptions of a DOE worksheet, 
see Storing the design (response surface or mixture). 

Augment/improve design 
The design columns in the worksheet comprise the candidate set of design points. For descriptions of a DOE worksheet, 
see Storing the design (response surface or mixture). 
In addition to the design columns, you may also have a column that indicates how many times a design point is to be 
included in the initial design, and whether a point must be kept in (protected) or may be omitted from the final design. See 
below for more information. 

Design indicator column 
There are two ways that you can define the initial design. You can use all of the rows of the design columns in the 
worksheet or you can create an indicator column to specify certain rows to include in the initial design. In addition, you can 
use this column to "protect" design points during the optimization process. If you protect a point, Minitab will not drop this 
design point from the final design. The indicator column can contain any positive or negative integers. 
Minitab interprets the indicators as follows: 

•    the magnitude of the indicator determines the number of replicates of the corresponding design point in the initial 
design 

•    the sign of the indicator determines whether or not the design point will be protected during the optimization process 
−    a positive sign indicates that the design point may be excluded from the final design 
−    a negative sign indicates that the design point may not be excluded from the final design 

Evaluate design 
The design columns in the worksheet comprise the candidate set of design points. For descriptions of a DOE worksheet, 
see Storing the design (response surface or mixture). 
In addition to the design columns, you may also have a column that indicates how many times a design point is to be 
included in the evaluation. This column must contain only positive integers. See below for more information. 

Design evaluation column 
There are two ways that you can define the design you want to evaluate. You can use all of the rows of the design 
columns in the worksheet or you can create an indicator column to specify certain rows to include in the design. The 
magnitude of the indicator determines the number of replicates of the corresponding design point.  
 

To select an optimal design using D-optimality 
1    Choose Stat > DOE > Response Surface or Mixture > Select Optimal Design. 
2    Under Criterion, choose D-optimality. 
3    In Number of points in optimal design, enter the number of points to be selected for the optimal design. You must 

select at least as many design points as there are terms in the model.  

More The feasible number of design points is dictated by various constraints (for example, time, budget, or ease of 
data collection). It is strongly recommended that you select more than the minimum number so you obtain 
estimates of pure error and lack-of-fit of the fitted model. 

4    Under Task, choose Select optimal design. 
5    Click Terms. 
6    Do one of the following: 

•    from Include the following terms, choose the order of the model you want to fit: 

−    for response surface designs, choose one of the following:  
linear, linear + squares, linear + interactions, or full quadratic 

−    for mixture designs, choose one of the following:  
linear, quadratic, special cubic, full cubic, special quartic, or full quartic 
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•    move the terms you want to include in the model to Selected Terms using the arrow buttons  

−    to move one or more terms, highlight the desired terms, then click  or   

−    to move all of the terms, click  or   

You can also move a term by double-clicking it. 
7    Click OK. 

Note Minitab represents factors and components with the letters A, B, C, ..., skipping the letter I for factors and the 
letter T for components. For mixture designs, process variables are represented by X1,...,Xn , and the amount 
variable by the letter T. 

More For more on specifying a response surface model, see Selecting model terms. For more information on 
specifying a mixture model, see Selecting model terms. 

8    If you like, use one or more of the options listed below, then click OK. 
 

To select an optimal design using distance-based optimality 
1    Choose Stat > DOE > Response Surface or Mixture > Select Optimal Design  
2    Under Criterion, choose Distance-based optimality. 
3    In Number of points in optimal design, enter the number of points to be included in the design. The number of 

points you enter must be less than or equal to the number of distinct design points in the candidate set. 
4    In Specify design columns, delete the design columns that you do not want to include in the optimal design. 

•    For a response surface design, you can include all the factors or a subset of the factors. 
•    For a mixture design, you must include all components. You can also include all the process variables or a subset 

of the process variables, and an amount variable.  
By default, Minitab will include all input variables in the candidate design. 

5    Under Task, choose Select optimal design. 
6    If you like, use one or more of the options listed below, then click OK. 
 

Example of selecting a D-optimal response surface design 
Suppose you want to conduct an experiment to maximize crystal growth. You have determined that four variables − time 
the crystals are exposed to a catalyst, temperature in the exposure chamber, pressure within the chamber, and 
percentage of the catalyst in the air inside the chamber − explain much of the variability in the rate of crystal growth. 
You generate the default central composite design for four factors and two blocks (the blocks represent the two days you 
conduct the experiment). This design, which contains 30 design points, serves as the candidate set for the D-optimal 
design. 
Available resources restrict the number of design points that you can include in your experiment to 20. You want to obtain 
a D-optimal design that reduces the number of design points. 
1    Open the worksheet OPTDES.MTW. 
2    Choose Stat > DOE > Response Surface > Select Optimal Design. 
3    In Number of points in optimal design, type 20. 
4    Click Terms. Click OK in each dialog box. 

Session window output 

Optimal Design: Blocks, A, B, C, D  
 
Response surface design selected according to D-optimality 
 
Number of candidate design points: 30 
Number of design points in optimal design: 20 
 
Model terms: Block, A, B, C, D, AA, BB, CC, DD, AB, AC, AD, BC, BD, CD 
 
Initial design generated by Sequential method 
Initial design improved by Exchange method 
Number of design points exchanged is 1 
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Optimal Design 
 
Row number of selected design points: 30, 8, 25, 24, 27, 26, 23, 28, 9, 15, 17, 
                                      3, 6, 13, 10, 22, 1, 16, 4, 19 
 
Condition number:                              16002.9 
D-optimality (determinant of XTX):         1.26217E+18 
A-optimality (trace of inv(XTX)):              6079.28 
G-optimality (avg leverage/max leverage):          0.8 
V-optimality (average leverage):                   0.8 
Maximum leverage:                                    1 

Interpreting the results 
The Session window output contains the following five parts:  

•    A summary of the D-optimal design. This design was obtained by selecting a subset of 20 points from a candidate set 
of 30 points. 

•    The model terms. D-optimal designs are dependent on the specified model. In this example, the terms include: 
Block A B C D AA BB CC DD AB AC AD BC BD CD 

These are the full quadratic model terms that were the default in the Terms subdialog box. Remember, a design that 
is D-optimal for one model will most likely not be D-optimal for another model. 

•    The method by which the initial design was generated and whether or not an improvement of the initial design was 
requested. In this example, the initial design was generated sequentially and the exchange method (using one design 
point) was used to improve the initial design. 

•    The selected design points in the order they were chosen. The numbers shown identify the row of the design points in 
the original worksheet.  

Note The design points that are selected depend on the row order of the points in the candidate set. Therefore, 
Minitab may select a different optimal design from the same set of candidate points if they are in a different 
order. This can occur because there may be more than one D-optimal design for a given candidate set of 
points. 

•    Minitab displays some variance-minimizing optimality measures. You can use this information to compare designs. 
 

To augment or improve a D-optimal design 
1    Choose Stat > DOE > Response Surface or Mixture > Select Optimal Design. 
2    Under Criterion, choose D-optimality.  
3    Under Task, choose Augment/improve design. If you have a design point indicator column, enter this column in the 

box.  
4    Do one of the following: 

•    To augment (add points) a design, in Number of points in optimal design, enter the number of points to be 
included in the final design. The number of points you enter must be greater than the number of points in the 
design you are augmenting. 

•    To improve a design's D-optimality but not add any additional points, in Number of points in optimal design, 
enter 0. In this case, the final design will have the same number of design points as the initial design. 

5    Click Terms.  
6    Do one of the following: 

•    from Include the following terms, choose the order of the model you want to fit: 

−    for response surface designs, choose one of the following: 
linear, linear + squares, linear + interactions, or full quadratic 

−    for mixture designs, choose one of the following: 
linear, quadratic, special cubic, full cubic, special quartic, or full quartic 

•    move the terms you want to include in the model to Selected Terms using the arrow buttons  

−    to move one or more terms, highlight the desired terms, then click  or   

−    to move all of the terms, click  or   

You can also move a term by double-clicking it. 
7    Click OK. 
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Note Minitab represents factors and components with the letters A, B, C, ..., skipping the letter I for factors and the 
letter T for components. For mixture designs, process variables are represented by X1,...,Xn , and the 
amount variable by the letter T. 

More For more on specifying a response surface model, see Selecting model terms. For more information on 
specifying a mixture model, see Selecting model terms. 

8    If you like, use one or more of the options, then click OK. 
 

To augment a distance-based optimal design 
1    Choose Stat > DOE > Response Surface or Mixture > Select Optimal Design. 
2    Under Criterion, choose Distance-based optimality. 
3    In Number of points in optimal design, enter the number of points to be in the final design. The number of points 

you enter must be greater than the number of points in the initial design but not greater then the number of "distinct" 
points in the candidate set. 

4    In Specify design columns, delete the design columns that you do not want to include in the optimal design. 
•    For a response surface design, you can include all the factors or a subset of the factors. 
•    For a mixture design, you must include all components. You can also include all the process variables or a subset 

of the process variables, and an amount variable. 
By default, Minitab will include all design variables in the candidate design. 

5    Under Task, choose Augment/improve design. If you have a design point indicator column, enter this column in the 
box.  

6    If you like, use one or more of the options, then click OK. 
 

To evaluate a design 
1    Choose Stat > DOE > Response Surface or Mixture > Select Optimal  
2    Under Task, choose Evaluate design. If you have an indicator column that defines the design, enter the column in 

the box.  
3    Click Terms.  
4    Do one of the following: 

•    from Include the component terms up through order, choose the order of the model you want to fit: 

−    for response surface designs, choose one of the following: 
linear, linear + squares, linear + interactions, or full quadratic  

−    for mixture designs, choose one of the following: 
linear, quadratic, special cubic, full cubic, special quartic, or full quartic  

•    move the terms you want to include in the model to Selected Terms using the arrow buttons  

−    to move one or more terms, highlight the desired terms, then click  or   

−    to move all of the terms, click  or   

You can also move a term by double-clicking it. 

5    Click OK. 

Note  Minitab represents factors and components with the letters A, B, C, ... , skipping the letter I for factors and the 
letter T for components. For mixture designs, process variables are represented by X1,... ,Xn , and the amount 
variable by the letter T. 

More For more on specifying a response surface model, see Selecting model terms. For more information on 
specifying a mixture model, see Selecting model terms. 

6    If you like, use one or more of the options, then click OK. 
 

Example of evaluating a design 
Suppose you want determine how reducing the model changes the optimality for the 20 point experimental design 
obtained in the Example of selecting a D-optimal response surface design. Remember that a model that is D-optimal for a 
given model only. 
1    Open the worksheet OPTDES3.MTW. (The design and indicator columns have been saved for you.) 



Response Surface Designs 

 Copyright © 2003–2005 Minitab Inc.  All rights reserved.  103

2    Choose Stat > DOE > Response Surface > Select Optimal Design. 
3    Choose Evaluate design, then enter OptPoint in the box. 
4    Click Terms. 
5    From Include the following terms, choose Linear. 
6    Click OK in each dialog box. 

Session window output 

Optimal Design: Blocks, A, B, C, D  
 
Evaluation of Specified Response Surface Design 
 
Number of design points in optimal design: 20 
 
Model terms: Block, A, B, C, D 
 
Specified Design 
 
Row number of selected design points: 1, 3, 4, 6, 8, 9, 10, 13, 15, 16, 17, 19, 
                                      22, 23, 24, 25, 26, 27, 28, 30 
 
Condition number:                           1.43109 
D-optimality (determinant of XTX):         41544000 
A-optimality (trace of inv(XTX)):           12.5582 
G-optimality (avg leverage/max leverage):  0.871492 
V-optimality (average leverage):                0.3 
Maximum leverage:                          0.344237 

Interpreting the results 
The Session window output contains the following four parts: 

•    The number of points in the design. 

•    The model terms. D-optimal designs depend on the specified model. In this example, the terms include: 
Block A B C D  

These are the linear model terms that you chose in the Terms subdialog box. Remember, a design that is D-optimal 
for one model will most likely not be D-optimal for another model.  

•    The selected design points. The numbers shown identify the row of the design points in the worksheet. 

•    In addition to the design's D-optimality, Minitab displays various optimality measures. You can use this information to 
evaluate or compare designs. If you compare the optimality of the 20-point design for a full quadratic model from the 
example of selecting a D-optimal response surface design with this 20-point design for a linear model, you will notice 
that the D-optimality increased from 1.2622E+18 to 41544000. 

 

Select Optimal Design (Response Surface) − Terms  
Stat > DOE > Response Surface > Select Optimal Design > Terms 
Fit a model by specifying the maximum order of the terms, or choose which terms to include from a list of all estimable 
terms. 

Dialog box items 
Include the following terms: Use this drop-down list to quickly set up a model. You can choose linear, linear and 
squared, linear and interactions, or a full quadratic model.  
Available Terms: Shows all terms that are estimable but not included in the fitted model.  
Selected Terms: Minitab includes terms shown in Selected Terms when it fits the model. 
Include blocks in the model: Check to include blocks in the model. Minitab only enables the checkbox for including 
blocks in the model when you specify more than one block in the Create Response Surface Design dialog box. 
 

Selecting Model Terms (Response Surface Design) 
The model you choose determines what terms are fit and whether or not you can model linear or curvilinear aspects of the 
response surface. If you include any second-order terms (squares or interactions), you can model curvilinear data. 
You can fit a linear, linear and squares, linear and two-way interactions, or full quadratic (default) model. Or, you can fit a 
model that is a subset of these terms. The table below shows what terms would be fit for a model with four factors.  
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This model type fits these terms 
linear A  B  C  D 

linear and squares A  B  C  D 
A∗A  B∗B  C∗C  D∗D 

linear and two-way 
interactions 

A  B  C  D   
A∗B  A∗C  A∗D  B∗C  B∗D  C∗D 

full quadratic (default) A  B  C  D   
A∗A  B∗B  C∗C  D∗D 
A∗B  A∗C  A∗D  B∗C  B∗D  C∗D 

 

To specify response surface model terms 
1    In the Optimal Design dialog box, click Terms.  
2    Do one of the following: 

•    from Include the following terms, choose linear, linear + squares,  
linear + interactions, or full quadratic 

•    move the terms you do not want to include in the model from Selected Terms to Available Terms using the arrow 
buttons  

−    to move one or more factors, highlight the desired terms then click  or   

−    to move all of the terms, click  or   

You can also move a term by double-clicking it. 
 

Select Optimal Design − Methods  
Stat > DOE > Response Surface or Mixture > Select Optimal Design > choose Augment/Improve design > Methods  
Allows you to choose the search procedure for improving the initial design. 

Dialog box items 
Search Procedure for Improving Initial Design 

Exchange method with number of exchange points: Choose to improve the initial design using the exchange 
method. Minitab will first add the best points from the candidate set, and then drop the worst points until the D-
optimality of the design cannot be improved further. Then, enter the number of points to be exchanged. 
Fedorov's method: Choose to improve the initial design using Fedorov's method. Minitab will simultaneously switch 
pairs of points. This is accomplished by adding one point from the candidate set and dropping another point so that the 
switch results in maximum improvement in D-optimality. This process continues until the design cannot be improved 
further. 
None: Choose to suppress improvement of the initial design. 

 

Select Optimal Design − Methods  
Stat > DOE > Response Surface or Mixture > Select Optimal Design > choose Select optimal design > Methods  
Allows you to specify whether the initial design is generated using a sequential or random algorithm, or a combination of 
both methods and to choose the search procedure for improving the initial design. 

Dialog box items 
Initial Design 

Generated by sequential optimization: Choose to have all design points selected sequentially. 
Percentage of design points to be selected randomly: Choose the percentage of design points to be selected 
randomly. You can choose from 10% to 100% in increments of 10. 

Number of random trials: Enter the number of trials for the optimization procedure. The default is 10. 
Base for random data generator: Enter a base for the random data generator. By entering a base for the random 
data generator, you can control the randomization so that you obtain the same pattern every time.  
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Search Procedure for Improving Initial Design 
Exchange method with number of exchange points: Choose to improve the initial design using the exchange 
method. Minitab will first add the best points from the candidate set, and then drop the worst points until the D-
optimality of the design cannot be improved further. Then, enter the number of points to be exchanged. 
Fedorov's method: Choose to improve the initial design using Fedorov's method. Minitab will simultaneously switch 
pairs of points. This is accomplished by adding one point from the candidate set and dropping another point so that the 
switch results in maximum improvement in D-optimality. This process continues until the design cannot be improved 
further. 
None: Choose to suppress improvement of the initial design. 

 

Select Optimal Design − Options 
Stat > DOE > Response Surface or Mixture > Select Optimal Design > Options 
Allows you to store optimal design information. 

Dialog box items 
Store selection indicator in present worksheet: Choose to store a column (named OptPoint) in the original worksheet 
that indicates how many times a design point has been selected by the optimal procedure 
Store selected rows of design columns in new worksheet: Choose to store the design points that have been selected 
by the optimal procedure in a new worksheet. 
Copy to a new worksheet also selected rows in column: Choose to store, in addition to the design columns, the rows 
of any non-design columns for the design points that were selected in a new worksheet. 
 

Select Optimal Design − Results  
Stat > DOE > Response Surface or Mixture > Select Optimal Design > Options > Results 
Allows you to control the display of Session window results. 

Dialog box items 
None: Choose to suppress display of results. Minitab stores all requested items. 
Summary table for final design only: Choose to display the summary table for the final design. 
Summary tables for intermediate and final designs: Choose to display the summary table for all optimal designs. 
Summary tables and final design matrix: Choose to display the summary table for the final design and the design 
points. 
 

Example of augmenting a D-optimal design 
In the Example of selecting a D-optimal response surface design, you selected a subset of 20 design points from a 
candidate set of 30 points. After you collected the data for the 20 selected design points, you found out that you could run 
five additional design points. Because you already collected the data for the original design, you need to protect these 
points in the augmented design so they can not be excluded during the augmentation/optimization procedure. To protect 
these points, you need to have negative indicators for the design points that were already selected for the first optimal 
design. 
1    Open the worksheet OPTDES2.MTW. (The design and indicator columns have been saved for you.) 
2    Choose Stat > DOE > Response Surface > Select Optimal Design. 
3    Choose Augment/improve design, then enter OptPoint in the box. 
4    In Number of points in optimal design, type 25. 
5    Click Terms. Click OK in each dialog box. 

Session window output 

Optimal Design: Blocks, A, B, C, D  
 
Response surface design augmented according to D-optimality 
 
Number of candidate design points: 30 
Number of design points to augment/improve: 20 
Number of design points in optimal design: 25 
 
Model terms: Block, A, B, C, D, AA, BB, CC, DD, AB, AC, AD, BC, BD, CD 
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Initial design augmented by Sequential method 
Initial design improved by Exchange method 
Number of design points exchanged is 1 
 
 
Optimal Design 
 
Row number of selected design points: 1, 3, 4, 6, 8, 9, 10, 13, 15, 16, 17, 19, 
                                      22, 23, 24, 25, 26, 27, 28, 30, 2, 5, 14, 
                                      18, 20 
 
Condition number:                              17778.5 
D-optimality (determinant of XTX):         1.72187E+20 
A-optimality (trace of inv(XTX)):              5788.08 
G-optimality (avg leverage/max leverage):         0.64 
V-optimality (average leverage):                  0.64 
Maximum leverage:                                    1 

Interpreting the results 
The Session window output contains the following five parts:  

•    A summary of the D-optimal design. This design was obtained by augmenting a design with containing 20 points by 
adding 5 more design points. The candidate set contains 30 design points. 

•    The model terms. D-optimal designs depend on the specified model. In this example, the terms include: 
Block A B C D AA BB CC DD AB AC AD BC BD CD 

These full quadratic model terms are the default in the Terms subdialog box. Remember, a design that is D-optimal for 
one model will most likely not be D-optimal for another model.  

•    The method by which the initial design was augmented and whether or not an improvement of the initial design was 
requested. In this example, two design points were added sequentially and the exchange method (using one design 
point) was used to improve the initial design. 

•    The selected design points in the order they were chosen. The numbers shown identify the row of the design points in 
the worksheet.  

Note The design points that are selected depend on the row order of the points in the candidate set. Therefore, 
Minitab may select a different optimal design from the same set of candidate points if they are in a different 
order. This can occur because there may be more than one D-optimal design for a given candidate set of 
points. 

•    Minitab displays some variance-minimizing optimality measures. You can use this information to compare designs. 
You can use this information to compare designs. For example, if you compare the optimality of the original 20-point 
design from the example of selecting a D-optimal response surface design with this 25-point design, you will notice 
that the D-optimality increased from 1.26217E+18 to 1.72187E+20. 
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Analyze Response Surface Design 
Analyze Response Surface Design 
Stat > DOE > Response Surface > Analyze Response Surface Design 
Fits response surface models generated with Create Response Surface Design.  
You can choose to fit models with the following terms: 

•    all linear terms 

•     all linear terms and all squared terms 

•     all linear terms and all two-way interactions 
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•    all linear terms, all squared terms, and all two-way interactions (the default) 

•    a subset of linear terms, squared terms, and two-way interactions 
The model you fit will determine the nature of the effect, linear or curvilinear, that you can detect. 

Dialog box items 
Responses: Select the column(s) containing the response data. You can enter up to 25 response variables. 
Do analysis using  

Coded units: Choose to perform the analysis using the default coding, −1 for the low level, +1 for the high level, and 0 
for a center point. Minitab will display the Session window output and optionally store coefficients based in this coded 
form.  
Uncoded units: Choose to perform the analysis using the values that you assigned in the Factors subdialog box. 
Minitab will display the Session window output and optionally store coefficients using the assigned values. 

 

Data − Analyze Response Surface Design 
To use Analyze Response Surface Design to fit a model, you must create and store the design using Create Response 
Surface Design, or create a design from data that you already have in the worksheet with Define Custom Response 
Surface Design. 

Enter up to 25 numeric response data columns that are equal in length to the design variables in the worksheet. Each row 
will contain data corresponding to one run of your experiment. You may enter the response data in any column(s) not 
occupied by the design data. The number of columns reserved for the design data is dependent on the number of factors 
in your design. 
If there is more than one response variable, Minitab fits separate models for each response.  
Minitab omits missing data from all calculations. 

Note When all the response variables do not have the same missing value pattern, Minitab displays a message. 
Since you would get different results, you may want to repeat the analysis separately for each response 
variable.  

 

To analyze a response surface design 
1    Choose Stat > DOE > Response Surface > Analyze Response Surface Design.  
2    In Responses, enter up to 25 columns that contain the response data. 
3    If you like, use one or more of the available dialog box options, then click OK.  
 

Choosing data units 
The following results may differ depending on whether you analyze the data in coded or uncoded units (the actual factor 
levels): 

•    coefficients and their standard deviations 

•    t-values for the constant and linear factors 

•    p-values for the constant and linear factors 
Some of the results are the same, including squared and interactions terms and the variance explained.  
 

To specify the data units for analysis 
1    In the Create Response Surface Design dialog box, under Analyze data using, choose coded units or uncoded 

units. 

More Analyze Response Surface Design uses the same method of coding as General Linear Model−see Design 
matrix used by General Linear Model.  

 

Analyze Response Surface Design − Terms 
Stat > DOE > Response Surface > Analyze Response Surface Design > Terms 
Fit a model by specifying the maximum order of the terms, or choose which terms to include from a list of all estimable 
terms. 
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Dialog box items 
Include the following terms: Use this drop-down list to quickly set up a model. You can choose Linear, Linear + 
squares, Linear + interactions, or Full quadratic. For more information on these models, see Selecting model terms. 
Available Terms: Shows all terms that are estimable but not included in the fitted model.  
Selected Terms: Minitab includes terms shown in Selected Terms when it fits the model. 
Include blocks in the model: Check to include blocks in the model. Minitab only enables the checkbox for including 
blocks in the model when you specify more than one block in the Create Response Surface Design dialog box. 
 

To specify the response surface model terms 
1    In the Analyze Response Surface Design dialog box, click Terms.  
2    Do one of the following: 

•    from Include the following terms, choose linear, linear + squares,  
linear + interactions, or full quadratic 

•    move the terms you do not want to include in the model from Selected Terms to Available Terms using the arrow 
buttons  

−    to move one or more factors, highlight the desired terms then click  or   

−    to move all of the terms, click  or   

You can also move a term by double-clicking it. 
 

Selecting model terms 
The model you choose determines what terms are fit and whether or not you can model linear or curvilinear aspects of the 
response surface. If you include any second-order terms (squares or interactions), you can model curvilinear data. 
You can fit a linear, linear and squares, linear and two-way interactions, or full quadratic (default) model. Or, you can fit a 
model that is a subset of these terms. The table below shows what terms would be fit for a model with four factors.  

This model type fits these terms 
linear A  B  C  D 

linear and squares A  B  C  D 
A∗A  B∗B  C∗C  D∗D 

linear and two-way 
interactions 

A  B  C  D   
A∗B  A∗C  A∗D  B∗C  B∗D  C∗D 

full quadratic (default) A  B  C  D   
A∗A  B∗B  C∗C  D∗D 
A∗B  A∗C  A∗D  B∗C  B∗D  C∗D 

 

Analyze Response Surface Design − Graphs 
Stat > DOE > Response Surface > Analyze Response Surface Design > Graphs 
Draw five different residual plots for regular, standardized, or deleted residuals . You do not have to store the residuals 
and fits in order to produce these plots.  

Dialog box items 
Residuals for Plots You can specify the type of residual to display on the residual plots. 

Regular: Choose to plot the regular or raw residuals. 
Standardized: Choose to plot the standardized residuals. 
Deleted: Choose to plot the Studentized deleted residuals. 

Residual Plots 
Individual plots: Choose to display one or more plots. 

Histogram: Check to display a histogram of the residuals. 
Normal plot: Check to display a normal probability plot of the residuals. 
Residuals versus fits: Check to plot the residuals versus the fitted values. 
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Residuals versus order: Check to plot the residuals versus the order of the data in the run order column. The row 
number for each data point is shown on the x-axis−for example, 1 2 3 4... n. 

Four in one: Choose to display a layout of a histogram of residuals, a normal plot of residuals, a plot of residuals 
versus fits, and a plot of residuals versus order.  
Residuals versus variables: Check to display residuals versus selected variables, then enter one or more columns. 
Minitab displays a separate graph for each column. 

 

Analyze Response Surface Design − Prediction 
Stat > DOE > Response Surface> Analyze Response Surface Design > Prediction 
You can calculate and store predicted response values for new design points.  

Dialog box items 
New Design Points (columns and/or constants)   

Factors: Type the text or numeric factor levels, or enter the columns or constants in which they are stored.  The 
number of factors must equal the number of factors in the design.  
Blocks: Type the text or numeric blocking levels, or enter the columns or constants in which they are stored. Each 
blocking level must equal one of the blocking levels in the design. You do not have to enter a blocking level.  

Confidence level: Type the desired confidence level (for example, type 90 for 90%). The default is 95%. 
Storage 

Fits: Check to store the fitted values for new design points. 
SEs of fits: Check to store the estimated standard errors of the fits. 
Confidence limits: Check to store the lower and upper limits of the confidence interval. 
Prediction limits: Check to store the lower and upper limits of the prediction interval. 

 

To predict responses in Analyze Response Surface Design 
1    Choose Stat > DOE > Response Surface > Analyze Response Surface Design > Prediction. 
2    In Factors, do any combination of the following: 

•    Type numeric factor levels.  
•    Enter stored constants containing numeric factor levels. 
•    Enter columns of equal length containing numeric factor levels. 
Factors must match your original design in these ways: 
 −   The number of factors and the order in which they are entered. 
 −   The units of the factor levels. 

3    In Blocks, do one of the following: 
•    Type a text or numeric blocking level.  
•    Enter a stored constant containing a text or numeric blocking level. 
•    Enter a column containing a text or numeric blocking level, equal in length to factor columns.  
Each blocking level must be one of the blocking levels in your design.  

4    In Confidence level, type a value or use the default, which is 95%. 
5    Under Storage, check any of the prediction results to store them in your worksheet. Click OK. 
 

Analyze Response Surface Design − Storage 
Stat > DOE > Response Surface > Analyze Response Surface Design > Storage 
You can store information from your analysis for future use. Minitab stores the checked values in the next available 
columns and names the columns. 

Dialog box items 
Fits and Residuals  

Fits: Check to store the fitted values. One column is stored for each response variable. 
Residuals: Check to store the residuals. One column is stored for each response variable. 
Standardized residuals: Check to store the standardized residuals.  
Deleted residuals: Check to store Studentized residuals. 
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Model Information  
Coefficients: Check to store the coefficients. One column is stored for each response variable. These are the same 
coefficients as are printed in the output. If some terms are removed because the data cannot support them, the 
removed terms do not appear on the output.  
Design matrix: Check to store the design matrix corresponding to your model. This is handy for storing the design 
matrix for use in other Minitab commands. Minitab takes the factors, creates the squares and cross-products, and 
stores all of these in a matrix. Copy the matrix into columns for use in other commands. 
Quadratic: Check to store the information about the equations fit. Minitab stores one column for each response. 

Other  
Hi (leverage): Check to store leverages.  
Cook's distance: Check to store Cook's distance.  
DFITS: Check to store DFITS. 

 

Analyze Response Surface Design − Results 
Stat > DOE > Response Surface > Analyze Response Surface Design > Results 
Allows you to control the display of Session window results. 

Dialog box items 
Display of Results You can control the display of output. 

Do not display: Choose to suppress display of results. Minitab stores all requested items. 
Coefficients, ANOVA table, and unusual observations: Choose to display a table of coefficients, s, R-sq, R-sq(adj), 
the analysis of variance table, and the unusual values in the table of fits and residuals.  
Table of fits and residuals, in addition to above: Choose to display a full table of fits and residuals in addition to the 
output described above. 

 

Example of fitting a linear response surface model 
The following examples use data from [3]. The experiment uses three factors − nitrogen, phosphoric acid, and potash − all 
ingredients in fertilizer. The effect of the fertilizer on snap bean yield was studied in a central composite design. 

The actual units for the −1 and +1 levels are 2.03 and 5.21 for nitrogen, 1.07 and 2.49 for phosphoric acid, 1.35 and 3.49 
for potash. The design is analyzed in coded units. If we were to analyze the design in the actual units, a few things would 
change: the coefficients and their standard deviations, the t-value and p-value for the constant term. Additional results 
would be the same, including which terms in the model are significant. 

Step 1 : Generating the central composite design 
1    Choose Stat > DOE > Response Surface > Create Response Surface Design. 
2    Under Type of Design, choose Central composite. 
3    From Number of factors, choose 3. 
4    Click Designs. To create the design, click OK. 

5    Click Factors. In the Name column, enter Nitrogen Phosphoric Acid Potash in rows one through three, respectively. 
Click OK in each dialog box. 

Step 2 : Fitting a linear model 
1    Open the worksheet CCD_EX1.MTW. (The design from the previous step and the response data have been saved for 

you.) 
2    Choose Stat > DOE > Response Surface > Analyze Response Surface Design. 
3    In Responses, enter BeanYield. Under Analyze data using, choose Coded units. 
4    Click Terms. 
5    From Include the following terms, choose Linear. Click OK in each dialog box. 
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Session window output 

Response Surface Regression: BeanYield versus Nitrogen, PhosAcid, Potash 
 
 
The analysis was done using coded units. 
 
Estimated Regression Coefficients for BeanYield 
 
Term         Coef  SE Coef       T      P 
Constant  10.1980   0.3473  29.364  0.000 
Nitrogen  -0.5738   0.4203  -1.365  0.191 
PhosAcid   0.1834   0.4203   0.436  0.668 
Potash     0.4555   0.4203   1.084  0.295 
 
S = 1.553   R-Sq = 16.8%   R-Sq(adj) = 1.2% 
 
 
Analysis of Variance for BeanYield 
 
Source          DF  Seq SS  Adj SS  Adj MS     F      P 
Regression       3   7.789   7.789  2.5962  1.08  0.387 
  Linear         3   7.789   7.789  2.5962  1.08  0.387 
Residual Error  16  38.597  38.597  2.4123 
  Lack-of-Fit   11  36.057  36.057  3.2779  6.45  0.026 
  Pure Error     5   2.540   2.540  0.5079 
Total           19  46.385 
 
 
Unusual Observations for BeanYield 
 
Obs  StdOrder  BeanYield     Fit  SE Fit  Residual  St Resid 
  7         9      8.260  11.163   0.788    -2.903     -2.17 R 
 16         3     13.190  10.500   0.807     2.690      2.03 R 
 
R denotes an observation with a large standardized residual. 
 
 
Estimated Regression Coefficients for BeanYield using data in uncoded units 
 
Term         Coef 
Constant    10.0144 
Nitrogen  -0.360862 
PhosAcid   0.258300 
Potash     0.425680 

Interpreting the results 
It is important to check the adequacy of the fitted model, because an incorrect or under-specified model can lead to 
misleading conclusions. By checking the fit of the linear (first-order) model you can tell if the model is under specified. The 
small p-value (p = 0.026) for the lack of fit test indicates the linear model does not adequately fit the response surface. 
The F-statistic for this test is (Adj MS for Lack of Fit) / (Adj MS for Pure Error).  
Because the linear model does not adequately fit the response surface, you need to fit a quadratic (second-order) model. 
 

Example of fitting a quadratic model 
In the previous example, you determined that the linear model did not adequately represent the response surface. The 
next step is to fit the quadratic model. The quadratic model allows detection of curvature in the response surface. 
1    Open the worksheet CCD_EX1.MTW. (The design and response data have been saved for you.) 
2    Choose Stat > DOE > Response Surface > Analyze Response Surface Design. 
3    In Responses, enter BeanYield. 
4    Click Terms. 
5    From Include the following terms, choose Full quadratic. Click OK. 
6    Click Graphs. 
7    Under Residual Plots, choose Four in one. Click OK in each dialog box. 
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Session window output 

Response Surface Regression: BeanYield versus Nitrogen, PhosAcid, Potash 
 
 
The analysis was done using coded units. 
 
Estimated Regression Coefficients for BeanYield 
 
Term                  Coef  SE Coef       T      P 
Constant           10.4623   0.4062  25.756  0.000 
Nitrogen           -0.5738   0.2695  -2.129  0.059 
PhosAcid            0.1834   0.2695   0.680  0.512 
Potash              0.4555   0.2695   1.690  0.122 
Nitrogen*Nitrogen  -0.6764   0.2624  -2.578  0.027 
PhosAcid*PhosAcid   0.5628   0.2624   2.145  0.058 
Potash*Potash      -0.2734   0.2624  -1.042  0.322 
Nitrogen*PhosAcid  -0.6775   0.3521  -1.924  0.083 
Nitrogen*Potash     1.1825   0.3521   3.358  0.007 
PhosAcid*Potash     0.2325   0.3521   0.660  0.524 
 
S = 0.9960   R-Sq = 78.6%   R-Sq(adj) = 59.4% 
 
 
Analysis of Variance for BeanYield 
 
Source          DF  Seq SS  Adj SS  Adj MS     F      P 
Regression       9  36.465  36.465  4.0517  4.08  0.019 
  Linear         3   7.789   7.789  2.5962  2.62  0.109 
  Square         3  13.386  13.386  4.4619  4.50  0.030 
  Interaction    3  15.291  15.291  5.0970  5.14  0.021 
Residual Error  10   9.920   9.920  0.9920 
  Lack-of-Fit    5   7.380   7.380  1.4760  2.91  0.133 
  Pure Error     5   2.540   2.540  0.5079 
Total           19  46.385 
 
 
Unusual Observations for BeanYield 
 
Obs  StdOrder  BeanYield     Fit  SE Fit  Residual  St Resid 
  2        12     11.060  12.362   0.776    -1.302     -2.09 R 
  7         9      8.260   9.514   0.776    -1.254     -2.01 R 
 16         3     13.190  12.004   0.815     1.186      2.07 R 
 
R denotes an observation with a large standardized residual. 
 
 
Estimated Regression Coefficients for BeanYield using data in uncoded units 
 
Term                   Coef 
Constant            12.4512 
Nitrogen          0.9622568 
PhosAcid           -2.28406 
Potash             -1.47942 
 
Nitrogen*Nitrogen -0.267571 
PhosAcid*PhosAcid   1.11636 
Potash*Potash     -0.238794 
Nitrogen*PhosAcid -0.600142 
Nitrogen*Potash    0.695057 
PhosAcid*Potash    0.306042 
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Graph window output 

 
Interpreting the results 
Since the linear model suggested that a higher-order model is needed to adequately model the response surface, you fit 
the full quadratic model. For the full quadratic model, the p-value for lack of fit is 0.133 suggesting that this model 
adequately fits the data. 
The first table on the results gives the coefficients for all the terms in the model. Because you used an orthogonal design, 
each effect is estimated independently. Therefore, the coefficients for the linear terms are the same as when you fit just 
the linear model. The error term, s = 0.996, is smaller because you reduced the variability accounted for by error. 
The Analysis of Variance table summarizes the linear terms, the squared terms, and the interactions. The small p-values 
for the interactions (p = 0.021) and the squared terms (p = 0.030) suggest there is curvature in the response surface. In 
the table of Estimated Regression Coefficients, you will see small p-values for the Nitrogen by Potash interaction (p = 
0.007), Nitrogen squared (p = 0.027), and Phosphoric acid squared (p = 0.058) suggesting these effects may be 
important. 
In addition, Minitab draws four residual plots. The residual plots do not indicate any problems with the model. For 
assistance in interpreting residual plots, see Residual plot choices. 
For contour and surface plots of this response surface, see Example of a Contour Plot and a Surface Plot. 
 

Contour/Surface Plots 
Contour/Surface Plots 
Stat > DOE > Response Surface > Contour/Surface Plots 
You can use Contour/Surface Plots to display two types of response surface plots: contour plots and surface plots. These 
plots show how a response variable relates to two factors based on a model equation. 

Dialog box items 
Contour plot: Check to display a contour plot, then click <Setup>.  
Surface plot: Check to display a surface plot, then click <Setup>. 
 

Contour and Surface Plots (Response Surface Design) 
Contour and surface plots are useful for establishing desirable response values and operating conditions.  

•    A contour plot provides a two-dimensional view where all points that have the same response are connected to 
produce contour lines of constant responses. 

•    A surface plot provides a three-dimensional view that may provide a clearer picture of the response surface.  
The illustrations below show a contour plot and 3D surface plot of the same data. The lowest z-values are found where X1 
and X2 both equal zero. As X1 and X2 move away from zero, the values for Y increase steadily. This is represented in the 
contour plot as concentric contours of increasing value, and in the 3D surface plot as an inverted cone. 
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Contour Plot 3D Surface Plot 

  
 

Note When the model has more than two factors, the factor(s) that are not in the plot are held constant. In the 
Settings subdialog box, you can specify the values to hold the remaining factors at. 

 

To plot the response surface 
1    Choose Stat > DOE > Response Surface > Contour/Surface Plots. 
2    Do one or both of the following: 

•    to generate a contour plot, check Contour plot and click Setup  
•    to generate a surface plot, check Surface plot and click Setup  

3    If you like, use one or more of the available dialog box options, then click OK in each dialog box. 
 

Data − Contour/Surface Plots 
Contour plots and surface plots are model dependent. Thus, you must fit a model using Analyze Response Surface 
Design before you can generate response surface plots with Contour/Surface Plots. Minitab looks in the worksheet for the 
necessary model information to generate these plots. 
 

Contour/Surface Plots − Contour 
Stat > DOE > Response Surface >Contour/Surface Plots > check Contour > Setup 
Generates a response surface contour plot for a single pair of factors or separate contour plots for all possible pairs of 
factors.  

Dialog box items 
Response: Select the column containing the response data. 
Factors  

Select a pair of factors for a single plot: Choose to display a graph for just one pair (x,y) factors. The graph is 
generated by calculating responses (z-values) using the values in the x- and y-factor columns and giving the other 
factors the values chosen in the Hold extra settings at option in the <Settings> subdialog box. 

X Axis: Choose a factor from the drop-down list to plot on the x-axis. 
Y Axis: Choose a factor from the drop-down list to plot on the y-axis. 

Generate plots for all pairs of factors: Choose to display graphs for all possible combinations of (x,y) factors with the 
calculated response (z). The graphs are generated by calculating responses (z-values) using the values in the x- and y-
factor columns and giving the other factors the values chosen in the Hold extra settings at option in the <Settings> 
subdialog box. With n factors, (n∗(n−1))/2 different contour plots will be generated. 

In separate panels of the same page: Choose to display all plots on one page.  
On separate pages: Choose to display each plot on a separate page.  

Display plots using 

Coded units: Choose to display points on the response surface plots using the default coding: −1 for the low level, +1 
for the high level, and 0 for a center point.  
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Uncoded units: Choose to display points on the response surface plots using the values that you assign in the 
<Factors> subdialog box.  

 

Contour/Surface Plots − Contour − Contours 
Stat > DOE > Response Surface > Contour/Surface Plots > check Contour > Setup > Contours 
Specify the number or location of the contour levels, and the way Minitab displays the contours. 

Dialog box items 
Contour Levels Controls the number of contour levels to display. 

Use defaults: Choose to have Minitab determine the number of contour lines (from 4 to 7) to draw.  
Number: Choose specify the number of contour lines, then enter an integer from 2 to 11 for the number of contour lines 
you want to draw. 
Values: Choose to specify the values of the contour lines in the units of your data. Then specify from 2 to 11 contour 
level values in strictly increasing order. You can also put the contour level values in a column and select the column. 

Data Display 
Area: Check to shade the areas that represent the values for the response, which are called contours. 
Contour lines: Check to draw lines along the boundaries of each contour. 
Symbols at design points: Check to display a symbol at each data point. 

 

To control plotting of contour levels (response surface design) 
1    In the Contour/Surface Plots dialog box, check Contour plot and click Setup. 
2    Click Contours. 
3    To change the number of contour levels, do one of the following: 

•    Choose Number and enter a number from 2 to 11. 
•    Choose Values and enter from 2 to 11 contour level values in the units of your data. You must enter the values in 

increasing order.  
4    Click OK in each dialog box. 
 

Contour/Surface Plots − Surface 
Stat > DOE > Response Surface > Contour/Surface Plots > Surface > Setup 
Draws a surface plot. Surface plots show how a response variable (the z-variable) relates to two factors (the x- and y-
variables).  
Response: Choose the column containing the response data. 
Factors  

Select a pair of factors for a single plot: Choose to display a graph for just one pair (x,y) factors. The graph is 
generated by calculating responses (z-values) using the values in the x- and y-factor columns and giving the other 
factors the values chosen in the Hold extra settings at option in the <Settings> subdialog box. 

X Axis: Choose a factor from the drop-down list to plot on the x-axis. 
Y Axis: Choose a factor from the drop-down list to plot on the y-axis. 

Generate plots for all pairs of factors: Choose to display a separate graph for each possible combination of (x,y) 
factors with the calculated response (z). The graphs are generated by calculating responses (z-values) using the values 
in the x- and y-factor columns and giving the other factors the values chosen in the Hold extra settings at option in the 
<Settings> subdialog box. With n factors, (n∗(n−1))/2 different surface plots will be generated. 

Display plots using 
Coded units: Choose to display points on the response surface plots using the default coding: 1 for the low level, +1 
for the high level, and 0 for a center point.  
Uncoded units: Choose to display points on the response surface plots using values that you assigned in the 
<Factors> subdialog box.  
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Contour/Surface Plots − Settings 
Stat > DOE > Response Surface > Contour/Surface Plots > Setup > Settings 
You can set the holding level for factors that are not in the plot at their highest, lowest, or middle (calculated mean) 
settings, or you can set specific levels at which to hold each factor. 

Dialog box items 
You may select one of the three choices for settings OR enter your own by typing a value in the table. 
Hold extra factors at 

High settings: Choose to set variables that are not in the graph at their highest setting. 
Middle settings: Choose to set variables that are not in the graph at the calculated median setting. 
Low settings: Choose to set variables that are not in the graph at their lowest setting.  

Factor: Shows all the factors in your design. This column does not take any input. 
Name: Shows all the names of factors in your design. This column does not take any input. 
Setting: Enter a value to hold each factor that is not being plotted. Use the up and down arrows to move in the Setting 
column. 
 

To set the holding level for factors not in the plot (response surface design) 
1    In the Contour/Surface Plots dialog box, click Setup. 
2    Click Settings.  
3    Do one of the following: 

•    To use the preset values, choose High settings, Middle settings, or Low settings under Hold extra factors at. 
When you use a preset value, all factors not in the plot will be held at their high, middle (calculated median), or 
low settings. (Not available for custom designs.) 

•    To specify the value(s) at which to hold the factor(s), enter a number in Setting for each factor you want control. 
This option allows you to set different hold settings for different factors. 

4    Click OK. 
 

Contour/Surface Plots − Options 
Stat > DOE > Response Surface > Contour/Surface Plots > Setup > Options 
You can determine the title of your plot.  

Dialog box items 
Title: To replace the default title with your own custom title, type the desired text in this box. 
 

Example of a contour plot and a surface plot (response surface design) 
In the fertilizer example, you generated a design, supplied the response data, and fit a linear model. Since this linear 
model suggested that a higher model is needed to adequately model the response surface, you fit the full quadratic 
model. The full quadratic provides a better fit, with the squared terms for nitrogen and phosphoric acid and the nitrogen by 
potash interaction being important. The example below is a continuation of this analysis. Now you want to try an 
understand these effects by looking at a contour plot and a surface plot of snap bean yield versus the significant factors − 
nitrogen and phosphoric acid. By default, Minitab selects the first factor, in this case nitrogen, for the vertical axis, and the 
second factor, phosphoric acid, for the horizontal axis. 
1    Open the worksheet CCD_EX1.MTW. (The design, response data, and model information have been saved for you.) 
2    Choose Stat > DOE > Response Surface > Contour/Surface Plots. 
3    Choose Contour plot and click Setup. Click OK. 
4    Choose Surface plot and click Setup. Click OK in each dialog box. 
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Graph window output 

 

 
Interpreting the results 
The contour plots indicate that the highest yield is obtained when nitrogen levels are low and phosphoric acid levels are 
high. This area appears at the upper left corner of the plot. 
The surface plot also shows that the highest yield is obtained when nitrogen levels are low and phosphoric acid levels are 
high. In addition, you can see the shape of the response surface and get a general idea of yield at various settings of 
nitrogen and phosphoric acid. 
Keep in mind that these plots are based on a model equation. You should be sure that your model is adequate before 
interpreting the plots. 
 

Overlaid Contour Plot 
Overlaid Contour Plot 
Stat > DOE > Response Surface > Overlaid Contour Plot 
Use an overlaid contour plot to draw contour plots for multiple responses and to overlay multiple contour plots on top of 
each other in a single graph. Contour plots show how response variables relate to two continuous design variables while 
holding the rest of the variables in a model at certain settings.  

Dialog box items 
Responses 

Available: Shows all the responses that have had a model fit to them and can be used in the contour plot. Use the 
arrow keys to move up to 10 response columns from Available to Selected. (If an expected response column does not 
show in the Available list, fit a model to it using Analyze RS Design.) 
Selected: Shows all responses that will be included in contour plot. 
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Factors 
X Axis: Choose a factor from the drop-down list to plot on the x-axis. 
Y Axis: Choose a factor from the drop-down list to plot on the y-axis. 

 

Data − Overlaid Contour Plot 
1    Create and store a design using Create Response Surface Design or create a design from data that you already have 

in the worksheet with Define Custom Response Surface Design. 
2    Enter up to ten numeric response columns in the worksheet 
3    Fit a model for each response using Analyze Response Surface Design. 
 

To create an overlaid contour plot 
1    Choose Stat > DOE > Factorial > Overlaid Contour Plot. 
2    Under Responses, move up to ten responses that you want to include in the plot from Available to Selected using 

the arrow buttons. (If an expected response column does not show in Available, fit a model to it using Analyze 
Factorial Design.) 

•    To move the responses one at a time, highlight a response, then click  or   

•    To move all of the responses, click  or   
You can also move a response by double-clicking it. 

3    Under Factors, choose a factor from X Axis and a factor from Y Axis. 

Note Only numeric factors are valid candidates for X and Y axes.

4    Click Contours.  
5    For each response, enter a number in Low and High. See Defining contours. Click OK. 
6    If you like, use any of the available dialog box options, then click OK. 
 

Overlaid Contour Plot − Contours 
Stat > DOE > Response Surface > Overlaid Contour Plot > Contours 
Define the low and high values for the contour lines for each response. 
For a discussion, see Defining contours. 

Dialog box items 
Responses: Lists the responses that have been selected to display on the overlaid contour plot. 

Low: Enter the low value for the contour lines for each response. 
High: Enter the high value for the contour lines for each response. 

 

Defining Contours 
For each response, you need to define a low and a high contour. These contours should be chosen depending on your 
goal for the responses. Here are some examples: 

•    If your goal is to minimize (smaller is better) the response, you may want to set the Low value at the point of 
diminishing returns, that is, although you want to minimize the response, going below a certain value makes little or no 
difference. If there is no point of diminishing returns, use a very small number, one that is probably not achievable. 
Use your maximum acceptable value in High. 

•    If your goal is to target the response, you probably have upper and lower specification limits for the response that can 
be used as the values for Low and High. If you do not have specification limits, you may want to use lower and upper 
points of diminishing returns.  

•    If your goal is to maximize (larger is better) the response, again, you may want to set the High value at the point of 
diminishing returns, although now you need a value on the upper end instead of the lower end of the range. Use your 
minimum acceptable value in Low. 

In all of these cases, the goal is to have the response fall between these two values. 
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Overlaid Contour Plot − Settings 
Stat > DOE > Response Surface > Overlaid Contour Plot >Settings 
You can set the holding level for factors that are not in the plot at their highest, lowest, or middle (calculated median) 
settings, or you can set specific levels to hold each factor. 

Dialog box items 
You may select one of the three choices for settings OR enter your own by typing a value in the table. (Settings represent 
uncoded levels.)  
Hold extra factors at 

High settings: Choose to set variables that are not in the graph at their highest setting. 
Middle settings: Choose to set variables that are not in the graph at the calculated median setting. 
Low settings: Choose to set variables that are not in the graph at their lowest setting.  

Factor: Shows all the factors in your design. This column does not take any input. 
Name: Shows all the names of factors in your design. This column does not take any input. 
Setting: Enter a value to hold each factor that is not being plotted. Use the up and down arrows to move in the Setting 
column. 
 

To set the holding level for factors not in the plot 
1    In the Overlaid Contour Plot dialog box, click Settings. 
2    Do one of the following: 

•    To use the preset values, choose High settings, Middle settings, or Low settings under Hold extra factors at. 
When you use a preset value, all factors not in the plot will be held at their high, middle (calculated median), or 
low settings. (Not available for custom designs.) 

•    To specify the value(s) at which to hold the factor(s), enter a number in Setting for each factor you want control. 
This option allows you to set a different holding value for each variable. 

3    Click OK. 
 

Overlaid Contour Plot − Options 
Stat > DOE > Response Surface > Overlaid Contour Plot > Options 
You can determine the title of your plot. 

Dialog box items 
Title: To replace the default title with your own custom title, type the desired text in this box. 
 

Example of an overlaid contour plot for response surface design 
This contour plot is a continuation of the analysis for the heat-sealing process experiment. Parts are placed inside a 
sealable bag, which is then sealed with a heat-sealing machine. The seal must be strong enough so that product will not 
be lost in transit, yet not so strong that the consumer cannot open the bag. The upper and lower specifications for the seal 
strength are 24 and 28 lbs., with a target of 26 lbs. 
Previous experimentation has indicated that the important factors for controlling the strength of the seal are: hot bar 
temperature (HotBarT), dwell time (DwelTime), hot bar pressure (HotBarP), and material temperature (MatTemp). Hot bar 
temperature (HotBarT) and dwell time (DwelTime) are important for reducing the variation in seal strength. 
Your goal is to optimize both responses: strength of the seal (Strength) and variability in the strength of the seal 
(VarStrength). With an overlaid contour plot, you can only look at two factors at a time. You will use the optimal solution 
values from the response optimizer example as the holding values for factors that are not in the plot (HotBarP and 
MatTemp). 
1    Open the worksheet RSOPT.MTW. 
2    Choose Stat > DOE > Response Surface > Overlaid Contour Plots. 

3    Click  to select both available responses. 
4    Click Contours. Complete the Low and High columns of the table as shown below, then click OK. 

Name Low High 

Strength 24 28 

VarStrength 0 1 
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5    Click Settings. In Setting, enter 163.842 for HotBarP and 104.552 for MatTemp. 
6    Click OK in each dialog box. 

Graph Window Output 

 
Interpreting the results 
The white area in the upper left corner of the plot shows the range of HotBarT and DwellTime where the criteria for both 
response variables are satisfied. You may increase or decrease the holding value to see the range change. To 
understand the feasible region formed by the three factors, you should repeat the process to obtain plots for all pairs of 
factors. 
You can use the plots in combination with the optimization plot to find the best operating conditions for sealing the bags. 
 

Response Optimizer 
Response Optimization Overview 
Many designed experiments involve determining optimal conditions that will produce the "best" value for the response. 
Depending on the design type (factorial, response surface, or mixture), the operating conditions that you can control may 
include one or more of the following design variables: factors, components, process variables, or amount variables.  
For example, in product development, you may need to determine the input variable settings that result in a product with 
desirable properties (responses). Since each property is important in determining the quality of the product, you need to 
consider these properties simultaneously. For example, you may want to increase the yield and decrease the cost of a 
chemical production process. Optimal settings of the design variables for one response may be far from optimal or even 
physically impossible for another response. Response optimization is a method that allows for compromise among the 
various responses. 
Minitab provides two commands to help you identify the combination of input variable settings that jointly optimize a set of 
responses. These commands can be used after you have created and analyzed factorial designs, response surface 
designs, and mixture designs. 

•    Response Optimizer − Provides you with an optimal solution for the input variable combinations and an optimization 
plot. The optimization plot is interactive; you can adjust input variable settings on the plot to search for more desirable 
solutions. 

•    Overlaid Contour Plot − Shows how each response considered relates to two continuous design variables (factorial 
and response surface designs) or three continuous design variables (mixture designs), while holding the other 
variables in the model at specified levels. The contour plot allows you to visualize an area of compromise among the 
various responses. 

 

Response Optimizer 
Stat > DOE > Response Surface > Response Optimizer 
Use response optimization to help identify the combination of input variable settings that jointly optimize a single response 
or a set of responses. Joint optimization must satisfy the requirements for all the responses in the set, which is measured 
by the composite desirability. 
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Minitab calculates an optimal solution and draws a plot. The optimal solution serves as the starting point for the plot. This 
optimization plot allows you to interactively change the input variable settings to perform sensitivity analyses and possibly 
improve the initial solution. 

Note Although numerical optimization along with graphical analysis can provide useful information, it is not a 
substitute for subject matter expertise. Be sure to use relevant background information, theoretical principles, 
and knowledge gained through observation or previous experimentation when applying these methods. 

Dialog box items 
Select up to 25 response variables to optimize 
Available: Shows all the responses that have had a model fit to them and can be used in the analysis. Use the arrow 
keys to move the response columns from Available to Selected. (If an expected response column does not show in the 
Available list, fit a model to it using Analyze RS Design.) 

Selected: Shows all responses that will be included in the optimization. 
 

Data − Response Optimizer 
Before you use Minitab's Response Optimizer, you must  
1    Create and store a design using Create Response Surface Design or create a design from data that you already have 

in the worksheet with Define Custom Response Surface Design.  
2    Enter up to 25 numeric response columns in the worksheet. 
3    Fit a model for each response Analyze Response Surface Design.  
You can fit a model with different design variables for each response. If an input variable was not included in the model for 
a particular response, the optimization plot for that response-input variable combination will be blank. 
Minitab automatically omits missing data from the calculations. If you optimize more than one response and there are 
missing data, Minitab excludes the row with missing data from calculations for all of the responses. 
 

To optimize multiple responses 
1    Choose Stat > DOE > Response Surface > Response Optimizer. 
2    Move up to 25 responses that you want to optimize from Available to Selected using the arrow buttons. (If an 

expected response column does not show in Available, fit a model to it using Analyze Response Surface Design.) 

•    to move responses one at a time, highlight a response, then click  or  

•    to move all the responses at once, click  or  
You can also move a response by double-clicking it. 

3    Click Setup. 
4    For each response, complete the table as follows: 

•    Under Goal, choose Minimize, Target, or Maximize from the drop-down list. 
•    Under Lower, Target, and Upper, enter numeric values for the target and necessary bounds as follows: 

1    If you choose Minimize under Goal, enter values in Target and Upper. 

2    If you choose Target under Goal, enter values in Lower, Target, and Upper. 

3    If you choose Maximize under Goal, enter values in Target and Lower. 
For guidance on choosing bounds, see Specifying bounds. 

•    In Weight, enter a number from 0.1 to 10 to define the shape of the desirability function. See Setting the weight for 
the desirability function. 

•    In Importance, enter a number from 0.1 to 10 to specify the relative importance of the response. See Specifying 
the importance for the composite desirability. 

5    Click OK. 
6    If you like, use any of the available dialog box options, then click OK. 
 

Method − Response Optimization 
Minitab's Response Optimizer searches for a combination of input variables that jointly optimize a set of responses by 
satisfying the requirements for each response in the set. The optimization is accomplished by:  
1    obtaining the individual desirability (d) for each response 
2    combining the individual desirabilities to obtain the combined or composite desirability (D) 
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3    maximizing the composite desirability and identifying the optimal input variable settings  

Note If you have only one response, the overall desirability is equal to the individual desirability. 

Obtaining individual desirability 
First, Minitab obtains an individual desirability (d) for each response using the goals and boundaries that you have 
provided in the Setup dialog box. There are three goals to choose from. You may want to: 

•    minimize the response (smaller is better)  

•    target the response (target is best) 

•    maximize the response (larger is better)  
Suppose you have a response that you want to minimize. You need to determine a target value and an allowable 
maximum response value. The desirability for this response below the target value is one; above the maximum 
acceptable value the desirability is zero. The closer the response to the target, the closer the desirability is to one. The 
illustration below shows the default desirability function (also called utility transfer function) used to determine the 
individual desirability (d) for a "smaller is better" goal: 

 d = desirability  

Target 
any response 
value less 
than the 
target value 
has a 
desirability of 
one  

Upper bound 
any response 
value greater 
than the upper 
bound has a 
desirability  
of zero 

 
As the response decreases, the desirability increases.  

  

The shape of the desirability function between the upper bound and the target is determined by the choice of weight. The 
illustration above shows a function with a weight of one. To see how changing a weight affects the shape of the 
desirability function, see Setting the weight for the desirability function. 

Obtaining the composite desirability 
After Minitab calculates an individual desirability for each response, they are combined to provide a measure of the 
composite, or overall, desirability of the multi-response system. This measure of composite desirability (D) is the weighted 
geometric mean of the individual desirabilities for the responses. The individual desirabilities are weighted according to 
the importance that you assign each response. For a discussion, see Specifying the importance for composite desirability. 

Maximizing the composite desirability 
Finally, Minitab employs a reduced gradient algorithm with multiple starting points that maximizes the composite 
desirability to determine the numerical optimal solution (optimal input variable settings).  

More    You may want to fine tune the solution by adjusting the input variable settings using the interactive optimization 
plot. See Using the optimization plot.  
 

Specifying Bounds 
In order to calculate the numerically optimal solution, you need to specify a response target and lower and/or upper 
bounds. The boundaries needed depend on your goal: 

•    If your goal is to minimize (smaller is better) the response, you need to determine a target value and the upper bound. 
You may want to set the target value at the point of diminishing returns, that is, although you want to minimize the 
response, going below a certain value makes little or no difference. If there is no point of diminishing returns, use a 
very small number, one that is probably not achievable, for the target value.  

•    If your goal is to target the response, you should choose upper and lower bounds where a shift in the mean still 
results in a capable process.  

•    If your goal is to maximize (larger is better) the response, you need to determine a target value and the lower bound. 
Again, you may want to set the target value at the point of diminishing returns, although now you need a value on the 
upper end instead of the lower end of the range.  
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Setting the Weight for the Desirability Function 
In Minitab's approach to optimization, each of the response values are transformed using a specific desirability function. 
The weight defines the shape of the desirability function for each response. For each response, you can select a weight 
(from 0.1 to 10) to emphasize or de-emphasize the target. A weight 

•    less than one (minimum is 0.1) places less emphasis on the target 

•    equal to one places equal importance on the target and the bounds 

•    greater than one (maximum is 10) places more emphasis on the target 
The illustrations below show how the shape of the desirability function changes when the goal is to maximize the 
response and the weight changes:  

Weight Desirability function 
 d = desirability 

0.1 
A weight less than one places less 
emphasis on the target. a response  
value far from the target may have a 
high desirability.  

                                            target 

 

1 
A weight equal to one places equal 
emphasis on the target and the  
bounds. The desirability for a response 
increases linearly. 

 
                                        target 

 

10 
A weight greater than one places more 
emphasis on the target. A response  
value must be very close to the target 
to havea high desirability. 

 
                                      target 

 
 
The illustrations below summarize the desirability functions: 

When the goal is to ...  

 

minimize the response  
Below the target the response 
desirability is one; above the 
upper bound it is zero.  
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target the response 
Below the lower bound the 
response desirability is zero; 
at the target it is one; above 
the upper bound it is zero. 

 
 

maximize the response  
Below the lower bound the 
response desirability is zero; 
above the target it is one.  

 
 

Specifying the Importance for Composite Desirability 
After Minitab calculates individual desirabilities for the responses, they are combined to provide a measure of the 
composite, or overall, desirability of the multi-response system. This measure of composite desirability is the weighted 
geometric mean of the individual desirabilities for the responses. The optimal solution (optimal operating conditions) can 
then be determined by maximizing the composite desirability. 
You need to assess the importance of each response in order to assign appropriate values for importance. Values must 
be between 0.1 and 10. If all responses are equally important, use the default value of one for each response. The 
composite desirability is then the geometric mean of the individual desirabilities. 
However, if some responses are more important than others, you can incorporate this information into the optimal solution 
by setting unequal importance values. Larger values correspond to more important responses, smaller values to less 
important responses. 
You can also change the importance values to determine how sensitive the solution is to the assigned values. For 
example, you may find that the optimal solution when one response has a greater importance is very different from the 
optimal solution when the same response has a lesser importance. 
 

Response Optimizer − Setup 
Stat > DOE > Response Surface > Response Optimizer > Setup 
Specify the goal, boundaries, weight, and importance for each response variable. 

Dialog box items 
Response: Displays all the responses that will be included in the optimization. This column does not take any input. 
Goal: Choose Minimize, Target, or Maximize from the drop-down list.  
Lower: For each response that you chose Target or Maximize under Goal, enter a lower boundary. 
Target: Enter a target value for each response. 
Upper: For each response that you chose Minimize or Target under Goal, enter an upper boundary. 
Weight: Enter a number from 0.1 to 10 to define the shape of the desirability function. 
Importance: Enter a number from 0.1 to 10 to specify the comparative importance of the response. 
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Response Optimizer − Options 
Stat > DOE > Response Surface > Response Optimizer > Options 
Define a starting point for the search algorithm, suppress display of the optimization plot, and store the composite 
desirability values. 

Dialog box items 
Factors in design: Displays all the factors that have been included in a fitted model. This column does not take any input 
Starting values: To define a starting point for the search algorithm, enter a value for each factor. Each value must be 
between the minimum and maximum levels for that factor. 
Optimization plot: Uncheck to suppress display of the multiple response optimization plot. 
Store composite desirability values: Check to store the composite desirability values. 
Display local solutions: Check to display the local solutions. 
 

Response Optimizer − Levels for Input Variables 
Enter a new value to change the input variable settings. 
For further discussion, see Using the optimization plot. 

Dialog box items 
Input New Level Value: Enter a new value to change the input variable settings. 
 

Using the Optimization Plot 
Once you have created an optimization plot, you can change the input variable settings. For factorial and response 
surface designs, you can adjust the factor levels. For mixture designs, you can adjust component, process variable, and 
amount variable settings. You might want to change these input variable settings on the optimization plot for many 
reasons, including: 

•    To search for input variable settings with a higher composite desirability 

•    To search for lower-cost input variable settings with near optimal properties 

•    To explore the sensitivity of response variables to changes in the design variables 

•    To "calculate" the predicted responses for an input variable setting of interest 

•    To explore input variable settings in the neighborhood of a local solution 
When you change an input variable to a new level, the graphs are redrawn and the predicted responses and desirabilities 
are recalculated. If you discover a setting combination that has a composite desirability higher than the initial optimal 
setting, Minitab replaces the initial optimal setting with the new optimal setting. You will then have the option of adding the 
previous optimal setting to the saved settings list. 

Note If you save the optimization plot and then reopen it in Minitab without opening the project file, you will not be 
able to drag the red lines with your mouse to change the factor settings. 

With Minitab's interactive Optimization Plot you can: 

•    Change input variable settings  

•    Save new input variable settings  

•    Delete saved input variable settings  

•    Reset optimization plot to optimal settings  

•    View a list of all saved settings  

•    Lock mixture components  
 

To change input variable settings 
1    Change input variable settings in the optimization plot by: 

•    Dragging the vertical red lines to a new position or  
•    Clicking on the red input variable settings located at the top and entering a new value in the dialog box that 

appears . 

Note You can return to the initial or optimal settings at any time by clicking  on the Toolbar or by right-clicking and 
choosing Reset to Optimal Settings. 
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Note For factorial designs with center points in the model: If you move one factor to the center on the optimization 
plot, then all factors will move to the center. If you move one factor away from the center, then all factors with 
move with it, away from the center. 

Note For a mixture design, you cannot change a component setting independently of the other component settings. 
If you want one or more components to stay at their current settings, you need to lock them. See To lock 
components (mixture designs only). 

 

To save new input variable settings 
1    Save new input variable settings in the optimization plot by 

•    Clicking  on the Optimization Plot Toolbar 
•    Right-clicking and selecting Save current settings from the menu 

Note The saved settings are stored in a sequential list. You can cycle forwards and backwards through the setting 

list by clicking on  or  on the Toolbar or by right-clicking and choosing the appropriate command from 
the menu. 

 

To delete saved input variable settings 
1    Choose the setting that you want to delete by cycling through the list.  
2    Delete the setting by: 

•    Clicking  on the Optimization Plot Toolbar 
•    Right-clicking and choosing Delete Current Setting  

 

To reset optimization plot to optimal settings 
1    Reset to optimal settings by: 

•    Clicking  on the Toolbar 
•    Right-clicking and choosing Reset to Optimal Settings 

 

To view a list of all saved settings 
1    View the a list of all saved settings by 

•    Clicking  on the Optimization Plot Toolbar 
•    Right-clicking and choosing Display Settings List 

More You can copy the saved setting list to the Clipboard by right-clicking and choosing Select All and then choosing 
Copy. 

 

Example of a response optimization experiment for response surface design 
You need to create a product that satisfies the criteria for both seal strength and variability in seal strength. Parts are 
placed inside a bag, which is then sealed with a heat-sealing machine. The seal must be strong enough so that product 
will not be lost in transit, yet not so strong that the consumer cannot open the bag. The lower and upper specifications for 
the seal strength are 24 and 28 lbs., with a target of 26 lbs. For the variability in seal strength, the goal is to minimize and 
the maximum acceptable value is 1. 
Previous experimentation has indicated that the following are important factors for controlling the strength of the seal: hot 
bar temperature (HotBarT), dwell time (DwelTime), hot bar pressure (HotBarP), and material temperature (MatTemp). Hot 
bar temperature (HotBarT) and dwell time (DwelTime) are important for reducing the variation in seal strength. 
You goal is to optimize both responses: strength of the seal (Strength) and variability in the strength of the seal 
(VarStrength). 
1    Open the worksheet RSOPT.MTW. (The design, response data, and model information have been saved for you.) 
2    Choose Stat > DOE > Response Surface > Response Optimizer. 

3    Click  to move Strength and VarStrength to Selected. 
4    Click Setup. Complete the Goal, Lower, Target, and Upper columns of the table as shown below: 



Response Surface Designs 

 Copyright © 2003–2005 Minitab Inc.  All rights reserved.  127

Response Goal Lower Target Upper 

Strength Target 24 26 28 

VarStrength Minimize  0 1 

5    Click OK in each dialog box. 

Session Window Output 

Response Optimization 
 
Parameters 
 
                    Goal      Lower     Target      Upper     Weight     Import 
Strength         Target         24         26         28          1          1 
VarStrength     Minimum          0          0          1          1          1 
 
Global Solution 
 
HotBarT      =  225.000 
DwelTime     =    0.464 
HotBarP      =    0.000 
MatTemp      =   50.000 
 
Predicted Responses 
 
Strength     =  26.0000, desirability =        1 
VarStrength  =  -0.6419, desirability =        1 
 
Composite Desirability =  1.00000 

Graph Window Output 

 
Interpreting the results 
The individual desirability of both the seal strength and the variance in seal strength is 1.0. Therefore, the combined or 
composite desirability of these two variables is 1.0. 
To obtain this desirability, you would set the factor levels at the values shown under Global Solution. That is, hot bar 
temperature would be set at 125.000, dwell time at 1.197, hot bar pressure at 163.842, and material temperature at 
104.552. 
If you want to adjust the factor settings of this initial solution, you can use the plot. Move the vertical bars to change the 
factor settings and see how the individual desirability of the responses and the composite desirability change. For 
example, you may want see if you can reduce the material temperature (which would save money) and still meet the 
product specifications. 
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Modify Design 
Modify Design 
Stat > DOE > Modify Design 
After creating a design and storing it in the worksheet, you can use Modify Design to make the following modifications: 

•    rename the factors and change the factor levels  

•    replicate the design 

•    randomize the design 
By default, Minitab will replace the current design with the modified design. 

Dialog box items 
Modification  

Modify factors: Choose to rename factors or change factor levels, and then click <Specify>. 
Replicate design: Choose to add up to ten replicates, and then click <Specify>. 
Randomize design: Choose to randomize the design, and then click <Specify>. 

Put modified design in a new worksheet: Check to have Minitab place the modified design in a new worksheet rather 
than overwriting the current worksheet. 
 

Modify Design − Factors  
Stat > DOE > Modify Design > Modify Factors 
Names the factors and assign values for factor settings.  
Use the arrow keys to navigate within the table, moving across rows or down columns. 

Tip You can also type new factor names directly into the Data window.

Dialog box items 
Factor: Shows the number of factors you have chosen for your design. This column does not take any input. 
Name: Enter text to change the name of the factors.  
Low: Enter the value for the low setting of each factor.  
High: Enter the value for the high setting of each factor.  
 

To rename factors or change factor levels 
1    Choose Stat > DOE > Modify Design. 
2    Choose Modify factors and click Specify. 
3    Under Name, click in the first row and type the name of the first factor. Then, use the arrow key to move down the 

column and enter the remaining factor names. 
2    Under Low, click in the row for the factor you would like to assign values and enter any numeric value. Use the arrow 

key to move to High and enter a numeric value that is greater than the value you entered Low. 
3    Repeat step 2 to assign levels for other factors. 
5    Click OK. 
 

Modify Design − Replicate 
Stat > DOE > Modify Design > check Replicate Design > Specify 
You can add up to ten replicates of your design. When you replicate a design, you duplicate the complete set of runs from 
the initial design. To see the runs that would be added to a two-factor central composite design, click here. 
True replication provides an estimate of the error or noise in your process and may allow for more precise estimates of 
effects. 

Dialog box items 
Number of replicates to add: Choose a number up to ten. 
 



Response Surface Designs 

 Copyright © 2003–2005 Minitab Inc.  All rights reserved.  129

To replicate the design 
1    Choose Stat > DOE > Modify Design. 
2    Choose Replicate design and click Specify. 
3    From Number of replicates to add, choose a number up to ten. Click OK. 
 

Replicating the design 
You can add up to ten replicates of your design. When you replicate a design, you duplicate the complete set of runs from 
the initial design. The runs that would be added to a two factor central composite design are as follows: 

Initial design One replicate added 
(total of two replicates) 

Two replicates added 
(total of three replicates) 

  A      B 
-1.414  0.000 
 1.000 -1.000 
 0.000  1.414 
 0.000  0.000 
 0.000  0.000 
 1.414  0.000 
 0.000  0.000 
 0.000  0.000 
 0.000  0.000 
 0.000 -1.414 
 1.000  1.000 
-1.000 -1.000 
-1.000  1.000 

   A     B 
-1.414  0.000 
 1.000 -1.000 
 0.000  1.414 
 0.000  0.000 
 0.000  0.000 
 1.414  0.000 
 0.000  0.000 
 0.000  0.000 
 0.000  0.000 
 0.000 -1.414 
 1.000  1.000 
-1.000 -1.000 
-1.000  1.000 
-1.414  0.000 
 1.000 -1.000 
 0.000  1.414 
 0.000  0.000 
 0.000  0.000 
 1.414  0.000 
 0.000  0.000 
 0.000  0.000 
 0.000  0.000 
 0.000 -1.414 
 1.000  1.000 
-1.000 -1.000 
-1.000  1.000 

  A      B 
-1.414  0.000 
 1.000 -1.000 
 0.000  1.414 
 0.000  0.000 
 0.000  0.000 
 1.414  0.000 
 0.000  0.000 
 0.000  0.000 
 0.000  0.000 
 0.000 -1.414 
 1.000  1.000 
-1.000 -1.000 
-1.000  1.000 
-1.414  0.000 
 1.000 -1.000 
 0.000  1.414 
 0.000  0.000 
 0.000  0.000 
 1.414  0.000 
 0.000  0.000 
 0.000  0.000 
 0.000  0.000 
 0.000 -1.414 
 1.000  1.000 
-1.000 -1.000 
-1.000  1.000 
-1.414  0.000 
 1.000 -1.000 
 0.000  1.414 
 0.000  0.000 
 0.000  0.000 
 1.414  0.000 
 0.000  0.000 
 0.000  0.000 
 0.000  0.000 
 0.000 -1.414 
 1.000  1.000 
-1.000 -1.000 
-1.000  1.000 

True replication provides an estimate of the error or noise in your process and may allow for more precise estimates of 
effects. 
 

Modify Design − Randomize Design 
Stat > DOE > Modify Design > choose Randomize design > Specify 
You can randomize the entire design or just randomize one of the blocks. For a general discussion of randomization, see 
Randomizing the design. 

More You can use Display Design to switch back and forth between a random and standard order display in the 
worksheet. 

Dialog box items 
Randomize entire design: Choose to randomize the runs in the data matrix. If your design is blocked, randomization is 
done separately within each block and then the blocks are randomized. 
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Randomize just block: Choose to randomize one block, then choose the block to randomize from the drop-down list. 
Base for random data generator: Enter a base for the random data generator. By entering a base for the random data 
generator, you can control the randomization so that you obtain the same pattern every time.  

Note If you use the same base on different computer platforms or with different versions of Minitab, you may not get 
the same random number sequence. 

 

To randomize the design 
1    Choose Stat > DOE > Modify Design. 
2    Choose Randomize design and click Specify.  
3    Do one of the following: 

•    Choose Randomize entire design. 
•    Choose Randomize just block, and choose a block number from the list. 

4    If you like, in Base for random data generator, enter a number. Click OK. 

Note You can use Stat > DOE > Display Design to switch back and forth between a random and standard order 
display in the worksheet. 

 

Display Design 
Display Design 
Stat > DOE > Display Design 
After you create the design, you can use Display Design to change the way the design points are stored in the worksheet. 
You can change the design points in two ways: 

•    display the points in either run or standard order. Standard order is the order of the runs if the experiment was done in 
Yates' order. Run order is the order of the runs if the experiment was done in random order. 

•    express the factor levels in coded or uncoded form. 

Dialog box items 
How to display the points in the worksheet  
Order for all points in the worksheet: Minitab sorts the worksheet columns according to the display method (random 
order or standard order) you select. By default, Minitab sorts a column if the number of rows is less than or equal to the 
number of rows in the design. Specify any columns that you do not want to reorder in the Columns Not to Reorder dialog 
box. Columns that have more rows than the design cannot be reordered. 

Run order for design: Choose to display points in run order. 
Standard order for design: Choose to display points in standard order. 

Units for factors  

Coded units: Choose to display the design points in coded units. Minitab sets the low level of all factors to −1, the high 
level to +1, and center points to 0. 
Uncoded Units: Choose to display the design points in uncoded units. The levels that you assigned in the Factors 
subdialog box will display the worksheet. 

 

To change the display order of points in the worksheet 
1    Choose Stat > DOE > Display Design.  
2    Choose Run order for the design or Standard order for the design. If you do not randomize a design, the columns 

that contain the standard order and run order are the same. 
3    Do one of the following: 

•    If you want to reorder all worksheet columns that are the same length as the design columns, click OK. 
•    If you have worksheet columns that you do not want to reorder:  

1    Click Options.  

2    In Exclude the following columns when sorting, enter the columns. These columns cannot be part of the 
design. Click OK in each dialog box. 
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To change the display units for the factors 
If you assigned factor levels in Factors subdialog box, the uncoded or actual levels are initially displayed in the worksheet. 
For example, if you entered 50 for the low level of temperature and 80 for the high level of temperature in the Factors 
subdialog box, these uncoded levels display in the worksheet. The coded levels are -1 and +1. 
If you did not assign factor levels, displaying the design in coded and uncoded units is the same.  
1    Choose Stat > DOE > Display Design. 
2    Choose Coded units or Uncoded units. Click OK. 
 

References - Response Surface Designs      
[1]    G.E.P. Box and D.W. Behnken (1960). "Some New Three Level Designs for the Study of Quantitative Variables," 

Technometrics 2, pp.455−475. 
[2]    G.E.P. Box and N.R. Draper (1987). Empirical Model-Building and Response Surfaces. John Wiley & Sons. p.249. 
[3]    A.I. Khuri and J.A. Cornell (1987). Response Surfaces: Designs and Analyses. Marcel Dekker, Inc. 
[4]    D.C. Montgomery (2001). Design and Analysis of Experiments, Fifth Edition. John Wiley & Sons. 
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Mixture Designs 
Mixture Designs Overview  
Mixture experiments are a special class of response surface experiments in which the product under investigation is made 
up of several components or ingredients. Designs for these experiments are useful because many product design and 
development activities in industrial situations involve formulations or mixtures. In these situations, the response is a 
function of the proportions of the different ingredients in the mixture. For example, you may be developing a pancake mix 
that is made of flour, baking powder, milk, eggs, and oil. Or, you may be developing an insecticide that blends four 
chemical ingredients. 
In the simplest mixture experiment, the response (the quality or performance of the product based on some criterion) 
depends on the relative proportions of the components (ingredients). The quantities of components, measured in 
weights, volumes, or some other units, add up to a common total. In contrast, in a factorial design, the response varies 
depending on the amount of each factor (input variable). 
Minitab can create designs and analyze data from three types of experiments: 

•    mixture experiments 

•    mixture-amounts (MA) experiments 

•    mixture-process variable (MPV) experiments 
The difference in these experiments is summarized below: 

Type Response depends on...  Example 

mixture  the relative proportions of the 
components only. 

 the taste of lemonade 
depends only on the 
proportions of lemon juice, 
sugar, and water 

mixture-amounts  the relative proportions of the 
components and the total 
amount of the mixture. 

 the yield of a crop depends 
on the proportions of the 
insecticide ingredients and the 
amount of the insecticide 
applied  

mixture-process variable  the relative proportions of the 
components and process 
variables. Process variables 
are factors that are not part of 
the mixture but may affect  the 
blending properties of 
the mixture.     

 the taste of a cake depends 
on the cooking time and 
cooking temperature, and the 
proportions of cake mix 
ingredients 

 

Mixture Experiments in Minitab      
The design and subsequent analysis of a mixture experiment might consist of the following steps: 
1    Choose a mixture design for the experiment. Before you begin using Minitab, you need to determine what design is 

appropriate for your problem. See Choosing a Design. 
2    Use Create Mixture Design to generate a simplex centroid, simplex lattice, or extreme vertices mixture design. In 

addition, you can include amounts or process variables in your design to create mixture-amounts designs and 
mixture-process variable designs. 
Use Define Custom Mixture Design to create a design from data you already have in the worksheet. Define Custom 
Mixture Design allows you to specify which columns contain your components and other design characteristics. You 
can then easily fit a model to the design.  

3    Use Modify Design to rename the components, replicate the design, randomize the design, and renumber the design. 
4    Use Display Design to change the display order of the runs and to change the units in which Minitab expresses the 

components or process variables in the worksheet.  
5    Perform the mixture experiment and collect the response data. Then, enter the data in your Minitab worksheet. See 

Collecting and Entering Data. 
6    Use Analyze Mixture Design to fit a model to the experimental data. 
7    Use plots to visualize the design space or response surface patterns. Use Simplex Design Plot to view the design 

space, or Response Trace Plot and Contour/Surface Plots to visualize response surface patterns. 
8    If you are trying to optimize responses, use Response Optimizer or Overlaid Contour Plot to obtain a numerical and 

graphical analysis. 
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Depending on your experiment, you may do some of the steps in a different order, perform a given step more than once, 
or eliminate a step. 
 

Choosing a Design  
Before you use Minitab, you need to determine what design is most appropriate for your experiment. Minitab provides 
simplex centroid, simplex lattice, and extreme vertices designs. 
When you are choosing a design you need to 

•    identify the components, process variables, and mixture amounts that are of interest 

•    determine the model you want to fit − see Selecting model terms 

•    ensure adequate coverage of the experimental region of interest 

•    determine the impact that other considerations (such as cost, time, availability of facilities, or lower and upper bound 
constraints) have on your choice of a design  

For a complete discussion of choosing a design, see [1].  
To help you visualize a mixture design, the following illustrations show design points using triangular coordinates. Each 
point on the triangle represents a particular blend of components that you would use in your experiment. For simplicity, 
the illustrations show three component designs. The diagrams below only show a few of the mixture designs you can 
create. Minitab can also create simplex lattice designs up to degree 10 and extreme vertices designs. For an explanation 
of triangular coordinates, see Triangular coordinate systems.  

      Unaugmented      Augmented 

 

 

Simplex 
Centroid 

permits fitting of up to a  
special cubic model 

permits partial fitting of up 
to a full cubic model 

 

 

Simplex Lattice 
Degree 1 

permits fitting of a linear  
model 

permits partial fitting of up 
to a quadratic model 

 

 

Simplex Lattice 
Degree 2 

permits fitting of up to a 
quadratic model 

permits partial fitting of up 
to a special cubic model 
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Simplex Lattice 
Degree 3 

permits fitting of up to a  
full cubic model 

permits fitting of up to a  
full cubic model 

Note When selecting a design, it is important to consider the maximum order of the fitted model required to 
adequately model the response surface. Mixture experiments frequently require a higher-order model than is 
initially planned. Therefore, it is usually a good idea, whenever possible, to perform additional runs beyond 
the minimum required to fit the model. For guidelines, see [1]. 

 

Triangular Coordinate Systems  
Triangular coordinate systems allow you to visualize the relationships between the components in a three-component 
mixture. In a mixture, the components are restricted by one another in that the components must add up to the total 
amount or whole. Triangular coordinate systems in this section show the minimum of the x1, x2, and x3 components as 0, 
with the maximums at 1.  
The following illustration shows the general layout of a triangular coordinate system. The components in mixture models 
are referred to in terms of their proportion to the whole, with the whole as 1. The vertices of the triangle represent pure 
mixtures (also called single-component blends). In pure mixtures, the proportion of one component is 1 and the rest are 0. 
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Any points along the edges of the triangle represent blends where one of the components is absent. The illustrations 
below show the location of different blends.  

 
Now let's look at some points on the coordinate system. 

 
Each location on the triangles in the above illustrations represents a different blend of the mixture. For example, 

•    edge midpoints are two-blend mixtures in which one component makes up 1/2 and a second component makes up 1/2 
of the mixture. 

•    edge trisectors are two-blend mixtures in which one component makes up 1/3 and another component makes up 2/3 
of the mixture. These points divide the triangle edge into 3 equal parts. 

•    the center point (or centroid) is the complete mixture in which all components are present in equal proportions 
(1/3,1/3,1/3). Complete mixtures are on the interior of the design space and are mixtures in which all of the 
components are simultaneously present. 

 

Create Mixture Design 
Create Mixture Design 
Stat > DOE > Mixture > Create Mixture Design 
You can create simplex centroid, simplex lattice, or extreme vertices designs.  

Note To create a design from data that you already have in the worksheet, see Define Custom Mixture Design.

Dialog box items 
Type of Design  

Simplex centroid (2 to 10 components): Choose to generate a simple centroid design. 
Simplex lattice (2 to 20 components): Choose to generate a simplex lattice design. 
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Extreme vertices (2 to 10 components): Choose to generate an extreme vertices design. 
Number of components: Choose the number of components in the design to be generated. 
 

Mixture Designs − Simplex Centroid  
Stat > DOE > Mixture > Create Mixture Design > choose Simplex centroid > Designs 
Generates settings for the components in an experiment with a simplex centroid design. You can  

•    add axial points to the interior of the design (by default, Minitab adds these points to the design)  

•    replicate the design  

Dialog box items 
Augment the design with axial points: Check to augment (or adds points to) the base design. See Placement of axial 
points in augmented designs. 
Replicate Design Points  

Number of replicates for the whole design: Choose to replicate the whole design, then choose a number of to 50 for 
the number of replicates. 
Number of replicates for the selected types of points: Choose to replicate only certain types of design points from 
the base design. Then, under Number, enter the number of replicates for each point type. 

 

Mixture Designs − Simplex Lattice Design 
Stat > DOE > Mixture > Create Mixture Design > choose Simplex lattice > Designs 
Generates settings for the components in an experiment with a simplex lattice design. You can 

•    choose the degree of a simplex lattice design 

•    add a center point or add axial points to the interior of the design (by default, Minitab adds these points to the design)  

•    replicate the design  

Dialog box items 
Degree of lattice: Choose a degree for your design from the drop-down list. The choices available depend on the number 
of components you chose in the main Create Mixture Design dialog box.  
Augment the design with center points: Check to add a center point to the design. 
Augment the design with axial points: Check to add axial points to design. See Placement of axial points in augmented 
designs.  
Replicate Design Points:  

Number of replicates for the whole design: Choose to replicate the whole design, then choose a number of to 50 for 
the number of replicates. 
Number of replicates for the selected types of points: Choose to replicate only certain types of design points from 
the base design. Then, under Number, enter the number of replicates for each point type. 

 

Mixture Designs − Extreme Vertices 
Stat > DOE > Mixture > Create Mixture Design > choose Extreme vertices > Designs 
Generates settings for the components in an experiment with an extreme vertices design. You can 

•    choose the degree of the design  

•    add a center point or add axial points to the interior of the design (by default, Minitab adds these points to the design)  

•    replicate the design  

Dialog box items 
Degree of design: Choose a degree for your design from the drop-down list. The choices available depend on the 
number of components you chose in the main Create Mixture Design dialog box.  
Augment the design with center points: Check to add a center point to the design. 
Augment the design with axial points: Check to add axial points to design.  
Replicate Design Points:  

Number of replicates for the whole design: Choose to replicate the whole design, then choose a number of to 50 for 
the number of replicates. 
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Number of replicates for the selected types of points: Choose to replicate only certain types of design points from 
the base design. Then, under Number, enter the number of replicates for each point type. 

 

To create a mixture design 
1    Choose Stat > DOE > Mixture > Create Mixture Design.  
2    If you want to see a summary of the simplex designs, click Display Available Designs. Use this table to compare 

design features. Click OK. 
3    Under Type of Design, choose Simplex centroid, Simplex lattice, or Extreme vertices. 
4    From Number of components, choose a number. 
5    Click Designs.  
6    If you like, use any of the options in the Design subdialog box. 
7    Click OK even if you do not change any of the options. This selects the design and brings you back to the main dialog 

box. 
8    If you like, click Components, Process Vars, Options, or Results to use any of the dialog box options, then click OK 

to create your design. 
 

Mixture Design − Available Designs 
Stat > DOE > Mixture > Create Mixture Design > Display Available Designs 
Displays a table to help you select an appropriate design, based on the: 

•    Number of components that are of interest 

•    Number of runs you can perform 
This dialog box does not take any input.  
 

Augmenting the Design 
In order to adequately cover the response surface, you want to use a design that has interior points. By default, Minitab 
augments a design by adding interior points to the design. Minitab adds axial points and a center point if it is not already in 
the base design. Each of these additional points is a complete mixture − that is, a mixture in which all components are 
simultaneously present. A design with these interior points would provide information on the inner portion of the response 
surface and allow you to model more complicated curvature. 
These points are primarily used to examine the lack-of-fit of a model. In addition, a design with these interior points would 
provide information on the inner portion of the response surface and allow you to model more complicated curvature.  
Each axial point is added halfway between a vertex and the center of the design. For calculations of these additional 
points, see Placement of axial points in augmented designs. 
The illustrations below show the points that are added when you augment a second-degree three-component simplex 
lattice design with both axial points and a center point. 

Unaugmented  Augmented 

 

 

 
To compare some other three-component designs, see the table under Choosing a Design. To view any design in Minitab, 
use Simplex Design Plot. 

Note If you do not want to augment your design, uncheck Augment the design with a center point and/or Augment 
the design with axial points in the Designs subdialog box. 
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To augment the design 
1    In the Create Mixture Design dialog box, click Designs. 
2    Check Augment the design. Click OK. 
 

Placement of Axial Points in Augmented Designs 
Minitab augments (or adds points to) the design using the axial points shown below. Each added point is half way 
between a vertex and the center of the design. 

( (q+1)/2q, 1/2q, 1/2q, 1/2q, 1/2q, ..., 1/2q ) ( 1/2q, (q+1)/2q, 1/2q, 1/2q, 1/2q, ..., 1/2q ) 
( 1/2q, 1/2q, (q+1)/2q, 1/2q, 1/2q, ..., 1/2q ) ( 1/2q, 1/2q, 1/2q, (q+1)/2q, 1/2q, ..., 1/2q ) 
. . . . . . . . . . . . . . 
( 1/2q, 1/2q, 1/2q, 1/2q, 1/2q, ..., (q+1)/2q ) 

By augmenting a design, you can get a better picture of what happens on the interior of the design, instead of just relying 
on points on the edges. 
 

Replicating the Design 
You can replicate your design in one of two ways. You can replicate 

•    the whole design up to 50 times 

•    only certain types of points as many times as you want 
When you replicate the whole design, you duplicate the complete set of design points from the base design. The design 
points that would be added to a first-degree three-component simplex lattice design are as follows: 

Initial design One replicate added 
(total of two replicates) 

Two replicates added 
(total of three replicates) 

A B C 

1 0 0 
0 1 0 
0 0 1 

A B C 

1 0 0 
0 1 0 
0 0 1 

1 0 0 
0 1 0 
0 0 1 

A B C 

1 0 0 
0 1 0 
0 0 1 

1 0 0 
0 1 0 
0 0 1 

1 0 0 
0 1 0 
0 0 1 

When you choose which types of points to replicate, you duplicate only the design points of the specified types of points 
from the base design. For example, the design points for a replicated second-degree three-component simplex lattice 
design are as follows. 

 Base design One replicate of each 
vertex and two replicates 
of each double blend 

Two replicates of each 
vertex and two replicates 
of each double blend 

A  B  C 

1  0  0 
.5 .5  0 
.5  0 .5 
0  1  0 
0 .5 .5 
0  0  1 

A  B  C 

1  0  0 
.5 .5  0 
.5  0 .5 
0  1  0 
0 .5 .5 
0  0  1 

.5 .5  0 

.5  0 .5 
0 .5 .5 

A  B  C 

1  0  0 
.5 .5  0 
.5  0 .5 
0  1  0 
0 .5 .5 
0  0  1 

1  0  0 
0  1  0 
0  0  1 

5 .5  0 
.5  0 .5 
0 .5 .5 

 

True replication provides an estimate of the error or noise in your process and may allow for more precise estimates of 
effects. 
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To replicate the design 
1    In the Create Mixture Design dialog box, click Designs.  
2    Under Replicate design points do one of the following: 

•    To replicate the entire base design, choose Number of replicates for the whole design and choose a number up 
to 50. 

•    To replicate only certain types of points, choose Number of replicates for the selected types of points and 
enter the number of replicates for each point type in the Number column of the table. 

3    Click OK. 
 

Mixture Design − Components 
Stat > DOE > Mixture > Create Mixture Design > Components 
You can: 

•    Generate the design in units of the actual measurements rather than the proportions of the components  

•    Perform a mixture amounts experiment with up to five amount totals  

•    Name components 

•    Set lower and upper bounds for constrained designs 

Dialog box items 
Total Mixture Amount: Enter any positive number to express values in terms of actual measurement units rather than 
expressing measurements as proportions, that is all components sum to 0 and 1. The default value is 1.  
Multiple totals (up to 5): Enter up to five positive numbers to perform a mixture amounts experiment. 
Component Bounds Specified in Amount (lower and upper are the first total, if you specified more than one) 

Name: Enter text to change the name of the components.  
Lower: Enter the value of the lower bound constraint for each component.  
Upper: Enter the value of the upper bound constraint for each component. 

 

Mixture−Amounts Designs 
In the simplest mixture experiment, the response is assumed to only depend on the proportions of the components in the 
mixture. In the mixture-amounts experiment, the response is assumed to depend on the proportions of the components 
and the amount of the mixture. For example, the amount applied and the proportions of the ingredients of a plant food 
may affect the growth of a house plant. When a mixture experiment is performed at two or more levels of the total mixture 
amount, it is called a mixture-amounts experiment. 
 

To create a mixture amounts design 
1    In the Create Mixture Design dialog box, click Components. 
2    Under Total Mixture Amount, choose Multiple totals and enter up to five mixture totals. Suppose you are testing 

plant food and would like evaluate plant growth when one gram versus two grams of food are applied. You would 
enter 1 2. Click OK. 

More For a complete discussion of mixture-amounts experiments, see [1] and [2].

 

Specifying the units for components 
If you did not change the total for the mixture from the default value of one, Minitab uses proportions to store your data. 
(This is equivalent to an amount total equal to one.) If you did change the total for the mixture, Minitab uses amounts − 
what you actually measure − to express your data. Depending on the mixture total and the presence of constraints, you 
may want to represent the design in another scale. 
You can choose one of three scales to represent the design: amounts, proportions, or pseudocomponents. With certain 
combinations of the mixture total and lower bound constraints, the various scalings are equivalent as shown in the 
following table: 
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Total mixture  Lower bound  Equivalent scales 

equal to 1 0 amounts 
proportions 
pseudocomponents 

equal to 1 greater than 0 amounts 
proportions 

not equal to 1 0 proportions 
pseudocomponents 

not equal to 1 greater than 0 none 

 

Create Mixture Design − Extreme Vertices − Linear Constraints 
Stat > DOE > Mixture > Create Mixture Design > choose Extreme vertices > Components > Linear constraints 
Allows you to set linear constraints for the set of components. See Setting linear constraints for extreme vertices designs 
for details. 

Dialog box items 
Specify a coefficient for one or more components, and a value for Lower and/or Upper 

Lower: Enter the lower value for the linear constraint. 
A, B, C, ... : There is one row for each component in the design. Enter a coefficient for one or more of the components 
Upper: Enter the upper value for the linear constraint. 

 

To set linear constraints for a set of components 
1    In the Create Mixture Design dialog box, click Components. 
2    Click Linear Constraints. 
3    In the first column of the table, enter a coefficient for one or more of the components and a lower and/or upper value. 

Use the arrow key to move down the column and enter desired values. The lower and upper values that you enter 
must be consistent with value of Single total or the first value in Multiple totals. 
You must enter at least one coefficient and an upper or lower value. If you do not enter a coefficient for a component, 
Minitab assumes it to be zero. 

4    Repeat step 3 to enter up to ten different linear constraints on the set of components. Click OK. 
 

Setting Linear Constraints for Extreme Vertices Designs 
In addition to the individual bounds on the components, you may have up to ten linear constraints on the set of 
components. For example, you would need a linear constraint in the following situation. Suppose you need to constrain 
the wet ingredients (eggs, milk, oil) of a cake mix so that together they are not less than 40% or greater than 60% of the 
total mixture. If you are willing to allow equal amounts of these three ingredients, you would use the following values for 
the linear constraint: lower value is 0.4, the upper value is 0.6, and the component coefficients are all 1. Examples for a 
four-component blend are shown in the table below: 

  Coefficients  

Condition 
Lower 
Value A B C  D 

Upper 
Value 

A + B > 10 and A + B < 20 10 1 1   20 
5A + 3B + 8D < 0.1  5 3  8 0.1 
0.5B + 0.8D > 0.9 0.9  0.5 0.8   

 

To name components 
1    In the Create Mixture Design dialog box, click Components. 
2    Under Name, click in the first row and type the name of the first component. Then, use the arrow key to move down 

the column and enter the remaining component names.  

More After you have created the design, you can change the component names by typing new names in the Data 
window, or with Modify Design. 
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Setting Lower and Upper Bounds 
By default, Minitab generates settings for an unconstrained design, that is, the lower bound is zero and the upper bound is 
one for all the components. However, in some mixture experimentation, it is necessary to set a lower bound and/or an 
upper bound on some or all of the components.  

•    Lower bounds are necessary when any of the components must be present in the mixture. For example, lemonade 
must contain lemon juice. 

•    Upper bounds are necessary when the mixture cannot contain more than a given proportion of an ingredient. For 
example, a cake mix cannot contain more than 5% baking powder. 

Constrained designs (those in which you specify lower or upper bounds) produce coefficients that are highly correlated. 
Generally, you can reduce the correlations among the coefficients by transforming the components to 
pseudocomponents. For information on displaying or analyzing the design in pseudocomponents, see Specifying the units 
for components. For complete discussion, see [1] and [3]. 
 

To set lower and upper bounds 
1    In the Create Mixture Design dialog box, click Components. 
2    Under Lower, click in the component row for which you want set a lower bound, and type a positive number. 

Each lower bound must be less than the corresponding upper bound. The sum of the lower bounds for all the 
components must be less than the value of Single total or the first value in Multiple totals. 

3    Use the arrow key to move to Upper and enter a positive number.  
Each upper bound must be greater than the corresponding lower bound. Each upper bound must be less than the 
value of Single total or the first value in Multiple totals. The sum of the upper bounds for all the components must be 
greater than the value of Single total or the first value in Multiple totals. 

4    Repeat steps 2 and 3 to assign bounds for other components. Click OK. 
When you change the default lower or upper bounds of a component, the achievable bounds on the other components 
may need to be adjusted. See Calculating achievable upper bounds. 
 

Calculating Achievable Upper Bounds 
When you change the default lower bounds of one component, the achievable upper values on the other components are 
also adjusted downward. Specifically, the achievable upper bound (Ui) for component i is 

Ui = Total for mixture − [L1 +  L2 +  ... +  L ( i−1) +  L( i+1) + ... +  Lq] where L is the lower bound 
Minitab prints out both the specified lower bounds and achievable upper bounds in the Session window output. As an 
example, suppose you have 3 components and you entered 10 in Total for mixture in the Designs subdialog box. If you 
entered the following lower bounds, L1 = 0, L2 = 2 and L3 = 1, then the achievable upper bounds are U1 = 7, U2 = 9 and U3 
= 8. 
 

To express a design in actual measurements 
1    In the Create Mixture Design dialog box, click Components. 
2    Under Total Mixture Amount, choose Single total and enter the sum of all the component measurements. Suppose 

you measure all the components of your mixture in liters. If the measurements add up to a total of 5.2 liters, you would 
enter 5.2. Click OK. 

 

Create Mixture Design − Process Variables 
Stat > DOE > Mixture > Create Mixture Design > Process Vars 
You can perform a mixture-process variable experiment by including up to seven process variables (factors) in your 
design. You can also: 

•    Specify the type of design (full or fractional factorial designs) and the fraction number to use for fractional factorial 
designs  

•    Name the process variables 

•    Set the high and low levels for the process variables. If your process variables could be continuous, use numeric 
levels; if your process variables are categorical, use text levels. 
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Dialog box items 
Process Variables 
None: Choose if you do not want to add any process variables to your design. 
Number: Choose to add process variables, then choose the number of variables from the list. 
Type of design: Choose the type of design (full or fractional factorial) for the process variables. The available designs 
depends on the number of process variables. 
Fraction number: If you choose a fractional factorial design, you can select the fraction you want to use. By default, 
Minitab uses the principal fraction. 
Process Variable 

Name: Enter text to change the name of the process variables. By default, Minitab names the process variables as 
X1,... ,Xn, where n is the number of process variables. 
Type: Choose to specify whether the process variables are numeric or text. 
Low: Enter the value for the low setting of each process variable. By default, Minitab sets the low level of all process 
variables to −1. Process variable settings can be changed to any numeric or text value. If one of the settings for a 
process variable is text, Minitab interprets the other setting as text. 
High: Enter the value for the high setting of each process variable. By default, Minitab sets the high level of all process 
variables to +1. Process variable settings can be changed to any numeric or text value. If one of the settings for a 
process variable is text, Minitab interprets the other setting as text.  

 

Mixture−Process Variable Designs 
Process variables are factors in an experiment that are not part of the mixture but may affect the blending properties of 
the mixture. For example, the adhesive properties of a paint may depend on the temperature at which it is applied.  
You can include up to seven two-level process variables in the mixture design. The process variables may be included as 
full or fractional factorial designs. The mixture design will be generated at each combination of levels of the process 
variables or at a fraction of the level combinations. 
 

To add process variables to a design 
1    In the Create Mixture Design dialog box, click Process Vars. 
2    Under Process Variables, choose Number, then choose a value from 1 to 7. 
3    From Type of design, choose a full or fractional factorial design. The available designs depend on the number of 

process variables chosen.  
4    If you like, you can select the fraction number you want to use. By default, Minitab uses the principal fraction. See 

Choosing a fraction. 
5    If you like, you can name the process variables and set the process variable levels. 
6    Click OK. 
 

To name process variables 
1    In the Create Mixture Design dialog box, click Process Vars. 
2    Under Name, click in the first row and type the name of the first process variable. Then, use the arrow key to move 

down the column and enter the remaining names. 
3    Click OK. 

More After you have created the design, you can change the process variable names by typing new names in the 
Data window, or with Modify Design. 

 

To assign process variable levels 
1    In the Create Mixture Design dialog box, click Process Vars. 
2    Under Low, click in the process variable row to which you would like to assign values and enter any value. Use the 

arrow key to move to High and enter a value. If you use numeric levels, the value you enter in High must be larger 
than the value you enter in Low. 

3    Repeat step 2 to assign levels for other process variables. Click OK. 

More To change the process variable levels after you have created the design, use Stat > DOE > Modify Design.
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Fractionating a Mixture-Process Variable Design 
When you generate a "complete" mixture-process variable design, the mixture design is generated at each combination of 
levels of the process variables. This may result in a prohibitive number of runs because the number of design points in the 
complete design increases quickly as the number of process variables increase. For example, a complete simplex 
centroid design with 3 mixture components and 2 process variables has 28 runs. The same 3-component design with 
three process variables has 56 runs; this design with 4 process variables has 112 runs.  

Tip You can also use an optimal design to reduce the number of runs.

The illustrations below show a 3-component mixture with 3 process variables: 

Full Factorial 1/2 Fraction 

  
Notice that the full factorial design contains twice as many design points as the ½ fraction design. The response is only 
measured at four of the possible eight corner points of the factorial portion of the design.  
The types of factorial designs that are available depend on the number of process variables. Factorial design availability is 
summarized in the table below: 

 Type of factorial design 

Number of 
process 
variables  full 1/2 fraction 

1/4 
fraction    1/8 fraction   1/16 fraction

one X     

two X     

three X X    

four X X    

five X X X   

six X X X X  

seven X X X X X 

 

Create Mixture Design − Options 
Stat > DOE > Mixture > Create Mixture Design > Options 
Allows you to 

•    randomize the design 

•    store the design 

•    store the design parameters (amounts, upper and lower bounds of the components, and linear constraints) in separate 
columns in the worksheet 

Dialog box items 
Randomize runs: Check to randomize the runs in the data matrix. If you specify blocks, randomization is done separately 
within each block and then the blocks are randomized. 

Base for random data generator: Enter a base for the random data generator. By entering a base for the random 
data generator, you can control the randomization so that you obtain the same pattern every time.  



Mixture Designs 

 Copyright © 2003–2005 Minitab Inc.  All rights reserved.  145

Note If you use the same base on different computer platforms or with different versions of Minitab, you may not get 
the same random number sequence. 

Store design in worksheet: Check to store the design in the worksheet. If you want to analyze a design, you must store 
it in the worksheet. 
Store design parameters in worksheet: Check to store the design parameters (totals, upper and lower bounds of the 
components, and linear constraints) in separate columns in the worksheet. 
 

Randomizing the Design 
By default, Minitab randomizes the run order of the design. The ordered sequence of the design points is called the run 
order. It is usually a good idea to randomize the run order to lessen the effects of factors that are not included in the 
study, particularly effects that are time-dependent. 
However, there may be situations when randomization leads to an undesirable run order. For instance, in industrial 
applications, it may be difficult or expensive to change component levels. Or, after component levels have been changed, 
it may take a long time for the system to return to steady state. Under these conditions, you may not want to randomize 
the design in order to minimize the level changes. 
Every time you create a design, Minitab reserves and names C1 (StdOrder) and C2 (RunOrder) to store the standard 
order and run order, respectively. 

•    StdOrder shows what the order of the runs in the experiment would be if the experiment was done in standard order.  

•    RunOrder shows what the order of the runs in the experiment would be if the experiment was run in random order.  
If you did not randomize, the run order and standard order are the same. 
If you want to re-create a design with the same ordering of the runs (that is, the same design order), you can choose a 
base for the random data generator. Then, when you want to re-create the design, you just use the same base. 

More You can use Stat > DOE > Display Design to switch back and forth between a random and standard order 
display in the worksheet. 

 

Storing the Design  
If you want to analyze a design, you must store it in the worksheet. By default, Minitab stores the design. If you want to 
see the properties of various designs before selecting the design you want to store, uncheck Store design in worksheet 
in the Options subdialog box. 
Every time you create a design, Minitab reserves and names the following columns: 

•    C1 (StdOrder) stores the standard order. 

•    C2 (RunOrder) stores run order. 

•    C3 (PtType) stores a numerical representation of the type of design point. 

•    C4 (Blocks) stores the blocking variable. When a design is not blocked, Minitab sets all column values to one. 

•    C5,... ,Cnumber of components + 4 stores the components. Minitab stores each component in your design in a separate 
column. 

•    In addition, depending on your design and storage options, Minitab may store the following: 
−    each process variable in a separate column (named X1,... ,Xn) 
−    an amount variable (named Amount) 
−    the design parameters (named Totals, Lower, Upper, Linear) 

If you named the components or process variables, these names display in the worksheet. After you create the design, 
you can change the component names directly in the Data window or with Modify Design. 
If you did not change the total for the mixture from the default value of one, Minitab uses proportions to store your data. If 
you did change the total for the mixture, Minitab uses amounts − what you actually measure − to express your data. After 
you create the design, you can specify one of three scales (see Specifying the units for components) to represent the 
data: amounts, proportions, or pseudocomponents. To change which of the three scales is displayed in the worksheet, 
use Display Design. 

Caution When you create a design using Create Mixture Design, Minitab stores the appropriate design information in 
the worksheet. Minitab needs this stored information to analyze the data properly. If you want to use Analyze 
Mixture Design, you must follow certain rules when modifying the worksheet data. See Modifying and Using 
Worksheet Data.  

If you make changes that corrupt your design, you may still be able to analyze it with Analyze Mixture Design 
after you use Define Custom Mixture Design. 
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Create Mixture Design − Results 
Stat > DOE > Mixture > Create Mixture Design > Results 
Control the display of Session window results. 

Dialog box items 
None: Choose to suppress display of results. Minitab stores all requested items. 
Summary table: Choose to display a summary of the design. Minitab displays the number of components, design points, 
process variables, design degree, and mixture total. 
Detailed description: In addition to above, Minitab displays the number of boundaries for each dimension, the number of 
design points for each type, and the bounds of mixture components. 
Detailed description and design table: In addition to above, Minitab displays a table with the components and process 
variables and their settings and the point type at each run. 
 

Example of a Simplex Centroid Design 
Suppose you want to study how the proportions of three ingredients in an herbal blend household deodorizer affect the 
acceptance of the product based on scent. The three components are neroli oil, rose oil, and tangerine oil. 
1    Choose Stat > DOE > Mixture > Create Mixture Design. 
2    Under Type of Design, choose Simplex centroid. 
3    From Number of components, choose 3. 
4    Click Designs. Make sure Augment the design with axial points is checked. Click OK. 
5    Click Components. In Name, enter Neroli, Rose, and Tangerine in rows 1 to 3, respectively. Click OK. 
6    Click Results. Choose Detailed description and design table. 
7    Click OK in each dialog box. 

Session window output 

Simplex Centroid Design 
 
 
Components:         3  Design points:  10 
Process variables:  0  Design degree:   3 
 
Mixture total: 1.00000 
 
 
Number of Boundaries for Each Dimension 
 
Point Type  1  2  0 
Dimension   0  1  2 
Number      3  3  1 
 
 
Number of Design Points for Each Type 
 
Point Type    1  2  3  0  -1 
Distinct      3  3  0  1   3 
Replicates    1  1  0  1   1 
Total number  3  3  0  1   3 
 
 
Bounds of Mixture Components 
 
          Amount        Proportion    Pseudocomponent
Comp   Lower   Upper   Lower   Upper   Lower    Upper
A     0.0000  1.0000  0.0000  1.0000  0.0000   1.0000
B     0.0000  1.0000  0.0000  1.0000  0.0000   1.0000
C     0.0000  1.0000  0.0000  1.0000  0.0000   1.0000
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Design Table (randomized) 
 
Run  Type       A       B       C 
  1     1  0.0000  1.0000  0.0000 
  2    -1  0.1667  0.6667  0.1667 
  3     2  0.5000  0.5000  0.0000 
  4     1  1.0000  0.0000  0.0000 
  5     1  0.0000  0.0000  1.0000 
  6     2  0.5000  0.0000  0.5000 
  7     0  0.3333  0.3333  0.3333 
  8    -1  0.6667  0.1667  0.1667 
  9     2  0.0000  0.5000  0.5000 
 10    -1  0.1667  0.1667  0.6667 

Interpreting the results 
MINITAB creates an augmented three-component simplex centroid design. The base design provides seven runs; 
augmentation adds three runs for a total of ten runs. 
Because you chose to display the detailed description and data tables, Minitab shows the component proportions you will 
use to create ten blends of your mixture. When you perform the experiment, use the blends in the run order that is shown. 
(Because you did not change the mixture total from the default of one, Minitab expresses each component in proportions.) 
For example, the first blend you will test will be made up of only rose oil: neroli (0.0000), rose oil (1.0000), and tangerine 
oil (0.0000). 

Note Minitab randomizes the design by default, so if you try to replicate this example, your run order may not 
match the order shown. 

 

Example of an Extreme Vertices Design 
Suppose you need to determine the proportions of flour, milk, baking powder, eggs, and oil in a pancake mix that would 
produce an optimal product based on taste. Because previous experimentation suggests that a mix that does not contain 
all of the ingredients or has too much baking powder will not meet the taste requirements, you decide to constrain the 
design by setting lower bounds and upper bounds. 
You decide that quadratic model will sufficiently model the response surface, so you decide to create a second-degree 
design. 
1    Choose Stat > DOE > Mixture > Create Mixture Design. 
2    Under Type of Design, choose Extreme vertices. 
3    From Number of components, choose 5. 
4    Click Designs. From Degree of design, choose 2. 
5    Make sure Augment the design with center point and Augment the design with axial points are checked. Click 

OK. 
6    Click Components. Complete the Name, Lower, and Upper columns of the table as shown below, then click OK. 

Component Name Lower Upper 

A Flour .425 1 

B Milk .30 1 

C Baking powder .025 .05 

D Eggs .10 1 

E Oil .10 1 

7    Click Results. Choose Detailed description and design table. Click OK in each dialog box. 

Session window output 

Extreme Vertices Design 
 
 
Components:         5  Design points:  33 
Process variables:  0  Design degree:   2 
 
Mixture total: 1.00000 
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Number of Boundaries for Each Dimension 
 
Point Type  1   2   3  4  0 
Dimension   0   1   2  3  4 
Number      8  16  14  6  1 
 
 
Number of Design Points for Each Type 
 
Point Type    1   2  3  4  5  0  -1 
Distinct      8  16  0  0  0  1   8 
Replicates    1   1  0  0  0  1   1 
Total number  8  16  0  0  0  1   8 
 
 
Bounds of Mixture Components 
 
            Amount            Proportion        Pseudocomponent 
Comp     Lower     Upper     Lower     Upper     Lower     Upper 
A     0.425000  0.475000  0.425000  0.475000  0.000000  1.000000 
B     0.300000  0.350000  0.300000  0.350000  0.000000  1.000000 
C     0.025000  0.050000  0.025000  0.050000  0.000000  0.500000 
D     0.100000  0.150000  0.100000  0.150000  0.000000  1.000000 
E     0.100000  0.150000  0.100000  0.150000  0.000000  1.000000 
 
* NOTE * Bounds were adjusted to accommodate specified constraints.
 
Design Table (randomized) 
 
Run  Type         A         B         C         D         E 
  1     1  0.425000  0.300000  0.050000  0.100000  0.125000 
  2     2  0.437500  0.300000  0.050000  0.112500  0.100000 
  3    -1  0.429688  0.329688  0.031250  0.104688  0.104688 
  4     2  0.450000  0.300000  0.025000  0.125000  0.100000 
  5     2  0.425000  0.300000  0.025000  0.125000  0.125000 
  6     2  0.425000  0.325000  0.025000  0.125000  0.100000 
  7     2  0.462500  0.300000  0.037500  0.100000  0.100000 
  8     1  0.425000  0.300000  0.025000  0.150000  0.100000 
  9     2  0.425000  0.312500  0.050000  0.100000  0.112500 
 10     2  0.425000  0.337500  0.037500  0.100000  0.100000 
 11    -1  0.429688  0.304688  0.043750  0.117188  0.104688 
 12     2  0.425000  0.300000  0.050000  0.112500  0.112500 
 13    -1  0.429688  0.304688  0.031250  0.104688  0.129688 
 14     2  0.450000  0.325000  0.025000  0.100000  0.100000 
 15     2  0.425000  0.312500  0.050000  0.112500  0.100000 
 
 16     2  0.437500  0.312500  0.050000  0.100000  0.100000 
 17    -1  0.429688  0.304688  0.031250  0.129688  0.104688 
 18     0  0.434375  0.309375  0.037500  0.109375  0.109375 
 19    -1  0.454687  0.304688  0.031250  0.104688  0.104688 
 20     1  0.425000  0.325000  0.050000  0.100000  0.100000 
 21     2  0.437500  0.300000  0.050000  0.100000  0.112500 
 22     1  0.425000  0.300000  0.050000  0.125000  0.100000 
 23     2  0.425000  0.300000  0.037500  0.137500  0.100000 
 24     2  0.425000  0.300000  0.037500  0.100000  0.137500 
 25     1  0.425000  0.300000  0.025000  0.100000  0.150000 
 26    -1  0.429688  0.304688  0.043750  0.104688  0.117188 
 27     2  0.425000  0.325000  0.025000  0.100000  0.125000 
 28    -1  0.442188  0.304688  0.043750  0.104688  0.104688 
 29    -1  0.429688  0.317188  0.043750  0.104688  0.104688 
 30     1  0.475000  0.300000  0.025000  0.100000  0.100000 
 31     1  0.450000  0.300000  0.050000  0.100000  0.100000 
 32     1  0.425000  0.350000  0.025000  0.100000  0.100000 
 33     2  0.450000  0.300000  0.025000  0.100000  0.125000 

Interpreting the results 
MINITAB creates an augmented five-component extreme vertices design. The base design provides 24 design points; 
augmentation adds 9 design points for a total of 33 runs. Augmenting this design adds 8 axial points and 1 center point to 
the design. 
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Because you chose to display the summary and data tables, MINITAB shows the component proportions you will use to 
create 33 blends of your mixture. When you perform the experiment, use the blends in the run order that is shown. 
(Because you did not change the mixture total from the default of one, MINITAB expresses each component in 
proportions.) 
MINITAB randomizes the design by default, so if you try to replicate this example, your run order may not match the order 
shown. 
 

Example of Simplex Design Plot 
In the Example of a simplex centroid design, you created a design to study how the proportions of three ingredients in an 
herbal blend household deodorizer affect the acceptance of the product based on scent. The three components are neroli 
oil, rose oil, and tangerine oil. To help you visualize the design space, you want to display a simplex design plot. 
1    Open the worksheet DEODORIZ.MTW. 
2    Choose Stat > DOE > Mixture > Simplex Design Plot. Click OK. 

Graph window output 

 
Interpreting the results  
The simplex design plot shows that there are ten points in the design space. The points are as follows: 

•    Three pure mixtures, one for each component (Neroli, Rose, and Tangerine). These points are found at the vertices of 
the triangle. 

•    Three binary blends, one for each possible two-component blend (Neroli-Rose, Rose-Tangerine, and Tangerine-
Neroli). These design points are found at the midpoint of each edge of the triangle. 

•    Three complete blends. All three components are included in these blends, but not in equal proportions.  

•    One center point (or centroid). Equal proportions of all three components are included in this blend. 
 
 

Define Custom Mixture Design 
Define Custom Mixture Design  
Stat > DOE > Mixture > Define Custom Mixture Design 
Use Define Custom Mixture Design to create a design from data you already have in the worksheet. For example, you 
may have a design that you created using Minitab session commands, entered directly into the Data window, imported 
from a data file, or created with earlier releases of Minitab. You can also use Define Custom Mixture Design to redefine a 
design that you created with Create Mixture Design and then modified directly in the worksheet.  
Custom designs allow you to specify which columns contain your components and other design characteristics. After you 
define your design, you can use Modify Design, Display Design, and Analyze Mixture Design. 

Dialog box items 
Components: Enter the columns that contain the component data. Data must be in the form of amounts. When the 
mixture total is one, amounts and proportions are equivalent. 
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Process Variables (optional): Enter any process variables you want to include in your design 
Mixture Amount 

Constant: Choose if you only have one mixture total. 
In Column: Choose if you have more than one mixture total. That is, you have a mixture-amount experiment. 

 

To define a custom mixture design 
1    Choose Stat > DOE > Mixture > Define Custom Mixture Design.  
2    In Components, enter the columns that contain the component data. Data must be in the form of amounts. (When the 

mixture total is one, amounts and proportions are equivalent. 
3    If you have process variables in your design, enter the columns in Process variables. 
4    If you have an amount variable, under Mixture Amount, choose In column, and enter the column that contains the 

amount data. 
5    Click Lower/Upper. 
6    If you have an mixture-amounts experiment, Minitab will enter the smallest value in your amount column in Total 

value matching Lower/Upper bounds. If this is not the value you want, change it to any other total in your amount 
column. 

7    Minitab will fill in the lower and upper bound table from the worksheet. Make any necessary corrections, then click OK. 
8    Do one of the following: 

•    If you do not have any columns containing the standard order, run order, point type, or blocks, click OK. 
•    If you have columns that contain data for the standard order, run order, point type, or blocks, click Designs 

1    If you have a column that contains the standard order of the experiment, under Standard Order Column, 
choose Specify by column and enter the column containing the standard order. 

2    If you have a column that contains the run order of the experiment, under Run Order Column, choose 
Specify by column and enter the column containing the run order. 

3    If you have a column that contains the design point type, under Point Type Column, choose Specify by 
column and enter the column containing the point types. 

4    If your design is blocked, under Blocks, choose Specify by column and enter the column containing the 
blocks. 

5    Click OK in each dialog box. 

 

Define Custom Mixture Design − Lower/Upper 
Stat > DOE > Mixture > Define Custom Mixture Design > Lower/Upper 
Allows you to store the design parameters in the worksheet and set one or more linear constraints for the set of 
components. 

Dialog box items 
Total value matching Lower/Upper bounds: If you have an mixture-amounts experiment, Minitab will enter the smallest 
value in your amount column. If this is not the value you want, change it to any other total in your amount column. 
Lower and Upper Bounds for Components: Choose to set the constraints. By default, Minitab uses the highest and 
lowest worksheet values. 

Component: Shows the component letter designation. This column does not take any input. 
Name: Shows the name of the components. This column does not take any input. 
Lower: Enter the value for the lower bound constraint for each factor. 
Upper: Enter the value for the upper bound constraint for each factor 

Store design parameters (totals, bounds, constraints) in the worksheet: Check to store the design parameters 
(totals, upper and lower bounds of the components, and linear constraints) in separate columns in the worksheet. 
 

Define Custom Mixture Design − Lower/Upper − Linear Constraints 
Stat > DOE > Mixture > Define Custom Mixture Design > Lower/Upper > Linear constraints 
Allows you to set linear constraints for the set of components. See Setting linear constraints for extreme vertices designs 
for details. 
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Dialog box items 
Specify a coefficient for one or more components, and a value for Lower and/or Upper 

Lower: Enter the lower value for the linear constraint. 
A, B, C, … : There is one row for each component in the design. Enter a coefficient for one or more of the components 
Upper: Enter the upper value for the linear constraint. 

 

Setting Linear Constraints for Extreme Vertices Designs 
In addition to the individual bounds on the components, you may have up to ten linear constraints on the set of 
components. For example, you would need a linear constraint in the following situation. Suppose you need to constrain 
the wet ingredients (eggs, milk, oil) of a cake mix so that together they are not less than 40% or greater than 60% of the 
total mixture. If you are willing to allow equal amounts of these three ingredients, you would use the following values for 
the linear constraint: lower value is 0.4, the upper value is 0.6, and the component coefficients are all 1. Examples for a 
four-component blend are shown in the table below: 

  Coefficients  

Condition 
Lower 
Value A B C  D 

Upper 
Value 

A + B > 10 and A + B < 20 10 1 1   20 
5A + 3B + 8D < 0.1  5 3  8 0.1 
0.5B + 0.8D > 0.9 0.9  0.5 0.8   

 

Define Custom Mixture Design − Low/High 
Stat > DOE > Mixture > Define Custom Mixture Design > Low/High 
Allows you to specify the process variable levels. 

Dialog box items 
Low and High Values for Process Variables 

Process V: Shows the process variable letter designation. This column does not take any input. 
Name: Shows the name of the process variables. This column does not take any input. 
Type: Choose either numeric or text for each process variable.  
Low: Enter the value for the low level for each process variable. 
High: Enter the value for the high level for each process variable. 

Worksheet data are 
Coded: Choose if the worksheet data are in coded form (-1 = low; +1 = high). 
Uncoded: Choose if the worksheet data are in uncoded form. That is, the worksheet values are in units of the actual 
measurements. 

 

Define Custom Mixture Design − Designs 
Stat > DOE > Mixture > Define Custom Mixture Design > Designs 
Allows you to specify which columns contain the blocks, run order, and standard order. 

Dialog box items 
Standard Order Column  

Order of the data: Choose if the standard order is the same as the order of the data in the worksheet.  
Specify by column: Choose if the standard order of the data is stored in a separate column, then enter the column. 

Run Order Column  
Order of the data: Choose if the run order is the same as the order of the data in the worksheet. 
Specify by column: Choose if the run order of the data is stored in a separate column, then enter the column. 

Point Type Column 
Unknown: Choose if you do not have a column indicating the point type. 
Specify by column: Choose if you have a column indicating the point type, then enter the column. 

Blocks  
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No blocks: Choose if your design is not blocked. 
Specify by column: Choose if your design is blocked, then enter the column containing the blocks. 

 

Select Optimal Design 
Select Optimal Design Overview 
The purpose of an optimal design is to select design points according to some criteria. Minitab's optimal design 
capabilities can be used with response surface designs and mixture designs. You can use Select Optimal Design to:  

Task Use to... 
Select an optimal design Select design points from a candidate set to achieve an optimal design. Select 

optimal design is often used to reduce the number of experimental runs when 
the original design contains more points than are feasible due to time or 
financial constraints.  

Augment an existing design Add design points to either D-optimal or distance-based designs. This may be 
useful if you determine you have additional resources to collect more data 
after you already generated an optimal design and collected data.   

Improve the D-optimality of a 
design 

Add or exchange points to improve the D-optimality of the design. You can not 
improve distance-based designs. 

Evaluate a design Obtain optimality statistics for your design. You can use this information to 
compare designs or to evaluate changes in the optimality of a design if you 
change the model. 
For example, you generate a D-optimal design for a certain model, but then 
decide to fit the model with different terms. You can determine the change in 
optimality using the Evaluate design task. 

Minitab provides two optimality criteria for the selection of design points:  

•    D-optimality − A design selected using this criterion minimizes the variance in the regression coefficients of the fitted 
model. You specify the model, then Minitab selects design points that satisfy the D-optimal criterion from a set of 
candidate design points.  

•    Distance-based optimality − A design selected using this criterion spreads the design points uniformly over the design 
space. The distance-based method can be used when it is not possible or desirable to select a model in advance. 

 

Select Optimal Design (Mixture) 
Stat > DOE > Mixture > Select Optimal Design 
Use to select design points based on some criteria to achieve an optimal design. You can use Select Optimal Design to: 

•    Select an "optimal" set of design points 

•    Augment (add points to) an existing design  

•    Improve the D-optimality of an existing design  

•    Evaluate and compare designs  

Dialog box items 
Criterion 

D-optimality: Choose to select design points based on D-optimality. 
Distance-based optimality: Choose to select design points based on distance-based optimality. 

Number of points in optimal design: Enter the number of points to be selected for the optimal design. If the criterion is 
D-optimality, the number of points must be at least as many design points as there are terms in the model. If the criterion 
is distance-based optimality, the number of points must be less than or equal to the number of distinct design points in 
the candidate set. 
Specify design columns: If the criterion is distance-based optimality, delete the design columns that you do not want to 
include in the optimal design. 

•    For a response surface design, you can include all the factors or a subset of the factors. 
•    For a mixture design, you must include all components. You can also include numeric process variables or a 

subset of the process variables, and an amount variable.  
By default, Minitab will include all input variables in the candidate design. 
Task 

Select optimal design: Choose to select an optimal design. 
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Augment/improve design (you may optionally provide an indicator column that you created): Choose to 
augment or improve an existing design. If you like, enter an indicator column in the box to define the initial design. 
Evaluate design (you may optionally provide an evaluate column that you created): Choose to evaluate a design. 
If you like, enter an evaluate column in the box to specify which worksheet rows to include in the design. 

Analyze Components in 
Proportions: Choose to analyze the design in proportions. 
Pseudocomponents: Choose to analyze the design in pseudocomponents. 

 

Data - Select Optimal Design 
The worksheet must contain a design generated by Create Response Surface Design, Define Custom Response Surface 
Design, Create Mixture Design, or Define Custom Mixture Design.  
The data required depends on the task. 

Select optimal design 
The design columns in the worksheet comprise the candidate set of design points. For descriptions of a DOE worksheet, 
see Storing the design (response surface or mixture). 

Augment/improve design 
The design columns in the worksheet comprise the candidate set of design points. For descriptions of a DOE worksheet, 
see Storing the design (response surface or mixture). 
In addition to the design columns, you may also have a column that indicates how many times a design point is to be 
included in the initial design, and whether a point must be kept in (protected) or may be omitted from the final design. See 
below for more information. 

Design indicator column 
There are two ways that you can define the initial design. You can use all of the rows of the design columns in the 
worksheet or you can create an indicator column to specify certain rows to include in the initial design. In addition, you can 
use this column to "protect" design points during the optimization process. If you protect a point, Minitab will not drop this 
design point from the final design. The indicator column can contain any positive or negative integers. 
Minitab interprets the indicators as follows: 

•    the magnitude of the indicator determines the number of replicates of the corresponding design point in the initial 
design 

•    the sign of the indicator determines whether or not the design point will be protected during the optimization process 
−    a positive sign indicates that the design point may be excluded from the final design 
−    a negative sign indicates that the design point may not be excluded from the final design 

Evaluate design 
The design columns in the worksheet comprise the candidate set of design points. For descriptions of a DOE worksheet, 
see Storing the design (response surface or mixture). 
In addition to the design columns, you may also have a column that indicates how many times a design point is to be 
included in the evaluation. This column must contain only positive integers. See below for more information. 

Design evaluation column 
There are two ways that you can define the design you want to evaluate. You can use all of the rows of the design 
columns in the worksheet or you can create an indicator column to specify certain rows to include in the design. The 
magnitude of the indicator determines the number of replicates of the corresponding design point.  
 

To select an optimal design using D-optimality 
1    Choose Stat > DOE > Response Surface or Mixture > Select Optimal Design. 
2    Under Criterion, choose D-optimality. 
3    In Number of points in optimal design, enter the number of points to be selected for the optimal design. You must 

select at least as many design points as there are terms in the model.  

More The feasible number of design points is dictated by various constraints (for example, time, budget, or ease of 
data collection). It is strongly recommended that you select more than the minimum number so you obtain 
estimates of pure error and lack-of-fit of the fitted model. 

4    Under Task, choose Select optimal design. 
5    Click Terms. 
6    Do one of the following: 
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•    from Include the following terms, choose the order of the model you want to fit: 

−    for response surface designs, choose one of the following:  
linear, linear + squares, linear + interactions, or full quadratic 

−    for mixture designs, choose one of the following:  
linear, quadratic, special cubic, full cubic, special quartic, or full quartic 

•    move the terms you want to include in the model to Selected Terms using the arrow buttons  

−    to move one or more terms, highlight the desired terms, then click  or   

−    to move all of the terms, click  or   

You can also move a term by double-clicking it. 
7    Click OK. 

Note Minitab represents factors and components with the letters A, B, C, ..., skipping the letter I for factors and the 
letter T for components. For mixture designs, process variables are represented by X1,...,Xn , and the amount 
variable by the letter T. 

More For more on specifying a response surface model, see Selecting model terms. For more information on 
specifying a mixture model, see Selecting model terms. 

8    If you like, use one or more of the options listed below, then click OK. 
 

To select an optimal design using distance-based optimality 
1    Choose Stat > DOE > Response Surface or Mixture > Select Optimal Design  
2    Under Criterion, choose Distance-based optimality. 
3    In Number of points in optimal design, enter the number of points to be included in the design. The number of 

points you enter must be less than or equal to the number of distinct design points in the candidate set. 
4    In Specify design columns, delete the design columns that you do not want to include in the optimal design. 

•    For a response surface design, you can include all the factors or a subset of the factors. 
•    For a mixture design, you must include all components. You can also include all the process variables or a subset 

of the process variables, and an amount variable.  
By default, Minitab will include all input variables in the candidate design. 

5    Under Task, choose Select optimal design. 
6    If you like, use one or more of the options listed below, then click OK. 
 

To augment or improve a D-optimal design 
1    Choose Stat > DOE > Response Surface or Mixture > Select Optimal Design. 
2    Under Criterion, choose D-optimality.  
3    Under Task, choose Augment/improve design. If you have a design point indicator column, enter this column in the 

box.  
4    Do one of the following: 

•    To augment (add points) a design, in Number of points in optimal design, enter the number of points to be 
included in the final design. The number of points you enter must be greater than the number of points in the 
design you are augmenting. 

•    To improve a design's D-optimality but not add any additional points, in Number of points in optimal design, 
enter 0. In this case, the final design will have the same number of design points as the initial design. 

5    Click Terms.  
6    Do one of the following: 

•    from Include the following terms, choose the order of the model you want to fit: 

−    for response surface designs, choose one of the following: 
linear, linear + squares, linear + interactions, or full quadratic 

−    for mixture designs, choose one of the following: 
linear, quadratic, special cubic, full cubic, special quartic, or full quartic 

•    move the terms you want to include in the model to Selected Terms using the arrow buttons  

−    to move one or more terms, highlight the desired terms, then click  or   

−    to move all of the terms, click  or   
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You can also move a term by double-clicking it. 
7    Click OK. 

Note Minitab represents factors and components with the letters A, B, C, ..., skipping the letter I for factors and the 
letter T for components. For mixture designs, process variables are represented by X1,...,Xn , and the 
amount variable by the letter T. 

More For more on specifying a response surface model, see Selecting model terms. For more information on 
specifying a mixture model, see Selecting model terms. 

8    If you like, use one or more of the options, then click OK. 
 

To augment a distance-based optimal design 
1    Choose Stat > DOE > Response Surface or Mixture > Select Optimal Design. 
2    Under Criterion, choose Distance-based optimality. 
3    In Number of points in optimal design, enter the number of points to be in the final design. The number of points 

you enter must be greater than the number of points in the initial design but not greater then the number of "distinct" 
points in the candidate set. 

4    In Specify design columns, delete the design columns that you do not want to include in the optimal design. 
•    For a response surface design, you can include all the factors or a subset of the factors. 
•    For a mixture design, you must include all components. You can also include all the process variables or a subset 

of the process variables, and an amount variable. 
By default, Minitab will include all design variables in the candidate design. 

5    Under Task, choose Augment/improve design. If you have a design point indicator column, enter this column in the 
box.  

6    If you like, use one or more of the options, then click OK. 
 

To evaluate a design 
1    Choose Stat > DOE > Response Surface or Mixture > Select Optimal  
2    Under Task, choose Evaluate design. If you have an indicator column that defines the design, enter the column in 

the box.  
3    Click Terms.  
4    Do one of the following: 

•    from Include the component terms up through order, choose the order of the model you want to fit: 

−    for response surface designs, choose one of the following: 
linear, linear + squares, linear + interactions, or full quadratic  

−    for mixture designs, choose one of the following: 
linear, quadratic, special cubic, full cubic, special quartic, or full quartic  

•    move the terms you want to include in the model to Selected Terms using the arrow buttons  

−    to move one or more terms, highlight the desired terms, then click  or   

−    to move all of the terms, click  or   

You can also move a term by double-clicking it. 

5    Click OK. 

Note  Minitab represents factors and components with the letters A, B, C, ... , skipping the letter I for factors and the 
letter T for components. For mixture designs, process variables are represented by X1,... ,Xn , and the amount 
variable by the letter T. 

More For more on specifying a response surface model, see Selecting model terms. For more information on 
specifying a mixture model, see Selecting model terms. 

6    If you like, use one or more of the options, then click OK. 
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Select Optimal Design (Mixture) − Terms  
Stat > DOE > Mixture > Select Optimal Design > Terms 
Allows you to: 

•    Fit a model by specifying the maximum order of the terms, or choose which terms to include from a list of all estimable 
terms  

•    Include inverse component terms, process variable terms, or an amount term in the model. You cannot include inverse 
terms if the lower bound for any component is zero or if you choose to analyze the design in pseudocomponents. 

Dialog box items 
Include the following terms: Use this drop-down list to quickly set up a model. You can choose linear, quadratic, special 
cubic, full cubic, special quartic, and full quartic. 
Include inverse component terms: Check to include all inverse component terms in the model. 
Include process variable terms up through order or Include amount variable terms up through order: The label of 
this item changes depending on the whether you have process or amount variables in your design. Choose an order for 
all process variables or an amount variable to include in the model. 
Available Terms: Shows all terms that are estimable but not included in the fitted model.  
Selected Terms: Minitab includes terms shown in Selected Terms when it fits the model. 
Include blocks in the model: Check to include blocks in the model. This option is only available when there is more than 
one distinct value in the blocks column. 
 

Selecting Model Terms (Mixture Design) 
The model terms that are available depend on the type of mixture design. You can fit a model to a simple mixture design 
(components only), a mixture-process variable design (components and process variables), or a mixture-amounts design 
(components and amounts). 
The order of the model you choose determines which terms are fit and whether or not you can model linear or curvilinear 
aspects of the response surface.  
In the Terms subdialog box, you can choose a linear, quadratic, special cubic, full cubic model, special quartic, or full 
quartic model. Or, you can fit a model that is a subset of these terms. The following table summarizes these models. For a 
discussion of the various blending effects you can model, see [1]. 

This model type           fits these terms           and models this type of blending 

linear 
(first-order) 

linear  additive 

quadratic  
(second-order) 

linear and quadratic additive 
nonlinear synergistic binary  
or  
additive 
nonlinear antagonistic binary 

special cubic 
(third-order) 

linear, quadratic,  
and special cubic 

additive 
nonlinear synergistic ternary  
nonlinear antagonistic ternary 

full cubic 
(third-order) 

linear, quadratic,  
special cubic, and  
full cubic 

additive 
nonlinear synergistic binary  
nonlinear antagonistic binary  
nonlinear synergistic ternary  
nonlinear antagonistic ternary 

special quartic 
(fourth-order) 

linear, quadratic,  
special cubic,  
full cubic, and  
special quartic 

additive 
nonlinear synergistic binary  
nonlinear antagonistic binary  
nonlinear synergistic ternary  
nonlinear antagonistic ternary  
nonlinear synergistic quaternary  
nonlinear antagonistic quaternary 
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full quartic 
(fourth-order) 

linear, quadratic,  
special cubic,  
full cubic,  
special quartic, and  
full quartic 

additive 
nonlinear synergistic binary  
nonlinear antagonistic binary  
nonlinear synergistic ternary  
nonlinear antagonistic ternary  
nonlinear synergistic quaternary  
nonlinear antagonistic quaternary 

You can fit inverse terms with any of the above models as long as the lower bound for any component is not zero and you 
choose to analyze the design in proportions. Inverse terms allow you to model extreme changes in the response as the 
proportion of one or more components nears its boundary. Suppose you are formulating lemonade and you are interested 
in the acceptance rating for taste. An extreme change in the acceptance of lemonade occurs when the proportion of 
sweetener goes to zero. That is, the taste becomes unacceptably sour. 
Analyze Mixture Design fits a model without a constant term. For example, a quadratic in three components is as follows: 
Y = b1A + b2B + b3C + b12AB + b13AC + b23BC 
 

To specify mixture model terms 
1    In the Optimal Design dialog box, click Terms. 
2    Do one of the following: 

•    from Include the component terms up through order, choose one of the following: 
linear, quadratic, special cubic, full cubic, special quartic, or full quartic 

•    move the terms you want to include in the model to Selected Terms using the arrow buttons  

−    to move one or more terms, highlight the desired terms, then click  or   

−    to move all of the terms, click  or   

You can also move a term by double-clicking it. 

Note Minitab represents components with the letters A, B, C, ..., skipping the letter T, process variables with 
X1...Xn, and amounts with the letter T. 

3    If you want to include inverse component terms, do one of the following: 
•    to include all the inverse component terms, check Include inverse component terms  

•    to include a subset of the inverse component terms, highlight the desired terms, then click   
4    If you want to include process variable or amount terms, do one of the following: 

•    from Include process variables/mixture amount terms up through order, choose an order 
•    move terms you want to include in the model to Selected Terms using the arrow buttons  

−    to move one or more terms, highlight the desired terms, then click  or   

−    to move all of the terms, click  or   

You can also move a term by double-clicking it. 
 

Select Optimal Design − Methods  
Stat > DOE > Response Surface or Mixture > Select Optimal Design > choose Augment/Improve design > Methods  
Allows you to choose the search procedure for improving the initial design. 

Dialog box items 
Search Procedure for Improving Initial Design 

Exchange method with number of exchange points: Choose to improve the initial design using the exchange 
method. Minitab will first add the best points from the candidate set, and then drop the worst points until the D-
optimality of the design cannot be improved further. Then, enter the number of points to be exchanged. 
Fedorov's method: Choose to improve the initial design using Fedorov's method. Minitab will simultaneously switch 
pairs of points. This is accomplished by adding one point from the candidate set and dropping another point so that the 
switch results in maximum improvement in D-optimality. This process continues until the design cannot be improved 
further. 
None: Choose to suppress improvement of the initial design. 
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Select Optimal Design − Methods  
Stat > DOE > Response Surface or Mixture > Select Optimal Design > choose Select optimal design > Methods  
Allows you to specify whether the initial design is generated using a sequential or random algorithm, or a combination of 
both methods and to choose the search procedure for improving the initial design. 

Dialog box items 
Initial Design 

Generated by sequential optimization: Choose to have all design points selected sequentially. 
Percentage of design points to be selected randomly: Choose the percentage of design points to be selected 
randomly. You can choose from 10% to 100% in increments of 10. 

Number of random trials: Enter the number of trials for the optimization procedure. The default is 10. 
Base for random data generator: Enter a base for the random data generator. By entering a base for the random 
data generator, you can control the randomization so that you obtain the same pattern every time.  

Search Procedure for Improving Initial Design 
Exchange method with number of exchange points: Choose to improve the initial design using the exchange 
method. Minitab will first add the best points from the candidate set, and then drop the worst points until the D-
optimality of the design cannot be improved further. Then, enter the number of points to be exchanged. 
Fedorov's method: Choose to improve the initial design using Fedorov's method. Minitab will simultaneously switch 
pairs of points. This is accomplished by adding one point from the candidate set and dropping another point so that the 
switch results in maximum improvement in D-optimality. This process continues until the design cannot be improved 
further. 
None: Choose to suppress improvement of the initial design. 

 

Select Optimal Design − Options 
Stat > DOE > Response Surface or Mixture > Select Optimal Design > Options 
Allows you to store optimal design information. 

Dialog box items 
Store selection indicator in present worksheet: Choose to store a column (named OptPoint) in the original worksheet 
that indicates how many times a design point has been selected by the optimal procedure 
Store selected rows of design columns in new worksheet: Choose to store the design points that have been selected 
by the optimal procedure in a new worksheet. 
Copy to a new worksheet also selected rows in column: Choose to store, in addition to the design columns, the rows 
of any non-design columns for the design points that were selected in a new worksheet. 
 

Select Optimal Design − Results  
Stat > DOE > Response Surface or Mixture > Select Optimal Design > Options > Results 
Allows you to control the display of Session window results. 

Dialog box items 
None: Choose to suppress display of results. Minitab stores all requested items. 
Summary table for final design only: Choose to display the summary table for the final design. 
Summary tables for intermediate and final designs: Choose to display the summary table for all optimal designs. 
Summary tables and final design matrix: Choose to display the summary table for the final design and the design 
points. 
 

References 
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Simplex Design Plot 
Simplex Design Plot 
Stat > DOE > Mixture > Simplex Design Plot 
You can use a simplex design plot to visualize the mixture design space (or a slice of the design space if you have more 
than three components). Minitab plots the design points on triangular axes. You can plot the following: 

•    components only  

•    components and process variables 

•    components and an amount variable 

Dialog box items 
Components 
Select a triplet of components for a single plot: Choose to plot three components. 

X-Axis: Choose a component to display on the x-axis. 
Y-Axis: Choose a component to display on the y-axis. 
Z-Axis: Choose a component to display on the z-axis. 

Select four components for a matrix plot: Choose to display four simplex design plots in a single page layout. Then 
choose four components from the drop-down list. 
Generate plots for all triplets of components: Choose to generate plots for all triplets of components, each in a 
separate window. 
Component Unit in Plot(s) 

Amount: Choose to display the components in amounts. 
Proportion: Choose to display the components in proportions. 
Pseudocomponent: Choose to display the components in pseudocomponents. 

Point Labels 
None: Choose to suppress display of point labels. 
Run Order: Choose to use the run order for the point labels. 
Replicates: Choose to use the number of times a point is replicated for the point labels. 
Point Type: Choose to use the point type for the point labels. 

Include process variables: Choose to display a simplex design plot for each level of a process variable. 
Plot all level combinations: Choose to display single simplex design plot and include all the levels of the process 
variables in a single layout. 
Include mixture amount variable: Choose to include an amount variable. By default, Minitab will plot the amount 
variable at its first defined value. 
Plot all mixture amounts: Choose to display a single simplex design plot include all the levels of the amount variable in a 
single layout. 
 

Data − Simplex Design Plots 
You must create and store a design using Create Mixture Design. 
 

To display a simplex design plot 
1    Choose Stat > DOE > Mixture > Simplex Design Plot. 
2    Do one of the following to select the number of plots to display: 

•    To display a single simplex design plot for any three components, choose Select a triplet of components for a 
single plot. Then, choose any three components that are in your design. 

•    To display a layout with four simplex design plots (each plot displays three components), choose Select four 
components for a matrix plot. Then, choose any four components that are in your design. 

•    To display a simplex design plot for all combinations of components, each in a separate window, choose Generate 
plots for all triplets of components. 

3    If you like, use any of the dialog box options, then click OK. 
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Simplex Design Plot − Options 
Stat > DOE > Mixture > Simplex Design Plot > Options 
Allows you to define the background grid and replace the default title with your own title. 

Dialog box items 
Grid Lines 

At intervals: Choose to define the background grid, and then choose an interval from the list.  
None: Choose to suppress the display of the background grid. 

Title: To replace the default title with your own custom title, type the desired text in this box. 
 

Simplex Design Plot − Settings 
Stat > DOE > Mixture > Simplex Design Plot 
You can set the holding level for components and process variables that are not in the plot at their highest or lowest 
settings, or you can set specific levels to hold each. For an amount variable, you can set the hold value at any of the 
totals. The hold values must be expressed in the following units: 

•    components in the units displayed in the worksheet 
•    process variables in coded units 

Note If you have text process variables in your design, you can only set their holding values at one of the text 
levels. 

Dialog box items 
Hold components at 

Lower bound setting: Choose to set all components that are not in the graph at their lower bound. 
Upper bound setting: Choose to set all components that are not in the graph at their upper bound. 
Component: Shows all the components in your design. This column does not take any input. 
Name: Shows all the names of components in your design. This column does not take any input. 
Setting: Enter a value to hold each component that is not being plotted. Use the up and down arrows to move in the 
Setting column. 

Hold process variables at 
Low setting: Choose to set variables that are not in the plot at their lowest setting. 
High setting: Choose to set variables that are not in the plot at their highest setting. 
Process Var.: Shows all the process variables in your design. This column does not take any input. 
Name: Shows all the names of process variables in your design. This column does not take any input. 
Setting: Enter a value to hold each process variable that is not being plotted. Use the up and down arrows to move in 
the Setting column. 

Hold mixture amount at: Choose a total at which to hold the mixture amount. 
 

To set the holding level for design variables not in the plot 
1    In the Simplex Design Plot dialog box, click Settings. 
2    Do one or more of the following to set the holding values:  

•    For components (only available for design with more than three components): 

−    To use the preset values for components, choose Lower bound setting or Upper bound setting under Hold 
components at. When you use a preset value, all components not in the plot will be held at their lower bound 
or upper bound.  

−    To specify the value at which to hold the components, enter a number in Setting for each component that you 
want to control. This option allows you to set a different holding value for each component. 

•    For process variables: 

−    To use the preset values for process variables, choose High setting or Low setting under Hold process 
variables at. When you use a preset value, all variables not in the plot will be held at their high or low 
settings.  
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−    To specify the value at which to hold the process variables, enter a number in Setting for each of the process 
variables you want to control. This option allows you to set a different holding value for each process variable. 

•    For an amount variable:  

−    In Hold mixture amount at, choose one of the mixture totals. Minitab displays the multiple totals that you 
entered in the Components subdialog box when you were creating the design. 

3    Click OK. 
 

Example of Simplex Design Plot 
In the Example of a simplex centroid design, you created a design to study how the proportions of three ingredients in an 
herbal blend household deodorizer affect the acceptance of the product based on scent. The three components are neroli 
oil, rose oil, and tangerine oil. To help you visualize the design space, you want to display a simplex design plot. 
1    Open the worksheet DEODORIZ.MTW. 
2    Choose Stat > DOE > Mixture > Simplex Design Plot. Click OK. 

Graph window output 

 
Interpreting the results  
The simplex design plot shows that there are ten points in the design space. The points are as follows: 

•    Three pure mixtures, one for each component (Neroli, Rose, and Tangerine). These points are found at the vertices of 
the triangle. 

•    Three binary blends, one for each possible two-component blend (Neroli-Rose, Rose-Tangerine, and Tangerine-
Neroli). These design points are found at the midpoint of each edge of the triangle. 

•    Three complete blends. All three components are included in these blends, but not in equal proportions.  

•    One center point (or centroid). Equal proportions of all three components are included in this blend. 
 

Factorial Plots 
Factorial Plots 
Stat > DOE > Mixture > Factorial Plots 
You can produce three types of factorial plots − main effects, interaction, and cube plots − to help you visualize how 
process variables are related to the response. You can only use factorial plots if you have process variables in your 
mixture design. Minitab plots only the actual data, not the fitted values.   

Dialog box items 
Main effects: Check to display a main effects plot, then click <Setup>.  
Interaction: Check to display an interactions plot, then click <Setup>.  
Cube: Check to display a cube plot, then click <Setup>.  
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Data − Factorial Plots 
To create factorial plots, you must: 

•    create a mixture design with process variables 

•    enter the response data in your worksheet (for main effects and interactions plots)  
For cube plots, you do not need to have response data, but you must create a mixture design first. If you enter a response 
column, Minitab displays the means for the raw response data at each point in the cube where observations were 
measured. If you do not enter a response column, Minitab draws points on the cube for the effects that are in your model.  
 

To display factorial plots 
1    Choose Stat > DOE > Mixture > Factorial Plots.  
2    Do one or more of the following: 

•    To generate a main effects plot, check Main effects, then click Setup. 
•    To generate a interactions plot, check Interaction, then click Setup. 
•    To generate a cube plot, check Cube, then click Setup.  
The setup subdialog box for the various factorial plots will differ slightly. 

3    In Responses, enter the numeric columns that contain the response (measurement) data. Minitab draws a separate 
plot for each column. Response columns are optional for the cube plot. 

4    Move the process variables you want to plot from the Available box to the Selected box using the arrow buttons. 
Click OK. 
You can plot up to 7 process variables with main effects, from 2 to 7 process variables with interactions plots, and 
from 2 to 7 process variables with cube plots.  
•    to move the process variables one at a time, highlight a variable, then click a single arrow button  
•    to move all of the process variables, click one of the double arrow buttons 
You can also move a process variable by double-clicking it. 

5    If you like, use any dialog box options, then click OK. 
 

Factorial Plots − Main Effects − Setup 
Stat > DOE > Mixture > Factorial Plots > check Main Effects > Setup 
Allows you to select the process variables to include in the main effects plot. Minitab plots the mean value of the response 
at each level of the process variable. A reference line is drawn at the overall average of the response data. 

Dialog box items 
Responses: Select the column(s) containing the response data. When you enter more than one response variable, 
Minitab displays a separate plot for each response.  
Process Variables to Include in Plots Use the arrow buttons to move terms from one list to the other. Select a term in 
one of the lists, then click an arrow button. The double arrows move all the terms in one list to the other. You can also 
move a term by double-clicking it. 

Available: Lists all process variables in your model. 
Selected: Lists all process variables that will be included in the main effects plot(s). You can have up to 7 process 
variables in the Selected list. 

 

Factorial Plots − Main Effects − Options 
Stat > DOE > Mixture > Factorial Plots > check Main Effects > Setup > Options 
You can add your own title to the plot.  

Dialog box items 
Title: To replace the default title with your own custom title, type the desired text in this box. 
 

Factorial Plots − Interaction − Setup 
Stat > DOE > Mixture > Factorial Plots > check Interaction > Setup 
Allows you to select the process variables to include in the interaction plot. 
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Dialog box items 
Responses: Select the column(s) containing the response data. When you enter more than one response variable, 
Minitab displays a separate plot for each response.  
Process Variables to Include in Plots Use the arrow buttons to move terms from one list to the other. Select a term in 
one of the lists, then click an arrow button. The double arrows move all the terms in one list to the other. You can also 
move a term by double-clicking it. 

Available: Lists all process variables in your model. 
Selected: Lists all process variables that will be included in the interactions plot(s). You can have up to 7 process 
variables in the Selected list. Minitab draws all two-way interactions of the selected process variables. 

 

Factorial Plots − Interaction − Options 
Stat > DOE > Mixture > Factorial Plots > check Interaction > Setup > Options 
You can display the interaction plot matrix and add your own title to the plot.  

Dialog box items 
Draw full interaction plot matrix: Check to display the full interaction matrix when you specify more than two process 
variables instead of displaying only the upper right portion of the matrix. In the full matrix, the transpose of each plot in the 
upper right displays in the lower left portion of the matrix. The full matrix takes longer to display than the half matrix. 
Title: To replace the default title with your own custom title, type the desired text in this box. 
 

Factorial Plots − Cube − Setup 
Stat > DOE > Mixture > Factorial Plots > check Cube > Setup 
You can to select the up to 8 2-level factors to include in the cube plot.  

Dialog box items 
Responses (optional): Select the column(s) containing the response data. For cube plots, the response variable is 
optional. If you do not enter a response variable, you will get a cube plot which only displays the design points. This is a 
nice way to visualize what a factorial design looks like. When you enter more than one response variable, Minitab displays 
a separate plot for each response.  
Factors to Include in Plots Use the arrow buttons to move terms from one list to the other. Select a term in one of the 
lists, then click an arrow button. The double arrows move all the terms in one list to the other. You can also move a term 
by double-clicking it. 

Available: Lists all factors in your model. 
Selected: Lists all factors that will be included in the cube plot(s). You must plot at least 2 but no more than 8 factors. 

 

Analyze Mixture Design 
Analyze Mixture Design 
Stat > DOE > Mixture > Analyze Mixture Design 
To use Analyze Mixture Design, you must first create and store the design using Create Mixture Design, or create a 
design from data that you already have in the worksheet with Define Custom Mixture Design. 
You can choose from six standard models (linear, quadratic, special cubic, full cubic, special quartic, or full quartic) or 
choose specific terms from a list of all estimable terms. See Selecting model terms for details. 
You can also select from four model fitting methods:  

•    Mixture regression  

•    Stepwise regression  

•    Forward selection 

•    Backward elimination 

Dialog box items 
Responses: Select the column containing the response variable. You may enter up to 25 response columns. 
Type of Model 

Mixture components only: Choose to fit a model for the components only. 
Mixture components and process variables: Choose to fit a model for the components and process variables. 
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Mixture amount experiment: Choose to fit a model for the components and the amount variable. 
Analyze Components in 

Proportions: Choose to fit the model in proportions. 
Pseudocomponents: Choose to fit the model in pseudocomponents. 

Model Fitting Method: Choose the mixture regression, stepwise, forward selection, or backward elimination. 
 

Data − Analyze Mixture Design 
Enter numeric response data column(s) that are equal in length to the design variables in the worksheet. Each row in the 
worksheet will contain the data for one run of your experiment. You may enter the response data in any columns not 
occupied by the design data. The number of columns reserved for the design data is dependent on the number of 
components in your design and whether or not you chose to store the design parameters (see Storing the design). 
If there is more than one response variable, Minitab fits separate models for each response.  
Minitab omits the rows containing missing data from all calculations. 

Note When all the response variables do not have the same missing value pattern, Minitab displays a message. 
When the responses do not have the same missing value pattern, you may want to perform the analysis 
separately for each response because you would get different results than if you included them all in a single 
analysis. 

 

To analyze a mixture design 
1    Choose Stat > DOE > Mixture > Analyze Mixture Design. 
2    In Responses, enter up to 25 columns that contain the measurement data. 
3    If you like, use one or more of the available dialog box options, then click OK. 
 

Analyze Mixture Design − Terms 
Stat > DOE > Mixture > Analyze Mixture Design > Terms 
Allows you to 

•    fit a model by specifying the maximum order of the terms, or choose which terms to include from a list of all estimable 
terms  

•    include inverse component terms, process variable terms, or an amount term in the model. You cannot include inverse 
terms if the lower bound for any component is zero or if you choose to analyze the design in pseudocomponents. 

Dialog box items 
Include the following terms: Use this drop-down list to quickly set up a model. You can choose linear, quadratic, special 
cubic, full cubic, special quartic, and full quartic. 
Include inverse component terms: Check to include all inverse component terms in the model. 
Include process variable terms up through order or Include amount variable terms up through order: The label of 
this item changes depending on the whether you have process or amount variables in your design. Choose an order for 
all process variables or an amount variable to include in the model. 
Available Terms: Shows all terms that are estimable but not included in the fitted model.  
Selected Terms: Minitab includes terms shown in Selected Terms when it fits the model. 
Include blocks in the model: Check to include blocks in the model. This option is only available when there is more than 
one distinct value in the blocks column. 
 

Selecting model terms 
The model terms that are available depend on the type of mixture design. You can fit a model to a simple mixture design 
(components only), a mixture-process variable design (components and process variables), or a mixture-amounts design 
(components and amounts). 
The order of the model you choose determines which terms are fit and whether or not you can model linear or curvilinear 
aspects of the response surface.  
In the Terms subdialog box, you can choose a linear, quadratic, special cubic, full cubic model, special quartic, or full 
quartic model. Or, you can fit a model that is a subset of these terms. The following table summarizes these models. For a 
discussion of the various blending effects you can model, see [1]. 
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This model type    fits these terms    and models this type of blending 

linear 
(first-order) 

linear  additive 

quadratic  
(second-order) 

linear and quadratic additive 
nonlinear synergistic binary  
or  
additive 
nonlinear antagonistic binary 

special cubic 
(third-order) 

linear, quadratic,  
and special cubic 

additive 
nonlinear synergistic ternary  
nonlinear antagonistic ternary 

full cubic 
(third-order) 

linear, quadratic,  
special cubic, and  
full cubic 

additive 
nonlinear synergistic binary  
nonlinear antagonistic binary  
nonlinear synergistic ternary  
nonlinear antagonistic ternary 

special quartic 
(fourth-order) 

linear, quadratic,  
and special quartic 

additive 
nonlinear synergistic binary  
nonlinear antagonistic binary  
nonlinear synergistic ternary  
nonlinear antagonistic ternary  
nonlinear synergistic quaternary  
nonlinear antagonistic quaternary 

full quartic 
(fourth-order) 

linear, quadratic,  
full cubic,  
special quartic, and  
full quartic 

additive 
nonlinear synergistic binary  
nonlinear antagonistic binary  
nonlinear synergistic ternary  
nonlinear antagonistic ternary  
nonlinear synergistic quaternary  
nonlinear antagonistic quaternary 

You can fit inverse terms with any of the above models as long as the lower bound for any component is not zero and you 
choose to analyze the design in proportions. Inverse terms allow you to model extreme changes in the response as the 
proportion of one or more components nears its boundary. Suppose you are formulating lemonade and you are interested 
in the acceptance rating for taste. An extreme change in the acceptance of lemonade occurs when the proportion of 
sweetener goes to zero. That is, the taste becomes unacceptably sour. 
Analyze Mixture Design fits a model without a constant term. For example, a quadratic in three components is as follows: 
Y = b1A + b2B + b3C + b12AB + b13AC + b23BC 
 

To specify mixture model terms 
1    In the Analyze Mixture Design dialog box, click Terms. 
2    Do one of the following: 

•    from Include the component terms up through order, choose one of the following: 
linear, quadratic, special cubic, full cubic, special quartic, or full quartic 

•    move the terms you want to include in the model to Selected Terms using the arrow buttons  

−    to move one or more terms, highlight the desired terms, then click  or   

−    to move all of the terms, click  or   

You can also move a term by double-clicking it. 

Note Minitab represents components with the letters A, B, C, ... , skipping the letter T, process variables with X1... 
Xn, and amounts with the letter T. 

3    If you want to include inverse component terms, do one of the following: 
•    to include all the inverse component terms, check Include inverse component terms  

•    to include a subset of the inverse component terms, highlight the desired terms, then click   
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4    If you want to include process variable or amount terms, do one of the following: 
•    from Include process variables/mixture amount terms up through order, choose an order 
•    move terms you want to include in the model to Selected Terms using the arrow buttons  

−    to move one or more terms, highlight the desired terms, then click  or   

−    to move all of the terms, click  or   

You can also move a term by double-clicking it. 
 

Analyze Mixture Design − Terms− Options 
Stat > DOE > Mixture > Analyze Mixture Design > choose Stepwise > Terms > Options 
Specifies the criteria for model selection. 

Dialog box items 
Selected Terms: Shows the terms that you chose in the Terms dialog box to include in the model. 
Forced Terms: Enter the terms that you want keep in the model regardless of their p-values. 
Selected Terms: Shows the terms that you chose in the Terms dialog box to include in the model. 
Terms to Begin with: Enter a starting set of model terms. These terms are removed if their p-values are greater than the 
Alpha to enter value. (If you want keep variables in the model regardless of their p-values, enter them in Forced Terms.) 

Alpha to enter: Set the value of α for entering a new term in the model. 

Alpha to remove: Set the value of α for removing a term from the model. 
Number of alternative terms to show: Type a number to display the next best alternate terms up to the number 
requested. If a new term is entered into the model, displays the term which was the second best choice, the third best 
choice, and so on.  
 

Analyze Mixture Design − Terms− Options 
Stat > DOE > Mixture > Analyze Mixture Design > choose Forward Selection > Terms > Options 
Specifies the criteria for model selection. 

Dialog box items 
Selected Terms: Shows the terms that you chose in the Terms dialog box to include in the model. 
Forced Terms: Enter the terms that you want keep in the model regardless of their p-values. 

Alpha to enter: Set the value of α for entering a new term in the model. 
Number of alternative terms to show: Type a number to display the next best alternate terms up to the number 
requested. If a new term is entered into the model, displays the term which was the second best choice, the third best 
choice, and so on.  
 

Analyze Mixture Design − Terms− Options 
Stat > DOE > Mixture > Analyze Mixture Design > choose Backward Elimination > Terms > Options 
Specifies the criteria for model selection. 

Dialog box items 
Selected Terms: Shows the terms that you chose in the Terms dialog box to include in the model. 
Forced Terms: Enter the terms that you want keep in the model regardless of their p-values. 

Alpha to remove: Set the value of α for removing a term from the model. 
Number of alternative terms to show: Type a number to display the next best alternate terms up to the number 
requested. If a new term is entered into the model, displays the term which was the second best choice, the third best 
choice, and so on.  
 

Analyze Mixture Design − Graphs 
Stat > DOE > Mixture > Analyze Mixture Design > Graphs 
Draw five different residual plots for regular, standardized, or deleted residuals. You do not have to store the residuals and 
fits in order to produce these plots.  
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Dialog box items 
Residuals for Plots You can specify the type of residual to display on the residual plots. 

Regular: Choose to plot the regular or raw residuals. 
Standardized: Choose to plot the standardized residuals. 
Deleted: Choose to plot the Studentized deleted residuals. 

Residual Plots 
Individual plots: Choose to display one or more plots. 

Histogram: Check to display a histogram of the residuals. 
Normal plot: Check to display a normal probability plot of the residuals. 
Residuals versus fits: Check to plot the residuals versus the fitted values. 
Residuals versus order: Check to plot the residuals versus the order of the data in the run order column. The row 
number for each data point is shown on the x-axis−for example, 1 2 3 4... n. 

Four in one: Choose to display a layout of a histogram of residuals, a normal plot of residuals, a plot of residuals 
versus fits, and a plot of residuals versus order.  
Residuals versus variables: Check to display residuals versus selected variables, then enter one or more columns. 
Minitab displays a separate graph for each column. 

 

Analyze Mixture Design − Prediction 
Stat > DOE > Mixture > Analyze Mixture Design > Prediction 
You can calculate and store predicted response values for new design points.  

Dialog box items 
New Design Points (columns and/or constants)   

Components: Type the numeric component values, or enter the columns or constants in which they are stored. The 
number of components must match the number of components in the design and must sum to the common total or to 
the total specified in Mixture Amount in the Analyze Mixture Design dialog box. 
Process Variables: Type the text or numeric process variables, or enter the columns or constants in which they are 
stored. The number of entries must equal the number of process variables in the design.  
Mixture Amount: Type the numeric mixture amount, or enter the constant in which they are stored. The value must 
equal one of the mixture amounts in the design. 
Blocks: Type the text or numeric blocking levels, or enter the columns or constants in which they are stored. Each 
blocking level must equal one of the blocking levels in the design. You do not have to enter a blocking level.  

Confidence level: Type the desired confidence level (for example, type 90 for 90%). The default is 95%. 
Storage 

Fits: Check to store the fitted values for new design points. 
SEs of fits: Check to store the estimated standard errors of the fits. 
Confidence limits: Check to store the lower and upper limits of the confidence interval. 
Prediction limits: Check to store the lower and upper limits of the prediction interval. 

 

To predict responses in mixture designs 
1    Choose Stat > DOE > Mixture > Analyze Mixture Design > Prediction. 
2    In Components, do any combination of the following: 

•     Type numeric component values.  
•     Enter stored constants containing numeric components values. 
•     Enter columns of equal length containing numeric components values. 
Components must match your original design in these ways: 
•     The number of components and the order in which they are entered. 
•     The sum of the components must equal the common total or the total specified in Mixture Amount. 

3    In Process Variables, do any combination of the following: 
•     Type text or numeric values.  
•     Enter stored constants containing text or numeric values. 
•     Enter columns containing numeric values, equal in length to component columns. 
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The process variables must match your original design in these ways: 
•     The number of variables and the order in which they are entered 
•     The levels and data type (text or numeric) of the corresponding variable. 

4    In Mixture Amount, type a value or enter a constant. The entry must be one of the values in the Amount column of 
the design.  

5    In Blocks, do one of the following:   
•     Type a text or numeric blocking level.  
•     Enter a stored constant containing a text or numeric blocking level. 
•     Enter a column containing text or numeric blocking levels, equal in length to component columns.  
Each blocking level must be one of the blocking levels in your original design.  

6    In Confidence level, type a value or use the default, which is 95%: 
7    Under Storage, check any of the prediction results to store them in your worksheet. Click OK. 
 

Analyze Mixture Design − Results 
Stat > DOE > Mixture > Analyze Mixture Design > Results 
Allows you to control the display of Session window results. 

Dialog box items 
Display of Results You can control the display of output. 

Do not display: Choose to suppress display of results. Minitab stores all requested items. 
Model selection, coefficients, and ANOVA table: Choose to display model selection steps, a table of coefficients, s, 
R-sq, R-sq(adj), the analysis of variance table. 
Unusual observations in addition to the above: Choose to display the unusual values in the table of fits and 
residuals in addition to the output described above.  
Full table of fits and residuals in addition to the above: Choose to display a full table of fits and residuals in addition 
to the output described above. 

 

Analyze Mixture Design − Storage 
Stat > DOE > Mixture > Analyze Mixture Design > Storage 

•    store the fits, and regular, standardized, and deleted residuals separately for each response − see Choosing a residual 
type  

•    store the coefficients for the model, the design matrix, and model terms separately for each response. The design 
matrix multiplied by the coefficients will yield the fitted values. Since Analyze Mixture Design does not allow a constant 
in the model, the design matrix does not contain a column of ones.  

•    store the leverages, Cook's distances, and DFITS to identify outliers  

Dialog box items 
Fits and Residuals  

Fits: Check to store the fitted values. One column is stored for each response variable. 
Residuals: Check to store the residuals. One column is stored for each response variable. 
Standardized residuals: Check to store the standardized residuals.  
Deleted residuals: Check to store Studentized residuals. 

Model Information  
Coefficients: Check to store the coefficients. One column is stored for each response variable. These are the same 
coefficients as are printed in the output. If some terms are removed because the data cannot support them, the 
removed terms do not appear on the output. 
Design matrix: Check to store the design matrix. When terms are removed because the data cannot support them, the 
design matrix does not contain the removed terms. The columns of the stored matrix match the coefficients that are 
printed and/or stored. 
Model terms: Check to store the terms that were included in the fitted model. 

Other  
Hi [leverage]: Check to store leverages.  
Cook's distance: Check to store Cook's distance.  
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DFITS: Check to store DFITS. 
 

Example of Analyzing a Simplex Centroid Design 
This example fits a model for the design created in Example of simplex centroid design. Recall that you are trying to 
determine how the proportions of the components in an herbal blend household deodorizer affect the acceptance of the 
product based on scent. The three components are neroli oil, rose oil, and tangerine oil. Based on the design points, you 
mixed ten blends. The response measure (Acceptance) is the mean of five acceptance scores for each of the blends.  
1    Open the worksheet DEODORIZ.MTW. 
2    Choose Stat > DOE > Mixture > Analyze Mixture Design. 
3    In Responses, enter Acceptance. Click OK. 

Session window output 

Regression for Mixtures: Acceptance versus Neroli, Rose, Tangerine 
 
 
Estimated Regression Coefficients for Acceptance (component proportions) 
 
Term                Coef  SE Coef      T      P    VIF 
Neroli             5.856   0.4728      *      *  1.964 
Rose               7.141   0.4728      *      *  1.964 
Tangerine          7.448   0.4728      *      *  1.964 
Neroli*Rose        1.795   2.1791   0.82  0.456  1.982 
Neroli*Tangerine   5.090   2.1791   2.34  0.080  1.982 
Rose*Tangerine    -1.941   2.1791  -0.89  0.423  1.982 
 
 
S = 0.490234    PRESS = 11.4399 
R-Sq = 73.84%   R-Sq(pred) = 0.00%   R-Sq(adj) = 41.14% 
 
 
Analysis of Variance for Acceptance (component proportions) 
 
Source          DF   Seq SS   Adj SS    Adj MS     F      P 
Regression       5  2.71329  2.71329  0.542659  2.26  0.225 
   Linear        2  1.04563  1.56873  0.784366  3.26  0.144 
   Quadratic     3  1.66766  1.66766  0.555887  2.31  0.218 
Residual Error   4  0.96132  0.96132  0.240329 
Total            9  3.67461 

  
Interpreting the results 
The magnitudes of the coefficients for the three pure mixtures indicate that tangerine oil (7.448) and rose oil (7.141) 
produce deodorizers with higher acceptance levels than neroli oil (5.856). 
Positive coefficients for two-blend mixtures indicate that the two components act synergistically or are complementary. 
That is, the mean acceptance score for the blend is greater than you would obtain by calculating the simple mean of the 
two acceptance scores for each pure mixture. 
Negative coefficients indicate that the two components are antagonistic towards one another. That is, the mean 
acceptance score is lower than you would obtain by calculating the simple mean of the two acceptance scores. 
The neroli oil by tangerine mixture is the only two-blend mixture that might be judged as significant (t = 2.34; p = 0.08) 
For a general discussion of analysis results, see [1]. 
 
 

Response Trace Plot 
Response Trace Plot 
Stat > DOE > Mixture > Response Trace Plot 
A response trace plot (also called a component effects plot) shows the effect of each component on the response. Several 
response traces, which are a series of predictions from the fitted model, are plotted along a component direction. The 
trace curves show the effect of changing the corresponding component along an imaginary line (direction) connecting the 
reference blend to the vertex.  
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Each component in the mixture has a corresponding trace direction. The points along a trace direction of a component are 
connected thereby producing as many curves as there are components in the mixture.  
Response trace plots are especially useful when there are more than three components in the mixture and the complete 
response surface cannot be visualized on a contour or surface plot. You can use the response trace plot to identify the 
most influential components and then use them for a contour or surface plot.  

Dialog box items  
Response: Choose a response to display on the plot 
Trace Direction 

Cox (proportion): Choose to use Cox's component direction. 
Piepel (pseudocomponents): Choose to use Piepel's component direction. 

Model Fitted in:  
Proportions: Choose to refit the model in proportions. 
Pseudocomponents: Choose to refit the model in pseudocomponents. 

Reference Blend 
Centroid of vertices: Choose to use the centroid (center point) of the experimental region as the reference blend. 
Row ID: Choose to use a given design point as the reference blend, and then enter the worksheet row containing the 
design point. 
Coordinates: Choose to specify reference blend coordinates, and then enter the coordinates in the box. 

 

To display a response trace plot 
1    Choose Stat > DOE > Mixture > Response Trace Plot. 
2    From Response, choose a response to plot. If an expected response is not in the list, fit a model to it with Analyze 

Mixture Design. 
3    Click OK. 
 

Component direction 
When changing the proportion of a component in a mixture to determine its effect on a response, you must make 
offsetting changes in the other mixture components because the sum of the proportions must always be one. The 
changes in the component whose effect you are evaluating along with the offsetting changes in the other components can 
be thought of as a direction through the experimental region. 
There are two commonly used trace directions along which the estimated responses are calculated: Cox's direction and 
Piepel's direction.  

•    When the design is not constrained and the reference point lies at the centroid of the unconstrained experimental 
region, both Cox's directions and Piepel's directions are the axes of the simplex.  

•    When the design is constrained, the default reference mixture point lies at the centroid of the constrained experimental 
region that is different than the centroid of the unconstrained experimental region. In this case, Cox's direction is 
defined in the original design space, whereas, Piepel's direction is defined in the L-pseudocomponent space.  

 

Response Trace Plot − Settings 
Stat > DOE > Mixture > Response Trace Plot > Settings 
Use to specify hold values for process variables (the default is the low setting) and the amount variable (the default is the 
average amount). 

Dialog box items 
Hold process variables at 

Low setting: Choose to set variables that are not in the plot at their lowest setting. 
High setting: Choose to set variables that are not in the plot at their highest setting. 
Process Var.: Shows all the process variables in your design. This column does not take any input. 
Name: Shows all the names of process variables in your design. This column does not take any input. 
Setting: Enter a value to hold each process variable that is not being plotted. Use the up and down arrows to move in 
the Setting column. 

Hold mixture amount at: Choose a total at which to hold the mixture amount. 
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Response Trace Plot − Options 
Stat > DOE > Mixture > Response Trace Plot > Options 
You can add your own title to the plot. 

Dialog box items 
Title: To replace the default title with your own custom title, type the desired text in this box. 
 

Example of a response trace plot 
In the Example of a simplex centroid design, you created a design to study how the proportions of three ingredients (neroli 
oil, rose oil, and tangerine oil) in an herbal blend household deodorizer affect the acceptance of the product based on 
scent. Next, you analyzed the response (Acceptance) in the Example of analyzing a simplex centroid design. Now, to help 
you visualize the component effects, you display a response trace plot. 
1    Open the worksheet DEODORIZ2.MTW. 
2    Choose Stat > DOE > Mixture > Response Trace Plot. 
3    Click OK.  

Graph window output 

  
 

Interpreting the results 
The trace plot shows how each component effects the response relative to the reference blend. In this example, the 
reference blend is the centroid of the design vertices. This trace plot provides the following information about the 
component effects. Starting at the location corresponding to the reference blend: 

•    As the proportion of neroli oil (solid black curve) in the mixture 
−    increases (and the other mixture components decrease), the acceptance rating of the deodorizer decreases 
−    decreases (and the other mixture components increase), the acceptance rating of the deodorizer decreases  
The proportion of neroli oil in the reference blend is near optimal. 

•    As the proportion of rose oil (long-dashed red curve) in the mixture 
−    increases (and the other mixture components decrease), the acceptance rating of the deodorizer decreases 

slightly 
−    decreases (and the other mixture components increase), the acceptance rating of the deodorizer increases 
A decrease in the proportion of rose oil relative to the reference blend may improve the acceptance rating. 

•    As the proportion of tangerine oil (short-dashed green curve) in the mixture 
−    increases (and the other mixture components decrease), the acceptance rating of the deodorizer increases slightly 
−    decreases (and the other mixture components decrease), the acceptance rating of the deodorizer decreases 
An increase in the proportion of tangerine oil relative to the reference blend may improve the acceptance rating. 

Keep the following in mind when you are interpreting a response trace plot: 

•    All components are interpreted relative to the reference blend. 
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•    Components with the greatest effect on the response will have the steepest response traces. 

•    Components with larger ranges (upper bound - lower bound) will have longer response traces; components with 
smaller ranges will have shorter response traces. 

•    The total effect of a component depends on both the range of the component and the steepness of its response trace. 
The total effect is defined as the difference in the response between the effect direction point at which the component 
is at its upper bound and the effect direction point at which the component is at its lower bound. 

•    Components with approximately horizontal response traces, with respect to the reference blend, have virtually no 
effect on the response. 

•    Components with similar response traces will have similar effects on the response. 
 

Contour/Surface Plots 
Contour/Surface Plots  
Stat > DOE > Mixture > Contour/Surface Plots 
You can use Contour/Surface Plots to display two types of response surface plots: contour plots and surface plots. These 
plots show how a response variable relates to three components based on a model equation. 

Dialog box items 
Contour plot: Check to display a contour plot, then click <Setup>. 
Surface plot: Check to display a surface plot, then click <Setup>. 
 

Contour and Surface Plots (Mixture Design) 
Contour and surface plots are useful for establishing desirable response values and mixture blends.  

•    A contour plot provides a two-dimensional view where all points that have the same response are connected to 
produce contour lines of constant responses. 

•    A surface plot provides a three-dimensional view that may provide a clearer picture of the response surface.  
The illustrations below show a contour plot and 3D surface plot of the same data.  

•    The highest flavor values are found where: 
−    A = 80%    B = 0%      C = 20% 
−    A = 0%      B = 80%    C = 20% 

•    The lowest flavor value is found where: 
−    A = 0%      B = 0%      C = 100% 

Contour Plot 3D Surface Plot 

  
 

Note When the model has more than three components, the components that are not in the plot are held constant. 
Any process and amount variables in the model are also held constant. You can specify the values at which to 
hold the remaining variables in the Settings subdialog box. 
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Data − Mixture Plots 
Trace plots, contour plots, and surface plots are model dependent. Thus, you must fit a model using Analyze Mixture 
Design before you can display these plots. Minitab looks in the worksheet for the necessary model information to generate 
these plots.  
 

To plot the response surface 
1    Choose Stat > DOE > Mixture > Contour/Surface Plots. 
2    Do one or both of the following: 

•    to generate a contour plot, check Contour plot and click Setup 
•    to generate a surface plot, check Surface plot and click Setup  

3    From Response, choose a response to plot. If an expected response is not in the list, fit a model to it with Analyze 
Mixture Design. 

4    If you like, use any of the dialog box options, then click OK. 
 

Contour/Surface Plots − Contour  
Stat > DOE > Mixture > Contour/Surface Plots > check Contour plot > Setup 
Allows you to display components, process variables, and an amount variable on a contour plot. 

Dialog box items 
Response: Choose a response for the plot. 
Components or Process Variables  

Select a triplet of components for a single plot: Choose to plot three components. 
X-Axis: Choose a component to display on the x-axis. 
Y-Axis: Choose a component to display on the y-axis. 
Z-Axis: Choose a component to display on the z-axis. 

Select four components for a matrix: Choose to display four simplex design plots in a single page layout. Then 
choose four components from the drop-down list. 
Generate plots for all triplets of components: Choose to generate plots for all triplets of components. 

In separate panels of the same page: Choose to display all plots on one page.  
On separate pages: Choose to display each plot on a separate page.  

Select a pair of numeric process variables for a single plot: Choose to generate a contour plot for one pair of 
process variables. 

X-Axis: Choose a process variable to display on the x-axis. 
Y-Axis: Choose a process variable to display on the y-axis. 

Generate plots for all pairs of numeric process variables: Choose to generate contour plots for all combinations of 
process variable levels. 

In separate panels of the same page: Choose to display all plots on one page.  
On separate pages: Choose to display each plot on a separate page.  

Model Fitted in 
Proportions: Choose to refit the model in proportions. 
Pseudocomponents: Choose to refit the model in  
Component Unit in Plot(s) 

Amount: Choose to display the components in amounts. 
Proportion: Choose to display the components in proportions. 
Pseudocomponent: Choose to display the components in pseudocomponents. 

Plot all level combinations: Choose to display single contour and include all the levels of the process variables in a 
single layout. 
Plot all mixture amounts: Choose to display a single contour plot and include all the levels of the amount variable in a 
single layout. 
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Contour/Surface Plots − Contour − Contours  
Stat > DOE > Mixture > Contour/Surface Plots > check Contour plot > Setup > Contours 
Allows you to specify the number or location of the contour levels, and the way Minitab displays the contours. 

Dialog box items 
Contour Levels Controls the number of contour levels to display. 

Use defaults: Choose to have Minitab determine the number of contour lines (from 4 to 7) to draw.  
Number: Choose specify the number of contour lines, then enter an integer from 2 to 11 for the number of contour lines 
you want to draw. 
Values: Choose to specify the values of the contour lines in the units of your data. Then specify from 2 to 11 contour 
level values in strictly increasing order.  

Data Display 
Area: Check to shade the areas that represent the values for the response, which are called contours. 
Contour lines: Check to draw lines along the boundaries of each contour. 
Symbols at design points: Check to display a symbol at each data point. 

 

Contour/Surface Plots − Contour − Options 
Stat > DOE > Mixture > Contour/Surface Plots > check Contour plot > Setup > Options 
Allows you to define the background grid and determine the title of your plot. 

Dialog box items 
Grid Lines 

At intervals: Choose to define the background grid, and then choose an interval from the list.  
None: Choose to suppress the display of the background grid. 

Title: To replace the default title with your own custom title, type the desired text in this box. 
 

To control plotting of contour levels (mixture design) 
1    In the Contour/Surface Plots dialog box, check Contour plot and click Setup. 
2    Click Contours. 
3    To change the number of contour levels, do one of the following: 

•    Choose Number and enter a number from 2 to 11. 
•    Choose Values and enter from 2 to 11 contour level values in the units of your data. You must enter the values in 

increasing order.  
4    Click OK in each dialog box. 
 

Contour/Surface Plots − Surface  
Stat > DOE > Mixture > Contour/Surface Plots > check Surface plot > Setup 
Allows you to display components, process variables, and an amount variable on a surface plot. 

Dialog box items 
Response: Choose a response for the plot. 
Components or Process Variables  

Select a triplet of components for a single plot: Choose to plot three components. 
X-Axis: Choose a component to display on the x-axis. 
Y-Axis: Choose a component to display on the y-axis. 
Z-Axis: Choose a component to display on the z-axis. 

Generate plots for all triplets of components: Choose to generate plots for all triplets of components, each in a 
separate window. 
Select a pair of numeric process variables for a single plot: Choose to generate a surface plot for one pair of 
process variables. 

X-Axis: Choose a process variable to display on the x-axis. 
Y-Axis: Choose a process variable to display on the y-axis. 
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Generate plots for all pairs of numeric process variables: Choose to generate surface plots for all combinations of 
process variable levels. 

Model Fitted in 
Proportions: Choose to refit the model in proportions. 
Pseudocomponents: Choose to refit the model in  

Component Unit in Plot(s) 
Amount: Choose to display the components in amounts. 
Proportion: Choose to display the components in proportions. 
Pseudocomponent: Choose to display the components in pseudocomponents. 

 

Contour/Surface Plots − Surface − Options  
Stat > DOE > Mixture > Contour/Surface Plots > check Surface plot > Setup > Options 
You can determine the title of your plot. 

Dialog box items 
Title: To replace the default title with your own custom title, type the desired text in this box. 
 

Contour/Surface Plots − Settings 
Stat > DOE > Mixture > Contour/Surface Plots > check Contour plot or Surface plot > Setup > Settings 
You can set the holding level for components, and process variables that are not in the plot at their highest or lowest 
settings, or you can set specific levels to hold each. The hold values must be expressed in the following units: 

•    components in the units displayed in the worksheet 
•    process variables in coded units 

Note If you have text process variables in your design, you can only set their holding values at one of the text levels.

Dialog box items 
Hold components at 

Lower bound setting: Choose to set all components that are not in the graph at their lower bound. 
Upper bound setting: Choose to set all components that are not in the graph at their upper bound. 
Component: Shows all the components in your design. This column does not take any input. 
Name: Shows all the names of components in your design. This column does not take any input. 
Setting: Enter a value to hold each component that is not being plotted. Use the up and down arrows to move in the 
Setting column. 

Hold process variables at 
Low setting: Choose to set variables that are not in the plot at their lowest setting. 
High setting: Choose to set variables that are not in the plot at their highest setting. 
Process Var.: Shows all the process variables in your design. This column does not take any input. 
Name: Shows all the names of process variables in your design. This column does not take any input. 
Setting: Enter a value to hold each process variable that is not being plotted. Use the up and down arrows to move in 
the Setting column. 

Hold mixture amount at: Choose a total at which to hold the mixture amount. 
 

To set the holding level for design variables not in the plot (mixture design) 
1    In the Setup subdialog box, click Settings. 
2    Do one or more of the following to set the holding values:  

•    For components (only available for design with more than three components): 

−    To use the preset values for components, choose Lower bound setting, Middle setting, or Upper bound 
setting under Hold components at. When you use a preset value, all components not in the plot will be held 
at their lower bound, middle, or upper bound.  
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−    To specify the value at which to hold the components, enter a number in Setting for each component that you 
want to control. This option allows you to set a different holding value for each component. 

•    For process variables: 

−    To use the preset values for process variables, choose High setting or Low setting under Hold process 
variables at. When you use a preset value, all variables not in the plot will be held at their high or low 
settings.  

−    To specify the value at which to hold the process variables, enter a number in Setting for each of the process 
variables you want to control. This option allows you to set a different holding value for each process variable. 

•    For an amount variable:  

−    In Hold mixture amount at, choose one of the mixture totals. Minitab displays the multiple totals that you 
entered in the Components subdialog box when you were creating the design. The default hold value is the 
average of the multiple totals.  

3    Click OK. 
 

Example of a contour plot and a surface plot (mixture design) 
In the deodorizer example, you fit a model to try to determine how the proportions of the components in an herbal blend 
deodorizer affect the acceptance of the product based on scent. The three components are neroli oil, rose oil, and 
tangerine oil. Based on the design points, you mixed ten blends. The response measure (Acceptance) is the mean of five 
acceptance scores for each of the blends. 
Now you generate a contour and a surface plot to help identify the component proportions that yield the highest 
acceptance score for the herbal blend. 
1    Open the worksheet DEODORIZ2.MTW. 
2    Choose Stat > DOE > Mixture > Contour/Surface Plots. 
3    Choose Contour plot and click Setup. Click OK. 
4    Choose Surface plot and click Setup. Click OK in each dialog box. 

Graph window output 
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Interpreting the results 
The area of the highest acceptance is located on the right edge of the plots. Both the contour and the surface plot show 
that the acceptance of the herbal deodorizer is highest when the mixture contains little or no rose oil and slightly more 
tangerine oil than neroli oil.  
 

Overlaid Contour Plot 
Overlaid Contour Plot  
Stat > DOE > Mixture > Overlaid Contour Plot 
Use an overlaid contour plot to draw contour plots for multiple responses and to overlay multiple contour plots on top of 
each other in a single graph. Contour plots show how response variables relate to three continuous design variables while 
holding the rest of the variables in a model at certain settings.  

Dialog box items 
Responses  

Available: Shows all the responses that have had a model fit to them and can be used in the contour plot. Use the 
arrow keys to move up to 10 response columns from Available to Selected. (If an expected response column does not 
show in the Available list, fit a model to it using Analyze Mixture Design.) 
Selected: Shows all responses that will be included in the contour plot. 

Select components or process variables as axes  
3 Components: Choose to display three components on the plot.  

X-Axis: Choose a component to display on the x-axis. 
Y-Axis: Choose a component to display on the y-axis. 
Z-Axis: Choose a component to display on the z-axis. 

2 process variables: Choose to display two process variables on the plot. 
X-Axis: Choose a process variable to display on the x-axis. 
Y-Axis: Choose a process variable to display on the y-axis. 

Model Fitted in  
Proportion: Choose to refit the model using proportions (the default). 
Pseudocomponents: Choose to refit the model using pseudocomponents. 

Component Unit in Plot(s)  
Amount: Choose to display the plot in amounts (the default). 
Proportion: Choose to display the plot in proportions. 
Pseudocomponents: Choose to display the plot in pseudocomponents. 
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Data − Overlaid Contour Plot 
1    Create and store a design using Create Mixture Design or create a design from data that you already have in the 

worksheet with Define Custom Mixture Design. 
2    Enter up to ten numeric response columns in the worksheet 
3    Fit a model for each response using Analyze Mixture Design. 
 

To create an overlaid contour plot 
1    Choose Stat > DOE > Factorial > Overlaid Contour Plot. 
2    Under Responses, move up to ten responses that you want to include in the plot from Available to Selected using 

the arrow buttons. 

•    To move the responses one at a time, highlight a response, then click  or   

•    To move all of the responses, click  or   
You can also move a response by double-clicking it. 

3    Do one of the following: 
•    To plot components, under Select components or process variables as axes, choose 3 Components. Then 

choose a component from X Axis, Y Axis, and Z Axis. 

Note Only numeric process variables are valid candidates for X and Y axes. 
•    To plot process variables, under Select components or process variables as axes, choose 2 process 

variables. 
4    Click Contours.  
5    For each response, enter a number in Low and High. See Defining contours. Click OK. 
6    If you like, use any of the available dialog box options, then click OK. 
 

Overlaid Contour Plot − Contours 
Stat > DOE > Mixture > Overlaid Contour Plot > Contours 
Define the low and high values for the contour lines for each response. 
For a discussion, see Defining contours. 

Dialog box items 
Responses: Lists the responses that have been selected to display on the overlaid contour plot. 

Low: Enter the low value for the contour lines for each response. 
High: Enter the high value for the contour lines for each response. 

 

Defining Contours 
For each response, you need to define a low and a high contour. These contours should be chosen depending on your 
goal for the responses. Here are some examples: 

•    If your goal is to minimize (smaller is better) the response, you may want to set the Low value at the point of 
diminishing returns, that is, although you want to minimize the response, going below a certain value makes little or no 
difference. If there is no point of diminishing returns, use a very small number, one that is probably not achievable. 
Use your maximum acceptable value in High. 

•    If your goal is to target the response, you probably have upper and lower specification limits for the response that can 
be used as the values for Low and High. If you do not have specification limits, you may want to use lower and upper 
points of diminishing returns.  

•    If your goal is to maximize (larger is better) the response, again, you may want to set the High value at the point of 
diminishing returns, although now you need a value on the upper end instead of the lower end of the range. Use your 
minimum acceptable value in Low. 

In all of these cases, the goal is to have the response fall between these two values. 
 

Overlaid Contour Plot − Settings 
Stat > DOE > Mixture > Overlaid Contour Plot > Settings 
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You can set the holding levels for components that are not in the plot and process variables at their highest, lowest, or 
middle (calculated median) settings, or you can se specific levels to hold each factor. For mixture designs that include an 
amount variable, you can specify the hold variable, instead of using the mean as the default.  

Dialog box items 
Select one of the three settings OR enter your own settings in the table. (Settings represent component unit in worksheet 
and coded process variable levels.)  
Hold components at  

Lower bound setting: Choose to set components that are not in the graph at their lowest setting. 
Middle bound setting: Choose to set components that are not in the graph at the calculated median setting.  
Upper bound setting: Choose to set components that are not in the graph at their highest setting. 
Component: Shows all the components in your design. This column does not take any input. 
Name: Shows all the names of components in your design. This column does not take any input. 
Setting: Enter a value at which to hold each component that is not being plotted. Use the up and down arrows to move 
in the Setting column. 

Hold process variables at 
Low setting: Choose to set process variables at their lowest setting. 
Middle setting: Choose to set process variables at the calculated median setting. 
High setting: Choose to set process variables at their highest setting. 
Process Var: Shows all the process variables in your design. This column does not take any input. 
Name: Shows all the names of process variables in your design. This column does not take any input. 
Setting: Enter a values at which to hold each process variable. Use the up and down arrows to move in the Setting 
column.  

Hold mixture amount at: For mixture designs that include an amount variable, specify the hold value, instead of using 
the mean as the default. 
 

To set the holding levels for variables not in the plot 
1    In the Overlaid Contour Plot dialog box, click Settings. 
2    Do one of the following to set the holding value for extra components or process variables: 

•    For process variables: 

−     To use the preset values for factors, covariates, or process variables, choose High settings, Middle settings, 
or Low settings. When you use a preset value, all variables not in the plot will be held at their high, middle 
(calculated median), or low settings. 

−     To specify the value at which to hold the factor, covariate, or process variable, enter a number in Setting for 
each of the design variables you want control. This option allows you to set a different holding value for each 
variables. 

•    For components: 

−     To use the preset values for components, choose Lower bound setting, Middle setting, or Upper bound 
setting under Hold components at. When you use a preset value, all components not in the plot will be held 
at their lower bound, middle, or upper bound.  

−     To specify the value at which to hold the components, enter a number in Setting for each component that you 
want control. This option allows you to set a different holding value for each components. 

3    Click OK. 
 

Overlaid Contour Plot − Options 
Stat > DOE > Mixture > Overlaid Contour Plot > Options 
You can determine the title of your plot. 

Dialog box items 
Title: To replace the default title with your own custom title, type the desired text in this box. 
 



Design of Experiments 

  Copyright © 2003–2005 Minitab Inc.  All rights reserved. 180 

Example of an overlaid contour plot for a mixture design 
This overlaid contour plot is a continuation of the analysis for the plastic pipe experiment. The compound normally used to 
make a plastic pipe is made of two materials: Mat-A and Mat-B. As a research engineer, you would like to determine 
whether or not a filler can be added to the existing formulation and still satisfy certain physical property requirements. You 
would like to include as much filler in the formulation as possible and still satisfy the response specifications. The pipe 
must meet the following specifications: 

•    impact strength must be greater than 1ft-lb / in 

•    deflection temperature must be greater than 190° F 

•    yield strength must be greater than 5000 psi 
Using an augmented simplex centroid design, you collected data and are now going to create an overlaid contour plot for 
three responses: impact strength (Impact), deflection temperature (Temp), and yield strength (Strength).  
1    Open the worksheet MIXOPT.MTW. (The design, response data, and model information have been saved for you. 

The data is from [1].)  
2    Choose Stat > DOE > Mixture > Overlaid Contour Plot. 

3    Click  to select all available responses. 
4    Click Contours. Complete the Low and High columns of the table as shown below: 

Name Low High 

Impact 1 7 

Temp 190 205 

Strength 5000 5800 

5    Click OK in each dialog box. 

Graph Window Output 

 
Interpreting the results  
The white area in the center of the plot shows the range of the three components, Mat-A, Mat-B, and Filler, where the 
criteria for all three response variables are satisfied.  
You can use this plot in combination with the optimization plot to find the "best" formulation for plastic pipe. 
 

Response Optimizer 
Response Optimization Overview 
Many designed experiments involve determining optimal conditions that will produce the "best" value for the response. 
Depending on the design type (factorial, response surface, or mixture), the operating conditions that you can control may 
include one or more of the following design variables: factors, components, process variables, or amount variables.  
For example, in product development, you may need to determine the input variable settings that result in a product with 
desirable properties (responses). Since each property is important in determining the quality of the product, you need to 
consider these properties simultaneously. For example, you may want to increase the yield and decrease the cost of a 
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chemical production process. Optimal settings of the design variables for one response may be far from optimal or even 
physically impossible for another response. Response optimization is a method that allows for compromise among the 
various responses. 
Minitab provides two commands to help you identify the combination of input variable settings that jointly optimize a set of 
responses. These commands can be used after you have created and analyzed factorial designs, response surface 
designs, and mixture designs. 

•    Response Optimizer − Provides you with an optimal solution for the input variable combinations and an optimization 
plot. The optimization plot is interactive; you can adjust input variable settings on the plot to search for more desirable 
solutions. 

•    Overlaid Contour Plot − Shows how each response considered relates to two continuous design variables (factorial 
and response surface designs) or three continuous design variables (mixture designs), while holding the other 
variables in the model at specified levels. The contour plot allows you to visualize an area of compromise among the 
various responses. 

 

Response Optimizer 
Stat > DOE > Mixture > Response Optimizer  
Use response optimization to help identify the combination of input variable settings that jointly optimize a single response 
or a set of responses. Joint optimization must satisfy the requirements for all the responses in the set, which is measured 
by the composite desirability. 
Minitab calculates an optimal solution and draws a plot. The optimal solution serves as the starting point for the plot. This 
optimization plot allows you to interactively change the input variable settings to perform sensitivity analyses and possibly 
improve the initial solution. 

Note Although numerical optimization along with graphical analysis can provide useful information, it is not a 
substitute for subject matter expertise. Be sure to use relevant background information, theoretical principles, 
and knowledge gained through observation or previous experimentation when applying these methods. 

Dialog box items 
Select up to 25 response variables to optimize  

Available: Shows all the responses that have had a model fit to them and can be used in the analysis. Use the arrow 
keys to move the response columns from Available to Selected. (If an expected response column does not show in 
the Available list, fit a model to it using Analyze Mixture Design.) 
Selected: Shows all responses that will be included in the optimization. 

Model Fitted in 
Proportions: Choose to refit the model in proportions. 
Pseudocomponents: Choose to refit the model in pseudocomponents. 

 

Data − Response Optimizer − Mixture Design 
Before you use Minitab's Response Optimizer, you must  
1    Create and store a design using Create Mixture Design or create a design from data that you already have in the 

worksheet with Define Custom Mixture Design.  
2    Enter up to 25 numeric response columns in the worksheet. 
3    Fit a model for each response Analyze Mixture Design.  
You can fit a model with different design variables for each response. If an input variable was not included in the model for 
a particular response, the optimization plot for that response-input variable combination will be blank. 
Minitab automatically omits missing data from the calculations. If you optimize more than one response and there are 
missing data, Minitab excludes the row with missing data from calculations for all of the responses. 
 

To optimize responses for mixture design 
1    Choose Stat > DOE > Mixture > Response Optimizer. 
2    Move up to 25 responses that you want to optimize from Available to Selected using the arrow buttons. (If an 

expected response column does not show in Available, fit a model to it using Analyze Mixture Design.) 

•    to move responses one at a time, highlight a response, then click  or  

•    to move all the responses at once, click  or  
You can also move a response by double-clicking it. 
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3    Click Setup. 
4    For each response, complete the table as follows: 

•    Under Goal, choose Minimize, Target, or Maximize from the drop-down list. 
•    Under Lower, Target, and Upper, enter numeric values for the target and necessary bounds as follows: 

1    If you choose Minimize under Goal, enter values in Target and Upper. 

2    If you choose Target under Goal, enter values in Lower, Target, and Upper. 

3    If you choose Maximize under Goal, enter values in Target and Lower. 
For guidance on choosing bounds, see Specifying bounds. 

•    In Weight, enter a number from 0.1 to 10 to define the shape of the desirability function. See Setting the weight for 
the desirability function. 

•    In Importance, enter a number from 0.1 to 10 to specify the relative importance of the response. See Specifying 
the importance for the composite desirability. 

5    Click OK. 
6    If you like, use any of the available dialog box options, then click OK. 
 

Method − Response Optimization 
Minitab's Response Optimizer searches for a combination of input variables that jointly optimize a set of responses by 
satisfying the requirements for each response in the set. The optimization is accomplished by:  
1    obtaining the individual desirability (d) for each response 
2    combining the individual desirabilities to obtain the combined or composite desirability (D) 
3    maximizing the composite desirability and identifying the optimal input variable settings  

Note If you have only one response, the overall desirability is equal to the individual desirability. 

Obtaining individual desirability 
First, Minitab obtains an individual desirability (d) for each response using the goals and boundaries that you have 
provided in the Setup dialog box. There are three goals to choose from. You may want to: 

•    minimize the response (smaller is better)  

•    target the response (target is best) 

•    maximize the response (larger is better)  
Suppose you have a response that you want to minimize. You need to determine a target value and an allowable 
maximum response value. The desirability for this response below the target value is one; above the maximum 
acceptable value the desirability is zero. The closer the response to the target, the closer the desirability is to one. The 
illustration below shows the default desirability function (also called utility transfer function) used to determine the 
individual desirability (d) for a "smaller is better" goal: 

 d = desirability  

Target 
any response 
value less 
than the 
target value 
has a 
desirability of 
one  

Upper bound 
any response 
value greater 
than the upper 
bound has a 
desirability  
of zero 

 
As the response decreases, the desirability increases.  

  

The shape of the desirability function between the upper bound and the target is determined by the choice of weight. The 
illustration above shows a function with a weight of one. To see how changing a weight affects the shape of the 
desirability function, see Setting the weight for the desirability function. 
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Obtaining the composite desirability 
After Minitab calculates an individual desirability for each response, they are combined to provide a measure of the 
composite, or overall, desirability of the multi-response system. This measure of composite desirability (D) is the weighted 
geometric mean of the individual desirabilities for the responses. The individual desirabilities are weighted according to 
the importance that you assign each response. For a discussion, see Specifying the importance for composite desirability. 

Maximizing the composite desirability 
Finally, Minitab employs a reduced gradient algorithm with multiple starting points that maximizes the composite 
desirability to determine the numerical optimal solution (optimal input variable settings).  

More    You may want to fine tune the solution by adjusting the input variable settings using the interactive optimization 
plot. See Using the optimization plot.  
 

Response Optimizer − Setup 
Stat > DOE > Mixture > Response Optimizer > Setup 
Specify the goal, boundaries, weight, and importance for each response variable. 

Dialog box items 
Response: Displays all the responses that will be included in the optimization. This column does not take any input. 
Goal: Choose Minimize, Target, or Maximize from the drop-down list.  
Lower: For each response that you chose Target or Maximize under Goal, enter a lower boundary. 
Target: Enter a target value for each response. 
Upper: For each response that you chose Minimize or Target under Goal, enter an upper boundary. 
Weight: Enter a number from 0.1 to 10 to define the shape of the desirability function. 
Importance: Enter a number from 0.1 to 10 to specify the comparative importance of the response. 
 

Specifying Bounds 
In order to calculate the numerically optimal solution, you need to specify a response target and lower and/or upper 
bounds. The boundaries needed depend on your goal: 

•    If your goal is to minimize (smaller is better) the response, you need to determine a target value and the upper bound. 
You may want to set the target value at the point of diminishing returns, that is, although you want to minimize the 
response, going below a certain value makes little or no difference. If there is no point of diminishing returns, use a 
very small number, one that is probably not achievable, for the target value.  

•    If your goal is to target the response, you should choose upper and lower bounds where a shift in the mean still 
results in a capable process.  

•    If your goal is to maximize (larger is better) the response, you need to determine a target value and the lower bound. 
Again, you may want to set the target value at the point of diminishing returns, although now you need a value on the 
upper end instead of the lower end of the range.  

 

Setting the Weight for the Desirability Function 
In Minitab's approach to optimization, each of the response values are transformed using a specific desirability function. 
The weight defines the shape of the desirability function for each response. For each response, you can select a weight 
(from 0.1 to 10) to emphasize or de-emphasize the target. A weight 

•    less than one (minimum is 0.1) places less emphasis on the target 

•    equal to one places equal importance on the target and the bounds 

•    greater than one (maximum is 10) places more emphasis on the target 
The illustrations below show how the shape of the desirability function changes when the goal is to maximize the 
response and the weight changes:  
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Weight Desirability function 
 d = desirability 

0.1 
A weight less than one places less 
emphasis on the target. a response  
value far from the target may have a 
high desirability.  

                                            target 

 

1 
A weight equal to one places equal 
emphasis on the target and the  
bounds. The desirability for a response 
increases linearly. 

 
                                        target 

 

10 
A weight greater than one places more 
emphasis on the target. A response  
value must be very close to the target 
to havea high desirability. 

 
                                      target 

 
 
The illustrations below summarize the desirability functions: 

When the goal is to ...  

 

minimize the response  
Below the target the response 
desirability is one; above the 
upper bound it is zero.  
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target the response 
Below the lower bound the 
response desirability is zero; 
at the target it is one; above 
the upper bound it is zero. 

 
 

maximize the response  
Below the lower bound the 
response desirability is zero; 
above the target it is one.  

 
 

Specifying the Importance for Composite Desirability 
After Minitab calculates individual desirabilities for the responses, they are combined to provide a measure of the 
composite, or overall, desirability of the multi-response system. This measure of composite desirability is the weighted 
geometric mean of the individual desirabilities for the responses. The optimal solution (optimal operating conditions) can 
then be determined by maximizing the composite desirability. 
You need to assess the importance of each response in order to assign appropriate values for importance. Values must 
be between 0.1 and 10. If all responses are equally important, use the default value of one for each response. The 
composite desirability is then the geometric mean of the individual desirabilities. 
However, if some responses are more important than others, you can incorporate this information into the optimal solution 
by setting unequal importance values. Larger values correspond to more important responses, smaller values to less 
important responses. 
You can also change the importance values to determine how sensitive the solution is to the assigned values. For 
example, you may find that the optimal solution when one response has a greater importance is very different from the 
optimal solution when the same response has a lesser importance. 
 

Response Optimizer − Options 
Stat > DOE > Mixture > Response Optimizer > Options 
Allows you to define a starting point for the search algorithm, suppress display of the optimization plot, and store the 
composite desirability values. 

Dialog box items 
Components in design: Displays all the components that have been included in the fitted model. This column does not 
take any input. 
Starting value: To define a starting point for the search algorithm, enter a value for each component. Each value must be 
between the minimum and maximum levels for that component. 
Process variables in design: Displays all the process variables that have been included in the fitted model. This column 
does not take any input. 
Starting value: To define a starting point for the search algorithm, enter a value for each process variable. Each value 
must be between the minimum and maximum levels for that process variable. 
Optimization plot: Uncheck to suppress display of the optimization plot. The default is to display the plot. 
Store composite desirability values: Check to store the composite desirability values. 
Display local solutions: Check to display the local solutions. 
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Response Optimizer − Levels for Input Variables 
Enter a new value to change the input variable settings. 
For further discussion, see Using the optimization plot. 

Dialog box items 
Input New Level Value: Enter a new value to change the input variable settings. 
 

Using the Optimization Plot 
Once you have created an optimization plot, you can change the input variable settings. For factorial and response 
surface designs, you can adjust the factor levels. For mixture designs, you can adjust component, process variable, and 
amount variable settings. You might want to change these input variable settings on the optimization plot for many 
reasons, including: 

•    To search for input variable settings with a higher composite desirability 

•    To search for lower-cost input variable settings with near optimal properties 

•    To explore the sensitivity of response variables to changes in the design variables 

•    To "calculate" the predicted responses for an input variable setting of interest 

•    To explore input variable settings in the neighborhood of a local solution 
When you change an input variable to a new level, the graphs are redrawn and the predicted responses and desirabilities 
are recalculated. If you discover a setting combination that has a composite desirability higher than the initial optimal 
setting, Minitab replaces the initial optimal setting with the new optimal setting. You will then have the option of adding the 
previous optimal setting to the saved settings list. 

Note If you save the optimization plot and then reopen it in Minitab without opening the project file, you will not be 
able to drag the red lines with your mouse to change the factor settings. 

With Minitab's interactive Optimization Plot you can: 

•    Change input variable settings  

•    Save new input variable settings  

•    Delete saved input variable settings  

•    Reset optimization plot to optimal settings  

•    View a list of all saved settings  

•    Lock mixture components  
 

To change input variable settings 
1    Change input variable settings in the optimization plot by: 

•    Dragging the vertical red lines to a new position or  
•    Clicking on the red input variable settings located at the top and entering a new value in the dialog box that 

appears . 

Note You can return to the initial or optimal settings at any time by clicking  on the Toolbar or by right-clicking and 
choosing Reset to Optimal Settings. 

Note For factorial designs with center points in the model: If you move one factor to the center on the optimization 
plot, then all factors will move to the center. If you move one factor away from the center, then all factors with 
move with it, away from the center. 

Note For a mixture design, you cannot change a component setting independently of the other component settings. 
If you want one or more components to stay at their current settings, you need to lock them. See To lock 
components (mixture designs only). 

 

To save new input variable settings 
1    Save new input variable settings in the optimization plot by 

•    Clicking  on the Optimization Plot Toolbar 
•    Right-clicking and selecting Save current settings from the menu 
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Note The saved settings are stored in a sequential list. You can cycle forwards and backwards through the setting 

list by clicking on  or  on the Toolbar or by right-clicking and choosing the appropriate command from 
the menu. 

 

To delete saved input variable settings 
1    Choose the setting that you want to delete by cycling through the list.  
2    Delete the setting by: 

•    Clicking  on the Optimization Plot Toolbar 
•    Right-clicking and choosing Delete Current Setting  

 

To reset optimization plot to optimal settings 
1    Reset to optimal settings by: 

•    Clicking  on the Toolbar 
•    Right-clicking and choosing Reset to Optimal Settings 

 

To lock components (mixture designs only) 
1    Lock a component by clicking on the black [ ] before the component name. You cannot lock a component at a value 

that would prevent any other component from changing. In addition, you must leave at least two components 
unlocked. 

 

To view a list of all saved settings 
1    View the a list of all saved settings by 

•    Clicking  on the Optimization Plot Toolbar 
•    Right-clicking and choosing Display Settings List 

More You can copy the saved setting list to the Clipboard by right-clicking and choosing Select All and then choosing 
Copy. 

 

Example of a response optimization experiment for mixture design 
The compound normally used to make a plastic pipe is made of two materials: Material A and Material B. As a research 
engineer, you would like to determine whether or not a filler can be added to the existing formulation and still satisfy 
certain physical property requirements. You would like to include as much filler in the formulation as possible and still 
satisfy the response specifications. The pipe must meet the following specifications: 

•    impact strength must be greater than 1ft-lb / in 

•    deflection temperature must be greater than 190° F 

•    yield strength must be greater than 5000 psi 
Using an augmented simplex centroid design, you collected data and are now going to optimize on three responses: 
impact strength (Impact), deflection temperature (Temp), and yield strength (Strength). 
1    Open the worksheet MIXOPT.MTW. (The design, response data, and model information have been saved for you. 

The data are from [1].)  
2    Choose Stat > DOE > Mixture > Response Optimizer. 

3    Click  to move Impact, Temp, and Strength to Selected. 
4    Under Model Fitted in, choose Pseudocomponents. 
5    Click Setup. Complete the Goal, Lower, Target, and Upper columns of the table as shown below: 

Response Goal Lower Target Upper 

Impact Maximize 1 3  

Temp Maximize 190 200  

Strength Maximize 5000 5200  
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6    Click OK in each dialog box. 

Session Window Output 

Response Optimization 
 
Parameters 
 
                    Goal      Lower     Target      Upper     Weight     Import 
Impact          Maximum          1          3          3          1          1 
Temp            Maximum        190        200        200          1          1 
Strength        Maximum       5000       5200       5200          1          1 
 
Global Solution 
 
Components 
 
Mat-A        =    0.575 
Mat-B        =    0.425 
Filler       =    0.000 
 
Predicted Responses 
 
Impact       =     7.26, desirability =        1 
Temp         =   203.93, desirability =        1 
Strength     =  5255.47, desirability =        1 
 
Composite Desirability =  1.00000 

Graph Window Output 

 
Interpreting the results 
In most cases, Minitab uses the units that are displayed in the worksheet for the numerical optimization and optimization 
plot results. However, if you have a design that is displayed in amounts and you have multiple total amounts, the 
components are displayed in proportions for both the numerical optimization and the optimization plot results. In this 
example, the results are displayed in proportions. 
Both the individual desirabilities and the combined or composite desirability of the three response variables are 1.0. 
To obtain this composite desirability, you would set the mixture component proportions at the values shown under Global 
Solution in the Session window output. The proportions of the three ingredients in the formulation used to make the plastic 
pipe would be: 0.575 of Mat-A; 0.425 of Mat-B, and 0.0 of Filler. The predicted responses for the formulation are: impact 
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strength = 7.26, deflection temperature = 203.93, and yield strength = 5255.47. These predicted responses indicate that 
the physical property specifications of the plastic pipe have been met. 
However, the objective of the experiment is to include as much filler in the formulation as possible and still satisfy the 
response specifications. Although you have satisfied the response specifications, the resulting formulation does not 
include any filler. You can move the vertical bars to change the component proportions and see whether or not you can 
add more filler and still satisfy the specifications. 
In the plot below, filler has been locked at .14 and the vertical bars have been moved to determine the proportions of a 
formulation with lower desirability, but one that still meets the required specifications. The specifications for impact 
strength and yield strength have been easily met, whereas, the specification for deflection temperature is barely satisfied. 
You can continue to change the formulation until you find a combination of proportions that fit your needs. 

 
 

Modify Design 
Modify Design 
Stat > DOE > Modify Design  
After creating a design and storing it in the worksheet, you can use Modify Design to make the following modifications: 

•    rename the components  

•    rename process variables and change levels  

•    replicate the design 

•    randomize the design  

•    renumber the design  
By default, Minitab will replace the current design with the modified design in the worksheet. To store the modified design 
in a new worksheet, check Put modified design in a new worksheet. 

Dialog box items 
Modification  

Modify variables: Choose to rename components, rename process variables, or change process variable level, then 
click <Specify>. 
Replicate design: Choose to add up to ten replicates, and then click <Specify>. 
Randomize design: Choose to randomize the design, and then click <Specify>. 
Renumber design: Choose to renumber the design. 

Put modified design in a new worksheet: Check to have Minitab place the modified design in a new worksheet rather 
than overwriting the current worksheet. 
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Modify Design − Modify Variables  
Stat > DOE > Modify Design > choose Modify Variables > Specify 
Allows you to rename components, rename process variables, and change process variable levels. 

Dialog box items 
Component: Shows the components you have chosen for your design. This column does not take any input. 
Name: Enter text to change the name of the components.  
 

To rename components 
1    Choose Stat > DOE > Modify Design. 
2    Choose Modify variables and click Specify. 
3    Under Name, click in the first row and type the name of the first component. Then, use the arrow key to move down 

the column and enter the remaining component names. Click OK. 

Tip You can also type new component or process variable names directly into the Data window. 

 

Modify Design − Mixture Process Variables 
Stat > DOE > Modify Design > check Modify variables > Specify > Process variables 
Allows you to rename process variables and change process variable levels. 

Dialog box items 
Process Variable 

Name: Enter text to change the name of the process variables.  
Type: Shows whether the variable is numeric or text. This column does not take any input. 
Lower: Enter the value of the low level for each process variable.  
Upper: Enter the value of the high level for each process variable. 

 

To rename process variables or change levels 
1    Choose Stat > DOE > Modify Design. 
2    Choose Modify variables and click Specify. 
3    Click Process Variables. 
4    Do one or both of the following: 

•    Under Name, click in the first row and type the name of the first process variable. Then, use the arrow key to move 
down the column and name the remaining process variables. 

•    Under Low, click in the process variable row you would like to assign values and enter any numeric or text value. 
Use the arrow key to move to High and enter a value. For numeric levels, the High value must be larger than Low 
value. 
Repeat to assign levels for other process variables. 

5    Click OK. 

Tip You can also type new component or process variable names directly into the Data window. 

 

Modify Design − Replicate  
Stat > DOE > Modify Design > check Replicate Design > Specify 
You can add up to ten replicates of your design.  

Dialog box items 
Number of replicates to add: Choose a number up to ten.  
 

To replicate the design 
1    Choose Stat > DOE > Modify Design. 
2    Choose Replicate design and click Specify. 
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From Number of replicates to add, choose a number up to ten. Click OK. 
 

Replicating the design  
You can add up to ten replicates of your design. When you replicate a design, you duplicate the complete set of runs from 
the initial design. The runs that would be added to a three-component simplex lattice design are as follows: 

Initial design One replicate added 
(total of two replicates) 

Two replicates added 
(total of three replicates) 

A B C 

1 0 0 
0 1 0 
0 0 1 

A B C 

1 0 0 
0 1 0 
0 0 1 

1 0 0 
0 1 0 
0 0 1 

A B C 

1 0 0 
0 1 0 
0 0 1 

1 0 0 
0 1 0 
0 0 1 

1 0 0 
0 1 0 
0 0 1 

True replication provides an estimate of the error or noise in your process and may allow for more precise estimates of 
effects. 
 

Modify Design − Randomize 
Stat > DOE > Modify Design > check Randomize > Specify 
Allows you to randomize the order of the runs in the worksheet. 

Dialog box items 
Randomize entire design: Choose to randomize all the runs in the design. 
Randomize just block: Choose to randomize the just the runs from a single block, then choose a block number from the 
list. 
Base for random data generator: Enter a base for the random data generator. By entering a base for the random data 
generator, you can control the randomization so that you obtain the same pattern every time. 

Note If you use the same base on different computer platforms or with different versions of Minitab, you may not get 
the same random number sequence. 

 

To randomize the design 
1    Choose Stat > DOE > Modify Design. 
2    Choose Randomize design and click Specify. 
3    Do one of the following: 

•    Choose Randomize entire design. 
•    Choose Randomize just block, and choose a block number from the list. (Mixture designs are not usually 

blocked.) 
4    If you like, in Base for random data generator, enter a number. Click OK. 

More You can use Stat > DOE > Display Design to switch back and forth between a random and standard order 
display in the worksheet. 

 

Renumbering the design 
You can renumber the design. Minitab will renumber the RunOrder column based on the order of design points in the 
worksheet. This is especially useful if you have selected an optimal design and you would like to renumber the design to 
determine an order in which to perform the experiment. 
 

To renumber the design 
1    Choose Stat > DOE > Modify Design. 
2    Choose Renumber design and click OK. 
 



Design of Experiments 

  Copyright © 2003–2005 Minitab Inc.  All rights reserved. 192 

Display Design 
Display Design 
Stat > DOE > Display Design  
After you create a design, you can use Display Design to change the way the design points are stored in the worksheet. 
You can change the design points in two ways: 

•    display the points in either random and standard order. Run order is the order of the runs if the experiment was done 
in random order. 

•    express the components in amounts, proportions, or pseudocomponents. 

•    express process variables in coded or uncoded units. 

Dialog box items 
How to display the points in the worksheet  
Order for all points in the worksheet: Minitab sorts the worksheet columns according to the display method (random 
order or standard order) you select. By default, Minitab sorts a column if the number of rows is less than or equal to the 
number of rows in the design. Specify any columns that you do not want to reorder in the Columns Not to Reorder dialog 
box. Columns that have more rows than the design cannot be reordered. 

Run order for design: Choose to display points in run order. 
Standard order for design: Choose to display points in standard order. 

Units for components You can specify one of three scales to represent the design: amounts, proportions, or 
pseudocomponents. Amounts are what you actually measure. By default, Minitab uses amounts to print and store your 
data. See Specifying the units for components for more information. 

Amount: Choose to display design points in the worksheet as amounts. 
Proportions: Choose to display design points in the worksheet as proportions. 
Pseudocomponents: Choose to display design points in the worksheet as pseudocomponents. 

Units for process variables  

Coded: Choose to perform the analysis using the default coding, −1 for the low level and +1 for the high level. 
Uncoded: Choose to perform the analysis using the values that you assigned in the Process Variables subdialog box.  

 

To change the display order of points in the worksheet 
1    Choose Stat > DOE > Display Design. 
2    Choose Run order for the design or Standard order for the design. If you do not randomize a design, the columns 

that contain the standard order and run order are the same. 
3    Do one of the following: 

•    If you want to reorder all worksheet columns that are the same length as the design columns, click OK. 
•    If you have worksheet columns that you do not want to reorder: 

1    Click Options. 

2    In Exclude the following columns when sorting, enter the columns. These columns cannot be part of the 
design. Click OK in each dialog box. 

 

Specifying the units for components 
If you did not change the total for the mixture from the default value of one, Minitab uses proportions to store your data. 
(This is equivalent to an amount total equal to one.) If you did change the total for the mixture, Minitab uses amounts − 
what you actually measure − to express your data. Depending on the mixture total and the presence of constraints, you 
may want to represent the design in another scale. 
You can choose one of three scales to represent the design: amounts, proportions, or pseudocomponents. With certain 
combinations of the mixture total and lower bound constraints, the various scalings are equivalent as shown in the 
following table: 
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Total mixture  Lower bound  Equivalent scales 

equal to 1 0 amounts 
proportions 
pseudocomponents 

equal to 1 greater than 0 amounts 
proportions 

not equal to 1 0 proportions 
pseudocomponents 

not equal to 1 greater than 0 none 

 

To change the units for the components 
1    Choose Stat > DOE > Display Design. 
2    Choose Amount, Proportions, or Pseudocomponents. Click OK. 
 

Pseudocomponents 
Constrained designs (those in which you specify lower or upper bounds) produce coefficients which are highly correlated.  

•    Lower bounds are necessary when any of the components must be present in the mixture. For example, lemonade 
must contain lemon juice. 

•    Upper bounds are necessary when the mixture cannot contain more than a given proportion of an ingredient. For 
example, a cake mix cannot contain more than 5% baking powder.  

Generally, you can reduce the correlations among the coefficients by transforming the components to 
pseudocomponents. For complete discussion, see [1] and [3]. 
Pseudocomponents, in effect, rescale the constrained data area so the minimum allowable amount (the lower bound) of 
each component is zero. This makes a constrained design in pseudocomponents the same as an unconstrained design in 
proportions. 
The table below shows two components expressed in amounts, proportions, and pseudocomponents. Suppose the total 
mixture is 50 ml. Let X1 and X2 be the amount scale. Thus X1 + X2 = 50. Suppose X1 has a lower bound of 20 (this 
means that the upper bound of X2 is 50 minus 20, or 30). Here are some points on the three scales: 

Amounts  Proportions  Pseudocomponents 

X1 X2  X1 X2  X1 X2  

50   0  1.0 0.0  1.0 0.0  
20 30  0.4 0.6  0.0 1.0  
35 15  0.7 0.3  0.5 0.5  

 

References - Mixture Designs      
[1]    J.A. Cornell (1990). Experiments With Mixtures: Designs, Models, and the Analysis of Mixture Data, John Wiley & 
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[3]    R.H Meyers and D.C. Montgomery (1995). Response Surface Methodology: Process and Product Optimization 

Using Designed Experiments, John Wiley & Sons. 
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Taguchi Designs 
Overview 
Taguchi Design Overview 
Dr. Genichi Taguchi is regarded as the foremost proponent of robust parameter design, which is an engineering method 
for product or process design that focuses on minimizing variation and/or sensitivity to noise. When used properly, 
Taguchi designs provide a powerful and efficient method for designing products that operate consistently and optimally 
over a variety of conditions. 
In robust parameter design, the primary goal is to find factor settings that minimize response variation, while adjusting (or 
keeping) the process on target. After you determine which factors affect variation, you can try to find settings for 
controllable factors that will either reduce the variation, make the product insensitive to changes in uncontrollable (noise) 
factors, or both. A process designed with this goal will produce more consistent output. A product designed with this goal 
will deliver more consistent performance regardless of the environment in which it is used. 
Engineering knowledge should guide the selection of factors and responses [3]. Robust parameter design is particularly 
suited for energy transfer processes; for example, a car's steering wheel is designed to transfer energy from the steering 
wheel to the wheels of the car. You should also scale control factors and responses so that interactions are unlikely. 
When interactions among control factors are likely or not well understood, you should choose a design that is capable of 
estimating those interactions. Minitab can help you select a Taguchi design that does not confound interactions of interest 
with each other or with main effects.  
Noise factors for the outer array should also be carefully selected and may require preliminary experimentation. The noise 
levels selected should reflect the range of conditions under which the response variable should remain robust. 
Robust parameter design uses Taguchi designs (orthogonal arrays), which allow you to analyze many factors with few 
runs. Taguchi designs are balanced, that is, no factor is weighted more or less in an experiment, thus allowing factors to 
be analyzed independently of each other.  
Minitab provides both static and dynamic response experiments. 

•    In a static response experiment, the quality characteristic of interest has a fixed level.  

•    In a dynamic response experiment, the quality characteristic operates over a range of values and the goal is to 
improve the relationship between an input signal and an output response. 

An example of a dynamic response experiment is an automotive acceleration experiment where the input signal is the 
amount of pressure on the gas pedal and the output response is vehicle speed. You can create a dynamic response 
experiment by adding a signal factor to a design − see Creating a dynamic response experiment.  
The goal of robust experimentation is to find an optimal combination of control factor settings that achieve robustness 
against (insensitivity to) noise factors. Minitab calculates response tables, linear model results, and generates main 
effects and interaction plots for: 

•    signal-to-noise ratios (S/N ratios, which provide a measure of robustness) vs. the control factors 

•    means (static design) or slopes (dynamic design) vs. the control factors 

•    standard deviations vs. the control factors 

•    natural log of the standard deviations vs. the control factors 
Use the results and plots to determine what factors and interactions are important and evaluate how they affect 
responses. To get a complete understanding of factor effects it is advisable to evaluate S/N ratios, means (static design), 
slopes (dynamic design), and standard deviations. Make sure that you choose an S/N ratio that is appropriate for the type 
of data you have and your goal for optimizing the response − see Choosing a signal-to-noise ratio for static designs.  

Note  If you suspect curvature in your model, select a design − such as 3-level designs − that allows you to detect 
curvature in the response surface.  

 

What is a Taguchi design? 
A Taguchi design, or an orthogonal array, is a method of designing experiments that usually requires only a fraction of the 
full factorial combinations. An orthogonal array means the design is balanced so that factor levels are weighted equally. 
Because of this, each factor can be evaluated independently of all the other factors, so the effect of one factor does not 
influence the estimation of another factor. 
In robust parameter design, you first choose control factors and their levels and choose an orthogonal array appropriate 
for these control factors. The control factors comprise the inner array. At the same time, you determine a set of noise 
factors, along with an experimental design for this set of factors. The noise factors comprise the outer array. 
The experiment is carried out by running the complete set of noise factor settings at each combination of control factor 
settings (at each run). The response data from each run of the noise factors in the outer array are usually aligned in a row, 
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next to the factors settings for that run of the control factors in the inner array. For an example, see Data for Analyze 
Taguchi Design. 
Each column in the orthogonal array represents a specific factor with two or more levels. Each row represents a run; the 
cell values indicate the factor settings for the run. By default, Minitab's orthogonal array designs use the integers 1, 2, 3... 
to represent factor levels. If you enter factor levels, the integers 1, 2, 3, ..., will be the coded levels for the design. 

The following table displays the L8 (2∗∗7) Taguchi design (orthogonal array). L8 means 8 runs. 2∗∗7 means 7 factors with 
2 levels each. If the full factorial design were used, it would have 2∗∗7 = 128 runs. The L8 (2∗∗7) array requires only 8 
runs − a fraction of the full factorial design. This array is orthogonal; factor levels are weighted equally across the entire 
design. The table columns represent the control factors, the table rows represent the runs (combination of factor levels), 
and each table cell represents the factor level for that run.  

L8 (2∗∗7) Taguchi Design 
 A  B C D E F G 

1 1  1 1 1 1 1 1 

2 1  1 1 2 2 2 2 
         

3 1  2 2 1 1 2 2 

4 1  2 2 2 2 1 1 

         

5 2  1 2 1 2 1 2 

6 2  1 2 2 1 2 1 

         

7 2  2 1 1 2 2 1 

8 2  2 1 2 1 1 2 

In the above example, levels 1 and 2 occur 4 times in each factor in the array. If you compare the levels in factor A with 
the levels in factor B, you will see that B1 and B2 each occur 2 times in conjunction with A1 and 2 times in conjunction 
with A2. Each pair of factors is balanced in this manner, allowing factors to be evaluated independently. 
Orthogonal array designs focus primarily on main effects. Some of the arrays offered in Minitab's catalog permit a few 
selected interactions to be studied. See Estimating selected interactions. 
You can also add a signal factor to the Taguchi design in order to create a dynamic response experiment. A dynamic 
response experiment is used to improve the functional relationship between an input signal and an output response. See 
Creating a dynamic response experiment. 
 

Choosing a Taguchi Design 
Before you use Minitab, you need to determine which Taguchi design is most appropriate for your experiment. In Taguchi 
designs, responses are measured at selected combinations of the control factor levels. Each combination of control factor 
levels is called a run and each measure an observation. The Taguchi design provides the specifications for each 
experimental test run. 
A Taguchi design, also known as an orthogonal array, is a fractional factorial matrix that ensures a balanced comparison 
of levels of any factor. In a Taguchi design analysis, each factor can be evaluated independently of all other factors. 
When choosing a design you need to 

•    identify the number of control factors that are of interest 

•    identify the number of levels for each factor 

•    determine the number of runs you can perform 

•    determine the impact of other considerations (such as cost, time, or facility availability) on your choice of design 
 

Taguchi design experiments in Minitab 
Performing a Taguchi design experiment may consist of the following steps: 
1    Before you begin using Minitab, you need to complete all pre-experimental planning. For example, you need to 

choose control factors for the inner array and noise factors for the outer array. Control factors are factors you can 
control to optimize the process. Noise factors are factors that can influence the performance of a system but are not 
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under control during the intended use of the product. Note that while you cannot control noise factors during the 
process or product use, you need to be able to control noise factors for experimentation purposes. 

2    Use Create Taguchi Design to generate a Taguchi design (orthogonal array). 
Or, use Define Custom Taguchi Design to create a design from data that you already have in the worksheet. Define 
Custom Taguchi Design allows you to specify which columns are your factors and signal factors. You can then easily 
analyze the design and generate plots.  

3    After you create the design, you may use Modify Design to rename the factors, change the factor levels, add a signal 
factor to a static design, ignore an existing signal factor (treat the design as static), and add new levels to an existing 
signal factor.  

4    After you create the design, you may use Display Design to change the units (coded or uncoded) in which Minitab 
expresses the factors in the worksheet.  

5    Perform the experiment and collect the response data. Then, enter the data in your Minitab worksheet. See Collecting 
and Entering Data. 

6    Use Analyze Taguchi Design to analyze the experimental data. See Analyzing Taguchi Designs. 
7    Use Predict Results to predict S/N ratios and response characteristics for selected new factor settings. See Predicting 

Results. 
 

Two-step optimization 
Two-step optimization, an important part of robust parameter design, involves first reducing variation and then adjusting 
the mean on target. Use two-step optimization when you are using either Nominal is Best signal-to-noise ratio. First, try to 
identify which factors have the greatest effect on variation and choose levels of these factors that minimize variation. 
Then, once you have reduced variation, the remaining factors are possible candidates for adjusting the mean on target 
(scaling factors). 
A scaling factor is a factor in which the mean and standard deviation are proportional. You can identify scaling factors by 
examining the response tables for each control factor. A scaling factor has a significant effect on the mean with a 
relatively small effect on signal-to-noise ratio. This indicates that the mean and standard deviation scale together. Thus, 
you can use the scaling factor to adjust the mean on target but not affect the S/N ratio. 
Use main effects plots to help you visualize the relative value of the effects of different factors. 
 

Collecting and Entering Data 
After you create your design, you need to perform the experiment and collect the response (measurement) data. To print 
a data collection form, follow the instructions below. After you collect the response data, enter the data in any worksheet 
column not used for the design. 

Printing a data collection form 
You can generate a data collection form in two ways. You can simply print the Data window contents, or you can use a 
macro. A macro can generate a "nicer" data collection form − see Help for more information. Although printing the Data 
window will not produce the prettiest form, it is the easiest method. Just follow these steps: 
1    When you create your experimental design, Minitab stores the factor settings in the worksheet. These columns 

constitute the basis of your data collection form. If you did not name factors or specify factor levels when you created 
the design and you want names or levels to appear on the form, see Modify Design. 

2    In the worksheet, name the columns in which you will enter the measurement data obtained when you perform your 
experiment. 

3    Choose File > Print Worksheet. Make sure Print Grid Lines is checked, then click OK. 

Note You can also copy the worksheet cells to the Clipboard by choosing Edit > Copy cells. Then paste the 
clipboard contents into a word-processing application, such as Microsoft Word, where you can create your own 
form. 

 

Create Taguchi Design 
Taguchi Design 
Stat > DOE > Taguchi > Create Taguchi Design 
Generates 2-level, 3-level, 4-level, 5-level, and mixed-level Taguchi designs. 

Dialog box items 
Type of Design:  

2-Level Design: Choose to create a 2-level design. 
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3-Level Design: Choose to create a 3-level design. 
4-Level Design: Choose to create a 4-level design. 
5-Level Design: Choose to create a 5-level design. 
Mixed Level Design: Choose to create a mixed-level design. 

Number of Factors: Specify the number of factors in the design you want to generate. 
 

To create a Taguchi Design 
1    Choose Stat > DOE > Taguchi > Create Taguchi Design.  
2    If you want to see a summary of the Taguchi designs available, click Display Available Designs. Click OK.  
3    Under Type of Design, choose a design. 
4    From Number of factors, choose a number. The choices available will vary depending on what design you have 

chosen. 
5    Click Designs.  
6    In the Designs box, highlight the design you want to create. If you like, use any options. 
7    Click OK even if you do not change any options. This selects the design and brings you back to the main dialog box. 
8    If you like, click Factors or Options to use any of the available dialog box options, then click OK in each dialog box to 

create your design. 
 

Taguchi Design − Display Available Designs 
Stat > DOE > Taguchi > Create Taguchi Design > Display Available Designs 
Displays a table to help you select an appropriate design, based on 

•    the number of factors that are of interest, and 

•    the number of runs you can perform. 
This dialog box does not take any input. 
 

Single-level designs 
The table below summarizes the single-level Taguchi designs available. The number following the "L" indicates the 
number of runs in the design. For example, the L4 (2∗∗3) design has four runs. The numbers in the table indicate the 
minimum and maximum number of available factors for each design. For example, an L8 (2∗∗7) design can have from two 
to seven factors with two levels each; an L16 (4∗∗5) design can have from two to five factors with four levels each.  

 Number of levels 

Designs 2 3 4 5 
L4 (2∗∗3) 2-3    

L8 (2∗∗7) 2-7    

L9 (3∗∗4)  2-4   

L12 (2∗∗11) 2-11    

L16 (2∗∗15) 2-15    

L16 (4∗∗5)   2-5  

L25 (5∗∗6)    2-6 

L27 (3∗∗13)  2-13   

L32 (2∗∗31) 2-31    

 

Mixed 2-3 level designs 
The table below summarizes the available Taguchi designs for mixed designs in which factors have 2 or 3 levels. The 
number in the table cells indicate the minimum and maximum number of factors available for each level. For example, an 
L18 (2∗∗1 3∗∗7) design can have one factor with two levels and from one to seven factors with three levels.  
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 Number of levels 

Designs 2 3 
L18 (2∗∗1 3∗∗7) 1 1-7 

L36 (2∗∗11 3∗∗12) 1-11 2-12 

L36 (2∗∗3 3∗∗13) 1-3 13 

L54 (2∗∗1 3∗∗25) 1 3-25 

 

Mixed 2-4 level designs 
The table below summarizes the available Taguchi designs for mixed designs in which factors have 2 or 4 levels. The 
number in the table cells indicate the minimum and maximum number of factors available for each level. For example, an 
L8 (2∗∗4 4∗∗1) design can have from one to four factors with two levels and one factor with four levels. 

 Number of levels 

Designs 2 4 
L8 (2∗∗4 4∗∗1) 1-4 1 

L16 (2∗∗12 4∗∗1) 2-12 1 

L16 (2∗∗9 4∗∗2) 1-9 2 

L16 (2∗∗6 4∗∗3) 1-6 3 

L16 (2∗∗3 4∗∗4) 1-3 4 

L32 (2∗∗1 4∗∗9) 1 2-9 

 

Mixed 2-8 level designs 
The table below show the available Taguchi design for mixed designs in which factors have 2 and 8 levels. The number in 
the table cells indicate the minimum and maximum number of factors available for each level. An L16 (2∗∗8 8∗∗1) design 
can have from one to eight factors with two levels and one factor with eight levels. 

 Number of levels 

Design 2 8 
L16 (2∗∗8 8∗∗1) 1-8 1 

 

Mixed 3-6 level designs 
The table below shows the available Taguchi design for mixed designs in which factors have 3 and 6 levels. The number 
in the table cells indicate the minimum and maximum number of factors available for each level. An L18 (3∗∗6 6∗∗1) 
design can have from one to six factors with three levels and one factor with six levels.  

 Number of levels 

Design 3 level 6 level 
L18 (3∗∗6 6∗∗1) 1-6 1 

 

Taguchi Design − Designs 
Stat > DOE > Taguchi > Create Taguchi Design > Designs 
Allows you to select a Taguchi design. The designs available depend on your choices in DOE > Taguchi > Create 
Taguchi Design. You can also choose to add a signal factor to create a dynamic response experiment. 

Dialog box items 
Add a signal factor for dynamic characteristics: Check to add a signal factor to the Taguchi design to create a 
dynamic response experiment. A dynamic response experiment is used to improve the functional relationship between an 
input signal and an output response. 
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Taguchi Design − Factors (Static Design) 
Stat > DOE > Taguchi > Create Taguchi Design > Factors 
Allows you to name or rename the factors and assign values for factor settings. You can assign factors to array columns 
yourself. Or, you can ask Minitab to assign factors to array columns to allow for the estimation of interactions you select. 

Dialog box items 
Assign Factors:  

To columns of the array as specified below: Choose this option to assign factors to columns of the orthogonal array. 
Assigning factors to columns of the array does not change how the design appears in the worksheet. For example, if 
you assigned Factor A to Column 3 of the array and Factor B to Column 2 of the array, Factor A would still appear in 
Column 1 in the worksheet and Factor B would still appear in Column 2 in the worksheet. 
To allow estimation of selected interactions: Choose this option to have Minitab automatically assign factors to 
array columns in order to allow the estimation of selected interactions. 

Factor: Shows the number of factors that you have chosen for your design. This column does not take any input. 
Name: Enter text to change the name of the factors. By default, Minitab names the factors alphabetically. 
Level Values: Enter numeric or text values for each level of the factor. By default, Minitab sets the levels of a factor to the 
integers 1, 2, 3, ...  
Column: Enter the column of the array that you want to assign the factor to. 
Levels: Shows the number of levels for each factor. This column does not take any input.  
 

Taguchi Design − Factors (Dynamic Design) 
Stat > DOE > Taguchi > Create Taguchi Design > Factors 
Allows you to name or rename the factors and assign values for factor settings. Allows you to name or rename the signal 
factor and assign values for the signal factor setting. You can assign factors to array columns yourself. Or, you can ask 
Minitab to assign factors to array columns to allow for the estimation of interactions you select. 

Dialog box items 
Assign Factors:  

To columns of the array as specified below: Choose to assign factors to columns of the orthogonal array. Assigning 
factors to columns of the array does not change how the design appears in the worksheet. For example, if you 
assigned Factor A to Column 3 of the array and Factor B to Column 2 of the array, Factor A would still appear in 
Column 1 in the worksheet and Factor B would still appear in Column 2 in the worksheet. 
To allow estimation of selected Interactions: Choose to have Minitab automatically assign factors to array columns 
in order to allow the estimation of selected interactions. 

Factor: Shows the number of factors that you have chosen for your design. This column does not take any input. 
Name: Enter text to change the name of the factors. By default, Minitab names the factors alphabetically. 
Level Values: Enter numeric or text values for each level of the factor. By default, Minitab sets the levels of a factor to the 
integers 1, 2, 3, ...  
Column: Enter the column of the array that you want to assign the factor to. 
Levels: Shows the number of levels for each factor. This column does not take any input.  
Signal Factor:  

Name: Enter text to change the name of the signal factor. By default, Minitab names it "Signal." 
Level Values: Enter numeric values for each level of the factor. 

 

To assign factors to columns of the array 
1    Choose Stat > DOE > Taguchi > Create Taguchi Design > Factors.  
2    Under Assign Factors, choose To columns of the array as specified below. 
3    In the factor table, click under Column in the cell that corresponds to the factor that you want to assign. From the 

drop-down list, choose the array column to which you want to assign the factor. Then, use the down arrow to move 
down the table and assign the factors to the remaining array columns. 

4    Click OK. 
 

To name factors 
1    Choose Stat > DOE > Taguchi > Create Taguchi Designs > Factors. 
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2    Under Name in the factor table, click in the first row and type the name of the first factor. Then, use the down arrow to 
move down the column and enter the remaining factor names. 

3    Click OK. 

Note    After you have create the design, you can change the factor names by typing new names in the Data window, or 
with Stat > DOE > Modify Design > Taguchi. 

Note  After you have create the design, you can change the factor names by typing new names in the Data window, 
or with Stat > DOE > Modify Design > Taguchi. 

 

Setting factor levels 
By default, Minitab sets the levels of a factor to the integers 1, 2, 3, .... You may change these to other numbers, such as 
the actual values of the factor level, or to text levels.  
One useful technique for customizing Taguchi designs (orthogonal arrays) is the use of "dummy treatments." You can 
create a dummy treatment in Minitab by repeating levels for the same factor, as long as there are at least two distinct 
levels.  
 

To set factor levels 
1    Choose Stat > DOE > Taguchi > Create Taguchi Designs > Factors. 
2    Under Level Values in the factor table, click in the first row and type the levels of the first factor. Then, use the down 

arrow to move down the column and enter the remaining levels. Click OK. 
 

Creating dummy treatments 
One useful technique for customizing Taguchi designs (orthogonal arrays) is the use of "dummy treatments." You can 
create a dummy treatment in Minitab by repeating levels for a factor, as long as there are at least two distinct levels. 

For example, if you wanted to use an L9 (3∗∗4) array, which has four three-level factors, but had one factor with only two 
levels, you could use a dummy treatment to accommodate this. Here, the L9 (3∗∗4) array is shown, both without and with 
a dummy treatment. In the dummy example, the factor levels for factor A are 1 2 1, where 1 is the repeated level for the 
dummy treatment. 

L9 (3∗∗4) array  L9 (3∗∗4) array (dummy) 

Run A B C D  Run A B C D 
1 1 1 1 1  1 1 1 1 1 
2 1 2 2 2  2 1 2 2 2 
3 1 3 3 3  3 1 3 3 3 
4 2 1 2 3  4 2 1 2 3 
5 2 2 3 1  5 2 2 3 1 
6 2 3 1 2  6 2 3 1 2 
7 3 1 3 2  7 1' 1 3 2 
8 3 2 1 3  8 1' 2 1 3 
9 3 3 2 1  9 1' 3 2 1 

In the L9 (3∗∗4) orthogonal array with dummy treatment above, factor A has repeated level 1, in place of level 3. This 
results in an L9 (3∗∗4) array with one factor at 2 levels and three factors at 3 levels. The array is still orthogonal, although 
it is not balanced. 
When choosing which factor level to use as the dummy treatment, you may want to consider the amount of information 
about the factor level and the availability of experimental resources. For example, if you know more about level 1 than 
level 2, you may want to choose level 2 as your dummy treatment. Similarly, if level 2 is more expensive than level 1, 
requiring more resources or time to test, you may want to choose level 1 as your dummy treatment. 
 

Taguchi Design − Factors − Interactions 
Stat > DOE > Taguchi > Create Taguchi Design > Factors > Interactions 
Allows you to select interactions that you want to be able to estimate using the Taguchi design you are creating. When 
you select interactions, Minitab will then try to assign factors to array columns so that the selected interactions can be 
estimated. 
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Dialog box items 
Available Terms: Shows all the interactions terms that are available but not selected. 
Selected Terms: Minitab tries to assign factors to the array columns to allow for the estimation of the interactions listed 
under Selected Terms.  
Factors: Lists the factors and their assigned names. This box does not take any input. 
 

To select interactions 
1    Choose Stat > DOE > Taguchi > Create Taguchi Design > Factors. 
2    Under Assign Factors, choose To allow estimation of selected interactions and then click Interactions. 
3    Move the interactions that you want to include in the design from Available Terms to Selected Terms using the arrow 

buttons 

•    to move the interactions one at a time, highlight an interaction, then click  or   

•    to move all of the interactions, click on  or   
You can also move an interaction by double-clicking it. 

4    Click OK. 
 

Interaction Tables 
Interaction table for the L8 (2∗∗7) array : 
 1 2 3 4 5 6 7 

1  3 2 5 4 7 6 

2   1 6 7 4 5 

3    7 6 5 4 

4     1 2 3 

5      3 2 

6       1 

Interaction table for the L16(2**15) array : 
 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

1  3 2 5 4 7 6 9 8 11 10 13 12 15 14 

2   1 6 7 4 5 10 11 8 9 14 15 12 13 

3    7 6 5 4 11 10 9 8 15 14 13 12 

4     1 2 3 12 13 14 15 8 9 10 11 

5      3 2 13 12 15 14 9 8 11 10 

6       1 14 15 12 13 10 11 8 9 

7        15 14 13 12 11 10 9 8 

8         1 2 3 4 5 6 7 

9          3 2 5 4 7 6 

10           1 6 7 4 5 

11            7 6 5 4 

12             1 2 3 

13              3 2 

14               1 
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Interaction table for the L27(3**13) array : 
 1 2 3 4 5 6 7 8 9 10 11 12 13 

1  3 2 2 6 5 5 9 8 8 12 11 11 

  4 4 3 7 7 6 10 10 9 13 13 12 

2   1 1 8 9 10 5 6 7 5 6 7 

   4 3 11 12 13 11 12 13 8 9 10 

3    1 9 10 8 7 5 6 6 7 5 

    2 13 11 12 12 13 11 10 8 9 

4     10 8 9 6 7 5 7 5 6 

     12 13 11 13 11 12 9 10 8 

5      1 1 2 3 4 2 4 3 

      7 6 11 13 12 8 10 9 

6       1 4 2 3 3 2 4 

       5 13 12 11 10 9 8 

7        3 4 2 4 3 2 

        12 11 13 9 8 10 

8         1 1 2 3 4 

         10 9 5 7 6 

9          1 4 2 3 

          8 7 6 5 

10           3 4 2 

           6 5 7 

11            1 1 

            13 12 

12             1 

             11 

Interaction table for the L32(2**31) array : 
 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 13 

1  3 2 5 4 7 6 9 8 11 10 13 12 15 14 17 

2   1 6 7 4 5 10 11 8 9 14 15 12 13 18 

3    7 6 5 4 11 10 9 8 15 14 13 12 19 

4     1 2 3 12 13 14 15 8 9 10 11 20 

5      3 2 13 12 15 14 9 8 11 10 21 

6       1 14 15 12 13 10 11 8 9 22 

7        15 14 13 12 11 10 9 8 23 

8         1 2 3 4 5 6 7 24 

9          3 2 5 4 7 6 25 

10           1 3 7 4 5 26 

11            7 6 5 4 27 

12             1 2 3 28 

13              3 2 29 

14               1 30 

15                31 
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Interaction table for the L32(2**31) array : Continued 
 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 

1 16 19 18 21 20 23 22 25 24 27 26 29 28 31 30 

2 19 16 17 22 23 20 21 26 27 24 25 30 31 28 29 

3 18 17 16 23 22 21 20 27 26 25 24 31 30 29 28 

4 21 22 23 16 17 18 19 28 29 30 31 24 25 26 27 

5 20 23 22 17 16 19 18 29 28 31 30 25 24 27 26 

6 23 20 21 18 19 16 17 30 31 28 29 26 27 24 25 

7 22 21 20 19 18 17 16 31 30 29 28 27 26 25 24 

8 25 26 27 28 29 30 31 16 17 18 19 20 21 22 23 

9 24 27 26 29 28 31 30 17 16 19 18 21 20 23 22 

10 27 24 25 30 31 28 29 18 19 16 17 22 23 20 21 

11 26 25 24 31 30 29 28 19 18 17 16 23 22 21 20 

12 29 30 31 24 25 26 27 20 21 22 23 16 17 18 19 

13 28 31 30 25 24 27 26 21 20 23 22 17 16 19 18 

14 31 28 29 26 27 24 25 22 23 20 21 18 19 16 17 

15 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16 

16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

17  3 2 5 4 7 6 9 8 11 10 13 12 15 14 

18   1 6 7 4 5 10 11 8 9 14 15 12 13 

19    7 6 5 4 11 10 9 8 15 14 13 12 

20     1 2 3 12 13 14 15 8 9 10 11 

21      3 2 13 12 15 14 9 8 11 10 

22       1 14 15 12 13 10 11 8 9 

23        15 14 13 12 11 10 9 8 

24         1 2 3 4 5 6 7 

25          3 2 5 4 7 6 

26           1 6 7 4 5 

27            7 6 5 4 

28             1 2 3 

29              3 2 

30               1 

 

Estimating selected interactions 
Taguchi designs are primarily intended to study main effects of factors. Occasionally, you may want to study some of the 
two-way interactions. Some of the Taguchi designs (orthogonal arrays) allow the study of a limited number of two-way 
interactions. This usually requires that you leave some columns out of the array by not assigning factors to them. Some of 
the array columns are confounded with interactions between other array columns. Confounding means that the factor 
effect is blended with the interaction effect, thus they cannot be evaluated separately. 
You can ask Minitab to automatically assign factors to array columns in a way that avoids confounding. Or, if you know 
exactly what design you want and know the columns of the full array that correspond to the design, you can assign factors 
to array columns yourself. Assigning factors to columns of the array does not change how the design appears in the 
worksheet. For example, if you assigned Factor A to Column 3 of the array and Factor B to Column 2 of the array, Factor 
A would still appear in Column 1 in the worksheet and Factor B would still appear in Column 2 in the worksheet. 
Interaction tables show confounded columns, which can help you to assign factors to array columns. For interaction tables 
for Minitab's catalog of Taguchi designs (orthogonal arrays), see Interaction tables. The interaction table for the L8 (2∗∗7) 
array is shown below. 



Taguchi Designs 

 Copyright © 2003–2005 Minitab Inc.  All rights reserved.  205

 1 2 3 4 5 6 7 

1  3 2 5 4 7 6 

2   1 6 7 4 5 

3    7 6 5 4 

4     1 2 3 

5      3 2 

6       1 

The columns and rows represent the column numbers of the Taguchi design (orthogonal array). Each table cell contains 
the interactions confounded for the two columns of the orthogonal array. 
For example, the entry in cell (1, 2) is 3. This means that the interaction between columns 1 and 2 is confounded with 
column 3. Thus, if you assigned factors A, B, and C to columns 1, 2, and 3, you could not study the AB interaction 
independently of factor C. If you suspect that there is a substantial interaction between A and B, you should not assign 
any factors to column 3. Similarly, the column 1 and 3 interaction is confounded with column 2, and the column 2 and 3 
interaction is confounded with column 1. 
 

Taguchi Design − Options 
Stat > DOE > Taguchi > Create Taguchi Design > Options 
Allows you to store the design in the worksheet. 

Dialog box items 
Store design in worksheet: Check to store the design in the worksheet. When you open this dialog box, the Store 
design in worksheet option is checked. If you want to see the properties of various designs before selecting the one 
design you want to store, you would uncheck this option. If you want to analyze a design, you must store it in the 
worksheet. 
 

To select a signal-to-noise ratio 
1    Choose Stat > DOE > Taguchi > Analyze Taguchi Design > Options. 
2    Under Signal-to-Noise Ratio, choose the S/N ratio that best fits the goals of the design. Choose from one of the 

following: 
•    Larger is better 
•    Nominal is best 
•    Nominal is best 
•    Smaller is better 

3    Click OK. 
 

Define Custom Taguchi Design 
Define Custom Taguchi Design 
Stat > DOE > Taguchi > Define Custom Taguchi Design  
Use Define Custom Taguchi Design to create a design from data you already have in the worksheet. For example, you 
may have a design you:  

•    created using Minitab session commands 

•    entered directly in the Data window 

•    imported from a data file 

•    created as another design type in Minitab 

•    created with earlier releases of Minitab 
You can also use Define Custom Taguchi Design to redefine a design that you created with Create Taguchi Design and 
then modified directly in the worksheet.  
Define Custom Taguchi Design allows you to specify which columns contain your factors and to include a signal factor. 
After you define your design, you can use Modify Design, Display Design, and Analyze Taguchi Design. 
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Dialog box items 
Factors: Enter the columns that contain the factor levels. 
Signal Factor  

No signal factor: Choose if there is no signal factor in your design. 
Specify by column: Enter the column that contains the signal factor. 

 

To define a custom Taguchi design 
1    Choose Stat > DOE > Taguchi > Define Custom Taguchi Design. 
2    In Factors, enter the columns that contain the factor levels. 
3    If you have a signal factor, choose Specify by column and enter the column that contains the signal factor levels. 

Click OK. 
 

Analyze Taguchi Design 
Analyze Taguchi Design 
Stat > DOE > Taguchi > Analyze Taguchi Design 
To use Analyze Taguchi Design, you must: 

•    Create and store the design using Create Taguchi Design, or create a design from data already in the worksheet using 
Define Custom Taguchi Design and 

•    Enter the response data in the worksheet  
Using Analyze Taguchi Design, you can: 

•    Generate main effects and interaction plots of the S/N ratios, means (static design), slopes (dynamic design), and 
standard deviations versus the control factors 

•    Display response tables and linear model results for S/N ratios, means (static design), slopes (dynamic design), and 
standard deviations 

The response tables, linear model results, and plots can help you determine which factors affect process variation and 
process location. 

Dialog box items 
Response data are in: Enter one or more columns containing the response data. 

Data − Analyze Taguchi Design 
Structure your data in the worksheet so that each row contains the control factors in the inner array and the response 
values from one complete run of the noise factors in the outer array. The maximum number of response columns you can 
enter is 50. The minimum number of response columns you can enter depends on your design. You can enter a single 
response column only if: 

•    Your design contains replicates.  

•    You measure more than one noise factor at each run and create your design so it has multiple runs at each 
combination of factor settings. You can then enter the noise factors in a single response column. (For more 
explanation, see the note below.) 

•    You are using the Larger is Better or Smaller is Better signal-to-noise ratio and you are not going to analyze or store 
the standard deviation. 

In all other cases, you must enter a minimum of 2 response columns.   
Here is an example: 

Time Pressure Catalyst Temperature Noise 1 Noise 2 
1 1 1 1 50 52 
1 1 1 2 44 51 
1 2 2 1 56 59 
1 2 2 2 65 77 
2 1 2 1 47 43 
2 1 2 2 42 51 
2 2 1 1 68 62 
2 2 1 2 51 38 
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This example, which is an L8 (2∗∗4), has four factors in the inner array (Time, Pressure, Catalyst, and Temperature). 
Recall, the inner array represents the control factors. There are two noise conditions in the outer array (Noise 1 and Noise 
2). There are two responses − one for each noise condition − in the outer array for each run in the inner array.  

Note As an alternative, you could have created an  L16 design, which generates 2 runs for each combination of 
factor settings. Then you would enter your reponse data for both noise conditions in a single response 
column. Since you would now have two rows with the same combination of factor settings, you would enter 
the response for Noise 1 in one of these rows and the response for Noise 2 in the other row. Minitab 
analyzes the data for these designs in exactly the same way.   

For dynamic designs, you must have a signal factor in your worksheet. See Adding a signal factor to an existing design. 
You can use Analyze Taguchi Design, which will prompt you to define your design, if you have a design and response 
data in your worksheet that was:  

•    Created using Minitab session commands 

•    Entered directly in the Data window  

•    Imported from a data file 

•    Created using another design type in Minitab 

•    Created with earlier releases in Minitab 
 

To fit a model 
1    Choose Stat > DOE > Taguchi > Analyze Taguchi Design. 
2    In Response data are in, enter the columns that contain the response data (noise factors). 
3    If you like, use any dialog box options, then click OK. 
 

Choosing a signal-to-noise ratio for static designs 
In static designs, you can select from four signal-to-noise (S/N) ratios, depending on the goal of your design. You should 
use your engineering knowledge, understanding of the process, and experience to choose the appropriate S/N ratio [2].  

Choose... S/N ratio formulas Use when the goal is to... And your data are... 
Larger is better S/N = −10∗log(Σ(1/Y2)/n) Maximize the response Positive 

Nominal is best S/N = −10∗log(σ2) Target the response and you want 
to base the S/N ratio on standard 
deviations only 

Positive, zero, or negative 

Nominal is best 
(default) 

S/N = 10∗log((Y2) / σ2) 
The adjusted formula is: 
S/N = 10∗log((Y2 − s2 / n )/ s2)   

Target the response and you want 
to base the S/N ratio on means 
and standard deviations 

Non-negative with an "absolute 
zero" in which the standard 
deviation is zero when the mean 
is zero 

Smaller is better S/N = −10∗log(Σ(Y2)/n)) Minimize the response Non-negative with a target value 
of zero 

Note  The Nominal is Best (default) S/N ratio is useful for analyzing or identifying scaling factors, which are 
factors in which the mean and standard deviation vary proportionally. Scaling factors can be used to 
adjust the mean on target without affecting S/N ratios. 

 

Analyze Taguchi Design − Graphs (Static Design) 
Stat > DOE > Taguchi > Analyze Taguchi Design > Graphs 
You can generate main effects plots and interaction plots. 

Dialog box items 
Generate plots of main effects and selected interactions in the model for  

Signal to Noise ratios: Check to display main effects and interactions plots for signal-to-noise ratios. 
Means: Check to display main effects and interaction plots for means. 
Standard deviations: Check to display main effects and interaction plots for standard deviations. 

Interaction plots 
Display interaction plot matrix: Check to display all the plots for the selected interactions in a matrix on a single 
page. 
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Use all factors that interact as rows and columns of the matrix or: To use all factors in the interaction plot 
matrix, do not specify factors for rows or columns below. 
Specify factors for rows: Choose factors to display on rows of interaction plot matrix.  
Specify factors for columns: Choose factors to display on columns of interaction plot matrix 

Display each interaction on a separate graph: Check to display the plots for the selected interactions on separate 
pages. 

 

Analyze Taguchi Design − Graphs (Dynamic Design) 
Stat > DOE > Taguchi > Analyze Taguchi Design > Graphs 
You can generate main effects plots and interaction plots. 

Dialog box items 
Generate plots of main effects and selected interactions in the model for  

Signal to Noise ratios: Check to display main effects and interactions plots for signal-to-noise ratios. 
Slopes: Check to display main effects and interaction plots for slopes. 
Standard deviations: Check to display main effects and interaction plots for standard deviations. 

Interaction plots 
Display interaction plot matrix: Check to display all the plots for the selected interactions in a matrix on a single 
page. 

Use all factors that interact as rows and columns of the matrix or: To use all factors in the interaction plot 
matrix, do not specify factors for row or columns below. 
Specify factors for rows: Choose factors to display on rows of interaction plot matrix.  
Specify factors for columns: Choose factors to display on columns of interaction plot matrix 

Display each interaction on a separate graph: Check to display the plots for the selected interactions on separate 
pages. 
Display scatterplots with fitted lines: Check to display scatterplots with fitted lines. 

 

To display main effects and interaction plots 
1    Choose Stat > DOE > Taguchi > Analyze Taguchi Design > Graphs.  
2    Under Generate plots of main effects and selected interactions for, check the statistics for which you want to 

generate plots.  
3    Under Interaction plots, do one of the following: 

•    Choose to display interactions in a matrix, then specify factors for rows and columns or leave blank to display all 
interactions. 

•    Choose to display each interaction on a separate page. 
4    Under Residuals for plots, choose the type of residual for which you want to generate plots. 
5    Under Residual Plots, do one of the following: 

•    Choose Individual plots to display one or more of the residual plots on separate pages. Then, check one or more 
of the residual plots. 

•    Choose Four in one to display a histogram of residuals, a normal plot of residuals, a plot of residuals versus fits, 
and a plot of residuals versus order on one page. 

6    Under Residual Plots, check Residuals versus variables to plot residuals versus selected variables, then enter one 
or more columns containing the variables you want to plot. Click OK. 

 

Analyze Taguchi Design − Analysis (Static Design) 
Stat > DOE > Taguchi > Analyze Taguchi Design > Analysis 
You can display response tables and linear model results for signal-to-noise ratios, means, and standard deviations. Use 
this analysis to help you identify: 

•    Factors that have the greatest effect on the response  

•    Factor levels that produce the desired result  
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Dialog box items 
Display response tables for 

Signal to Noise ratios: Check to display response tables for signal-to-noise ratios. 
Means: Check to display response tables for means. 
Standard deviations: Check to display response tables for standard deviations. 

Fit linear model for 
Signal to Noise ratios: Check to display linear model results for signal-to-noise ratios.   
Means: Check to display linear model results for means.   
Standard deviations: Check to display linear model results for standard deviations.   

Note If you choose to use the  loge-transformed standard deviations in the Options sub-dialog box and you check 
standard deviations under Display response tables for and Fit linear model for, Minitab will use the loge-
transformed standard deviation in the response tables and linear model. 

 

To display response tables and regression (static design) 
1    Choose Stat > DOE > Taguchi > Analyze Taguchi Design > Analysis.  
2    For each statistic (Signal to noise ratios, Means, and Standard deviations), do any of the following: 

•    Under Display response table for, check to display the response table. 
•    Under Fit linear model for, check to display results from the regression analysis.  

 

Analyze Taguchi Design − Analysis (Dynamic Design) 
Stat > DOE > Taguchi > Analyze Taguchi Design > Analysis 
You can display response tables and linear model results for signal-to-noise ratios, slopes, and standard deviations. Use 
this analysis to help you identify: 

•    Factors that have the greatest effect on the response  

•    Factor levels that produce the desired result  

Dialog box items 
Display response tables for 

Signal to Noise ratios: Check to display response tables for signal-to-noise ratios. 
Means: Check to display response tables for means. 
Standard deviations: Check to display response tables for standard deviations. 

Fit linear model for 
Signal to Noise ratios: Check to display linear model analysis for signal-to-noise ratios.   
Means: Check to display linear model analysis for means.   
Standard deviations: Check to display linear model analysis for standard deviations.   

Note If you choose to use the loge-transformed standard deviations in the Options sub-dialog box and you check 
standard deviations under Display response tables for and Fit linear model for, Minitab will use the loge-
transformed standard deviation in the response tables and linear model. 

 

To display response tables and regression results (dynamic design) 
1    Choose Stat > DOE > Taguchi > Analyze Taguchi Design > Analysis.  
2    For each statistic (Signal to Noise ratios, Slopes, and Standard deviations), do any of the following: 

•    Under Display response table for, check to display the response table. 
•    Under Fit linear model for, check to display results from the regression analysis.  

 

Analyze Taguchi Design − Terms 
Stat > DOE > Taguchi > Analyze Taguchi Design > Terms. 
You can specify which terms to include in the model. 
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Dialog box items 
Available Terms: Shows all terms that are estimable but not included in the fitted model.  
Selected Terms: Shows terms that Minitab includes when it fits the model. 
 

To select which terms to include 
1    Choose Stat > DOE > Taguchi > Analyze Taguchi Design > Terms.  
2    Move the terms that you want to include in the model from Available Terms to Selected Terms using the arrow 

buttons. 

•    To move the terms one at a time, highlight a term, then click  or . 

•    To move all terms, click on  or . 
You can also move a term by double-clicking it.  

 

Analyze Taguchi Design − Analysis Graphs (static design) 
Stat > DOE > Taguchi > Analyze Taguchi Design > Analysis Graphs 
You can generate residual plots based on the linear model results. 

Dialog box items 
Residuals for plots 

Regular: Check to use regular residuals in residual plots. 
Standardized: Check to use standardized residuals in residual plots. 
Deleted: Check to use deleted residuals in residual plots. 

Residuals Plots 
Individual plots: Choose to display one or more plots. 

Histogram: Check to display a histogram of the residuals. 
Normal plot: Check to display a normal probability plot of the residuals. 
Residuals versus fits: Check to plot residuals versus the fitted values. 
Residuals versus order: Check to plot residuals versus the order of the data. The row number for each data point is 
shown on the x-axis − for example, 1 2 3 4... n. 

Four in one: Choose to display a layout of a histogram of residuals, a normal plot of residuals, a plot of residuals 
versus fits, and a plot of residuals versus order. 
Residuals versus variables: Check to plot residuals versus selected variables, then enter one or more columns. 
Minitab displays a separate graph for each column.  

 

Analyze Taguchi Design − Analysis Graphs (dynamic design) 
Stat > DOE > Taguchi > Analyze Taguchi Design > Analysis Graphs 
You can generate residual plots based on the linear model results. 

Dialog box items 
Residuals for plots 

Regular: Check to use regular residuals in residual plots. 
Standardized: Check to use standardized residuals in residual plots. 
Deleted: Check to use deleted residuals in residual plots. 

Residuals Plots 
Individual plots: Choose to display one or more plots. 

Histogram: Check to display a histogram of the residuals. 
Normal plot: Check to display a normal probability plot of the residuals. 
Residuals versus fits: Check to plot residuals versus the fitted values. 
Residuals versus order: Check to plot residuals versus the order of the data. The row number for each data point is 
shown on the x-axis − for example, 1 2 3 4... n. 

Four in one: Choose to display a layout of a histogram of residuals, a normal plot of residuals, a plot of residuals 
versus fits, and a plot of residuals versus order. 
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Residuals versus variables: Check to plot residuals versus selected variables, then enter one or more columns. 
Minitab displays a separate graph for each column.  

 

To display residual plots 
1    Choose Stat > DOE > Taguchi > Analyze Taguchi Design > Analysis Graphs.  
2    Under Residuals for plots, choose the type of residual for which you want to generate plots. 
3    Under Residual Plots, do one of the following: 

•    Choose Individual plots to display one or more of the residual plots on separate pages. Then, check one or more 
of the residual plots. 

•    Choose Four in one to display a histogram of residuals, a normal plot of residuals, a plot of residuals versus fits, 
and a plot of residuals versus order on one page. 

4    Under Residual Plots, check Residuals versus variables to plot residuals versus selected variables, then enter one 
or more columns containing the variables you want to plot. Click OK. 

 

Analyze Taguchi Design − Options (Static Design) 
Stat > DOE > Taguchi > Analyze Taguchi Design > Options 
You to can choose the S/N ratio that best meets the objective of your static design. You can also use a loge 
transformation on the standard deviations to stabilize their variability.  

Dialog box items 
Signal to Noise Ratio:  

Larger is better: Choose when the goal is to maximize the response. 
Nominal is best: Choose when the goal is to target the response and you want to base the S/N ratio on standard 
deviations only. 
Nominal is best: Choose when the goal is to target the response and you want to base the S/N ratio on means and 
standard deviations (default). 
Smaller is better: Choose when the goal is to minimize the response. 

Use adjusted formula for nominal is best: Check to use the adjusted formula for the nominal is best (default) S/N ratio. 
Use ln(s) for all standard deviation output: Check to use the loge-transformed standard deviations as the response 
variable in the response tables, regression results, and on the main effects and interactions plots.  
 

Note  The Nominal is best (default) S/N ratio is good for analyzing or identifying scaling factors, which are factors in 
which the mean and standard deviation vary proportionally. Scaling factors can be used to adjust the mean on 
target without affecting S/N ratios. 

 

Analyze Taguchi Design − Options (Dynamic Design) 
Stat > DOE > Taguchi > Analyze Taguchi Design > Options 
You can specify a response reference value and signal value through which the regression line should pass. Or, you can 
choose to fit lines with no fixed reference point. 
Dynamic response experiments are used to improve the functional relationship between input signal and output response. 
The output response should be directly proportional to the input signal. The ideal functional relationship between input 
signal and output response is a line through the origin. 
In some cases, you may wish to choose a reference point, other than the origin, through which the line should pass. For 
example, your results may be generated far from zero, and by specifying a reference point in the range of results, you can 
enhance the sensitivity of the analysis. You can also choose to fit the line with no fixed reference point. In this case, the 
intercept will be fitted to the data. 

Dialog box items 
Dynamic signal-to-noise ratio 

Fit all lines through a reference point:  
Response reference value: Enter a numeric value corresponding to the desired output (response) value. 
Signal reference value: Enter a signal factor level corresponding to the response reference value. 

Fit each line through the average response at: 
Signal reference value: Enter a signal factor level at which to calculate the average response for each line.  
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Fit lines with no reference point: Choose to fit the regression line with no fixed reference point. In this case, the line 
will pass through the origin. 
Use adjusted formula for signal to noise: Check to use the adjusted formula for the signal-to-noise ratio. 
Use ln(s) for all standard deviation output: Check to use the loge-transformed standard deviations as the response 
variable in the response tables, regression/ANOVA results, and on the main effects and interactions plots.  

 

To specify a reference point for the response 
1    Choose Stat > DOE > Taguchi > Analyze Taguchi Design. 

2    Click Options. 
3    In Response reference value, enter a numeric value corresponding to the desired output (response) value. 
4    In Signal reference value, enter a signal factor level corresponding to the response reference value. Click OK. 
 

To fit a line with no fixed reference point 
1    Choose Stat > DOE > Taguchi > Analyze Taguchi Design. 
2    Click Options. 
3    Choose Fit lines with no fixed reference point. Click OK. 
 

Analyze Taguchi Design − Storage (Static Design) 
Stat > DOE > Taguchi > Analyze Taguchi Design > Storage. 
Use to store your choice of statistics in the worksheet.  

Dialog box items 
Store the following items  

Signal to Noise ratios: Choose to store signal-to-noise ratios in the worksheet. 
Means: Choose to store means in the worksheet. 
Standard deviations: Choose to store standard deviations in the worksheet. 
Coefficients of variation: Choose to store coefficients of variation in the worksheet. 
Natural log of standard deviations: Choose to store the natural log of standard deviations in the worksheet. 
Fits and Residuals Minitab stores one column for each statistic you fit with a linear model.  

Fits: Check to store the fitted values.  
Residuals: Check to store the residuals.  
Standardized residuals: Check to store the standardized residuals.  
Deleted residuals: Check to store the Studentized residuals.  

Model information Minitab stores information for each statistic you fit with a linear model. 
Coefficients: Check to store the coefficients.  
Design matrix: Check to store the design matrix corresponding to your model.  

Other diagnostics Minitab stores one column for each statistic you fit with a linear model. 
Hi (leverage): Check to store leverages. 
Cook's distance: Check to store Cook's distance. 
DFITS: Check to store DFITS. 

 

Analyze Taguchi Design − Storage (Dynamic Design) 
Stat > DOE > Taguchi > Analyze Taguchi Design > Storage 
Use to store your choice of statistics in the worksheet.  

Dialog box items 
Store the following items  

Signal to Noise ratios: Choose to store signal-to-noise ratios in the worksheet. 
Slopes: Choose to store slopes in the worksheet. 
Intercepts: Choose to store intercepts in the worksheet. 
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Standard deviations (square root of MSE): Choose to store standard deviations in the worksheet. 
Natural log of standard deviations: Choose to store the natural log of standard deviations in the worksheet. 
Fits and Residuals Minitab stores one column for each statistic for which you fit a linear model.  

Fits: Check to store the fitted values. 
Residuals: Check to store the residuals. 
Standardized residuals: Check to store the standardized residuals. 
Deleted residuals: Check to store the Studentized residuals. 

Model information Minitab stores information for each statistic for which you fit a linear model. 
Coefficients: Check to store the coefficients. 
Design matrix: Check to store the design matrix corresponding to your model.  

Other diagnostics Minitab stores information for each statistic for which you fit a linear model. 
Hi (leverage): Check to store leverages. 
Cook's distance: Check to store Cook's distance. 
DFITS: Check to store DFITS. 

 

Example of a static Taguchi design 
You manufacture golf balls and are working on a new design to maximize ball flight distance. You have identified four 
control factors, each with two levels: 

•    Core material (liquid vs. tungsten) 

•    Core diameter (118 vs. 156) 

•    Number of dimples (392 vs. 422) 

•    Cover thickness (.03 vs. .06) 
You also want to test the interaction between core material and core diameter.    
The response is ball flight distance in feet. The noise factor is two types of golf clubs: driver and a 5-iron. You measure 
distance for each club type, resulting in two noise factor columns in the worksheet. Because your goal is to maximize flight 
distance, you select the larger-is-better signal-to-noise (S/N) ratio.  
1    Open the worksheet GOLFBALL.MTW. The design and response data have been saved for you. 
2    Choose Stat > DOE > Taguchi > Analyze Taguchi Design. 
3    In Response data are in, enter Driver and Iron. 
4    Click Analysis. 
5    Under Fit linear model for, check Signal-to-noise ratios and Means. Click OK. 
6    Click Terms.  
7    Move the term AB to Selected Terms by using the arrow keys or double-clicking it. Click OK. 
8    Click Options.  
9    Under Signal to Noise Ratio, choose Larger is better. Click OK in each dialog box. 

Session window output  

Taguchi Analysis: Driver, Iron versus Material, Diameter, Dimples, Thickness 
 
 
Linear Model Analysis: SN ratios versus Material, Diameter, Dimples, Thickness 
 
 
Estimated Model Coefficients for SN ratios 
 
Term                            Coef  SE Coef       T      P 
Constant                      38.181   0.4523  84.418  0.000 
Material Liquid                3.436   0.4523   7.596  0.017 
Diameter 118                   3.967   0.4523   8.772  0.013 
Dimples 392                    2.982   0.4523   6.593  0.022 
Thicknes 0.03                 -3.479   0.4523  -7.692  0.016 
Material*Diameter Liquid 118   1.640   0.4523   3.625  0.068 
 
S = 1.279   R-Sq = 99.2%   R-Sq(adj) = 97.2% 
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Analysis of Variance for SN ratios 
 
Source             DF   Seq SS   Adj SS   Adj MS      F      P 
Material            1   94.427   94.427   94.427  57.70  0.017 
Diameter            1  125.917  125.917  125.917  76.94  0.013 
Dimples             1   71.133   71.133   71.133  43.47  0.022 
Thickness           1   96.828   96.828   96.828  59.17  0.016 
Material*Diameter   1   21.504   21.504   21.504  13.14  0.068 
Residual Error      2    3.273    3.273    1.637 
Total               7  413.083 
 
 
 
 
Linear Model Analysis: Means versus Material, Diameter, Dimples, Thickness 
 
 
Estimated Model Coefficients for Means 
 
Term                            Coef  SE Coef       T      P 
Constant                      110.40    8.098  13.634  0.005 
Material Liquid                36.86    8.098   4.552  0.045 
Diameter 118                   51.30    8.098   6.335  0.024 
Dimples 392                    23.25    8.098   2.871  0.103 
Thicknes 0.03                 -22.84    8.098  -2.820  0.106 
Material*Diameter Liquid 118   31.61    8.098   3.904  0.060 
 
S = 22.90   R-Sq = 97.9%   R-Sq(adj) = 92.6% 
 
 
Analysis of Variance for Means 
 
Source             DF  Seq SS  Adj SS   Adj MS      F      P 
 
Material            1   10871   10871  10870.8  20.72  0.045 
Diameter            1   21054   21054  21053.5  40.13  0.024 
Dimples             1    4325    4325   4324.5   8.24  0.103 
Thickness           1    4172    4172   4172.4   7.95  0.106 
Material*Diameter   1    7995    7995   7994.8  15.24  0.060 
Residual Error      2    1049    1049    524.6 
Total               7   49465 
 
 
 
 
Response Table for Signal to Noise Ratios 
Larger is better 
 
Level  Material  Diameter  Dimples  Thickness 
1         41.62     42.15    41.16      34.70 
2         34.75     34.21    35.20      41.66 
Delta      6.87      7.93     5.96       6.96 
Rank          3         1        4          2 
 
 
Response Table for Means 
 
Level  Material  Diameter  Dimples  Thickness 
1        147.26    161.70   133.65      87.56 
2         73.54     59.10    87.15     133.24 
Delta     73.72    102.60    46.50      45.68 
Rank          2         1        3          4 
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Graph window output 

 

 
Interpreting the results  
Each linear model analysis provides the coefficients for each factor at the low level, their p-values and an analysis of 
variance table. Use the results to determine whether the factors are significantly related to the response data and each 
factor's relative importance in the model. 
The order of the coefficients by absolute value indicates the relative importance of each factor to the response; the factor 
with the biggest coefficient has the greatest impact. The sequential and adjusted sums of squares in the analysis of 
variance table also indicate the relative importance of each factor; the factor with the biggest sum of squares has the 
greatest impact. These results mirror the factor ranks in the response tables.  
In this example, you generated results for S/N ratios and means. For S/N ratios, all the factors and the interaction terms 
are significant at an α-level of 0.10. For means, core material (p=0.045), core diameter (p=0.024), and the interaction of 
material with diameter (p=0.06) are significant because their p-values are less than 0.10.  However, because both factors 
are involved in the interaction, you need to understand the interaction before you can consider the effect of each factor 
individually.  
The response tables show the average of each response characteristic (S/N ratios, means) for each level of each factor. 
The tables include ranks based on Delta statistics, which compare the relative magnitude of effects. The Delta statistic is 
the highest minus the lowest average for each factor. Minitab assigns ranks based on Delta values; rank 1 to the highest 
Delta value, rank 2 to the second highest, and so on. Use the level averages in the response tables to determine which 
level of each factor provides the best result.  
In this example, the ranks indicate that core diameter has the greatest influence on both the S/N ratio and the mean. For 
S/N ratio, cover thickness has the next greatest influence, followed by core material and dimples. For means, core 
material has the next greatest influence, followed by dimples and cover thickness. 
For this example, because your goal is to increase ball flight distance, you want factor levels that produce the highest 
mean. In Taguchi experiments, you always want to maximize the S/N ratio. The level averages in the response tables 
show that the S/N ratios and the means were maximized when the core was liquid, the core diameter was 118, there were 
392 dimples, and the cover thickness was .06. Examining the main effects plots and interaction plots confirms these 
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results. The interaction plot shows that, with the liquid core, the flight distance is maximized when the core diameter is 
118.    
Based on these results, you should set the factors at: 

Material Liquid 

Diameter 118 

Dimples 392 

Thickness .06 

Next, you may want to use Predict Results to see the predicted S/N ratios and means at these factor settings. See 
Example of predicting results.  
 

Example of a dynamic Taguchi design 
You are trying to increase the robustness of a measurement system. A measurement system is dynamic because as the 
input signal changes, the output response changes. Ideally, a measurement system should have a 1:1 correspondence 
between the value being measured (signal factor) and the measured response (system output). Similarly, zero should 
serve as the fixed reference point (all lines should be fit through the origin) because an input signal of zero should result in 
a measurement of zero. 
Your initial experiment included seven potential control factors but your results suggested that three factors, each with two 
levels, are most important: sensor, output device, and  relay. The signal factor is the actual value of the item being 
measured and the output response is the measurement. You have identified two noise conditions.  
1    Open the worksheet SENSOR.MTW. The design and response data have been saved for you. 
2    Choose Stat > DOE > Taguchi > Analyze Taguchi Design. 
3    In Response data are in, enter Noise1 and Noise2. 
4    Click Graphs. Under Generate plots of main effects and selected interactions for, check Standard deviations.  
5    Check Display scatterplots with fitted lines. Click OK. 
6    Click Analysis. Under Display response tables for and Fit linear model for, check Standard deviations. 
7    Click OK in each dialog box. 

Session window output 

Taguchi Analysis: Noise1, Noise2 versus Sensor, Output, Relay 
 
 
Linear Model Analysis: SN ratios versus Sensor, Output, Relay 
 
 
Estimated Model Coefficients for SN ratios 
 
Term         Coef  SE Coef       T      P 
Constant  20.6879   0.3017  68.560  0.000 
Sensor 1   2.0050   0.3017   6.645  0.003 
Output 1  -0.4724   0.3017  -1.566  0.192 
Relay 1   -0.5370   0.3017  -1.780  0.150 
 
S = 0.8535   R-Sq = 92.6%   R-Sq(adj) = 87.0% 
 
 
Analysis of Variance for SN ratios 
 
Source          DF  Seq SS  Adj SS   Adj MS      F      P 
Sensor           1  32.162  32.162  32.1616  44.15  0.003 
Output           1   1.785   1.785   1.7855   2.45  0.192 
Relay            1   2.307   2.307   2.3071   3.17  0.150 
Residual Error   4   2.914   2.914   0.7284 
Total            7  39.168 
 
 
 
 
Linear Model Analysis: Slopes versus Sensor, Output, Relay 
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Estimated Model Coefficients for Slopes 
 
Term          Coef   SE Coef         T      P 
Constant   1.00122  0.000125  8039.325  0.000 
Sensor 1  -0.00034  0.000125    -2.708  0.054 
Output 1   0.00004  0.000125     0.294  0.783 
Relay 1    0.00003  0.000125     0.274  0.798 
 
S = 0.0003523   R-Sq = 65.2%   R-Sq(adj) = 39.1% 
 
 
Analysis of Variance for Slopes 
 
Source          DF    Seq SS    Adj SS    Adj MS     F      P 
Sensor           1  0.000001  0.000001  0.000001  7.33  0.054 
Output           1  0.000000  0.000000  0.000000  0.09  0.783 
Relay            1  0.000000  0.000000  0.000000  0.07  0.798 
Residual Error   4  0.000000  0.000000  0.000000 
Total            7  0.000001 
 
 
 
 
 
Linear Model Analysis: Standard Deviations versus Sensor, Output, Relay 
 
 
Estimated Model Coefficients for Standard Deviations 
 
Term           Coef   SE Coef       T      P 
Constant   0.095414  0.002341  40.753  0.000 
Sensor 1  -0.021261  0.002341  -9.081  0.001 
Output 1   0.003906  0.002341   1.668  0.171 
Relay 1    0.005262  0.002341   2.247  0.088 
 
S = 0.006622   R-Sq = 95.8%   R-Sq(adj) = 92.6% 
 
 
Analysis of Variance for Standard Deviations 
 
Source          DF    Seq SS    Adj SS    Adj MS      F      P 
Sensor           1  0.003616  0.003616  0.003616  82.46  0.001 
Output           1  0.000122  0.000122  0.000122   2.78  0.171 
Relay            1  0.000221  0.000221  0.000221   5.05  0.088 
Residual Error   4  0.000175  0.000175  0.000044 
Total            7  0.004135 
 
 
 
 
Response Table for Signal to Noise Ratios 
Dynamic Response 
 
Level  Sensor  Output  Relay 
1       22.69   20.22  20.15 
2       18.68   21.16  21.22 
Delta    4.01    0.94   1.07 
Rank        1       3      2 
 
 
Response Table for Slopes 
 
Level  Sensor  Output  Relay 
1       1.001   1.001  1.001 
2       1.002   1.001  1.001 
Delta   0.001   0.000  0.000 
Rank        1       2      3 
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Response Table for Standard Deviations 
 
Level   Sensor   Output    Relay 
1      0.07415  0.09932  0.10068 
2      0.11668  0.09151  0.09015 
Delta  0.04252  0.00781  0.01052 
Rank         1        3        2 

Graph window output 
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Interpreting the results 
Each linear model analysis provides the coefficients for each factor at the low level, their p-values and an analysis of 
variance table. Use the results to determine whether the factors are significantly related to the response data and each 
factor's relative importance in the model. 
The order of the coefficients by absolute value indicates the relative importance of each factor to the response; the factor 
with the biggest coefficient has the greatest impact. The sequential and adjusted sums of squares in the analysis of 
variance table also indicate the relative importance of each factor; the factor with the biggest sum of squares has the 
greatest impact. These results mirror the factor ranks in the response tables.  

In this example, the p-values for the coefficients indicate that sensor is significant in all models at the 0.10 α-level and 
relay is significant only in the model with standard deviations at the 0.10 α-level. 
The response tables show the average of each response characteristic (S/N ratios, means) for each level of each factor. 
The tables include ranks based on Delta statistics, which compare the relative magnitude of effects. The Delta statistic is 
the highest minus the lowest average for each factor. Minitab assigns ranks based on Delta values; rank 1 to the highest 
Delta value, rank 2 to the second highest, and so on. The ranks indicate the relative importance of each factor to the 
response. Use the level averages in the response tables to determine which level of each factor provides the best result.  
The response tables for S/N ratio and standard deviation both show that sensor has the greatest effect on the variability of 
the response, which was also shown in the linear model analysis. Because you are trying to reduce the variability in the 
measurement system, you want to maximize the signal-to-noise (S/N) ratio and reduce the standard deviation. The 
response tables and main effects plots indicate that level 1 for sensor and level 2 for relay and output device reduce the 
variation in the response. These levels produce the highest S/N ratios and lowest standard deviations. 
You should run a confirmatory experiment to ensure the levels identified produce the desired result. 
 

Predict Taguchi Results 
Predict Taguchi Results (Static Design) 
Stat > DOE > Taguchi > Predict Results. 
You can predict signal-to-noise (S/N) ratios and response characteristics for selected factor settings using the model from 
your Taguchi experiment. For example:    
1    Examine the response tables and main effects plots to identify the factors and settings that have the greatest effect on 

the S/N ratio or standard deviation. 
2    Choose several combinations of settings from the other factors. 
3    From the prediction results, determine which combination of factor settings comes closest to the desired mean without 

significantly reducing the S/N ratio. 
4    Perform a follow-up experiment using the selected levels to determine how well the prediction matches the observed 

result. 
If there are minimal interactions among the factors or if the interactions have been correctly accounted for by the 
predictions, the observed results should be close to the prediction, and you will have succeeded in producing a robust 
product. On the other hand, if there is substantial disagreement between the prediction and the observed results, then 
there may be unaccounted for interactions or unforeseen noise effects. This suggests that further investigation is 
necessary. 
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You can specify the terms in the model used to predict results. For example, you may decide not to include a factor in the 
prediction because the response table and main effects plot indicate that the factor does not have much of an effect on 
the response. You can also decide whether or not to include selected interactions in the model. Interactions included in 
the model will affect the predicted results. 

Dialog box items 
Predict 

Mean: Choose to predict means for the selected factor settings. 
Signal to Noise ratio: Choose to predict signal-noise ratios for the selected factor settings. 
Standard deviation: Choose to predict standard deviations for the selected factor settings. 
Natural log of standard deviation: Choose to predict the natural log of the standard deviations for the selected factor 
settings. 

Store predicted values in worksheet: Choose to store the predicted values in the worksheet. 
 

Predict Taguchi Results (Dynamic Design) 
Stat > DOE > Taguchi > Predict Taguchi Results 
You can predict signal-to-noise (S/N) ratios and response characteristics for selected factor settings using the model from 
your Taguchi experiment. For example:    
1    Examine the response tables and main effects plots to identify the factors and settings that have the greatest effect on 

the S/N ratio or standard deviation. 
2    Choose several combinations of settings from the other factors. 
3    From the prediction results, determine which combination of factor settings comes closest to the desired mean without 

significantly reducing the S/N ratio. 
4    Perform a follow-up experiment using the selected levels to determine how well the prediction matches the observed 

result. 
If there are minimal interactions among the factors or if the interactions have been correctly accounted for by the 
predictions, the observed results should be close to the prediction, and you will have succeeded in producing a robust 
product. On the other hand, if there is substantial disagreement between the prediction and the observed results, then 
there may be unaccounted for interactions or unforeseen noise effects. This suggests that further investigation is 
necessary. 
You can specify the terms in the model used to predict results. For example, you may decide not to include a factor in the 
prediction because the response table and main effects plot indicate that the factor does not have much of an effect on 
the response. You can also decide whether or not to include selected interactions in the model. Interactions included in 
the model will affect the predicted results. 

Dialog box items 
Predict 

Slope: Choose to predict slopes for the selected factor settings. 
Signal to Noise ratio: Choose to predict signal-noise ratios for the selected factor settings. 
Standard deviation: Choose to predict standard deviations for the selected factor settings. 
Natural log of standard deviation: Choose to predict the natural log of the standard deviations for the selected factor 
settings. 

Store predicted values in worksheet: Choose to store the predicted values in the worksheet. 
 

Data − Predict Taguchi Results 
In order to predict results, you need to have: 

•    Created and stored the design using Create Taguchi Design or created a design from data already in the worksheet 
with Define Custom Taguchi Design. 

•    Analyzed the design using Analyze Taguchi Design.  
 

To predict results for a Taguchi design 
1    Choose Stat > DOE > Taguchi > Predict Results. 
2    Choose to predict one or more of the following: 

•    Mean (static design) or slope (dynamic design) 
•    Signal-to-noise ratio 
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•    Standard deviations 
•    Natural log of standard deviation 

3    Click Terms. 
4    Move the factors that you do not want to include in the model from Selected Terms to Available Terms using the 

arrow buttons, then click OK. 

•    to move the terms one at a time, highlight a term, then click  or   

•    to move all of the term, click on  or   
You can also move a term by double-clicking it. 

5    Click Levels. 
6    Do one of the following 

•    To specify factor levels that are already stored in a worksheet column 

−     Choose Select variables stored in worksheet. 

−     Under Levels, click in the first row and enter column containing the new levels of the first factor. Then, use 
the down arrow key to move down the column and enter the remaining factor level columns. Click OK in each 
dialog box. 

•    To select levels from a list of the existing factor levels 

−     Choose Select levels from a list. 

−     Under Levels, click in the first row and choose the factor level from the drop-down list. Then,  use the down 
arrow key to move down the column and choose the remaining factor levels. Click OK in each dialog box. 

 

Predict Taguchi Results − Levels 
Stat > DOE > Taguchi > Predict Taguchi Designs > Levels 
You can specify the levels of the factors for which you want to predict results.  

Dialog box items 
Specify new levels of factors in 

Uncoded units: Choose if the new factor levels are in uncoded units. 
Coded units: Choose if the new factor levels are in coded units. 

Method of specifying new factor levels  
Select variables stored in worksheet: Choose if you want to specify factor levels that are already stored in a 
worksheet column. 
Select levels from a list: Choose if you want to select levels from a list of the existing factor levels. 
Factor: Lists the factors and their assigned names. This box does not take any input. 
Levels: If you are specifying factor levels stored in the worksheet, enter the column containing the new levels of the 
first factor. If you are selecting levels from a list of existing factor levels, click in the row and choose the factor level from 
the drop-down list. 

 

Predict Taguchi Results − Terms 
Stat > DOE > Taguchi > Predict Taguchi Designs > Terms 
Use to select the linear terms and two-way interactions for the model on which the predictions will be based. 

Dialog box items 
Include the selected terms in the prediction  

Available Terms: Shows all the interactions terms that are available but not selected. 
Selected Terms: Shows all the terms that are selected to be included in the prediction model. 

 

Example of predicting results 
Suppose you want to predict results for the golf ball experiment. You identified four controllable factors that you thought 
would influence golf ball distance: core material, core diameter, number of dimples, and cover thickness. Because you 
want to maximize the signal-to-noise (S/N) ratio and mean, you chose factor settings: liquid core, core diameter of 118, 
392 dimples, and the cover thickness of .06. 
1    Open the worksheet GOLFBALL2.MTW. The design and response information has been saved for you. 
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2    Choose Stat > DOE > Taguchi > Predict Taguchi Results. 
3    Uncheck Standard deviation and Natural log of standard deviation. 
4    Click Terms. Make certain that the terms A, B, C, D, and AB are in the Selected Terms box. Click OK. 
4    Click Levels. 
5    Under Method of specifying new factor levels, choose Select levels from a list. 

6    Under Levels, click in the first row and choose the factor level according to the table below. Then, use the  key to 
move down the column and choose the remaining factor levels. 

Factor Level 
Material Liquid 
Diameter 118 
Dimples 392 
Thickness .06 

7    Click OK in each dialog box. 

Session window output  

Taguchi Analysis: Driver, Iron versus Material, Diameter, Dimples, Thickness
 
 
Predicted values 
 
 
S/N Ratio     Mean 
  53.6844  276.263 
 
 
Factor levels for predictions 
 
Material  Diameter  Dimples  Thickness 
Liquid         118      392       0.06 

Interpreting the results  
For the factor settings you selected, the S/N ratio is predicted to be 53.6844 and the mean (the average ball flight 
distance) is predicted to be 276 yards. Next, you might run an experiment using these factor settings to test the accuracy 
of the model. 
 

Modify Design 
Modify Design − Taguchi (Static Design) 
Stat > DOE > Modify Design > Taguchi 
After creating a Taguchi design and storing it in the worksheet, you can use Modify Design to make the following 
modifications: 

•    rename the factors and change the factor levels for the control factors in the inner array 

•    add a signal factor to a static design  
By default, Minitab will replace the current design with the modified design. To store the modified design in a new 
worksheet, check Put modified design in a new worksheet in the Modify Design dialog box. 

Dialog box items 
Modification 

Modify factors in inner array: Choose to rename factors or to change factor levels, and then click <Specify>. 
Add signal factor: Choose add a signal factor to an existing static response experiment, and then click <Specify>. 

Put modified design in new worksheet: Check to have Minitab place the modified design in a new worksheet rather 
than overwriting the current worksheet. 
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Add Signal Factor (Static Design) 
Stat > DOE > Modify Design > Taguchi > Specify 
Allows you to add a signal factor to an existing static design. 

Dialog box items 
Name: Enter text to change the name of the signal factor. By default, Minitab names it "Signal." 
Level Values: Enter numeric values for each level of the factor. 
 

Modify Design − Taguchi (Dynamic Design) 
Stat > DOE > Modify Design > Taguchi 
After creating a Taguchi design and storing it in the worksheet, you can use Modify Design to make the following 
modifications: 

•    rename the factors and change the factor levels for the control factors in the inner array 

•    ignore the signal factor (treat the design as static)  

•    add new levels to the signal factor in an existing dynamic design  
By default, Minitab will replace the current design with the modified design. To store the modified design in a new 
worksheet, check Put modified design in a new worksheet in the Modify Design dialog box. 

Dialog box items 
Modification 

Modify factors in inner array: Choose to rename factors or to change factor levels, and then click <Specify>. 
Modify signal factor: Choose to rename the signal factor or to add new levels to the signal factor, and then click 
<Specify>. 

Put modified design in new worksheet: Check to have Minitab place the modified design in a new worksheet rather 
than overwriting the current worksheet. 
 

Modify Factors  
Stat > DOE > Modify Design > Taguchi > Specify 
Allows you to name or rename the factors and assign values for factor settings. Use the arrow keys to navigate within the 
table, moving across rows or down columns. 

Dialog box items 
Factor: Shows the number of factors you have chosen for your design. This column does not take any input. 
Name: Enter text to change the name of the factors. By default, Minitab names the factors alphabetically. 
Level Values: Enter numeric or text values for each level of the factor. By default, Minitab sets the levels of a factor to the 
integers 1, 2, 3, ... 
Levels: Shows the number of levels for each factor. This column does not take any input.  
 

To rename factors or change factor levels 
1    Choose Stat > DOE > Modify Design.  
2    Choose Modify factors in inner array. Click Specify.  
3    Under Name, click in the first row and type the name of the first factor. Then, use the down arrow key to move down 

the column and enter the remaining factor names. 
4    Under Level Values, click in the first row and type the levels of the first factor. Then, use the down arrow key to move 

down the column and enter the remaining levels. Click OK in each dialog box. 
 

To change the units for the factors 
1    Choose Stat > DOE > Display Design. 
2    Choose Coded units or Uncoded units. Click OK. 
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Adding New Levels to the Signal Factor 
When you add signal factor levels to an existing dynamic design, new rows (replicates) are appended to the end of the 
existing worksheet. For example, if you add 3 new signal factor levels to an existing L8 (2∗∗7) design, 24 rows (3 
replicates of 8 rows each) are added to the worksheet. 
When you add new signal factor levels to an existing dynamic design, the run order will be different from the order that 
results from adding a signal factor while creating a new design. The order of the rows does not affect the Taguchi 
analysis. 
 

Modify Signal Factors (Dynamic Design) 
Stat > DOE > Modify Design > Taguchi > Specify 
Allows you to ignore an existing signal factor and treat the design as non-dynamic. You can also add new levels to an 
existing signal factor. 

Dialog box items 
Modification 

Ignore signal factor (treat as non-dynamic): Choose to ignore the signal factor in the design and treat the design as 
non-dynamic. 
Add new levels to signal factor: Choose to add new levels to an existing signal factor. Enter the new signal factor 
levels in the box. 

 

Adding a Signal Factor to an Existing Static Design 
When you add a signal factor to an existing static design, Minitab adds a new signal factor column after the factor 
columns and appends new rows (replicates) to the end of the existing worksheet. For example, if you add a signal factor 
with 2 levels to an existing L4 (2∗∗3) array, 4 rows (1 replicate of 4 runs) are added to the worksheet; if you add a signal 
factor with 3 levels, 8 rows (2 replicates of 4 runs) are added to the worksheet. A replicate is the complete set of runs from 
the initial design. 

Static design 
(No signal factor) 

Dynamic design 
(Added signal factor with 
2 levels) 

Dynamic design 
(Added signal factor 
with 3 levels) 

A  B  
1   1  
1   2  
2   1  
2   2  

A   B   Signal factor  
1   1        1  
1   2        1  
2   1        1  
2   2        1  
 
1   1        2 
1   2        2  
2   1        2  
2   2        2  

A   B   Signal factor  
1   1        1  
1   2        1  
2   1        1  
2   2        1  
 
1   1        2 
1   2        2  
2   1        2  
2   2        2  
 
1   1        3 
1   2        3  
2   1        3  
2   2        3  

Note When you add a signal factor to an existing static design, the run order will be different from the order that 
results from adding a signal factor while creating a new design. The order of the rows does not affect the 
Taguchi analysis. 

 

To add a signal factor to an existing static design 
1    Choose Stat > DOE > Modify Design.  
2    Choose Add signal factor. Click Specify. 
3    If you like, in the signal factor table under Name, click in the first row and type the name of the signal factor. 
4    Under Level Values, enter the levels of the signal factor. You must enter at least two distinct values. Click OK. 
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Note You can also specify signal factor levels using a range and increments. You can specify a range by typing two 
numbers separated by a colon. For example, 1:5 displays the numbers 1, 2, 3, 4, and 5. You can specify an 
increment by typing a slash "/" and a number. For example, 1:5/2 displays every other number in a range: 1, 3, 
and 5. 

 

To add new levels to the signal factor 
1    Choose Stat > DOE > Modify Design. 
2    Choose Modify signal factor. Click Specify.  
3    Choose Add new levels to signal factor. Enter the new signal factor levels. Click OK. 

Note You can also specify signal factor levels using a range and increments. You can specify a range by typing two 
numbers separated by a colon. For example, 1:5 displays the numbers 1, 2, 3, 4, and 5. You can specify an 
increment by typing a slash "/" and a number. For example, 1:5/2 displays every other number in a range: 1, 3, 
and 5. 

 

To ignore the signal factor 
1    Choose Stat > DOE > Modify Design. 
2    Choose Modify signal factor. Click Specify 
3    Select Ignore signal factor (treat as non-dynamic). Click OK in each dialog box. 
 

Display Design 
Display Design − Taguchi 
Stat > DOE > Display Design > Taguchi 
After you create the design, you can use Display Design to change the way the design points are stored in the worksheet. 
You can display the factor levels in coded or uncoded form. 
If you assigned factor levels in Factors subdialog box, the uncoded (actual) factor levels are initially displayed in the 
worksheet. If you did not assign factor levels (used the default factor levels, which are 1, 2, 3, ...), the coded and uncoded 
units are the same. 

Dialog box items 
How to display the points in the worksheet 
Units for factors:  

Coded units: Choose to display the factor levels in the worksheet in coded form. 
Uncoded units: Choose to display the factor levels in the worksheet in uncoded form.  

 

To change the units for the factors 
1    Choose Stat > DOE > Display Design. 
2    Choose Coded units or Uncoded units. Click OK. 
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